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JSL Board - 2024 
 

 
 

JSL Head Coaches – 2024 

 

JSL BOARD NAME CELL PHONE PERSONAL EMAIL

PRESIDENT Bo Greenwood (804) 833-8942 cgg5d@virginia.edu

VICE-PRESIDENT Emily Callahan (607) 222-5375 emcallahan05@gmail.com

SECRETARY Diane Barros (407) 616-3072 dlpbarros@gmail.com

TREASURER Brian Craddock (434) 817-7980 bac@fplegal.com

PAST PRESIDENT Jennifer McKeever (434) 825-0143 jlm2z@yahoo.com

CHAMPS COMMITTEE VACANT

DUAL MEET COMMITTEE VACANT

WEB PAGE Christina Meyer (434) 249-4884 cfmeyer1@gmail.com

ACAC Team Rep Jackie Parker (434) 872-1161 jacquelinewparker@gmail.com

BHSC Team Rep Maia Ritter (617) 543-7300 maiaritter@yahoo.com

CBST Team Rep Teresa Altman (540) 805-0406 tlaltman05@hotmail.com

CGST Team Rep Jeanie Alexander (434) 989-7681 jeanie.v.alexander@gmail.com

CITY Team Rep Ann Tuzson (434) 409-9383 aet2n@yahoo.com

ELKS Team Rep Laura Outland (804) 370-6245 elks389swimteam@gmail.com

FAST Team Rep Cos DiFazio (434) 962-1168 cos.difazio@gmail.com

FCC Team Rep Amanda Crombie (434) 531-7535 Ajcrombie@virginia.edu

FLST Team Rep Abby Binter (434) 327-2085 abby.binter@gmail.com

FSBC Team Rep Becky Bryan (434) 282-6486 Aquatics@frysspring.org

FV Team Rep Robin Fisher (678) 472-6396 rlsolovey@aol.com

GHG Team Rep Michele Kibler (757) 209-3957 michele.kibler@gmail.com

GLEN Team Rep Caroline Hamilton (434) 466-9328 carolinehamilton820@gmail.com

HM Team Rep Tara Fontenot (434) 989-5823 taraefontenot@gmail.com

KWC Team Rep Claire Chantell (434) 282-9653 clairechantell@gmail.com

LG Team Rep Julia Robbins (540) 223-2597 juliarobbins872@gmail.com

LMST Team Rep Colin Provencher (860) 444-1626 cprov40@yahoo.com

ADVISORS (non voting):

Advisor to the Board Bob Garland, Jr (434) 906-6200 bgarlandjr@gmail.com

BH-JSL Liaison Gordon Hair (434) 960-0849 grhair311@gmail.com

Officials Advisor Locke Boyer (434) 882-0340 flb4j@comcast.net

Rules Judge Bob Garland, Jr (434) 906-6200 bgarlandjr@gmail.com

Seeding/Registrar Advisor Locke Boyer (434) 882-0340 flb4j@comcast.net

Social Media Advisor VACANT

Software Advisor Jessica Simons (434) 962-0443 jrsimons@comcast.net

                                        EXECUTIVE COMMITTEE HIGHLIGHTED IN YELLOW

HEAD COACHES NAME CELL PHONE POOL EMAIL

ACAC Head Coach Jeremy Edwards (804) 592-9351 (434) 978-7529 jeremye@acac.com

BHSC Head Coach Noah Hargrove (434) 906-8528 (434) 972-2237 hargrove2@kenyon.edu

CBST Head Coach Matt Morgan Unlisted (540) 825-1746 headcoach.culpeperbarracudas@gmail.com

CGST Head Coach Tasha Congdon (434) 960-2878 (434) 205-4380 natasha.congdon@gmail.com

CITY Head Coach Andrea Ross (434) 293-7399 (434) 977-2607 rossa@charlottesville.gov

ELKS Head Coach Courtney Duprey (434) 981-3871 (434) 296-6015 courtneyduprey225@gmail.com

FAST Head Coach Michael DiFazio (434) 962-8516 none difaziomike99@gmail.com

FCC Head Coach Jeffrey Zhang (978) 831-8096 (434) 245-0695 bkf4cy@virginia.edu

FLST Co-Head Eve Czirjak (434) 466-7107 (434) 973-0974 evelyn.czirjak@gmail.com

FLST Co-Head Marissa Trader (434) 282-5621 (434) 973-0974 marissatrader@gmail.com

FSBC Head Coach Wesley Kittelberger (703) 474-1413 (434) 296-4181 coach@frysspring.org

FV Co-Head Alissa Hansen (434) 987-5601 (434) 973-7946 alissahansen98@gmail.com

FV Co-Head Dave Anderson (757) 784-5911 (434) 973-7946 danderson@piedmontymca.org

GHG Head Coach Patrick Kibler (434) 960-1114 (434) 985-7328 pdk8d@virginia.edu

GLEN Head Coach Luke Noble    (Ext 153) (434) 817-0506 (434) 817-0506 luke@theclubatglenmore.com

HM Head Coach Helen Dixon (540) 661-6170 (434) 973-9690 hsdixon3@gmail.com

KWC Head Coach Alexa Dunn (814) 602-9941 (434) 977-7665 Alexa.Dunn16@gmail.com

LG Head Coach Debra Bickley (540) 760-1464 (540) 967-1085 CoachDebraB@yahoo.com

LMST Co-Head Austin Fairbanks Unlisted (434) 589-3165 Unlisted

LMST Co-Head Maria Arroyo (434) 987-9477 (434) 589-3165 mariaarroyo1993@gmail.com
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JSL Meet Directors – 2024 

 
 

JSL Computer Operators – 2024 

  

MEET DIRECTORS NAME CELL PHONE EMAIL

ACAC Meet Director Ashley Brooks (434) 996-1533 ashleywc@icloud.com

ACAC Meet Director Paul Breza (Backup) (434) 466-3539 pmbreza@gmail.com

BHSC Meet Director Ryan Ritter (434) 989-7710 Ryan.ritter@gmail.com

CBST Meet Director Megan Lucas (540) 308-0285 megannlucas@gmail.com

CGST Meet Director Rob Ayres (434) 906-5428 rayres70@gmail.com

CITY Meet Director Ann Tuzson (434) 409-9383 aet2n@yahoo.com

CITY Meet Director Betsy Roettger (434) 327-8739 elroettger@gmail.com

ELKS Meet Director Leann Adcock (434) 960-2416 adcock07@comcast.net

ELKS Meet Director Amy Duprey (Backup) (434) 981-9229 amyduprey@hotmail.com

FAST Co-Meet Director Ashley Birckhead (434) 459-1961 ashleybirckhead@gmail.com

FAST Co-Meet Director Brittany Kirtley (434) 566-1509 brittanykirtley23@gmail.com

FCC Meet Director Kristin Kauffman (434) 249-9942 kauffmangirls@yahoo.com

FLST Meet Director Abby Binter (434) 327-2085 abby.binter@gmail.com

FLST Meet Director Karen Trader (434) 531-7405 traderkaren5@gmail.com

FSBC Meet Director Jennifer Sturek (434) 284-1775 jcsturek@gmail.com

FSBC Meet Director Megan Haury (434) 422-2204 meganhaury@gmail.com

FV Meet Director Jeff Hansen (434) 987-2059 meetdirector@fairviewclub.org

GHG Meet Director Sarah Prater (434) 531-3787 sprater@ocss-va.org

GLEN Meet Director Karen Hathaway (434) 760-0738 kmhathaway@gmail.com

HM Meet Director Wes Shelley (434) 964-8635 wesley@wesleyshelley.com

KWC Meet Director Dave Jaskot (301) 461-6691 dwj5z@yahoo.com

KWC Asst. Meet Director Kim Dowdell (434) 242-0922 kim.dowdell@gmail.com

LG Meet Director Valarie Hobbs (814) 706-8910 Hobbsve@lcps.k12.va.us

LMST Meet Director Todd Kalinosky (571) 243-2971 todd.kalinosky@gmail.com

LMST Asst. Meet Director Colin Provencher (860) 444-1626 cprov40@yahoo.com

COMPUTER OPERATORS NAME CELL PHONE EMAIL

ACAC Computer Operator Brian Vanyo (703) 907-9229 brianvanyo@yahoo.com

BHSC Computer Operator Christie Shaps (434) 242-4569 cshaps@earthlink.net

BHSC Computer Operator Elizabeth Contiliano (847) 274-3867 econtiliano@yahoo.com

BHSC Computer Operator Jessica Simons (434) 962-0443 jrsimons@comcast.net

BHSC Computer Operator Mary Rutherford (434) 249-2820 maryljamison@gmail.com

CBST Computer Operator Emily Royston (540) 735-6271 Evroyston@live.com

CBST Computer Operator Teresa Altman (540) 805-0406 tlaltman05@hotmail.com

CGST Computer Operator Chelsea Sachno (804) 855-8841 cgstleadership@gmail.com

CGST Computer Operator Mike Yoensky (540) 449-1321 mike.yoensky@gmail.com

CITY Computer Operator Sean Shanks (434) 996-8190 seanshanks@gmail.com

ELKS Computer Operator Cristy Bodie (434) 981-5378 cmbodie@gmail.com

ELKS Computer Operator Amy Duprey (Backup) (434) 981-9229 amyduprey@hotmail.com

FAST Computer Operator Lymari Rodríguez Rosado (201) 951-2135 lymarirr@yahoo.com

FAST Computer Operator Natasha Gray (434) 882-5338 natashagray1105@gmail.com

FCC Computer Operator Shannon Mrazik (973) 768-4666 shannon.mrazik@gmail.com

FLST Computer Operator Jonathan Seek (703) 332-9865 Jonathan_Seek@yahoo.com

FSBC Computer Operator Scott Wrightson (202) 369-3764 wrightson@gmail.com

FV Computer Operator Andy Lofton (434) 409-1784 andy.lofton@gmail.com

GHG Computer Operator Rachel Freid (434) 960-5150 rachelfreid0710@gmail.com

GLEN Computer Operator Lauren Byrne (434) 249-1390 laurenB3214@gmail.com

GLEN Computer Operator Denise Paduano (540) 471-0786 denisepaduano73@gmail.com

HM Computer Operator Jen Elmore (703) 409-8962 mrs.elmore@yahoo.com

HM Computer Operator Wendy King (434) 960-3853 ourthotfulspot@yahoo.com

KWC Computer Operator Clint Key (919) 423-7851 clintkey@gmail.com

KWC Computer Operator Dave Jaskot (Backup) (301) 461-6691 dwj5z@yahoo.com

LG Computer Operator Debra Bickley (540) 760-1464 CoachDebraB@yahoo.com

LG Computer Operator Kate Straley (540) 223-3269 kateems@gmail.com

LMST Computer Operator Todd Kalinosky (571) 243-2971 todd.kalinosky@gmail.com

LMST Computer Operator Maricel Caballero (434) 996-4616 maricel.caballero@kyndryl.com
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JSL 2024 SCHEDULE FINAL (CORRECTED 6/9/24)

DIVISION I

DAY > WED TUE WED TUE WED WED WED

DATE > 6/12 6/18 6/26 7/2 7/3 7/10 7/17

FORMAT > MR/LF MR/LF IM/FR MR/LF MR/LF IM/FR IM/FR

CGST 1 LMST @ FSBC FV GLEN @ HM @ BHSC

No Scoring

BHSC 2 @ FCC @ GLEN FSBC @ HM FV CGST

No Scoring

HM 3 @ CITY @ FV @ GLEN BHSC CGST FSBC

No Scoring

FSBC 4 KWC CGST @ BHSC FV @ GLEN @ HM

No Scoring

GLEN 5 @ FLST BHSC HM @ CGST FSBC @ FV

No Scoring

FV 6 GHG HM @ CGST @ FSBC @ BHSC GLEN

No Scoring

DIVISION II

DAY > WED TUE WED TUE WED WED WED

DATE > 6/12 6/18 6/26 7/2 7/3 7/10 7/17

FORMAT > MR/LF MR/LF IM/FR MR/LF MR/LF IM/FR IM/FR

LMST 7 @ CGST @ FCC GHG FLST @ KWC CITY

No Scoring

CITY 8 HM FLST FCC @ KWC @ GHG @ LMST

No Scoring

KWC 9 @ FSBC @ GHG @ FLST CITY LMST FCC

No Scoring

FCC 10 BHSC LMST @ CITY @ GHG FLST @ KWC

No Scoring

FLST 11 GLEN @ CITY KWC @ LMST @ FCC GHG

No Scoring

GHG 12 @ FV KWC @ LMST FCC CITY @ FLST

No Scoring

DIVISION III

DAY > WED TUE WED TUE WED WED WED

DATE > 6/12 6/18 6/26 7/2 7/3 7/10 7/17

FORMAT > MR/LF IM/FR IM/FR MR/LF MR/LF IM/FR MR/LF

ACAC 13 CBST @ LG @ ELKS FAST @ CBST FAST

w/ LG w/ ELKS w/ ELKS

No Scoring

FAST 14 @ LG @ ELKS CBST @ ACAC LG @ ACAC

w/ ELKS w/ CBST SWIM @ FUMA w/ ELKS SWIM @ FUMA

No Scoring

LG 15 FAST ACAC @ ELKS @ CBST @ FAST @ ELKS

w/ ELKS w/ ACAC SWIM @ FUMA w/ CBST

No Scoring

CBST 16 @ ACAC @ ELKS @ FAST LG ACAC @ ELKS

w/ FAST SWIM @ FUMA w/ ELKS w/ LG

No Scoring

ELKS 17 @ LG FAST ACAC @ ACAC @ CBST LG

w/ FAST w/ CBST w/ LG w/ FAST  w/ ACAC w/ CBST

No Scoring

MR/LF (now listed at top of each division) = Swim Medley Relay & Long Free (Omit IM & Free Relay)

IM/FR (now listed at top of each division) = Swim IM & Free Relay (Omit Medley Relay & Long Free)

ALL MEETS WILL BE HELD ON WEDNESDAYS STARTING AT 6PM

(Any meet may start earlier if mutually agreed upon in advance)

** PAY ATTENTION TO EXCEPTIONS AND CHANGES AS HIGHLIGHTED IN SCHEDULE !! **

CHAMPIONSHIP DATES ARE FRIDAY, JULY 26th AND SATURDAY, JULY 27th
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SECTION II - JEFFERSON SWIM LEAGUE BYLAWS AND RULES AND REGULATIONS 
  All permanent changes for current season are highlighted in yellow. 
  All one-year trials for current season are highlighted in blue. 

 
 BYLAWS 
Page 1 Article I : Purpose 
 Article II : Board 
Page 2 Article II : Board (continued) 
 Article III : Officers 
Page 3 Article III : Officers (continued) 
 

 RULES AND REGULATIONS 
Page 4 Article IV : Organization 
Page 5 Article IV : Organization (continued) 
Page 6 Article IV : Organization (continued) 
 Article V : Eligibility 
Page 7 Article V : Eligibility (continued) 
Page 8 Article V : Eligibility (continued) 
Page 8 Article VI : Conduct of Meets 
Page 9 Article VI : Conduct of Meets (continued) 
Page 10 Article VI : Conduct of Meets (continued) 
Page 11 Article VI : Conduct of Meets (continued) 
Page 12 Article VI : Conduct of Meets (continued) 
Page 13 Article VII : Championship Meet 
Page 14 Article VII : Championship Meet (continued) 
Page 15 Article VII : Championship Meet (continued) 
Page 16 Article VII : Championship Meet (continued) 
Page 17 Article VIII : Order of Events (Championship Format) 
Page 18 Article VIII : Order of Events (“IM/FR” Format) 
Page 19 Article VIII : Order of Events (“MR/LF” Format) 

  



Jefferson Swim League Procedure Manual - Revised July 5, 2024 
 

[JSL MAN – Sec 2 Bylaws]                                                                               © 2024 JSL - Team Manual Section II - Page 1 

 

JEFFERSON SWIM LEAGUE BYLAWS and RULES AND REGULATIONS 
All permanent changes for current season are highlighted in yellow. 

All one-year trials for current season are highlighted in blue. 
 

BYLAWS 
ARTICLE I: PURPOSE 
 

1. The purpose of this Board is to ensure a summer age group swimming program in 
the Central Virginia area and to provide a maximum opportunity for the greatest 
number to participate. 

 
2. The organization is organized exclusively for charitable, religious, educational, and 

scientific purposes under Section 501(c)(3) of the Internal Revenue Code, or 
corresponding section of any future federal tax code.  (Added, 2014) 

 
3. Upon the dissolution of this organization, assets shall be distributed for one or 

more exempt purposes within the meaning of Section 501(c)(3) of the Internal 
Revenue Code, or corresponding section of any future federal tax code, or shall be 
distributed to the federal government, or to a state or local government, for a public 
purpose.  (Added, 2014) 

 
 
ARTICLE II: BOARD 
 

1. The members of the League Board will consist of five officers, the Chair of the 
Champs Committee, the Chair of the Dual Meet Committee, appointed Advisors, 
and one voting representative from each swim team duly selected by that team for 
a 1-year term beginning on January 1.  Any team failing to provide their 
Representative’s name and contact information by that date will incur a $100 fine.  
The phrase “all representatives” means the total number of team representatives 
on the Board.  (Revised, 2023) 

 

2. A representative cannot have children swimming on another member team.  
(Revised, 2004)  

 

3. A representative or officer cannot be a coach and must be at least 21 years old.  
(Revised, 2004) 

 

4. No representative shall serve more than three consecutive years.  (Revised, 1997)  
 

5. Each representative will have one vote.  The representative is considered to be the 
official contact for all official JSL communications both to and from the Board.  
Motions may only be made by a Team Representative.  If the Team Representative 
is not available an alternate must be provided to JSL.  (Revised, 2022) . 

 

6. A simple majority of all Representatives will constitute a quorum and a simple 
majority of the quorum will carry such resolutions presented except any changes in 
the Bylaws will require a 75% approval of all representatives.  Bylaw resolutions 
may not be voted upon after the first reading except in the case of emergency or 
safety issues.  A second reading at the next Board meeting is required prior to a 
vote being taken. 

  

 Changes to the Rules and Regulations may be approved by a simple majority of all 
representatives after a second reading.  Single season trial programs, which may 
be in conflict with existing Rules and Regulations, may be approved by a simple 
majority of all representatives after one reading.  After a single-season trial, any 
program in conflict with existing Rules and Regulations may only be continued by a 
simple majority of all representatives after a second reading.  (Revised, 2020) 
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7. Officers or Team Representatives may be removed from the Board by a 75% vote 
of all Representatives.  Grounds for removal may include, but not be limited to, 
failure to perform the normal assigned duties of the position, failure to regularly 
attend Board meetings, conviction of a “barrier crime” as defined by the state of 
Virginia, or any actions which violate the standards of the League.  (Adopted 2012) 

 

8. Members of the Jefferson Swim League (JSL) Board who also serve on the Board 
of Directors of the Ben Hair – Just Swim for Life Foundation (BH-JSL) may propose 
motions, but not vote on any motion which references that organization.  (Adopted 

2013) 
 

9. Teams may be removed from the League or put on probation by a 75% vote of all 
Representatives.  Grounds for probation or removal may include, but not be limited 
to; failure to maintain a minimum team size of 40 swimmers, failure to provide a 
safe and adequate pool suitable for hosting meets, or any actions which violate the 
standards of the League.  Teams in violation of any of the above must be given a 
written notice in September that begins a one-year probation to correct any issues 
which may cause them to be removed from the League.  A vote for removal will be 
taken at the following September Board Meeting.  (Revised 2017) 

 
10. Rules and Regulations will be in accordance with current USA Swimming Rules 

and Regulations except as noted otherwise.  Rules and Regulation changes in 
conflict with USAS Rules and Regulations require a 75% approval from all 
Representatives.  (Revised, 2016) 

 
 

ARTICLE III: OFFICERS 
 

1. The Board Officers will consist of a President, Vice-President, Secretary, 
Treasurer, and Immediate Past President.  All but the Immediate Past President 
must be elected in September and all will serve one-year terms beginning on 
January 1st.  The Board Officers, Chair of the Champs Committee, Chair of the 
Dual Meet Committee, and Web Page Advisor will comprise the Executive 
Committee.  The President must have prior JSL Board experience.  The Vice-
President, Secretary, and Treasurer can be elected from the Board or from other 
interested individuals.  If possible, the Vice-President will be President Elect and 
will serve as President for the following year.  (Revised, 2024) 

 
2. No Officer may serve in the same position more than once in three years, nor can 

any team provide the President more than once in three years, nor can the 
President and Vice President be from the same team except by 75% majority vote 
of all representatives.  If any officer is unable to serve their full term, he/she must 
notify the Executive Committee and full Board in writing as soon as possible.  A 
new election may be held, as per Article III to fulfill the remaining term.  (Revised, 

2018)  
 

3. Officers will not have a vote except in the case of a tie, in which case the President 
or in his/her absence the Vice-President, Secretary, Treasurer, or Immediate Past-
President in that order will cast the tie-breaking vote.  This same chain of order will 
also be used for other actions required of the President in his/her absence.  (Revised, 

2001)  
 

  

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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4. The Executive Committee will meet on an "as-needed" basis to facilitate the 
operation of the Board.  Its duties may include, but not be limited to, preparing the 
dual meet schedule, organizing new programs, investigating new business, 
administering the financial assistance fund, approving major financial transactions, 
and generally making recommendations to the whole Board for final approval. 

  

 The Executive Committee meetings will be considered closed meetings, but may 
be opened or restricted by a simple majority vote of the Committee. 

  

 The Executive Committee is responsible for imposing all individual and team 
penalties.  All monetary fines will be donated to a charity chosen by the Board.  
Names of swimmers who are penalized will not be made public if possible.   

  

 The Executive Committee has the authority to make timely or urgent decisions on 
behalf of the full Board in matters which only require a majority Board vote if 
convening the full Board is not practical.  Any such decisions made by the 
Executive Committee and the facts surrounding those decisions must be 
immediately communicated to the full Board and can be overturned by a simple 
majority of the full Board.  (Revised, 2020) 

 
5. The Executive Committee will be responsible for the tentative summer meet 

schedule for the coming season to be approved by the Board no later than the 
March meeting.  The Championship dates and location for the following season 
must be set no later than September. (Revised, 2024)  

 

6. The Executive Committee may appoint a Rules Judge to a one-year term.  The 
Rules Judge will have sole authority in rules and bylaws interpretation and may not 
be a voting member of the Board or a member of the Executive Committee.  The 
Rules Judge rulings may be overturned by a 75% majority of the full Board all 
Representatives.  (Revised, 2024) 
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RULES AND REGULATIONS 
 

ARTICLE IV: ORGANIZATION 
 

1. Meetings will be held as close to monthly as possible (except August) from 
February to September, at a time, date, and place to be determined by the 
Executive Committee.  The meeting day and/or time may be changed or additional 
meetings called by the President provided that adequate notice is given to all 
Board members and there is no conflict with any other League function.  Nothing in 
this bylaw shall preclude the President from convening emergency meetings or 
conducting virtual meetings via Internet communications provided the entire Board 
is notified and all procedures in Article II, #6 are followed.  Board meetings are 
considered to be open meetings, but may be closed or restricted by a simple 
majority vote of all Representatives.  (Revised, 2020) 

 

2. The League shall be divided into Divisions by seeding the teams.  Each team's 
seeding for the coming season will be determined by the team's Championship 
finish position in the just completed season.  The first-place team will become team 
#1; the second-place team will be #2, etc.  Ties will be decided by the teams 
switching relative positions with one another for the coming season.  Divisions will 
be decided by a majority vote of the Board, with the top Division designated as I, 
the next as II, and so on.  Any new team(s) added to the League will be originally 
seeded by a majority vote of the Board and a Division(s) expanded appropriately.   

 

 Division Championships will be determined by the won-loss records of the teams in 
all scored meets.  A second-place finish in a tri-meet will be counted as one-half of 
a win.  (Revised, 2012) 

 

3. The League may purchase outright or share ownership of certain equipment (such 
as, but not limited to computers, software, start systems, watches, etc.) with each 
team.  The League may purchase supplies (such as, but not limited to ribbons, 
forms, labels, etc.) for use by the teams.   

 

 Maintenance and repair of equipment (or replacement if beyond repair) and 
replacement of lost or damaged supplies will be the responsibility of the individual 
team.  Repairs covered by warranty will be facilitated by the League. 

 

 If a team withdraws from the League within three years after joint purchase of any 
equipment, the equipment or replacements shall be returned to the League.  
Equipment or the replacements and supplies purchased exclusively by the League 
shall remain as property of the League and shall be returned at the discretion of the 
Board when a team withdraws.  (Revised, 2023)  

 

4. Teams wishing to join the league must have an anticipated roster of at least 40 
swimmers and a pool available for League meets.  The pool must be at least 25 
yards long and 5 lanes wide and be suitable for nighttime competition.  A request in 
writing must be submitted to the President no later than January 15th and the team 
must have a representative present at the League's February & March Board 
meetings.  Acceptance of new teams will require a 75% approval of all 
representatives.  Upon acceptance the new team will be required to deposit $500 
which will be refunded at the end of their second consecutive season of active 
participation.  (Revised, 2012) 

 

5. The Board may hire persons on a contract basis to perform duties as determined 
by the Board.  Hiring and pay rate will require a majority vote of the Board.  In 
addition, the Board may appoint unpaid Advisors who will be considered as 
members of the Board, but have no vote and may not serve as the team 
representative.  These Advisors may include experienced individuals who have 
such skills as general knowledge of the operation and needs of the League, 
computer software, web page design and maintenance, championship seeding and 
organization, and any other skills deemed to benefit the League.  (Revised, 2023) 
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6. The term “coach(es)” refers to all paid or unpaid persons designated by their team 
as a coach or who serve in a coaching capacity at any League sanctioned event 
such as swim meets, time trials, etc.  The term “deck” means the immediate area 
surrounding the pool as defined by fencing, barriers, walls, etc. and includes any 
area where swimmers normally gather in preparation for the meet, such as team 
areas, clerk-of-course, etc. 

  

  Head Coaches must be at least 18 years old and Assistant Coaches must be at 
least 15 years old by June 1st of the current season.  The expectation is that all 
coaches will be fully JSL certified by the first meet of the season.  Coaches not 
certified to coach by the fourth week of the season may only attend JSL sanctioned 
events as a spectator unless registered as a swimmer. 

  

 Only coaches on deck 18 years old and over prior to June April 1st of the current 
season must have successfully passed a USA Swimming, JSL approved or Virginia 
State Police criminal background check within the last two years.  The background 
check must be nationwide and include all city, county, state, and federal criminal 
records and sex offender registries.  JSL approved companies are listed in Section 
III, Appendix W, of the Team Procedure Manual.  Teams may apply to the 
Executive Committee prior to June 1st for a waiver to use other national 
background checks. No coach who has been convicted of any "Barrier Crime", as 
defined by the state of Virginia, will be allowed in any area where swimmers are 
present at a JSL sanctioned event   

  

 All coaches on deck during JSL sanctioned events must have a current Safety 
Training for Swim Coaches (with CPR/AED and First Aid) certification and will have 
successfully completed a JSL approved Athlete Protection Program within the past 
two years.  A one-time certification in Concussion Protocol Training is required.  
With approval of the Executive Committee, coaches with a physical disability that 
prevents in-water training are only required to have the online portion of Safety 
Training for Swim Coaches certification.  At least one coach from each team on 
deck during JSL sanctioned events must have a current Lifeguarding certification.  
Assistant Coaches who are 15 years old are required by federal law and JSL to 
have a lifeguarding certificate. 

  

 Approved courses for the above certifications are listed on the USA Swimming web 
page under USAS Coaches Safety Requirements.  A copy of certification(s) and 
successful background check for each coach must be on file with the designated 
JSL person by 9PM two days prior to the coach being on the deck during a JSL 
sanctioned event.  Birth dates for those coaches under 18 must be provided.  
Teams that are prohibited from supplying copies of background checks must 
provide a signed written list of coaches with successful completion dates of 
background checks from their personnel departments or other authorized 
person(s).  Swimmers who are also coaches, but who are not certified, may be 
allowed on deck only to swim.  Violations will result in a $250.00 fine to the team 
per coach per sanctioned event and the offending coach will be prohibited from 
attending JSL sanctioned events until certified.  (Revised, 2024) 
 

7. Each team must provide the current thunder and lightning procedure and proof of 
liability insurance for their home meet facility via a current Certificate of Insurance 
delivered to the President or Treasurer no later than May 31st at 9PM or on the 
expiration date of the previous policy.  A minimum of $1,000,000 liability per 
occurrence and $2,000,000 aggregate coverage is recommended.  A $50.00 late 
fee (for one or both) will be charged for teams not meeting these deadlines.  A 
thunder and lightning procedure and current Certificate of Insurance must be on file 
prior to any JSL sanctioned meet being held at any such facility and the thunder 
and lightning procedure must be posted on jsl.org.  (Revised, 2015) 
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8. At each monthly meeting of the Board, the Treasurer must present the following 
reports for approval by the Board: 

 a. the financial report which will contain an accounting of all receipts and 
disbursements since the last report and a photocopy of all JSL bank account 
statements (with the account number deleted) since the last report 

 b. the team summary report which will contain a list of all teams and their current 
status as to insurance certificates, membership statements, registered swimmers, 
fees received and due to the League, and ad sales summaries. 

 c. the championship report which will contain a summary of championship 
receipts and disbursements 

 d. other reports as requested by the Board 
 As soon as possible after the end of each calendar year, the outgoing President 

and outgoing Treasurer must jointly review all financial records (including each 
receipt and disbursement) of that year and confirm the accuracy of those records 
by their signatures on the end-of-year financial statement.  This jointly-signed 
statement must be approved by the Board by a unanimous vote of at least a 
quorum present no later than the following March meeting.  (Revised, 2007) 

 
9. For insurance purposes, incidents involving property damage, theft, or personal 

injury during or as a consequence of a JSL sponsored swim meet must be reported 
on the Jefferson Swim League incident report form to the President of the League 
within 48 hours of knowledge of the occurrence.  (Revised, 2015) 

 
10. Teams whose pools do not meet all of USA Swimming’s Facilities Standards 

(Article 103) must petition the Board for exemption from those individual standards.  
Approval of exemptions shall require a 75% majority of all Representatives and 
approved exemptions shall be recorded in Section 4 of the JSL Team Manual.  
(Adopted, 2004) 

 
11. The Board shall maintain a financial assistance fund in the amount of $1,500 

available on a first-come-first-served basis to defray the full cost of the JSL 
registration fee for up to 10 individual eligible swimmers per team.  The team must 
waive the full team fee or have the full fee sponsored by a third party based only on 
financial need before JSL will consider waiving the League fee.  The waiver 
request with the eligible swimmer’s names(s) must be submitted in writing to the 
President by June 30th.  The Treasurer shall be solely responsible for awarding of 
financial assistance, but must provide a complete accounting to the full Board in a 
timely manner.  (Revised 2023)  

 
12. No one convicted of a “barrier crime”, as defined by the state of Virginia, may serve 

in a volunteer position at any JSL sanctioned event.  (Added, 2020) 

 
ARTICLE V: ELIGIBILITY 
 

1. The governing day of age for the entire summer season will be the swimmer’s age 
on June 1st.  The minimum age is 5 years old.  Swimmers who have swum on a 
college level team are not eligible regardless of age.  Swimmers who are 17 and 
under on June 1st are eligible to swim regardless of high school or college status.  
Swimmers who are 18 years of age on June 1st may swim the summer swim 
season provided they are still in or have immediately finished high school.  (Revised, 

2008)  
 
2. Age groups as determined by the swimmer’s age on June first are as follows:  

   8 & Unders (8&U) 
   9 - 10-year-olds (9-10) 
   11 - 12-year-olds (11-12) 
   13 - 14-year-olds (13-14) 
   15 - 18-year-olds (15-18) 
       (Revised, 2017) 
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3. All swimmers will be bona fide members of their respective teams with membership 
to be regulated by the individual teams.  A swimmer may not compete on more 
than one team in a season.  A swimmer may not change teams in one season after 
competing with their original team.  (Revised, 1996)  

 
4. Each team must provide their current swim team membership and eligibility 

requirements for the coming season to the President or Treasurer no later than 
May 31st at 9PM.  This information will be posted on the League’s Website (JSL 
Teams) in a timely manner.  Changes in requirements not reported to the Board by 
the deadline will carry a $50.00 late fee.  (Revised, 2016)  

 
5. There will be a non-refundable charge of $30.00 per swimmer (including $1.00 to 

BH-JSL) from the teams to help meet expenses of the League and its 
Championship meet.  One copy of a COMPLETED JSL Registration Form for each 
swimmer must be received by the President, Treasurer, or Registrar of the 
Jefferson Swim League and an accurate Roster file containing a cl2 or hy3 file of 
all properly registered swimmers must be transmitted or taken to the Registrar by 
9PM two days before the team's first scheduled meet. All of the initial team fees 
must be in the hands of the Treasurer by this same deadline.  Failure to submit the 
initial fees by the deadline will result in a $100 fine to the team.   Teams using 
Board-approved online registration must collect all of the information required by 
the League’s registration form (including waivers) and do not submit handwritten 
registration forms. 

 

 New swimmers must be added (in the same manner, including updated Roster file) 
by 9PM two days before the meet in which they are to swim the first time.  
Swimmers failing to meet the above deadlines may not swim.  The swimmer is not 
an eligible swimmer until all information is received in the manner described above.  
Corrections made to the Roster file must be brought to the attention of the 
Registrar via email.  The President or Treasurer will forward appropriate materials 
to the Registrar in a timely manner.  Teams are responsible for timely payment of 
all fees as determined by the Treasurer.  The Executive Committee has the 
authority to refuse additional members of a team for non-payment of fees.  (Revised, 

2022) 
 
6. Swimmers may be entered as official in only three individual events and the 

scheduled relay(s) except in the first week when swimmers are limited to two 
individual events and one relay.  No swimmer may swim officially in more than 1 
age group of the same relay nor can a 5- or 6-year-old swim both the 6-and-under 
event and the 8-and-under event in the same individual event. 

  

 Seeding times must be the fastest official JSL time swum by the swimmer (or relay 
team) in the entered event during the current JSL season.  Otherwise, the swimmer 
will be entered as “no time” and seeded last.  No relay split times (including lead-off 
splits) are considered to be official times and cannot be used for seeding purposes. 

  

 Changes (other than deletions) may not be made without approval of all competing 
Meet Directors once the entry data has been exchanged among the competing 
teams.  (Revised, 2015) 

 
7. Swimmers in relays may move up one or more age groups if not swimming in their 

own age group relay, however, no swimmer official or exhibition will be allowed to 
swim up in individual events.  (Revised, 2004)  

 
8. Official meet results must verify a swimmer’s participation in at least two League 

meets one of which may be JSL Board approved time trial during the current 
season to be eligible to be entered or compete in the Championship meet.  (Revised, 

2017) 
 

  

https://www.jsl.org/teams2020.php
https://www.jsl.org/teams2020.php
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9. Swimmers found to be in violation of the above sections of Article V - Eligibility will 
be disqualified and deleted from any individual or relay event(s) illegally swum by 
that swimmer.  An additional 25 points per illegal swimmer will be subtracted from 
the total team score for each meet illegally swum.  (Revised, 2015)  

 

10. Any team found swimming or attempting to swim a swimmer in place of another 
swimmer (that is, using the wrong name) will forfeit all of the points (individual and 
total relay) earned illegally by that swimmer and an additional 100 points per 
swimmer for each infraction.  In addition, the swimmer(s) will be disqualified for the 
remainder of the meet and the incident brought to the attention of the Board by the 
Meet Director.  (Adopted, 1996)  

 

11. Organized JSL Team practice with a JSL coach present is not allowed in the 
YMCA after the first meet of the season.  Teams found in violation will forfeit 100 
points at that season's Championship.  (Revised 2023) 

 

12. A swimmer without a physical disability must be able to swim 25 yards or meters 
unassisted to be eligible to swim in a JSL meet.  (Revised 2023) 

 
 

ARTICLE VI: CONDUCT OF MEETS 
 

1. The regular season schedule will consist of the “IM/FR” or “MR/LF” formats which 
list the official events for the meet with each team scheduled as close to an equal 
number of each format and home and away meets as possible.  Additional 
exhibition events may be added to a meet, or the event order, time, date, or 
location of a meet may be changed by mutual agreement of the competing teams’ 
JSL Representatives up to one week prior to the first meet of the season.  After 
that date the event order, time, date, or location of a meet may be changed and 
additional exhibition heats or events may be added by mutual agreement of the 
Home and Visiting teams’ Meet Directors, prior to the deadline for meet entries.  
(Revised, 2015) 

 
2. Points awarded for individual events will be 7-5-4-3-2-1 with no team taking more 

than 2 scoring places.  Points awarded for relay events will be 10-5-3 with no team 
taking more than 1 scoring place.  No points or ribbons will be awarded to a 
disqualified or unofficial swimmer or relay team.  Ribbons will be awarded for 1st 

through 16th place with heat winners for all individual and relay events.  Ribbon 
distribution will follow the actual order of finish.  (Revised, 2016) 

 
3. All swimmers must meet the eligibility requirements of Article V.  “Official” 

swimmers are those swimmers who are entered in an event by the meet entry 
deadline and are eligible for ribbons and points.  “Exhibition” swimmers are those 
swimmers who were not part of their team’s allowable number of entries in an 
event, or who are entered for time only, or who have exceeded their maximum 
number of allowable event entries, or who missed the meet entry deadline.  Relay 
Teams with one or more Exhibition swimmers will swim as Exhibition.  Exhibition 
swimmers or Exhibition Relay Teams are not eligible to receive ribbons or points 
and are designated as “X” (exhibition) on all reports and labels.  However, their 
times are considered official.  (Revised, 2024) 

 

  



Jefferson Swim League Procedure Manual - Revised July 5, 2024 

[JSL MAN – Sec 2 Bylaws]                                                                               © 2022 JSL - Team Manual Section II - Page 9 

4. In all pools there will be a maximum of three heats of official swimmers for all 
events, except events #P21 and P22 and #21 through 30 (6&U, 8&U, 9-10, 11-12, 
13-14, 15-18 short freestyle events) where unlimited official heats are allowed; 
events 41 and 42 (8&U backstroke) where five official heats are allowed; and relay 
events where only one official heat is allowed.  Each team is only allowed to enter 
up to the number of official swimmers which equals their fair share of the available 
lanes in the official heats.  

  

 After all official entries are made, no further additional heats shall be added to 
accommodate exhibition swimmers.  That is, exhibition swimmers may only occupy 
vacant lane(s) of a heat containing official swimmers.  Exhibition swimmers must 
be seeded last in each event and designated with an "X" (exhibition) beside their 
name on all reports and labels.  In addition, any coach entering exhibition 
swimmers must verify that “Exhibition” timing cards are used for these swimmers.  
Available lanes for exhibition swimmers will be divided equitably between the 
teams.  By mutual agreement of the Home and Visiting Meet Directors, additional 
heats of exhibition swimmers may be added prior to the start of the meet, or the 
total number of heats may be decreased at any time before or during the meet.  
(Revised, 2017)  

 

5. All meet entries must be made using the JSL Upload Utility as instructed on the 
“Meet Entries Upload Page” of jsl.org no later than 9 PM two days before the 
scheduled meet.  Optional requests by the visiting team's coach for odd or even 
lanes must be made at this time.  In the event of communication difficulty with 
jsl.org, the President may devise an alternate procedure for meet entries with all 
teams complying.  Uploads received after 9 PM will carry a $50.00 fine.  After 10 
PM there will be a $100 fine.  (Revised, 2016) 

 

6. At the time computerized entries are made for a meet, the coach should enter any 
known exhibition swimmers by checking the EXH column in TEAM Manager.  The 
coach should also submit a list of exhibition swimmers in order of preference to the 
home team computer operator for various events.  These exhibition swimmers do 
not have to be approved by the Meet Directors.  They will be added to empty lanes 
in existing heats divided equitably between the teams up to the 3-heat maximum in 
each event and will be seeded last. 

  

Prior to the meet entry deadline, requests from teams that have not been 
scheduled to swim the 8&U Medley Relay events at least three times shall be 
honored by the addition of exhibition events 10 and 11 in IM/FR meets.  (Revised, 

2024) 
 

7. Late entries may be made to empty lanes in existing heats up until the start of the 
meet.  These late changes require the approval of the Home and Visiting Meet 
Directors and the swimmers will be exhibition as outlined in Article VI, #3 & #4.  
Changes from one event to another are not permitted under any conditions.  
(Adopted, 2004)  

 

8. The home team is responsible for watches, CTS Starting system, and coordinating 
qualified officials and all volunteer positions with equal participation by each team.  
There must be three timers assigned to each lane.  Minimum age for timers is 15. 
(Revised, 2023) 

 

9. Each meet will start at a time approved by the Board with the pool open for practice 
at least one hour in advance and ending 15 minutes before the scheduled meet 
start unless different times are agreed upon by the Home and Visiting Meet 
Directors.  Meets which have not begun within one hour of the scheduled start time 
(unless agreed upon by the Home and Visiting Meet Directors) due to inclement 
weather will be rescheduled as outlined below in #18. 

  

 Once all teams are on the premises, the decision to cancel the meet cannot be 
made prior to the one-hour delay unless agreed upon by the Home and Visiting 
Meet Directors.  The decision to cancel prior to arrival must be made by the Home 
Meet Director in conference with the visiting Team Meet Director(s).  (Revised, 2004)  

  

https://www.jsl.org/general2020.php?menu=meets&section=entries&content=entriesup


Jefferson Swim League Procedure Manual - Revised July 5, 2024 

[JSL MAN – Sec 2 Bylaws]                                                                               © 2022 JSL - Team Manual Section II - Page 10 

10. The home team must have qualified lifeguards on duty from the time the pool is 
opened for the visiting team and continuing for the duration of the meet.  There 
must be sufficient lifeguards for the size of the pool and the expected size of the 
meet.  Coaches on duty may not also function as lifeguards.  All teams are 
encouraged to have qualified lifeguards on duty (who are not functioning as 
coaches) during all practices.  (Adopted, 2013) 

 
11. During warm-ups for each team, the team's coach shall designate lap lane(s) in 

which swimmers must climb (not jump) into the pool feet first and two-way traffic 
will be allowed with swimmers keeping to the right in the lane.  Sprint lane(s) must 
be designated in which swimmers may dive in at reasonable intervals, swim to the 
other end, and get out.  There will be only one-way traffic in a sprint lane.  (Revised, 

2004) 
 
12. In the interest of fairness, no physical assistance shall be given any swimmer at the 

start or before the end of any race (e.g., providing towels to cover slippery starting 
blocks) unless that assistance is offered to every swimmer.  (Revised, 2019)  

 
13. The Meet Director has the authority to modify the rules for the swimmer with a 

disability using the guidelines under Article 105 of USA Swimming Rules and 
Regulations.  Additional modifications may not be made unless the swimmer swims 
as exhibition.  (Revised, 2005)  

 
14. If a coach has a problem or complaint, he/she must take it to the Referee or, in his 

or her absence, to the Host Meet Director.  Protests against the judgment of 
decisions of starters, stroke, turn, place, and relay take-off judges can only be 
considered by the Referee and the Referee's decision shall be final.  (Revised, 2011) 

 
15. No false starts are allowed in any age group, but the disqualified swimmer(s) will 

be allowed to swim the event.  The Referee shall otherwise follow the rules under 
Article 101.1.3 of USA Swimming Rules and Regulations.  (Revised, 2023)  

 
16 Integration of the official times will be used to determine the order of finish provided 

there are three valid times on every lane.  Sweep judges will be used to provide 
secondary confirmation of the order of finish.  In pools where an automatic or semi-
automatic timing system is used, the order of finish will be determined using USA 
Swimming rule 102.24 (USA Swimming Rules and Regulations).  (Revised, 2012) 

 
17. No dual meet will last past 10PM except in cases of delay caused by inclement 

weather.  Weather delayed meets will not go past 10:30PM.  No further event 
groups (IM, Med Relay, Short Free, Fly, Breast, Back, Long Free, or Free Relay) 
may be called to the blocks after time has expired.  However, events (e.g., 74) 
which are in the water when time expires may be completed through that event 
group (e.g., all of Long Free events) if agreed upon prior to the start of the meet 
and scoring will be through the last completed individual or relay event.  By mutual 
agreement of the Home and Visiting Meet Directors and confirmed by the Referee 
PRIOR to the beginning of the meet, either or both of the above times may be 
extended 30 minutes and event groups may be completed after time expires.  
(Revised, 2012) 

 
  

https://www.usaswimming.org/docs/default-source/rules-regulations/2021-mini-rulebook.pdf
https://www.usaswimming.org/docs/default-source/rules-regulations/2021-mini-rulebook.pdf
https://www.usaswimming.org/docs/default-source/rules-regulations/2021-mini-rulebook.pdf
https://www.usaswimming.org/docs/default-source/rules-regulations/2021-mini-rulebook.pdf
https://www.usaswimming.org/docs/default-source/rules-regulations/2021-mini-rulebook.pdf
https://drive.google.com/open?id=1ZDO-r5qyMZ5pGIAiHATP2io37NpYy5O7
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18. The Host Team Meet Director in conference with the Visiting Team Meet 
Director(s) shall be responsible for making and implementing all decisions 
regarding weather and air quality issues.  Generally accepted electronic lightning 
and weather monitoring devices must be used to assist in those decisions. 

  

 In the event of thunder or lightning (including “heat” lightning) or rain hard enough 
to obscure the bottom of the pool as observed by lifeguard(s), Referee, or any 
Meet Director, the Meet Director(s) or Referee shall immediately stop the meet and 
clear the pool of all swimmers.  In the case of thunder or lightning, everyone will 
also be cleared from the deck and directed to safe shelter until at least 30 minutes 
have passed since thunder or lightning were last observed.  The meet may not be 
resumed until after this 30-minute period has passed as determined by the Meet 
Directors.  Each team shall have a plan for clearing its pool area which fits its 
structure and safe shelter availability.  The host's team's pool management policy 
will prevail if stricter than League policy. 

  

 Meets shall not be held when the Air Quality Index (AQI) is 300 or above at the 
host pool location as determined by AirNow.gov.  For any AQI over 150, the Host 
Team Meet Director in conference with the Visiting Team Meet Director(s) shall 
determine if the meet shall be held.(Revised, 2024)  

 
19. The Home Meet Director in conference with the visiting Team Meet Director(s) will 

decide when a meet shall be suspended due to inclement weather or other 
circumstances.  After the completion of one-half of the scheduled official events a 
meet will be considered complete.  Tuesday or Wednesday suspended meets will 
be swum on Thursday of the same week except any meet involving held at Greene 
Hills will be swum on Monday of the following week.  By mutual agreement of the 
Home and Visiting Meet Directors, a meet not completing the half-way event may 
be considered complete or another completion date may be agreed upon.  (Revised, 

2024) 
 
20. For all suspended meets, anything swum will not be re-swum and the score will be 

carried forward.  The remainder of the meet may be re-seeded only to include 
including the possible change of swimmers from exhibition to official status, the 
addition of new swimmers as exhibition who meet the requirements of Article V, #5, 
and the deletion of swimmers who cannot attend the rescheduled meet. 

  

 All changes from exhibition to official status and all additions must be approved and 
initialed on the timing cards by the Home and Visiting Meet Directors.  A swimmer 
is not allowed to change from one event to another under any circumstances. 

  

Rescheduled Meets which have not been swum prior to the upcoming Sunday for 
the competing teams, may be treated as a new meet, except anything swum will 
not be re-swum and the score will be carried forward.  Additionally, the number of 
allowable swims by each swimmer will include the totals from both meets.  The 
“9PM two days before the meet” deadlines must be followed.   (Revised, 2024)  

 
21. No alcoholic beverages, illicit drugs, or tobacco products are to be consumed by 

coaches or swimmers during warm-ups or during the course of the meet or by 
officials (including all deck workers, table workers, & clerks) while on duty during 
the course of the meet.  Violations must be reported to both the home and visiting 
team(s) Meet Directors at the time of the occurrence.  Each violation will carry a 
$50.00 team penalty.  (Revised, 2010) 

 
  

https://www.airnow.gov/
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22. Alcohol may not be served or consumed on the deck during meets.  Spectators 
consuming alcohol must be restricted to outlying areas of the pool.  Smoking and 
use of other tobacco products is prohibited on the pool deck and in all areas used 
by swimmers during the meet or during warm-up periods prior to the meet.  Stricter 
team regulations may supersede this section.  Violations will carry a $50.00 fine.  
(Revised, 2020)  

 
23. All swimmers, coaches, parents, and officials shall conduct themselves in a 

sportsman-like manner prior to, during, and immediately following swim meets.  
Suspected violation(s) should be directed in writing to the Executive Committee in 
a timely manner through the team's authorized Representative.  The suspected 
violator(s) and appropriate witness(es) may be called before the Executive 
Committee at its discretion for a hearing at which time guilt and punishment shall 
be determined by a majority of all Executive Committee members. 

  

 Theft, willful destruction of property, or attempted or intentional bodily injury will be 
punishable by suspension for at least the next two League meets.  A written 
apology as directed by the Executive Committee will be required prior to the 
individual(s) resuming participation in the League.  A 100-point penalty will be 
assessed against the offender’s team for any of these infractions occurring during 
the course of a League meet.  In addition, all points scored by an offending 
swimmer(s) will be canceled for that meet. 

  

 All Executive Committee hearings and decisions must be reported to the full Board 
in a timely manner.  Any decision by the Executive Committee may be appealed to 
the full Board.  A simple majority of all representatives will be required to overrule 
the Executive Committee.  (Revised, 2020)  

 
24. Both dual meets and Tri-meets may be included in the schedule and either may be 

scored or unscored at the discretion of the Board.  In all meets ribbon distribution 
will follow the actual order of finish.  Unscored meets will count towards a 
swimmer’s two-meet Championship qualification requirement and all times will be 
considered official.  All other JSL rules and procedures will be in effect. 

  

 In the first week of the season each swimmer may be entered as official in only 
TWO individual events and one relay and coaches have the option to submit the 
names of those swimmers who are to be seeded in the fastest heat of each event.  
This information must be submitted by the meet entry deadline. 

  

 The Board may schedule time trials open to all swimmers with no times in the 
scheduled events.  The time trials must have a Referee present and use all JSL 
rules and procedures.  One JSL Board approved time trial may count towards the 
two-meet qualifying standard for Championship entry. 

 

 Intra-squad meets may be scheduled by the Board prior to the start of the season, 
but are not considered to be official JSL meets unless a Referee is present and all 
JSL Rules and Regulations are followed.  (Revised, 2020) 

 
25. Both Home and Visiting Team Meet Directors are required to notify the Executive 

Committee of any rules violations occurring while serving in their official positions 
at a dual meet.  Final scores are submitted as swum and any penalties will be 
determined by the Executive Committee.  (Revised, 2010) 

 
26. Diving is not allowed for 8-and-under relays from the non-block end of any pool 

during a JSL sanctioned event. except at the Championship at UVa’s Aquatic and 
Fitness Center.  (Revised, 2024) 
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ARTICLE VII CHAMPIONSHIP MEET 
 

1. All rules and regulations listed above shall apply except as listed below.  
 

2. The meet will include all events as listed under the Championship Meet Format.  
Each team may have up to four official entries in each individual event and one 
entry into each relay event.  Each individual swimmer may officially enter a 
maximum of four events - three individual events and one relay event or two 
individual events and two relay events.  Swimmers entered in a 6-&-Under event 
will not be allowed to enter that same event as an 8-&-under.  (Revised, 2018) 

 

3. All swimmers NOT officially entered in any events (as outlined in #2 above) may be 
entered as exhibition (X), first in the unlimited heats of short free, then as exhibition 
(X) in one other event of either butterfly, backstroke, or breaststroke.  Swimmers 
who are official in only one event (as outlined in #2 above) may be entered as 
exhibition (X) in one more event of either short free, butterfly, backstroke, or 
breaststroke.  Swimmers who are official in two or more events (as outlined in #2 
above) may not be entered as exhibition in further events.  Entry as an alternate 
shall not eliminate the swimmer as an exhibition entry into short free or into the one 
other event.  No team may enter an exhibition swimmer who has a faster seed time 
than any of the team's four official entries in an event.  All exhibition swimmers will 
swim their individual events and be eligible for points and ribbons.  (Revised, 2004) 

 

4. As many alternates as the coach feels necessary are allowed.  However, entry as 
an alternate shall count as an entry towards the limit of four entries for each 
swimmer for the meet.  No team may enter an alternate who has a faster seed time 
than any of the team's four official entries in an event.  Alternates will be allowed to 
fill (in order of seed times) open positions in individual events to complete a partial 
heat until final seedings have been printed.  Alternates will also be allowed to fill (in 
order of overall seed times, not necessarily from team scratched) any lane vacancy 
created by a swimmer being "scratched" at the seeding meeting.  All alternates will 
be eligible for points and ribbons.  No alternates may be added to any individual 
event after final seeding.  (Revised, 2004) 

 

5. Each team will be allowed to enter only ONE relay team in each event.  Alternates 
are allowed as substitutes.  The entry (seed) time must be the best (fastest) official 
time actually swum by a relay team during the current season in the JSL.  If a 
swimmer is moved up to an older group in a relay; he/she may not swim the SAME 
relay with his/her age group.  He/she may, however, swim (for example) as an 11-
12 in the Medley Relay and as a 13-14 in the Freestyle Relay. 

  

 All members of each relay team must report to the Clerk-of-Course as the event is 
called.  Final names and swimming order for relay events will be listed on the relay 
timer's card prior to the end of the warm-up session for Medley Relay and by the 
end of the Butterfly events for Free Relay; otherwise, the team will swim as 
exhibition.  Additionally, the Clerk will confirm the identity of each swimmer prior to 
the event being called to the starting blocks.  (Revised, 2013)  

 

6. All seeding entry times must be the best (fastest) official times swum by the 
swimmer in the event during the current season in the JSL.  Seeding times will be 
entered as unconverted yard time (Y), short meter (S), or long meter (L) using the 
Team Manager Program.  The Computerized Meet Manager will convert all times 
to be consistent with the Championship venue.  Alternates will be entered in the 
same manner on a separate disc as a separate meet and will be chosen based on 
fastest time(s) and lane availability.  (Revised, 2013)  
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7. After the final seedings, "no shows" (sickness, etc.) in individual events will NOT be 
replaced in the meet.  That is, the lane will remain vacant.  Coaches should report 
all "No shows" to the Clerk-of-Course at the start of the meet.  If a swimmer present 
has to drop out of an event, the coach should report this to the Clerk-of-Course 
prior to the first heat of the event taking the blocks.  (Revised, 1997)  

 

8. The seeding is to be done by computer no later than the Saturday prior to the 
Championship Meet.  At a deadline time determined by the Executive Committee, 
Coaches must submit a Commlink file via email attachment which contains all 
Championship entries to the Seeding Advisor.  A coach (or designated person) 
must be available by phone until it is successfully entered into the JSL computer. 

 

 Any new swimmers added after the meet entry deadline shall swim as exhibition 
and will not be eligible for points or awards.  If a swimmer has no recorded time in 
a given event, he/she should be listed as "No Time" and will be seeded last.  If a 
swimmer is entered in more than the allowed number of events, he/she will be 
dropped from the last event(s) entered in error. 

 

 No later than Sunday prior to the Meet, all Coaches will be provided with a 
preliminary heat sheet to proofread during the JSL Board meeting.  Errors will be 
noted and corrections made at the end of the Board meeting.  No coach's errors 
may be corrected without the Seeding Advisor’s approval.  A final copy of the 
seeding sheet will be made and copies given to all coaches as soon as possible.  
At this point, changes must be approved by the Referee prior to the start of the 
Championship meet session.  New entries shall be limited to those swimmers 
inadvertently left off of the original Championship entries and the swimmer entered 
as Exhibition on a space available basis.  Timing sheets and cards will be printed 
by computer after the final proofread.  (Revised, 2023) 

 

9. Any team which fails to have Championship Entries in by the designated deadline 
time will be penalized 100 points for the Championship.  (Adopted, 1996) 

 

10. If a coach has a problem or complaint, he/she must take it to the Referee.  
 

11. All officials, starters, announcers, table workers, etc. must report promptly as 
assigned.  Absentees must be replaced by the team responsible for that position  

 Teams failing to fill their assigned Championship positions by 12 Noon on the 
Friday one week prior to Champs will incur a 25-point penalty per vacant position to 
be deducted from their final team score.  Teams will also incur a 25-point penalty 
per absentee volunteer or substitute more than 15 minutes late at the 
Championship.  (Revised, 2020) 

 

12. Warm-ups will be held at the discretion of the Board with lane assignments, times, 
and length assigned by the Board.  Meet start times and schedules are determined 
by the Board.  (Revised, 2004)  

 

13. Refreshments will be provided to officials.  A break(s) to change officials will be 
scheduled at the discretion of the Board.  (Revised, 2004)  

 

14. FREE heat sheets will be provided as needed for officials and coaches.  All other 
full programs will be sold.  (Revised, 2004)  
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15. Awards for all events will follow the actual order of finish.  Trophies will be awarded 
for first place in 6 and under events.  Medals will be awarded for first, second and 
third places in all other events.  Ribbons will be awarded from 4th through 36th 
place in 12-year-old and under events and from 4th through 25th place in all 13 
year old and over events.  Heat ribbons will be awarded.  Jefferson cups will be 
awarded for each over-all age/sex group winner and runners up. 

 

 Team Plates will be awarded to team winner and runner-up in each division as 
determined by overall raw score.  In addition, team plates will be awarded to the 
regular season champions and runners-up in each division.  The JSL 
Sportsmanship Award will be awarded to the team in each Division with the highest 
sportsmanship rating.  (Revised, 2015)  

 
 16. Scoring 
   Individual Relay Relay Individual* 

First = 19.0 points 29.0 points 9.50 points 
Second = 18.0 points 28.0 points 9.00 points 
Third = 17.5 points 27.5 points 8.75 points 
Fourth = 17.0 points 27.0 points 8.50 points 
Fifth = 16.5 points 26.5 points 8.25 points 
Sixth = 16.0 points 26.0 points 8.00 points 
Seventh = 15.5 points 25.5 points 7.75 points 
Eighth = 15.0 points 25.0 points 7.50 points 
Ninth = 14.5 points 24.5 points 7.25 points 
Tenth = 14.0 points 24.0 points 7.00 points 
Eleventh = 13.5 points 23.5 points 6.75 points 
Twelfth = 13.0 points 23.0 points 6.50 points 
Thirteenth = 12.5 points 22.5 points 6.25 points 
Fourteenth = 12.0 points 22.0 points 6.00 points 
Fifteenth = 11.5 points 21.5 points 5.75 points 
Sixteenth = 11.0 points 21.0 points 5.50 points 
Seventeenth = 10.5 points 20.5 points 5.25 points 
Eighteenth = 10.0 points 20.0 points 5.00 points 
Nineteenth = 9.5 points 19.5 points 4.75 points 
Twentieth = 9.0 points 19.0 points 4.50 points 
Twenty-first = 8.5 points 18.5 points 4.25 points 
Twenty-second = 8.0 points 18.0 points 4.00 points 
Twenty-third = 7.5 points 17.5 points 3.75 points 
Twenty-fourth = 7.0 points 17.0 points 3.50 points 
Twenty-fifth = 6.5 points 16.5 points 3.25 points 
Twenty-sixth = 6.0 points 16.0 points 3.00 points 
Twenty-seventh = 5.5 points 15.5 points 2.75 points 
Twenty-eighth = 5.0 points 15.0 points 2.50 points 
Twenty-ninth = 4.5 points 14.5 points 2.25 points 
Thirtieth = 4.0 points 14.0 points 2.00 points 
Thirty-first = 3.5 points 13.5 points 1.75 points 
Thirty-second = 3.0 points 13.0 points 1.50 points 
Thirty-third = 2.5 points 12.5 points 1.25 points 
Thirty-fourth = 2.0 points 12.0 points 1.00 point 
Thirty-fifth = 1.5 points 11.5 points 0.75 point 
Thirty-sixth = 1.0 point 11.0 points 0.50 point 

  
 No team will be allowed to score more than TWO places in any individual event.  

*Relay Individual points will only be awarded to individual swimmers who swim less 
than three individual events.  (Revised, 2014)  
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17. Protests against the judgment of decisions of starters, stroke, turn, place, and relay 
take-off judges can only be considered by the Referee and the Referee's decision 
shall be final.  (Adopted, 1997)  

 
18. The order of finish shall be by integration of official times as determined by 

following procedures in the current USA Swimming Rules and Regulations, Section 
102.24.  (Revised, 2012)  

https://www.usaswimming.org/docs/default-source/rules-regulations/2021-mini-rulebook.pdf
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ARTICLE VIII: JSL ORDER OF EVENTS 
 

 1. Championship Format (All Events) 
 

 BOYS EVENTS   GIRLS EVENTS 
 

 8&U FREESTYLE RELAY Group Events  
 **  P1 6&U 100yd/m Boys, Girls, &/or Mixed Free Relay (short course only)  ** 
 

 INDIVIDUAL MEDLEY Group Events 
 (Short Course Only) 
 3 ........... 9-10 100yd/m .............. 4 
 5 ........... 11-12 100yd/m .............. 6 
 7 ........... 13-14 100yd/m .............. 8 
 9 ........... 15-18 100yd/m .............10 
 

 MEDLEY RELAY Group Events 
 (8&U Medley relay is NOT swum in long course pools) 
 11 ........... 8&U 100yd/m .............12 
 13 ........... 9-10 200yd/m .............14 
 15 ........... 11-12 200yd/m .............16 
 17 ........... 13-14 200yd/m .............18 
 19 ........... 15-18 200yd/m .............20 
 

 SHORT FREESTYLE Group Events 
 **  P21 ........... 6&U 25yd/m .......... P22 ** 
 21 ........... 8&U 25yd/m .............22 
 23 ........... 9-10 50yd/m .............24 
 25 ........... 11-12 50yd/m .............26 
 27 ........... 13-14 50yd/m .............28 
 29 ........... 15-18 50yd/m .............30 
 

 BREASTSTROKE Group Events 

 31 ........... 8&U 25yd/m .............32 
 33 ........... 9-10 50yd/m .............34 
 35 ........... 11-12 50yd/m .............36 
 37 ........... 13-14 50yd/m .............38 
 39 ........... 15-18 50yd/m .............40 
 

 BACKSTROKE Group Events 
 **  P41 ........... 6&U 25yd/m .......... P42 **  thru event P41 is halfway in short course 
 41 ........... 8&U 25yd/m .............42 
 43 ........... 9-10 50yd/m .............44  thru event 43 is halfway in long course 
 45 ........... 11-12 50yd/m .............46 
 47 ........... 13-14 50yd/m .............48 
 49 ........... 15-18 50yd/m .............50 
 

 BUTTERFLY Group Events 
 51 ........... 8&U 25yd/m .............52 
 53 ........... 9-10 50yd/m .............54 
 55 ........... 11-12 50yd/m .............56 
 57 ........... 13-14 50yd/m .............58 
 59 ........... 15-18 50yd/m .............60 
 

 LONG FREESTYLE Group Events 

 61 ........... 8&U 50yd/m .............62 
 63 ........... 9-10 100yd/m .............64 
 65 ........... 11-12 100yd/m .............66 
 67 ........... 13-14 100yd/m .............68 
 69 ........... 15-18 100yd/m .............70 
 

 FREESTYLE RELAY Group Events 

 (8&U relay is NOT swum in long course pools) 
 1 ........... 8&U 100yd/m............….2 (Swum at beginning in dual meets.) 
 73 ........... 9-10 200yd/m .............74 
 75 ........... 11-12 200yd/m .............76 
 77 ........... 13-14 200yd/m .............78 
 79 ........... 15-18 200yd/m .............80 
 

 ** Ribbons only, no points, but records kept ** 

  Total = 83 S.C. or 70 L.C. Events 
 
  (Revised, 2017) 
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 2. “IM/FR” Format (Short Course Pools Only) 
 

 BOYS EVENTS   GIRLS EVENTS 
 

 8&U FREESTYLE RELAY Group Events 
 **   P1 ........... 6&U     100yd/m Boys, Girls, &/or Mixed Free Relay  ** 
 1 ........... 8&U 100yd/m .............. 2 
 

 INDIVIDUAL MEDLEY Group Events 
 3 ........... 9-10 100yd/m .............. 4 
 5 ........... 11-12 100yd/m .............. 6 
 7 ........... 13-14 100yd/m .............. 8 
 9 ........... 15-18 100yd/m .............10 
 

 SHORT FREESTYLE Group Events 
 **  P21 ........... 6&U 25yd/m .......... P22 ** 
 21 ........... 8&U 25yd/m .............22 
 23 ........... 9-10 50yd/m .............24 
 25 ........... 11-12 50yd/m .............26 
 27 ........... 13-14 50yd/m .............28 
 29 ........... 15-18 50yd/m .............30 
 

 BREASTSTROKE Group Events 

 31 ........... 8&U 25yd/m .............32 
 33 ........... 9-10 50yd/m .............34 
 35 ........... 11-12 50yd/m .............36 
 37 ........... 13-14 50yd/m .............38 
 39 ........... 15-18 50yd/m .............40  thru event 39 is halfway in short course 
  

 BACKSTROKE Group Events 
 **  P41 ........... 6&U 25yd/m .......... P42 **  
 41 ........... 8&U 25yd/m .............42 
 43 ........... 9-10 50yd/m .............44 
 45 ........... 11-12 50yd/m .............46 
 47 ........... 13-14 50yd/m .............48 
 49 ........... 15-18 50yd/m .............50  
 

 BUTTERFLY Group Events 
 51 ........... 8&U 25yd/m .............52 
 53 ........... 9-10 50yd/m .............54 
 55 ........... 11-12 50yd/m .............56 
 57 ........... 13-14 50yd/m .............58 
 59 ........... 15-18 50yd/m .............60 
 

 FREESTYLE RELAY Group Events 

 73 ........... 9-10 200yd/m .............74 
 75 ........... 11-12 200yd/m .............76 
 77 ........... 13-14 200yd/m .............78 
 79 ........... 15-18 200yd/m .............80 
 

 ** Ribbons only, no points, but records kept ** 

  Total = 63 Short Course Events 
    (Revised, 2024) 
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 3. “MR/LF” Format (Long and Short Course Pools) 
 

 BOYS EVENTS   GIRLS EVENTS 
 

 8&U FREESTYLE RELAY Group Events 
 (6&U Mixed Free Relay is NOT swum in long course pools) 
 **  P1 6&U 100yd/m Boys, Girls, &/or Mixed Free Relay   ** 
 

 MEDLEY RELAY Group Events 
 (8&U Medley Relay is NOT swum in long course pools) 
 11 ........... 8&U 100yd/m .............12 
 13 ........... 9-10 200yd/m .............14 
 15 ........... 11-12 200yd/m .............16 
 17 ........... 13-14 200yd/m .............18 
 19 ........... 15-18 200yd/m .............20 
 

 SHORT FREESTYLE Group Events 
 **  P21 ........... 6&U 25yd/m .......... P22 ** 
 21 ........... 8&U 25yd/m .............22 
 23 ........... 9-10 50yd/m .............24 
 25 ........... 11-12 50yd/m .............26 
 27 ........... 13-14 50yd/m .............28 
 29 ........... 15-18 50yd/m .............30 
 

 BREASTSTROKE Group Events 

 31 ........... 8&U 25yd/m .............32 
 33 ........... 9-10 50yd/m .............34 
 35 ........... 11-12 50yd/m .............36 
 37 ........... 13-14 50yd/m .............38 
 39 ........... 15-18 50yd/m .............40  thru event 40 is halfway in short course 
 

 BACKSTROKE Group Events 
 **  P41 ........... 6&U 25yd/m .......... P42 ** thru event P41 is halfway in long course 
 41 ........... 8&U 25yd/m .............42 
 43 ........... 9-10 50yd/m .............44 
 45 ........... 11-12 50yd/m .............46 
 47 ........... 13-14 50yd/m .............48 
 49 ........... 15-18 50yd/m .............50 
 

 BUTTERFLY Group Events 
 51 ........... 8&U 25yd/m .............52 
 53 ........... 9-10 50yd/m .............54 
 55 ........... 11-12 50yd/m .............56 
 57 ........... 13-14 50yd/m .............58 
 59 ........... 15-18 50yd/m .............60 
 

 LONG FREESTYLE Group Events 

 61 ........... 8&U 50yd/m .............62 
 63 ........... 9-10 100yd/m .............64 
 65 ........... 11-12 100yd/m .............66 
 67 ........... 13-14 100yd/m .............68 
 69 ........... 15-18 100yd/m .............70 
 

 ** Ribbons only, no points, but records kept ** 

  Total = 65 S.C. or 62 L.C. Events  
 
 (Revised, 2024) 
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Page 12 G. Sweep Judge 
Page 13 H. False Start Rope 
Page 14 I. Timer 
Page 15 J. Head-of-Table 
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 P. Awards 
 Q. Refreshments 
Page 24 R. Meet Marshal 
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SWIM MEET JOB DESCRIPTIONS 
 

A. REFEREE & CHIEF JUDGE (should wear white shirt and blue shorts) 
  (See Appendices C, C1, N, N1, P, Q, R, S, T, U, & X for additional Information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Referee 
 

Since the 2006 season, JSL has attempted to have Referees at all dual meets.  These 
persons are selected by the JSL Board’s Officials Advisor.  USA Swimming, YMCA, or 
High School certified referees or stroke-and-turn judges will be used whenever 
possible.  JSL volunteers who are interested in becoming a JSL Referee may contact 
the following to become certified as a Referee or Stroke & Turn Judge with the 
organizations below: 
Virginia Swimming locally - Gordon Hair grhair311@gmail.com 
 Kevin Hogan hogan.kevin.t@gmail.com 

 David Strider davidstrider9876@yahoo.com 
 YMCA - Jessica Simons jrsimons@comcast.net 
 High School - Locke Boyer flb4j@comcast.net 

 

The Referee must see that all rules are enforced and applied appropriately and decide all 
questions arising during the course of the meet, the final settlement of which is not otherwise 
covered by the rules.  JSL swim meets operate under USA Swimming Rules and 
Regulations and JSL Bylaws and Rules & Regulations and Procedures.  The full 
Referee job description is found in the USA Swimming Rules and Regulations under 
Article 102.13.  Certain procedures below were taken from that Article. 

The Referee has authority over the Chief Judge, Stroke-and-Turn Judges, and the Starter 
and will be primarily responsible for the deck to include strokes-and-turns and starts.  The 
Meet Director ensures that the meet is running as smoothly and efficiently as possible and is 
primarily responsible for areas “out of the pool”.  There may be situations which require 
consultation between the Meet Director and Referee to resolve certain issues.  Good 
communication and cooperation are essential.  In the unexpected absence of a Referee, 
Locke Boyer (434-882-0340), the Officials Advisor should be contacted to select a suitable 
Referee replacement.  If a Referee is assigned and cannot make the meet, Locke Boyer 
should be contacted as soon as possible. 

The Referee should arrive about 30 minutes before the meet begins to conduct various 
meetings with Meet Directors, Coaches, and Officials and to make sure the pool is set up 
properly and safely. 
 

• Surveys the pool area to confirm that the pool area is set up properly and safely.  
Problems should be directed to the Home Meet Director for correction.  Pays particular 
attention to physical protection of exposed corners as described in Section IV, pages 4-
7, of this Team Manual. 

• Meets with both Meet Directors prior to the start of the meet to discuss ground rules, 
breaks, and time limit decisions.  Ensures that the meet end time has been agreed upon 
by both Meet Directors and the official time has been determined. 

• Meets with Coaches to lay ground rules, if needed.   

• Meet Directors must verify that all coaches on deck have current JSL Coaches 
Certification.  They will refer problems with certifications to the JSL Executive Committee 
for resolution. 

• Meets with Stroke-and-Turn Judges to answer questions, lay ground rules, and 
determine rotation, if needed.  (see head strikes and bumps procedure on next page) 

• Supervises deck and ensures that the meet is conducted in accordance with USA 
Swimming Rules and Regulations and JSL Bylaws and Rules & Regulations and 
Procedures.  

• Approves use of kinesiology tape by swimmers.  Swimmers must have a signed 
statement from a physician stating the need for wearing tape in competition.  

https://www.jsl.org/information2020.php?content=refcourse&menu=support&section=workers
mailto:grhair311@gmail.com
mailto:hogan.kevin.t@gmail.com
mailto:davidstrider9876@yahoo.com
mailto:jrsimons@comcast.net
mailto:flb4j@comcast.net
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.jsl.org/information2020.php?content=teammanual
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
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A. REFEREE & CHIEF JUDGE (continued) 

• Signals the Starter, before each race, that all officials and timers are in position, the 
course is clear, and that the heat may start. 

• Gives decisions at any point where opinions of judges differ or overrules any judge who 
is not correctly interpreting the applicable rules. 

• Makes an immediate investigation, when automatic or semi-automatic officiating 
equipment is used and an apparent malfunction occurs, to determine the correct order of 
finish. 

• Prohibits the use of any device that disrupts or interferes with the meet. 

• Modifies the rules for any swimmer with a disability, if needed, using Article 105 of the 
USA Swimming Rules and Regulations and JSL Bylaws and Rules & Regulations 
and Procedures Article VI, #13. 

• Assigns Chief Judge responsibilities when available and appropriate. 

• Stops the meet in the event of thunder or lightning. 

• Refers any swimmer with possible head injury to their Head Coach for evaluation. 

• Assists Meet Director(s) with completion of JSL Injury and Incident Report Form if 
needed.  “When in doubt, fill it out.” 

JSL requires that Referees review the following procedure for 
head strikes or bumps at the pre-meet Stroke and Turn briefing: 

• All Stroke and Turn Judges are to watch for head strikes or 
bumps. 

• When a S&T Judge observes a head strike or bump, if the 
swimmer appears hurt, the observing S&T Judge will get another 
Judge to immediately cover their position. 

• The observing S&T Judge will take the swimmer to the Meet 
Referee. 

• The Meet Referee will ensure that the swimmer is seen by their 
Coach and the swimmer’s parent(s).  (ALL JSL Coaches are 
certified in concussion protocol.) 

• The Coach and parent(s) will make a decision about “return to 
play” or go to the Emergency Room. 

• If the decision is to go to the ER or set out a few days, JSL 
requires a note from the swimmer’s physician to return to practice 
or a meet. 

• It is the intent of JSL that, if a swimmer is hurt, we do not want 
them to continue with the meet and will need documentation from 
their physician to return to play and at what level. 

 
 

A CHIEF JUDGE, when available, will be assigned to assist the Referee with the conduct of 
the meet.  This individual may assign and supervise the activities of the Stroke-and-Turn 
Judges.  The main responsibilities will be to approve all disqualifications on the turn end of 
the pool and judging of relay takeoffs.  When approving a disqualification the official should 
be asked what their jurisdiction was, what they saw, and the rule that was violated. 
 
  

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
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B. MEET DIRECTOR 
  (See Appendices A, H, N, O, & X for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Meet Director 
 

As outlined below, it is easy to see why the Home Meet Director is one of the most important 
volunteers for a team.  S/he is ultimately responsible for conducting all home meets and 
serves as the official representative (spokesperson) for the team at away meets.  Meet 
Directors are encouraged to attend ALL JSL pre-season clinics, but are REQUIRED to 
attend the Meet Director Orientation Class. 
 
As noted in the Referee Job Description, the Referee has authority over the Stroke-and-Turn 
Judges and the Starter while the Meet Director ensures that the meet is running as smoothly 
and efficiently as possible.  It might be said that the Meet Director is in charge of the areas 
“out of the pool” and the Referee is in charge of “in the pool”.  There may be situations which 
require consultation between the Meet Director and Referee to resolve certain issues.  Good 
communication and cooperation are essential.  In the unexpected absence of a Referee, 
Locke Boyer (434-882-0340), the Officials Advisor should be contacted to select a suitable 
Referee replacement. 

 
The Meet Director Supervises all home dual/tri meets and ensures that the meets are 
conducted in accordance with USA Swimming Rules and Regulations and the JSL 
Bylaws and Rules & Regulations and Procedures.  S/he also assists the Home Meet 
Director at away meets. 
 

• The Meet Director must ensure that pool area is reserved and arrives well before the 
meet begins to make sure the pool is set up properly and safely (in accordance with 
USA Swimming Rules and Regulations (where appropriate) to include: 
o physical protection of exposed corners as described in Section IV, pages 4-7, of this 

Team Manual. 
o lane lines 
o starting blocks 
o backstroke flag lines 
o lights (if available) 
o scorer's table and chairs 
o clerk-of-Course tables and chairs 
o sweep judge chairs (2 on each side of pool at finish line) 
o crowd control ropes where needed 
o false start rope 
o proper pool water depth and starting block height 
o qualified Lifeguards on duty at all times when swimmers are present 
o publicity if needed 
o other preparations as needed 

 

• The Meet Director must ensure that adequate supplies are available for the meet to 
include:  
o all ribbons 
o timers cards 
o sweep judge cards 
o "DQ" slips 
o laptop computer with Meet Manager Program 
o printer with adequate paper and labels 
o heat sheets (several for table, starter, S&T, C-of-C, etc.) 
o CTS Starting System (fully charged) with 2 extra speakers 
o backup CTS Starting System (from visiting team) 
o megaphone or PA system 
o stop watches (3 blue and 3 green per lane if possible) 
o sufficient pencils, paper clips, etc. 
o refreshments (water, lemonade, ice tea, etc.) 
o automatic or semi-automatic timing equipment if available 
o other supplies as needed 

  

https://www.jsl.org/information2020.php?content=meetdirect&menu=support&section=workers
https://www.jsl.org/support2020.php?section=meetdirectors&content=meetdirectors
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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B. MEET DIRECTOR (continued) 
 

• Meet Directors are encouraged to make online Heat Sheets available to Swim Meet 
Parents.  (Thanks to Ryan Ritter of BHSC for the following Procedure!) 
o Computer Operator or other designated person, posts it to the Team’s website home 

page and alerts Meet Director that it's live 
o Meet Director goes to a free QR Code Generator (Example), adds the live website 

link to the generator and downloads the custom QR Code for that meet. 
o Meet Director prints a handful of single page copies of that QR code (Example) and 

posts in strategic positions at the pool entrance and around the pool deck 
o Meet Director communicates to the visiting team that a very small number of heat 

sheets will be printed in order to save on printing costs and reduce environmental 
impact and directs the visiting team to use their mobile device or print ahead at 
home. 

• The Meet Director is ultimately responsible for ensuring that there are sufficient 
volunteers to run both home and away meets.  Some teams use online signup, but there 
is a JSL Parent Volunteer Roster (See Appendix A) that can be used by the Meet 
Director for this purpose.  All of the needed positions are listed and there are columns 
for first and second half volunteers.  Note that some positions with an asterisk are the 
responsibility of the Home team, but the rest of the positions are split as evenly as 
possible between the two teams.  

• Meets with Referee prior to the start of the meet to discuss ground rules, breaks, and 
time limit decisions.  Contacts Officials Advisor, Locke Boyer (434-882-0340) if Referee 
unavailable. 

• Verifies that all coaches on deck are properly certified.  Reports violations to the 
Executive Committee for final resolution.  

• Keeps official time for meet to ensure that the meet ends on time in accordance with 
JSL Bylaws and Rules & Regulations and Procedures.  

• Serves as Announcer if separate announcer unavailable.  
o Announces start of meet. 
o Directs swimmers to Clerk-of-Course area well in advance of their event. 
o Makes other announcements as needed. 

• Ensures that special needs swimmers are accommodated according to Article 105 of the 
USA Swimming Rules and Regulations and JSL Guidelines (Section III, Appendix 
H).  

• Consults with the Visiting Team Meet Director on all changes occurring during the meet 
(e.g. changes or additions to events, adding, or deleting heats, etc.)   JSL Bylaws and 
Rules & Regulations and Procedures require that changes other than deletions 
require approval of BOTH the Home and Visiting Meet Directors.  All changes must be 
initialed by both to ensure that the Clerk-of-Course is properly notified.  It is the 
responsibility of the coach to get the changes properly approved.  

• Refers any swimmer with possible head injury to their Head Coach for evaluation. 
 

Thunder or lightning can pose a grave danger for all participants, especially swimmers, at a 
swim meet.  Extreme caution is needed in all decisions involving thunder or lightning.  Every 
Team is required by JSL to have a thunder and lightning policy.  Know your team’s policy 
and procedures.  In conference with the Referee and visiting Team Meet Director(s), the 
Meet Director makes decisions as to starting, stopping, re-starting, and/or rescheduling 
meets as outlined in the JSL Bylaws and Rules & Regulations and Procedures Article VI, 
#18, #19, #20.  (N.B. As always, common sense must prevail in all decisions involving the 
safety of the swimmers, officials, and spectators.  It is certainly better to err on the side of 
safety rather than expose anyone to unnecessary risk.)  The Jefferson Swim League 
suggests the following guidelines for clearing the pool area during thunderstorms. 

• Move inside a large building.  

• Stay away from pipes, fences, railings, or any metal objects that might carry lightning.  

• Avoid using outdoor (landline) telephones.  

• Avoid open areas such as picnic shelters, heights, fields, and tall trees.  

• Avoid showers.  
  

https://www.adobe.com/express/feature/image/qr-code-generator
https://docs.google.com/document/d/1Aw4J-CUqvHkehCAl4jFuDMfCXSqC7nGM0kdC1WW2cNc/edit
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.jsl.org/documents/bin/Current/JSLTeamManual.pdf#page=69
https://www.jsl.org/documents/bin/Current/JSLTeamManual.pdf#page=69
http://www.jsl.org/information2020.php?content=bylaws
http://www.jsl.org/information2020.php?content=bylaws
http://www.jsl.org/information2020.php?content=bylaws
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
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B. MEET DIRECTOR (continued) 
The Home Meet Director has the authority to remove any participant from the premises who 
is clearly out of order or presenting a danger to himself or others.  

• Examples may include but are not limited to:  
o verbal or physical abuse against any official or volunteer 
o a loud argument on the verge of escalating to a more serious problem 
o obnoxious, profane, or sexually inappropriate behavior 
o physical violence of any kind such as fighting, hitting with objects, etc. 
o persons who refuse to obey rules such as moving when asked, etc. 
o persons found destroying or committing theft of property 

• In the event of emergency, assists all meet personnel in resolving the problem. 
o assists in calling for appropriate emergency personnel 
o assists in coordinating emergency personnel 
o assists meet personnel in resolving emergency 
o directs participants to nearest exit if needed 
o assists in directing participants to return when instructed by meet personnel 

The Meet Director’s responsibilities do not end immediately after the last event.   

• Ensures that the following are transmitted to JSL by the Computer Operator  

• Meet Backup file uploaded to JSL Meet Results Upload Page ASAP 
a. Results uploaded to JSL Meet Results Upload Page by 9:00PM following day 

• Ensures that electronic data results are available to other teams when requested.  (Any 
team requesting immediate data results will provide a thumb drive for copying.)  

• Organizes and assists in cleanup after the meet.  

• A link to the JSL Sportsmanship Rating Form will be sent to you after every meet.  
Failure to complete the form in a timely manner will result in points being deducted from 
your team’s Sportsmanship rating.  Information may be found online at Sportsmanship 
Rating and the form should be completed in a fair and objective manner by rating the 
opposing teams(s) for sportsmanship.  Input should be obtained from your team’s 
coaches, parents, and swimmers as appropriate.   

• When at away meets, assists the Home Meet Director as needed or requested.  

• Ensures that a JSL Injury and Incident Report Form is completed where needed.  (See 
Appendix X)  “When in doubt, fill it out.”  

 
VISITING MEET DIRECTOR 
As mentioned earlier, as your Team’s Home Meet Director, you will also serve as the official 
spokesperson (representative) for your team at away meets.  Many JSL Bylaws and Rules 
& Regulations and Procedures require that BOTH Home and Visiting Meet Directors 
consult with each other to make decisions.  Cooperation and good communication between 
Meet Directors are essential to a great Meet. 

• Ensure that your team’s FULLY CHARGED CTS Start System and Microphone is taken 
to ALL away meets.  It may be left in a car to be used if needed.  

• Ensure that your team’s watches are taken to away meets.  They may be left in your car 
to be used if needed. 

• Check in with the Home Meet Director on arrival.  

• Assist the Home Meet Director as needed to ensure a successful meet.  

• Assist with cleanup after the meet paying particular attention to the areas occupied by 
your team.  
  

https://www.jsl.org/meet-results-uploads2020.php
https://www.jsl.org/meet-results-uploads2020.php
https://www.jsl.org/general2020.php?section=sportsmanship&content=meet_sportsmanship&menu=main
https://www.jsl.org/general2020.php?section=sportsmanship&content=meet_sportsmanship&menu=main
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
https://www.jsl.org/information2020.php?content=teammanual
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C. STARTER (should wear white shirt and blue shorts) 
  (See Appendices C, C1, Q, R, S, & T for additional information) 

Online CTS Infinity Start System Manual can be found at Infinity F849 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Starter 
 

Under the direction of the Referee, the Starter starts every race.  S/he should be equipped 
with the Colorado Timing Start System and shall be stationed within 10 feet of the starting 
end where the light flash is clearly visible to the timers and the sound is easily heard by the 
swimmers.  The Starter may also have other duties such as: 

• Assisting in announcing if separate announcer unavailable. 

• Serving as dual confirmation relay takeoff judge for starting end of pool on starter's side. 
The Starter position is normally the responsibility of the Home Team. 

 

Jefferson Swim League requires starters to be USAS certified or have attended a JSL 
clinic for starters within the current calendar year.  Information on the current 
season’s JSL Starter Clinic may be found here: Starter Clinic.  If you are already 
certified as a USAS Starter, please provide your certification to the JSL Officials 
Advisor, Locke Boyer, at flb4j@comcast.net.  Starters who have served in that 
position in the previous season in JSL are not required to repeat any starter clinics 
except at the discretion of the Officials Advisor. 

 

Since 2015, “dive-over” starts have been used in ALL age groups for 50m and over 
individual events.  The starter must be aware that swimmers will remain in the water, 
clinging to the lane line at the completion of a heat.  The following heat will be started and 
“dive over” the swimmers remaining in the water from the previous heat. 

• Receives swimmers from the Clerk-of-Course.  (See Appendices Q, R, & T)  

• Consults event sheet to confirm that all swimmers are present and in correct lanes.   

• Notifies swimmers of the following: 

o Event number 

o Distance (with pool length clarification; e.g. 1 length) 

o Event name 

o Stroke(s) to be used and order, (if applicable) 

o Relay swimmers are to leave the pool immediately after swimming their leg. 

• Referee, if available, BLOWS WHISTLE and commands, "Quiet for the start!" if needed.  

• In the unexpected absence of a Referee, contact Locke Boyer (434-882-0340), 

• Directs swimmers to, "Take your mark!" and gives sufficient time for swimmers to come 

to starting position with at least one foot at the front edge of the platform.  Backstroke 

swimmers may be directed to, "Place your feet!" and must have both hands on the 

gutter or starting grips.  Standing in or on the gutter, placing the toes above the lip of the 

gutter or bending the toes over the lip of the gutter before or after the start is prohibited.  

At this point it is too late for a swimmer to show for heat or changes to be made in relay 

teams.  

• Gives starting signal (horn and light) when all swimmers are motionless 

• Refers any swimmer with possible head injury to their Head Coach for evaluation.  
 

A “False Start” is committed when a swimmer leaves the starting platform before the start 

signal is sounded.  Beginning in 2023, the following false start procedure is used in all age 

groups.  Article 101.1.3 of the USAS Rules and Regulations will be followed.  

• Gives false start signal (multiple horn blasts) if false start is committed by a swimmer 

entering the water & directs remaining swimmers to, "Stand up!". 

• If all swimmers have entered the water at the start, but one or more have false started, 

the race will continue without recall.   

• Allows any swimmer with a false start to swim the event, but issues a disqualification 

after consulting with the Referee. 

• Disqualifies any swimmer with a false start and consults Referee. 

• Changes order of events or heats (using discretion) to rest swimmers involved in false 

starts. 

https://drive.google.com/file/d/1bXuqaQVJpfGdjykmx9aVeUHt7i6JS3Su/view?usp=sharing
https://www.jsl.org/information2020.php?content=starter&menu=support&section=workers
https://www.jsl.org/support2020.php?section=officials&content=clinics
mailto:flb4j@comcast.net
https://www.usaswimming.org/officials/rules-regulations
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D. CLERK OF COURSE 
  (See Appendices B, B1, E, E1, F, F1, and F2 for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Clerk of Course 
 

The Clerk-of-Course (“the Clerk”) is responsible for arranging swimmers in the proper order 
for their events.  Both the home and visiting teams must have a Head Clerk and at least one 
assistant (or more, depending on the size of the team).  A good Clerk-of-Course is essential 
to the smooth, orderly, and efficient operation of every swim meet.  This begins with proper 
training and adherence to JSL procedures and ends with the satisfaction of efficiently run 
swim meets for the swimmers. 

 

The Clerk uses a PA System or megaphone, or advises the announcer (or starter) to call 
swimmers to report to the Clerk-of-Course area well in advance of their event being called to 
the starting blocks.  Coaches can be valuable assistants for rounding up swimmers.  Once 
the swimmers from both teams arrive at the Clerk, they are identified, placed on chairs or 
benches in event, heat, and lane order, and given their correct timing card.  The swimmers 
are then directed or taken to the area behind the starting blocks to wait for their event to 
begin.  Proper timing is essential because too many kids at the Clerk or behind the starting 
blocks can cause mass confusion, but too few can cause unnecessary delays in the meet. 

 

The Clerk-of-Course should arrive one hour before the start of meet to ensure that a 
designated area is set up to receive swimmers.  The area should be well lit and have two 
tables, one for each team.  A PA system or megaphone is helpful.  There should be chairs 
or benches set in rows with enough seats to accommodate at least four heats of swimmers.  
The number of seats across in each row must equal the number of lanes in the pool and be 
designated by lane numbers.  Depending on the size of the team, there should be 2 or more 
Clerks.  Additional parent or assistant coach volunteers may help lead the youngest children 
to the starting blocks.  Both home and visiting teams must have sufficient Clerks. 

 

• Arrives one hour before meet begins and obtains completed Meet Program (Appendix 
B) from Computer Operator and completed timing cards from coach.  It is possible that 
the clerks may have to assist in attaching labels to the timing cards, but this should be 
done well in advance of the meet.  The Meet Manager program should pre-seed the 
meet using the following guidelines: 
o First heat contains the slowest swimmers. 
o Last heat contains the fastest swimmers.  Heats between first and last go from 

slowest to fastest swimmers. 
o Fastest swimmers are placed in the center lanes and slower swimmers to the 

outside within each heat. 
o Exhibition swimmers (“X” on all computer printouts and time cards) are seeded in 

the slowest heats and lanes if available. 
o Stickers are preprinted designating the correct event, lane, and heat for almost all 

swimmers.  Blue timing cards are for boys and pink are for girls.  (No sexism 
intended, it’s just easier.) 

o There are special “EXHIBITION” timing cards for all exhibition swimmers, but a 
regular card may be used if clearly marked. 

  

https://www.jsl.org/information2020.php?content=courseclerk&menu=support&section=workers
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D. CLERK OF COURSE (continued) 
• If it necessary to hand-seed a heat, the following guidelines apply for dual meets: 

o Lane Number  >>> 8 7 6 5 4 3 2 1 
o 5 Lane Pool    3* 2 1* 1 2* 
o 6 Lane Pool   3 2* 1 1* 2 3* 
o 7 Lane Pool  4 3* 2 1* 1 2* 3 
o 8 Lane Pool 4* 3 2* 1 1* 2 3* 4 

• If it necessary to hand-seed a heat, the following guidelines apply for tri meets: 
o Lane Number  >>> 8 7 6 5 4 3 2 1 
o 6 Lane Pool   V1 H V2 V1 H V2 
o 8 Lane Pool V2 V1 H V2 V1 H V2 V1 

• The Championship Format for ten lanes is based strictly on seed times: 
o Lane Number  >> 10 9 8 7 6 5 4 3 2 1 
o 10 Lane Pool 10 8 6 4 2 1 3 5 7 9 

• Heats are limited as follows: 
o There are a maximum of 3 heats of each event with a few exceptions. 
o Events P21-P22 and 21-30 (short free) may have unlimited heats and events 41-42 

(8 and under backstroke) may have 5 heats.  Relay events are only allowed 1 heat. 
o Any additional heats have to be approved by BOTH the Home and Visiting Meet 

Directors.  There are boxes on the timing cards for their initials. 
o Exhibition swimmers may only be added to empty lanes which are available in 

existing heats of official swimmers.  The lanes available for exhibition swimmers 
must be split equitably between the teams with any uneven preference going to the 
visitor(s).  Remember, Exhibition swimmers MUST be approved by BOTH Meet 
Directors. 

o No heats may be added to accommodate exhibition swimmers without approval of 
BOTH the Home and Visiting Meet Directors.  There are boxes on the timing cards 
for their initials. 

o Alternate lanes are used for each team where possible. 
 

• Organize Swimmers at the Clerk 
o Confirm all timers’ cards are stickered with the correct Boy or Girl label.  
o Assist announcer in calling swimmers to the Clerk-of-Course area in a timely 

manner and maintain an event board (listing events that have been called) if 
possible.  

o Retain timing cards to give to swimmers as they are seeded at the Clerk-of-Course 
area.  

o Stage swimmers by event number, heat, and lane number using the Meet Heat 
Sheet and timing cards.  

o Position each swimmer in the correct event, heat, and lane in the chairs or on the 
benches.  

o Give swimmers the correct timing card by confirming the name of swimmer and their 
event, heat, and lane position.  

o Direct swimmers to the area behind starting blocks in such a manner that there is 
always one heat waiting behind the blocks.  

o Do NOT add any swimmers to an event without approval of BOTH the Home and 
Visiting Meet Directors.  There are boxes on the timing card for their initials.  
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D. CLERK OF COURSE (continued) 

• Make changes if needed 
o Despite pre-meet planning and entry deadlines, last-minute changes may have to be 

made by the Clerk.  
o EXHIBITION swimmers may be added up until the start of the meet with the 

approval of BOTH Meet Directors’ initials on the timing card.  Note that no official 
swimmers may be added.  

o Swimmers may be deleted at any time by Coaches or the Clerks without the 
approval of either Meet Director.  

o Heats may be combined (collapsed) in the interest of saving time when there are 
swimmers missing.  Be sure all of those affected (Computer Operator, Referee, 
Starter, etc.) are comfortable with combining heats.  

o The timing card MUST be changed to reflect the correct event, heat, and lane for 
any changes or additions.  (see example)  

o ALL changes made by the Clerk MUST be communicated to the Computer 
Operator, Referee, and Starter.  

• Direct or take the swimmers to the starting blocks. 
o Once all of the swimmers are lined up correctly at the Clerk area they can be taken 

or directed to the area behind the starting blocks to wait for their event.  Remember 
to keep at least one heat ready to swim behind the blocks, but not too many heats 
that will create confusion.  

o It is best for younger swimmers (8 and under) to join hands by heat and be led by an 
adult to the starting blocks.  Each swimmer should be individually positioned in the 
correct lane behind the starting block.  

o Older swimmers can simply be told to go to their correct lane behind the starting 
blocks.  

o It is very important for RELAY TEAMS to be correctly lined up at the Clerk and 
behind the starting blocks.  That is, they must be in the correct order to swim the 
event.  Failure to swim in the correct order may result in the team being disqualified.  

o For 100m or y relays (8 and under), the 1st and 3rd swimmers are at the starting 
end and the 2nd and 4th swimmers are at the opposite end.  It is very important that 
both sets of swimmers are in the correct lane and order at opposite ends of the pool. 
 An adult must position each set correctly at both ends of the pool.  (100m or y 
relays are only swum in 25m or y pools)  

o For 200m or y relays in a 50m pool, the 1st and 3rd swimmers are also at the 
starting end and the 2nd and 4th swimmers are at the opposite end.  These will be 
older swimmers and can usually be trusted to find their correct positions without 
direct supervision.  

o For 200m or y relays in a 25m or y pool, all swimmers are on the starting end of the 
pool.  

• Take care of any problems that arise. 
o Ensure that signatures or recognized initials from BOTH Home and Visiting Meet 

Directors are on the timing card(s) prior to making any seeding substitutions or 
additions once the meet has been seeded.  Failure to have proper approval can 
result in penalties against the offending team.  (Deletions from an event do NOT 
require approval.)  It is the coach’s responsibility to get both of the Meet Directors’ 
initials on timing cards.  

o Accommodate late arrivals (not late entries) if possible up to the time the event is 
called to the blocks.  Late arrivals must not delay the meet in any way.  

o Do not allow changes (other than deletions or combined heats) once the meet has 
begun.  

o Heats and events may be combined using good judgment so as not to confuse 
officials or create hardships on swimmers.  This should only be done in the interest 
of shortening the meet due to “no-shows”, etc.  

o Report to the Computer Operator, Referee, Starter, and/or Announcer any heat or 
event combinations or deletions by appropriate communication (written and/or 
verbal).  In computerized meets, it is essential that these officials be advised of any 
changes.  

o Consult with the Meet Directors to limit heats if meet is running late.  
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E. STROKE AND TURN JUDGE (should wear white shirt & blue shorts) 
  (See Appendices C, C1, & Q for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Stroke-&-Turn Judge 

 
Jefferson Swim League requires Stroke-and-Turn Judges to be either USAS, high 
school, or YMCA certified or have attended a USAS, high school, YMCA, or JSL Clinic 
for Stroke and Turn Judges within the current calendar year.  If you are already 
certified as a USAS, high school, or YMCA Stroke and Turn Judge, provide your 

certification to the JSL Officials Advisor, Locke Boyer, at flb4j@comcast.net.  JSL-

certified Stroke-and-Turn Judges who have served in that capacity for the previous 
season may go to one of the live clinics OR renew their certification without attending 
the clinic by taking the online course at strokeandturn.com and successfully passing 
the final test. 
 

NEW JSL-certified Stroke-and-Turn Judges must successfully complete the 
strokeandturn.com course AFTER attending the mandatory JSL Clinic.  Obtain a 
prepaid key for strokeandturn.com from Locke Boyer, flb4j@comcast.net.  These new 
judges should “shadow” or “walk” with an experienced judge (trainer) for their first meet if 
possible and then begin to make calls at a second meet with a trainer.   
IT IS THE EXPECTATION OF THE JSL BOARD THAT S & T JUDGES WORK AT LEAST THE EQUIVALENT 
OF 2 FULL MEETS (4 HALVES TO INCLUDE BOTH 1st & 2nd HALVES) AFTER USING A PREPAID KEY.  THE 
COST OF THE KEYS WILL BE CHARGED BACK TO TEAMS FOR JUDGES NOT MEETING THAT STANDARD. 
 

 Stroke and Turn Judges observe all of the swimmers for illegal technique immediately after 
the start, during the stroke, at the turns, and at the finish.  There should be at least two 
Stroke-and-Turn Judges on each end of the pool and preferably one for every two lanes on 
each end.  Newer Stroke-and-Turn Judges are allowed as extras to obtain experience. 

JSL STRONGLY ENCOURAGES ALL STROKE AND TURN JUDGES TO WORK THE ENTIRE MEET. 
 

• Observes swimmers for compliance with USA Swimming Rules and Regulations for 
the following: 
o style of swimming designated for the event (i.e. stroke) 
o correctness and completeness of "Turn" 

• Judges relay takeoffs at both ends of the pool.  More detailed information may be found 
in the Relay Takeoff Judge Course.  The Stroke-and-Turn Judge initiates the 
disqualification, but it must be confirmed by another judge having jurisdiction over the 
lane in which the violation occurred.  Without dual confirmation, the violation did not 
occur.  Violations called outside of the judge's jurisdiction are not valid.  The Starter may 
serve as a Relay Takeoff Judge at starting end of pool.  In the absence of an adequate 
number of judges, the Referee/Chief Judge can delegate responsibility to another 
person(s). 
o Records valid take-offs as "O" and early take-offs as "X" on Relay Take-Off Slip.  
o Compares Relay Take-Off Slip with confirming judge at end of relay.  
o Disqualifies any relay team with early take-off confirmed by both judges.  

• See head strikes or bumps procedure on next page. 
 

Occasionally swimmers will use an illegal technique immediately after the start, during the 
stroke, during the turn, or at the finish during an event.  The Stroke and Turn Judge must 
observe this and make the “DQ call”.  This ensures that no swimmer gains an unfair 
advantage. 

• Raises one hand with open palm (except early take-offs) when any infraction is 
observed. 

• Reports violations on DQ slip detailing: swimmers name (obtain if possible) 
o event number 
o heat number 
o lane number 
o judge's initials 
o description of infraction  

• The Stroke & Turn Judge does not notify any swimmer or coach of the disqualification. 

• Gives completed DQ slip to Referee for validation. 

• In the unexpected absence of a Referee, Locke Boyer (434-882-0340), the Officials 
Advisor should be contacted to select a suitable Referee replacement. 

https://www.jsl.org/information2020.php?content=sandt&menu=support&section=workers
https://www.jsl.org/support2020.php?section=officials&content=clinics
https://www.jsl.org/support2020.php?section=officials&content=clinics
mailto:flb4j@comcast.net
https://strokeandturn.com/
https://strokeandturn.com/
https://www.jsl.org/support2020.php?section=officials&content=clinics
http://www.strokeandturn.com/
mailto:flb4j@comcast.net
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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JSL requires that Referees review the following procedure for head strikes or 
bumps at the pre-meet Stroke and Turn briefing: 

• All Stroke and Turn Judges are to watch for head strikes or bumps. 

• When a S&T Judge observes a head strike or bump, if the swimmer appears 
hurt, the observing S&T Judge will get another Judge to immediately cover their 
position. 

• The observing S&T Judge will take the swimmer to the Meet Referee. 

• The Meet Referee will ensure that the swimmer is seen by their Coach and the 
swimmer’s parent(s).  (ALL JSL Coaches are certified in concussion protocol.) 

• The Coach and parent(s) will make a decision about “return to play” or go to the 
Emergency Room. 

• If the decision is to go to the ER or set out a few days, JSL requires a note from 
the swimmer’s physician to return to practice or a meet. 

• It is the intent of JSL that, if a swimmer is hurt, we do not want them to continue 
with the meet and will need documentation from their physician to return to play 
and at what level. 

 
F. RELAY TAKEOFF JUDGE 
  (See Appendices C, C1, and Q for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Relay Takeoff Judge 

 
Relay Takeoff Judges serve to keep the competition fair and equitable by ensuring that no 
relay swimmer gains an unfair advantage by taking off before the incoming swimmer 
touches the wall.  Relay takeoffs are normally judged by the Stroke and Turn Judges. 
 However, in the absence of an adequate number of judges, the Referee or Chief Judge 
may delegate the responsibility for relay takeoffs to another person(s).  All Takeoff Judges 
must position themselves on the side(s) at the end(s) of the pool so as to have a clear view 
of the touch of the incoming swimmer(s) and the feet of the departing swimmer(s). 

• Judges relay takeoffs (not the start) by the following: 
o Marks the Relay Take-Off Slip with the event number, heat number, and initials. 
o Observes feet of every swimmer leaving platform as incoming swimmer touches end 

of pool and places an "O" in the appropriate lane and swimmer block on the Relay 
Take-off Judging Slip if take-off was legal. 

o Does NOT raise hand, but places an "X" in the appropriate lane and swimmer block 
on the Relay Take-off Judging Slip if any swimmer is not in contact with the platform 
when incoming swimmer touches.  (Starting swimmer may be in motion as long as 
s/he is still in contact with platform.) 

o Upon completion of relay events, compares completed slips with other confirming 
judge.  It is important to note that a violation did NOT occur unless there is dual 
confirmation (that is, both Relay Takeoff Judging Slips agree) with the other official 
having jurisdiction over the lane(s) in which the violation(s) occurred.  Violations 
called outside of the judge's jurisdiction are not valid.  

• If BOTH Relay Takeoff slips agree that a violation occurred 
o Both Relay Takeoff Slips must be must be completed with event number, heat 

number, lane number, and initials. 
o One of the Judges must completely make out a USAS DQ Slip indicating under 

“Relays” which swimmer had an early takeoff. 
o Both Judges must sign the USAS DQ Slip 

• Gives both the completed USAS DQ Slip and Relay Takeoff Judging Slip to Referee for 
validation. 

• The Relay Takeoff Slip is stapled to the DQ Slip at the table. 

https://www.jsl.org/information2020.php?content=relaytakeoff&menu=support&section=workers
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G. SWEEP JUDGE 
  (See Appendix D for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Sweep Judge 

 
A total of four Sweep Judges confirm the order of finish in each heat by serving as a backup 
to the timers.  It is a position that should not be taken lightly and requires experience, 
concentration, and a keen eye.  Two Sweep Judges from each team (in dual meets) are 
stationed on each side of the pool having a clear direct view of the finish line.  In tri-meets, at 
least one of the four Judges should be from the smallest of the three teams.  One Sweep 
Judge card is filled out on each side of the pool for each heat.  One Sweep Judge observes 
and calls out the order of finish, while the other assists and records the order on the Sweep 
Judge card.  Some part of the swimmer’s body must touch the wall to be considered a finish. 
 

The sweep judges should arrive at least 15 minutes before the start of the meet and 
immediately report to the deck to get their position assignments, 2 inches of sweep judge 
cards, and pencils.  Sweep Judges must be provided chairs at the ends of the pool where 
race finishes will take place.  Sweep Judges should expect to get wet so dress 
appropriately.  It is also helpful to have towels.  
 

A close finish involving 2 or 3 swimmers happens with some frequency.  You must pay close 
attention to the finish of every race. 
 
One Sweep Judge Card is completely filled out on both sides of the pool for each heat.  As 
noted previously, one Sweep Judge observes and calls out the order of finish, while the 
other assists and records the order on the Sweep Judge card.  This takes place 
simultaneously on both sides of the pool at the finish end.  Both sets of Sweep Judges must 
pay close attention to the starter (or announcer) noting which event and heat is in the water. 

• Prior to the beginning of the heat, fill out the top of the card with the event and heat 
number.  (event 3, heat 2 in the example)  The starter will make this clear. 

• Cross out lanes which have no swimmer (7 and 8 in the example). 

• At the end of the race one Judge calls out the order of finish by lane number and the 
other records it.  In the example, lane 3 finished first, lane 4 was second, followed by 
lanes 1, 2, 6, and 5. 

• Remember, some part of the swimmer’s body must touch the wall to be considered a 
finish. 

• Initial the card and hold it up for the runner to collect. 

• Refers any swimmer with possible head injury to their Head Coach for evaluation. 
 

Occasionally questions will arise concerning sweep judging and the order of finish. 

• It is NOT up to the Sweep Judge to determine if the swimmer made a legal touch. 
 Sweep Judges only determine the order of finish (who touched in what order). 

• If it is not possible to determine the order of finish (e.g. between two swimmers), record 
each as a “tie”.  It is far better to record a “tie” than to guess at the finish.  (See Appendix 
D for 1st and 2nd place, lanes 3 and 4.) 

• If you missed one or two swimmers, put a question mark beside their finish.  (See 
Appendix D for 5th place, lane 6.)  If, for some reason, you miss the entire finish do NOT 
guess at the order.  It is far better to record “Missed finish” across the card than to guess 
at the finish.     

• Record “DNF” to designate any swimmer who “did not finish” the race.  This is rare, but 
happens occasionally.  (See Appendix D for 6th place, lane 5.) 

• If you run low on cards, have the runner get more for you from the Meet Director.  You 
should start with 2” or more of cards to last for the entire meet. 

• No one should ever be in front of the sweep judges.  Make them move.  You have the 
best seat in the house! 

  

https://www.jsl.org/information2020.php?content=sweep&menu=support&section=workers
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H. FALSE START ROPE 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT False Start Rope 
 

Occasionally a swimmer will “false start” by leaving the starting blocks before the start signal 
is given by the Starter.  The False Start Rope position is referred to simply as “False Start 
Rope” and is responsible for stopping a heat upon hearing the false start signal (multiple 
beeps).  Obviously you are not the actual rope, just the person who occupies that position.  
In JSL, the False Start (Recall) Rope is normally stretched across the midpoint of the pool, 
about 4 feet above the surface of the water, and secured on each side such that it can be 
dropped quickly across all lanes.  Most false start ropes are tied on one side and then 
secured on the other side such that the operator can release the rope quickly.  This position 
is normally the responsibility of the Home Team.  A chair should be provided for the False 
Start Rope position. 

Since 2023, JSL has not allowed false starts in any age group.  If a swimmer commits a 
false start, the swimmers are normally not recalled, but the event is allowed to swim and the 
offending swimmer is simply disqualified after the heat is swum.  Occasionally, the Referee 
will want to recall the swimmers because of multiple false starts or other issues.  In that 
situation the signal for a false start is given by the starter (multiple beeps on the start 
system), the False Start Rope is dropped, the swimmers stop and return to the blocks, and 
the heat is restarted. 

It is NOT the responsibility of the False Start Rope position to determine that a false start 
has occurred.  That is the responsibility of the Starter or Referee.  Your responsibility is to 
quickly drop or release the rope immediately upon hearing the false start signal (multiple 
beeps).   

• Make sure the False Start Rope is secured on both sides of the pool so that it can be 
dropped or released quickly from one side.  A chair is helpful to have on the releasing 
side. 

• PAY ATTENTION and release the rope immediately upon hearing the false start signal 
(multiple beeps).  Because there are so few false starts it can be very easy to become 
distracted or daydream.  Don’t blow your big chance by looking at your cell phone or 
talking with your kids. 

• It is not your responsibility to make sure all swimmers stop at the rope.  Some younger 
swimmers will ignore the rope and swim over or under it.  If you have quickly and 
properly dropped the rope, that’s all you can do. 

• Once the swimmers have (hopefully) stopped at the rope and are returning to the 
blocks, you may raise and re-secure the rope to be ready for the restart of that heat or 
the next. 

 

https://www.jsl.org/information2020.php?content=falsestart&menu=support&section=workers


Jefferson Swim League Procedure Manual - Revised July 5, 2024 

[JSL Man – Sec 3 Jobs]                                        © 2024 JSL - Team Manual Section III - Page 14 

I. TIMER 
  (See Appendices E, E-l, F, F-l, G, G1, & G2 for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Timer 
 

 JSL timers MUST review the ONLINE TRAINING FOR TIMER prior to serving as a timer.  In 
dual meets there must be 3 timers in each lane in addition to the designated head timer.  
Valid times from the 3 watches in each lane not only determine the official time for each 
swimmer, but also the order of finish.  Where automatic or semiautomatic timing equipment 
is used there still must be 3 timers per lane with 1 to 3 also serving as “button pushers”.  The 
home team is responsible for obtaining sufficient watches for the meet (3 each of blue and 
green per lane plus 1 each of blue and green for the head timer(s) plus backups).  In 
addition to serving as a backup timer, the HEAD TIMER organizes timers prior to meet, 
gives instructions, assigns lanes, and gives out watches ensuring that each timer has one 
blue watch and one green watch.  New timers should be given a copy of Recommended 
Timing Procedures for Jefferson Swim League (see Appendix G) to study prior to the meet.  
The HEAD TIMER will review this procedure with all timers prior to the start of the meet.  
Head Timers must be familiar with all procedures regarding timing. 

 

Beginning in 2007, a new method of timing and recording was developed using TWO 
watches (one blue and one green) per timer.  This method is commonly known as “Dive-
Over Starts” and is used in all age groups except 8&U.  The timer must be aware that 
swimmers will remain in the water, clinging to the lane line at the completion of a heat.  The 
following heat will be started and “dive over” the swimmers who are remaining in the water 
from the previous heat. 
 
The timer starts one watch (e.g. blue) for heat #1 and that watch is stopped, but not cleared, 
at the end of the heat.  The following heat #2 is then started on the other cleared watch (e.g. 
green).  Once that heat #2 is in the water, the times from the previous heat #1 are recorded 
from the blue watch and that watch is cleared.  When the following heat #2 is complete, the 
green watch is stopped, but not cleared.  The next heat #3 is started on the cleared blue 
watch.  Once that heat #3 is in the water, times from heat #2 are recorded from the green 
watch and that watch is cleared.  This process continually repeats itself throughout the meet 
with the timers not recording times from heats until the following heat is started with another 
watch.  Timers must keep one cleared watch available at all times so as not to delay the 
start of any heat. 

 

• Takes card from swimmer and verifies name, event, heat, and lane.  Initials card upper 

right-hand corner confirming that this information has been verified. 

• Extends arm horizontally over starting block to signal starter that there is no swimmer in 

the lane. 

• Resets watch and is prepared to time at beginning of race when starter signals "Clear 

watches!" 

• Raises hand vertically to signal starter to delay start if not prepared to time when starter 

asks, "Timers and judges ready?" 

• Starts watch from flash of strobe light (not sound) 

• Raises hand to signal head timer to take over position if start is missed, watch 

malfunctions, or watch is stopped prematurely.  If a backup watch is not obtained, the 

time is not recorded 

• Stops watch when any part of swimmer touches end of pool or course at end of race 

(being aware that many races are multi-lap events). 

• Reminds swimmers to stay in the water, clinging to lane line, at the end of the heat. 

• If the finish time is missed, no time is recorded. 

• Reads watch and records all times to hundredths (thousandths are dropped) on timers 

card, initials box to verify accuracy, and gives completed card to runner. 

• Refers any swimmer with possible head injury to their Head Coach for evaluation. 

https://www.jsl.org/information2020.php?content=timer&menu=support&section=workers
https://www.jsl.org/information2020.php?content=timer&menu=support&section=workers
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J. HEAD OF TABLE 
  (See Appendices J, K, L, & M for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Head of Table 
 

The “Table” is short for Scoring Table.  The Table is where the event results and team 
scores are determined and awards are labeled.  Sorters, Computer Operators, Assistants 
and Checkers, and Awards positions all work at the “Table”.  Runners report to the Table 
also.  The Head of Table position is normally the responsibility of the Home Team.  Ideally, 
the Head will be familiar with all positions at the table, especially Sorter.  It is not necessary 
to be familiar with the operation of the computer. 

The Head of the Table has several main responsibilities: 

• obtaining sufficient volunteers to operate the table 

• setting up equipment and supplies at the table 

• Assigning positions using equal number of volunteers from each team (runners are a 
table position and are normally provided by home team in addition to other table 
workers)  

• answering questions and mediating disputes that may arise at the table 

• assisting at any position at the table (but not normally for the Computer Operator)  

• ensuring data entry is completed and transmitted to JSL by the Computer Operator 

• ensuring that all teams get their ribbons at the end of the meet  

• organizing and assisting in cleanup at the end of the meet  
 

Prior to the start of the swim meet, the Head of Table ensures that adequate supplies, a 

large table, and sufficient chairs are available for all positions from both teams.  

• Prepares 3 (or 4) boxes for timing cards, ribbons and DQ slips 

o Timing Card box (timing cards are retained by home team as official records) 

o Home Team ribbons & DQ slips 

o Visiting Team One ribbons & DQ slips 

o Visiting Team Two ribbons & DQ slips (tri-meet only, if needed) 

o Ensures that Laptop Computer with Meet Manager program is available 

o Ensures that printer, paper, and labels are available 

• Sets up table using the following format depending on space availability at poolside:  

Sorter   Sorter  Computer Assistant  Computer Operator  Backup Check(2)  Awards(2) 
(boys) (girls) 

• Approximately 12 chairs are needed with a table large enough to comfortably 
accommodate all. 

• Two chairs for each position should be available for both teams and placed in this 
order: Boy and Girl Sorters, Computer Assistants, Computer Operators, Backup 
Checkers, and Awards. 

• Some teams designate one person to hand out Heat Winner ribbons at the finish end of 
the pool as each heat is completed, so that person will have to be added if your team 
does it that way. 

• A computer must be supplied by each team, but the home team must supply a printer. 

• Sufficient table supplies (pens, pencils, rubber bands, paper clips, staples, printer 
paper, labels, etc.) and ribbons must be available for the full meet.  Normally 2 packs of 
1st thru 8th and Heat Winner and 1 pack of 9th thru 16th ribbons are plenty.  Some 
teams give out Super Swimmer ribbons at meets also. 

• There should be 3 or 4 boxes available for results, timing cards, and awards.  One box 
is labeled for the Meet Results and will contain the timing cards and computer printouts 
to be retained by the home team as official records.  There should be one box for each 
team to contain their ribbons and DQ Slips. 

• During the Meet, the Head of Table may perform the following: 
o Assists at any table position needed 
o Mediates disputes and solves problems arising at table 
o Ensures that all data entry is completed at end of meet and transmitted to the JSL 

website or given on thumb drive to appropriate people 
o Organizes and assists in clean-up of table and supplies 

https://www.jsl.org/information2020.php?content=headtable&menu=support&section=workers
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K. RUNNER 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Runner 

 
 One (or preferably two) runner(s) assist in gathering the various cards from timers and 

judges to take to the scoring table.  The Runner(s) help the meet run smoothly and 
efficiently by gathering timing cards, DQ slips, and other paperwork and taking them to the 
scoring table (The Table).  Runners should wear comfortable shoes and check in with the 
Head of the Table prior to the start of the meet to get their instructions.  Runners perform the 
following duties after each heat: 
 

• Collects the following after each heat being aware that timer’s cards may not be 

completed until after the beginning of the following heat: 

o "DQ" slips and sweep judge cards from sweep judges 

o Timers cards from timers 

o Takes cards immediately (in heat and sex order) to appropriate boy or girl sorter 

at table 

o Returns to collect more cards 

• With 25 meter or yard events, the Runners may assist getting the Timers cards from 

the kids at the blocks and taking them to the Timers at the other end of the pool.  Be 

sure to give them out to the timers in the correct lane and heat order.  Some teams use 

Lane Timer’s Sheets and this step is not needed.  However the Lane Timer’s Sheets 

have to be picked up after every event and taken to the Table. 

https://www.jsl.org/information2020.php?content=runner&menu=support&section=workers
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L1. SORTER (3 timers per lane) 
  (See Appendices C, D, E, E1, F, F1, F2, G2, & G3 for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Sorter 
 

Sorters report to the Head of the Table prior to the start of the meet.  Their job is to sort 
(organize) the Timing Cards, Sweep Judge Cards, and DQ (disqualification) Slips into event, 
heat, and lane order then determine the official times for the swimmers.  In JSL, the official 
times determine the order of finish, so the Sorter position is very important.  Ideally two 
Sorters from each team are needed and the work is normally divided into boy Sorters and 
girl Sorters.  Being a Sorter requires a cool head and a thorough knowledge of the 
procedures outlined below.  A general knowledge of swimming and its terms is preferred.  
The sorter position is much easier when the meet is run with three timers per lane.  See 
Section L2 if there are only 2 timers pre lane. 

 

• After each heat, Runners will bring the Timing Cards, Sweep Judge Cards, and DQ 
Slips (if any) to the Sorters at the Table.  Group all of these cards by the same heat and 
event. 
o There will be one timing card for each swimmer in every heat. 
o There should be two Sweep Judge Cards for each heat.   
o There may or may not be DQ Slips for the heat.  Also, DQ Slips may come in at a 

later time than the rest of the cards for the heat. 

• As noted above, the Runners will be bringing all Timing Cards, Sweep Judge Cards, and 
DQ Slips (if any) to the Sorter at the Table after each heat.  They will be mixed up and 
first need to be sorted.  
o Put all Timer’s Cards from each heat in each event together, along with the two 

Sweep Judge Cards and any DQ Slips.  The illustration at the right shows what this 

might look like for a boy’s event with one DQ Slip.  Girl’s Timer Cards are pink. 

o Look at the Sweep Judge Cards and confirm that all of the Timer’s Cards for that 
heat are present.  The Sweep Judge Card is a record of the order of finish for each 
lane which had a swimmer.  If there were 6 swimmers on the Sweep Judge Card in 
the heat, you should have 6 timing cards. 

o Note if there are any DQ Slips for that heat and locate the timing card for the 
offending swimmer.  Staple the top (white) copy of the DQ Slip (along with any 
Relay Takeoff slips) to that swimmer’s timing card and circle or mark “DQ” on the 
Timing Card.  Place the bottom (yellow) copy of the DQ Slip into the ribbon or DQ 
box for that swimmer’s team. 

o Make sure all Exhibition (unofficial) Cards are clearly marked. 

• The Sorters also determine the official time for the swimmers which ultimately 
determines where the swimmer placed in the event.  Official times are determined for 
Exhibition swimmers, but not place. 
o Look at the THREE times at the bottom of each swimmer’s Timing Card.  The official 

time is the MIDDLE time of those three times.  Clearly circle this time with a red pen 
or suitable marker.  Note that the times should be fairly close together.  Three 
Tenths of a second (0.3) or less between times is considered close.  If two times 
agree, circle both as that is the official time.   

o If there are only TWO times, they must be averaged.  A calculator should be 
available. 

o If there is only ONE time, that is the official time. 
o Official times are NOT determined for DQ’d (disqualified) swimmers. 
o If there are large discrepancies in times (0.5 second or more) or only one or two 

times are available, the Sweep Judge Cards should be consulted.  It is particularly 
helpful if both Sweep Judge Cards agree since that is almost certainly the order of 
finish and that will help confirm certain times.  Mark “Times OK” on the swimmer’s 
card if you checked them against the Sweep Judge Card.  Always consult with more 
experienced sorters in this situation. 

• Make sure all Exhibition (unofficial) cards are clearly marked for the Computer Operator. 

• Pass the cards in correct lane, heat, and event order to the Computer Assistant and 
start on the next heat or event. 

  

https://www.jsl.org/information2020.php?content=sorter&menu=support&section=workers
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SORTER (continued) 

• Potential problems may be solved as follows: 
o If a timing card is missing from a heat have the Runner or someone go to that lane 

and see if the timing card can be located.  If it is found at a later time, circle the 
official time and pass it to the Computer Assistant for immediate entry by the 
Computer Operator. 

o If a Sweep Judge Card is missing from a heat, have the Runner or someone go to 
the Sweep Judges and see if the card can be located.  

o If a DQ Slip is received after the heat has been passed to the Computer Assistant, 
separate the copies, place the bottom (yellow) copy into the team’s ribbon or DQ 
box, and pass the top (white) copy to the Computer Assistant for immediate entry. 
 The timing cards from that heat must be located and the DQ Slip stapled to the 
offending swimmer’s timing card. 

o If a DQ Slip is later marked “void” by the Referee, the voided DQ slip is still retained 
with the timing cards and the bottom (yellow) copy is removed from the team’s 
ribbon or DQ box.  Don’t forget to determine the official time for that swimmer and 
have it entered by the Computer Operator as soon as possible. 

o If a tie happens (two identical official times), “TIE” is circled on both swimmers’ 
timing cards. 

o If times from a particular lane are frequently “messed up” or missing, the Meet 
Director should be consulted to determine if there is a timer or watch issue that 
needs correcting. 

o Assistance in determining the official time when there are not 3 valid times can be 
found at Section III, Appendix G2 of the Team Procedure Manual. 

o Always seek another opinion if an official time cannot be easily determined. 
o If it is difficult or impossible to determine the official time for whatever reason, the 

Referee must be consulted and will assist in determining the official time based on 
the best available evidence.  In this instance “JD” (Judge’s Decision) must be circled 
on the Timing Card.  

https://www.jsl.org/documents/bin/Current/JSLTeamManual.pdf#page=67
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L2. SORTER (2 timers per lane) 
  (See Appendices C, D, E, E1, F, F1, F2, G2 & G3 for additional information) 
 

THIS PROCEDURE SHOULD NO LONGER BE USED AS USA SWIMMING REQUIRES 3 
TIMERS PER LANE.  IT IS LEFT IN THE MANUAL FOR REFERENCE ONLY 

 
 The sorter position becomes much more complex when the meet is run with only two timers 

per lane.  It requires a thorough knowledge of the procedures below and a cool head.  A 
general knowledge of swimming and its terms is preferred.  Ideally two or more sorters from 
each team are needed and the work is normally divided by gender groups.  The sorters 
organize the timing cards, “DQ” slips, and sweep judge cards as they are delivered to the 
table by the runners, then determine the order of finish for the swimmers.   
 
1. Receives 2 sweep judge cards (white) from runner for each heat swum 
 
2. Receives 1 timer's card (pink for girls or blue for boys) from runner for each swimmer in 

heat 
 
3. Sorts (organizes) all cards into individual heats first, and groups heats into event order 

next 
 
4. Compares timers cards to sweep judge cards to make sure all timers’ cards are present 

in each heat (Note that empty lanes should be “X’ed” out at the top of the card.) 
 
5. Separates all complete “DQ" (yellow) slips and matches with timers cards, circles "DQ" 

at top of timers card, staples together with the “DQ” slip behind the swimmer’s timing 
card, but leaves them in correct heat and lane location (does not determine place or 
compute times for DQ'd swimmers) 
a. "DQ" slips must be complete with swimmers name, Event #, Heat #, Lane #, 

Judge's initials, and infraction 
b. Questionable "DQ" slips should be brought to the attention of the Referee for 

official ruling.  No one at the Scoring Table may rule on the validity of a DQ. 
c. "DQ" slips, which have been voided by the Referee, should be marked "VOID", 

reason voided, and retained with valid "DQ" slips. 
 

6. Locates and clearly marks any exhibition timers cards (see Appendix E-I & F-I) but 
leaves them in correct heat and lane order.  If an official timing card was used for an 
exhibition swimmer, an “X” should be clearly marked at the top of the card.  (Exhibition 
swimmers receive no points or ribbons, but their official time is determined) 

 
7. Compares both sweep judge cards in each heat for order of finish 

a. IF BOTH SWEEP JUDGE CARDS AGREE, THAT IS THE ORDER OF FINISH 
FOR THAT HEAT (regardless of official time).  If this results in an order of finish 
which conflicts with the official times, “JD” must be circled on all cards affected 
and brought to the attention of the Computer Assistant. 

b. If both sweep judge cards do not agree, a “ballot must be conducted (see #8 
below) 
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L2. SORTER (2 timers per lane) 
  (continued) 
 

THIS PROCEDURE SHOULD NO LONGER BE USED AS USA SWIMMING REQUIRES 3 
TIMERS PER LANE.  IT IS LEFT IN THE MANUAL FOR REFERENCE ONLY 

 
8. Conducts Ballot within a heat if sweep judges do not agree (See Appendix G3) 

a. Awards 1 point for 1st place rank by sweep judge (2 points for 2nd, 3 points for 
3rd, etc.) 

b. Awards 1 point for best official time (2 points for 2nd, 3 points for 3rd, etc.) 
c. Adds together total number of points obtained by each swimmer involved in 

balloting 
d. Awards first place to swimmer with the lowest number of points (2nd place to the 

next lowest, etc.) 
e. Awards ties if point totals are the same, omitting next place 

i) Circles two cards first and skips second when there is a tie for first place (3rd 
and 4th are still awarded) 

ii) Circles two cards second and skips third when there is a tie for second (1st 
and 4th are still awarded) 

iii) Circles two cards third when there is a tie for third (1st and 2nd are still 
awarded) 

iv) Circles two cards fourth when there is a tie for fourth 1st, 2nd, and 3rd are 
still awarded) 

v) Awards any further ties in the manner described above 
f. Circles "JD" on all cards involved in balloting 
g. Circles "Tie" on all cards involved in ties 
 

9. Computes and circles the official time on each swimmer's card (except DQ's) in red ink 
a. Circles middle time when 3 different times are given (however, if 2 of those times 

agree, that is the official time)  
b. Computes and circles average when 2 times are given (thousandths are dropped)  
c. Puts cards in order by time (in each heat) with the lowest (i.e. fastest) time on top 
 

10. Compares sweep judge cards (if they agree) with the timers cards from each individual 
heat and puts timers cards in finish order (according to sweep judge cards, if they 
agree) with first place in each heat on top.  Determines heat winners (as in 7 above) 
and circles "HW" at the top rather than "1", "2", "3", etc. 
a. Awards multiple ribbons in case of heat ties (do not ballot) 
b. Awards "HW" only to official, non-DQ'd swimmers who did not place in the event 
c. Usually awards no heat ribbon in a heat in which any swimmer finishes 1st 

through 8th in the event (may award heat ribbon in this situation at discretion of 
table) 

d. Realizes that sweep judging can NOT be used to compare one heat against 
another, that times must prevail when the various heats are integrated by the 
computer into final results. 

 
11. Puts timers’ cards back into heat and lane order and passes timing cards for each 

event (in event, heat and lane number order) to Computer Assistant. e.g. heat 1 lane 3, 
4, 5 / heat 2 lane 1, 2, 3, 4, 5, 6, etc.  It is important to note that heats can be passed 
forward as completed without waiting for the entire event to be completed. 
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M. COMPUTER ASSISTANT (Reader) 
  (See Appendix T and Section 5 for complete computer instructions) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Computer Assistant 
 

 The Computer Assistant should be a Computer Operator (or other knowledgeable 
person) from the opposing team and should be familiar with the computer program and 
operation of the computer and printers.  The purpose of this position is to assist in data entry 
by reading information to the Computer Operator and observing data entry as a double-
check.  Ideally this person should be qualified to relieve the Computer Operator periodically. 

• Receives completed Timing Cards, Sweep Judge Cards, and "DQ" slips from Sorters. 

• Verifies Event and Heat Number on cards with Event and Heat Number in computer to 
confirm that correct heat is being finalized. 

• Reads information to Operator one card at a time noting that certain information does 
not have to be repeated for each card. 
o Reads Event Number. 
o Reads Heat Number. 
o Reads Lane Number. 
o Reads Swimmer’s Name (noting if “Exhibition” or “JD”). 
o Reads Swimmer’s Official Time or “DQ”. 

• Observes data entry for errors and communicates to Computer Operator. 

• Rubber-bands completed heats together and passes to Backup Checker. 
 

You may wish to learn more about your position by consulting the following: 

• Sign up for JSL Software Training for Computer Operators. 

• To view or download the JSL Computer Manual 

• To view or download Hy-Tek User Guides or Demos for Meet Manager or Team 
Manager  
o Click on User Guide next to the Product Name to download and save the zipped 

Acrobat PDF file to your hard drive.  Then unzip the downloaded zip file and open 
it with Acrobat Reader to view the User Guide. 

o Click on Lite or Demo next to the Product Name to download and save the file to 
your Desktop. Then open the Lite/Demo file from your Desktop to install the 
Lite/Demo software. 

 

If you need help with Hy-Tek software, please contact Jessica Simons, the JSL Computer 
Advisor at (434) 962-0443 or jrsimons@comcast.net.  

  

https://www.jsl.org/information2020.php?content=compassist&menu=support&section=workers
https://www.jsl.org/support2020.php?section=computers&content=softwaretrain
https://www.jsl.org/documents/bin/Current/JSLComputerManual.pdf
https://hytek.active.com/downloads.html
https://hytek.active.com/downloads.html
mailto:jrsimons@comcast.net
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N. COMPUTER OPERATOR 
  (See Appendix T and Section 5 for complete computer instructions) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Computer Operator 
 

 JSL requires Computer Operators to attend an orientation class.  If you would like to 
become certified as a JSL Computer Operator, sign up for classes at: JSL Software 
Training.  Experienced Operators may be excused from the class at the discretion of 
the Software Advisor.   
 

The Computer Operator enters all official times into the computer one heat at a time.  This 
person MUST be familiar with Hy-Tek Meet Manager program and operation of the 
computer and printers prior to the start of the meet.  The Assistant will read the data as the 
Operator keys it in.  Alternating jobs will minimize fatigue.  The Computer Operator and 
Assistant must not get distracted with discussions going on around them - their job is to 
enter approved (pre-sorted) data as fast & as accurately as possible, not make decisions 
regarding the data unless there is an obvious error.  Last minute entries, but not deletions, 
require the initials of BOTH Meet Directors and these entries are ALWAYS entered as 
Exhibition (unofficial).  It is the coach’s responsibility to obtain proper authorization from 
BOTH Meet Directors.  No one at the table should attempt to assist in getting this 
authorization.  Detailed instructions for the Meet Manager program may be found in the JSL 
Computer Manual. 
 

Computer Operators must arrive well before the Meet starts and are often responsible for 
their team’s computer, printer and supplies.  They must report to the Head of the Table and 
ensure that all equipment is setup properly.  Last minute meet changes will start coming in 
very quickly. 

• Makes last minute changes as approved by BOTH Meet Directors (deletions do not 
require approval). 

• Enters data as quickly and as accurately as possible (as read by Computer Assistant). 

• Prints the running score every 10 events (if possible) for posting and announcement. 

• Prints 2 copies of official results as needed. 
o One set of results is posted. 
o The second set is passed to the Backup Checkers along with the timing cards. 

• Prints Awards labels as often as possible and passes to awards table. 

• Summarizes meet results with reports and saves file on computer. 

• Uploads a Meet Backup File to JSL Meet Results Upload Page ASAP after meet ends. 

• Uploads Meet Results to the JSL Meet Results Upload Page by 9PM the following day. 

• Provides any team with a data file of the meet results on request (The requesting team 
must provide a thumb drive or other storage device.). 

 

A “Computer Operator’s Checklist” is found in Appendix T of this manual. 
 
You may wish to learn more about your position by consulting the following: 

• Sign up for JSL Software Training for Computer Operators. 

• To view or download the JSL Computer Manual  

• To view or download Hy-Tek User Guides or Demos for Meet Manager or Team 
Manager  
o Click on User Guide next to the Product Name to download and save the zipped 

Acrobat PDF file to your hard drive.  Then unzip the downloaded zip file and open 
it with Acrobat Reader to view the User Guide. 

o Click on Lite or Demo next to the Product Name to download and save the file to 
your Desktop. Then open the Lite/Demo file from your Desktop to install the 
Lite/Demo software. 

 

If you need help with Hy-Tek software, please contact Jessica Simons, the JSL Computer 
Advisor at (434) 962-0443 or jrsimons@comcast.net.  

 

https://www.jsl.org/information2020.php?content=compop&menu=support&section=workers
https://www.jsl.org/support2020.php?section=computers&content=softwaretrain
https://www.jsl.org/support2020.php?section=computers&content=softwaretrain
https://www.jsl.org/documents/bin/Current/JSLComputerManual.pdf
https://www.jsl.org/documents/bin/Current/JSLComputerManual.pdf
https://www.jsl.org/meet-results-uploads2020.php
https://www.jsl.org/meet-results-uploads2020.php
https://www.jsl.org/support2020.php?section=computers&content=softwaretrain
https://www.jsl.org/documents/bin/Current/JSLComputerManual.pdf
https://hytek.active.com/downloads.html
https://hytek.active.com/downloads.html
mailto:jrsimons@comcast.net
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O. BACKUP CHECKER 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Backup Checker 

 
 Each team should have at least one Backup Checker.  The two checkers normally divide the 

work by gender.  The Backup Checker position is responsible for comparing the official 
times on the timing cards with the final results and reviewing the print-outs for data entry 
errors, etc., PRIOR to posting or announcing.  In addition, there may be other duties as 
requested by the Computer Operator.  The Backup Checker should have a general 
knowledge of swimming. 
 

• Receives timing cards and corresponding final results printout for each event. 

• Places timing cards into finish order, if more convenient for checking. 

• Compares the official time on each card to the corresponding time on the final results. 

• Brings discrepancies to the attention of the computer operator. 

• Notifies computer operator verbally. 

• Passes back any timing cards entered in error for correction. 

• Removes “DQ” slips from timing cards and places them into appropriate team’s ribbon 
box. 

• Places cards and results without errors into the meet record box to be retained by home 
team. (Cards may be left in finish order.) 

P. AWARDS 
  (See Appendix K for additional information) 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Awards 
 

The Awards Position is responsible for labeling all of the ribbons given out at a swim meet 
and should report to the Head of Table prior to the start of the meet.  Each team should have 
one Awards person and the work is normally divided by gender.  Most all award labels are 
now printed by computer, so little writing is done.  The Awards position performs the 
following: 

• Receives ribbon labels from Computer Operator. 

• Attaches computer generated label on the back of the appropriate ribbon. 

• Notes that every member of ribbon-winning relay teams gets a ribbon. 
o There will be four ribbon labels printed for each place. 

• Writes heat winner ribbons or arranges for them to be given out after each heat. 
(N.B. JSL Rules & Regulations require heat winner ribbons). 

• Places all ribbons in the ribbon box of appropriate team. 

Unfortunately, the Awards Volunteers have to stay for a short time after the meet ends to 
label the ribbons from the last few events. 

• Ensures that someone from each team takes the team’s ribbon box. 

• Assists in cleanup after the end of meet by putting ribbons back into the correct storage 
box for use at the next meet. 

 
Q. REFRESHMENTS 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Refreshments 
 

All of the Swim Meet Volunteers get thirsty during the course of a swim meet and it is the 
responsibility of the home team to provide refreshments like water, lemonade, iced tea, 
sports drinks, etc. several times during the meet.  The Refreshments server may also be 
responsible for making sure that refreshments and cups are available, so check with your 
team.  The Refreshments position is normally the responsibility of the Home Team. 

 

Refreshments must be distributed at least twice to all VOLUNTEERS who are working the 
meet and COACHES who are on duty.  On extremely hot evenings refreshments should be 
distributed more often.  Spectators and parents who are not working the meet are not 
included. 

 

Just to be clear, alcoholic beverages are NOT allowed on the deck at a JSL Swim Meet. 
 Spectators consuming alcohol must be restricted to outlying areas of the pool.  There may 
be a $50.00 fine against your team for various alcohol-related violations. 

https://www.jsl.org/information2020.php?content=backupchecker&menu=support&section=workers
https://www.jsl.org/information2020.php?content=awards&menu=support&section=workers
https://www.jsl.org/information2020.php?content=refreshments&menu=support&section=workers
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R. MEET MARSHAL 

 ONLINE TRAINING FOR THIS POSITION MAY BE FOUND AT Meet Marshal 
 

The Meet Marshal has the authority to warn and stop any behavior deemed unsafe or 
inappropriate for a Jefferson Swim League meet.  Swim meets are children’s sporting events 
and major trouble would be unexpected.  Most infractions are minor and can be stopped 
with a simple friendly suggestion by the Meet Marshal.  Any difficulty with any swimmer, 
parent, coach, or spectator should be immediately reported to the Home Meet Director.  The 
Meet Director has the authority to remove anyone from the premises who is behaving in an 
unsafe manner or who is in any way disrupting the meet.  The Meet Marshal position is 
normally the responsibility of the Home Team.  In the absence of available or qualified 
personnel, the Home Meet Director may also serve as the Meet Marshal.  

• Monitors all areas for unsafe conditions such as, but not necessarily limited to: 
o excessive horseplay or other actions where injury may occur 
o any problem which might cause physical injury (e.g. broken glass, etc.) 
o any spectators or swimmers who, by their actions, represent a danger to themselves 

or others 
o the appearance of lightning or sound of thunder 

• Monitors all areas for behavior which might result in destruction of property.  
o bathrooms should be checked on a regular basis 
o areas outside of the immediate deck area should be checked  

• Keeps area behind blocks free of all but the timers or other officials and swimmers 
waiting for their events.  (Timers have watches, stroke-and-turn judges have “DQ” slips, 
and swimmers should have timing cards.)  
o A reasonable number of Coaches may be allowed behind the blocks especially to 

help with younger swimmers.  
o Coaches must not be allowed to disrupt or interfere with the Meet in any way.  

• Assists the Clerk-of-Course in keeping that area clear of all but officials and swimmers 
who are being seeded or are waiting for their event.  

• Keeps restricted areas clear (e.g. closed pools or other areas where participants are not 
allowed).  

• Notifies Home Meet Director of any difficulty with any participant which cannot be 
resolved with a simple warning or suggestion.  

• Extremely difficult persons should be reported to the Home Meet Director who has the 
authority to remove any participant from the premises who is clearly out of order or 
presenting a danger to himself or others.  Examples may include but are not limited to:  
o verbal or physical abuse of any official or volunteer 
o a loud argument on the verge of escalating to a more serious problem 
o obnoxious, profane, or sexually inappropriate behavior 
o physical violence of any kind such as fighting, hitting with objects, etc. 
o persons who refuse to obey rules such as moving when asked, etc. 
o persons found destroying or committing theft of property  

• Refers any swimmer with possible head injury to their Head Coach for evaluation.  

• In the event of emergency, assists all meet personnel in resolving the problem.  
o assists in calling for appropriate emergency personnel 
o assists in coordinating emergency personnel 
o assists meet personnel in resolving emergency 
o directs participants to nearest exit if needed 
o assists in directing participants to return when instructed by meet personnel 

• Assists Meet Director(s) with completion of JSL Injury and Incident Report Form if 
needed.  (See Appendix X)  “When in doubt, fill it out.”  

 

https://www.jsl.org/information2020.php?content=meetmarshal&menu=support&section=workers
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SECTION III - APPENDICES (All changes for current season are highlighted) 

Appendix A JSL Parent Volunteer Roster (Revised, 2016) 
Appendix B JSL Meet Program Report (Revised, 2001) 
Appendix B1 JSL Meet Time Line (Added, 2001) 
Appendix B2 How to Save Time in a Swim Meet (Added 2021) 
Appendix C USAS Stroke Disqualification (DQ) Slip (Revised, 2023) 
Appendix C1 JSL Relay Take-Off Slip (Added, 2011) 
Appendix D JSL Sweep Judge Card (Revised, 2005) 
Appendix E JSL Boys Event Timers Card (Revised, 2019) 
Appendix F JSL Girls Event Timers Card (Revised, 2019) 
Appendix F2 JSL Exhibition Unisex Event Timers Card (Revised, 2023) 
Appendix G JSL Recommended Timing Procedures (Revised, 2014) 
Appendix G1 JSL Watches 
Appendix G2 Official Time and Order of Finish (Revised, 2015) 
Appendix G3 JSL Ballot Form (Revised, 2023)  
Appendix H JSL Guidelines for Special Needs Swimmers (Revised, 2014) 
Appendix H1 JSL Procedure for Entering Special Needs Swimmers (Added, 2007) 
Appendix I Helpful Hints for Coaches (Revised, 2022) 
Appendix J JSL Digital Media Policy (Revised May, 2024) 
Appendix K JSL Ribbon Label (Revised, 2001) 
Appendix L NOAA Radio Information & Guidelines (Added, 2008) 
Appendix M NOAA Radio WX-150 User’s Manual (Added, 2008) 
Appendix N USAS Concussion Information Sheet (Added 2018) 
Appendix N1 JSL Procedure for Head Strikes or Bumps (Added 2022) 
Appendix O JSL Sportsmanship Rating Form (Revised, 2015) 
Appendix P Tidbits for the Referee (Added, 2006) 
Appendix Q Stroke-and-Turn Judge Guidelines (Added, 2006) 
Appendix R Good Starting Procedure (Added, 2006) 
Appendix S Whistle Starts (Revised, 2008) 
Appendix S1 Whistle Start Protocol (Revised, 2008) 
Appendix T Computer Operator Checklist 
Appendix U USA Swimming Changes for Current Year (Revised annually) 
Appendix V Protests (Revised 2023) 
Appendix W Coaches Background Checks (Revised, 2023) 
Appendix W1 Coaches Athlete Protection and Concussion Training (Revised 2023) 
Appendix X JSL Injury and Incident Report Form (Revised 2020) 
Appendix Y JSL Registration Form (Revised 2020) 
Appendix Y1 JSL Registration Fee Waiver (Added 2021) 
Appendix Z Guidelines for Swimwear, Taping, Braces, etc. (Revised, 2020) 
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Appendix B 
(Revised, 2001) 

 

JEFFERSON SWIM LEAGUE MEET PROGRAM 
 

Jefferson Swim League        1:00 PM  05/28/2001  Page 1 

FCC@BHSC - 07/19/2000 

Meet Program - Wednesday Evening Event  

 

 1P Mixed 6 & Under 100 SC Meter Freestyle Re 

Lane Team Relay Seed Time 

 
Heat   1   Finals 

 1 FCC-VA B NT 
 2 BHSC-VA A NT 

 3 FCC-VA A 2:01.24 

 4 FCC-VA C NT 

 5 BHSC-VA B NT 

 
Event  3 Boys 9-10 100 SC Meter IM 

Lane Name Age   Team Seed Time 

 
Heat   1   Finals 

 2 Dittmar, Will  10 FCC-VA NT 

 3 Tungate, Robert M   9 BHSC-VA NT 

 4 Graham, Kyle C   9 BHSC-VA NT 

Heat   2   Finals 

 1 Snyder, Jeffrey A   9 FCC-VA NT 

 2 Thomasson, Jack  10 FCC-VA NT 
 3 Wells, Carter L  10 FCC-VA 1:44.46 

 4 Cooke, David F   9 FCC-VA 2:02.53 

 5 Haar, Fred H   9 FCC-VA NT 

Heat   3   Finals 

 1 Graff, Simon   9 BHSC-VA 1:41.78 

 3 Spinosa, Michael D 10 BHSC-VA 1:32.98 

 4 Timko, Matthew O   9 FCC-VA 1:36.29 
 5 Luck, William A  10 BHSC-VA 1:40.71 

 6 Kessler, Kyle D  10 FCC-VA 1:44.40 

 
Event  4 Girls 9-10 100 SC Meter IM 

Lane Name Age   Team Seed Time 

 
Heat   1   Finals 

 2 Turner, Caroline R   9 BHSC-VA NT 

 3 Johnson, Jeanie A  10 BHSC-VA NT 

 4 Wright, Alice E  10 FCC-VA NT 

Heat   2   Finals 

 2 Graham, Scout C  10 BHSC-VA NT 

 3 Wilson, Lauren  10 BHSC-VA NT 

 4 Schwartz, Mary F   9 BHSC-VA NT 

 5 Blackwell, Brooke A  9 BHSC-VA NT 
Heat   3   Finals 

 1 Kennedy, Jamie  10 FCC-VA NT 

 2 DeBUTTS, Sunny  10 FCC-VA 1:49.20 

 3 Little, Liza S   9 FCC-VA 1:40.63 

 4 Thomas, Brea   9 BHSC-VA 1:45.27 

 5 Nicholaou, Effie L   9 BHSC-VA 2:03.63 

 6 Brightwell, Elizabeth K 9 FCC-VA NT 
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Appendix B1 
(Revised, 2001) 

 

JEFFERSON SWIM LEAGUE SESSION REPORT 
 

Licensed To:  Jefferson Swim League                05/28/2001  Page 1 

               FCC@BHSC - 07/19/2000 

 Session Report Session: 1   Wednesday Evening 

 Day of Meet: 1   Starts at 05:00 PM   Heat Interval: 45 Seconds 
 

Round Event Entries Heats Starts at 
 

Finals 1PMixed 6 & Under 100 Freestyle Relay 5 1 05:00 PM _______ 

Finals 3 Boys 9-10 100 IM 13 3 05:03 PM _______ 

Finals 4 Girls 9-10 100 IM 13 3 05:11 PM _______ 

Finals 5 Boys 11-12 100 IM 6 1 05:18 PM _______ 

Finals 6 Girls 11-12 100 IM 12 3 05:21 PM _______ 

Finals 7 Boys 13-14 100 IM 6 1 05:28 PM _______ 

Finals 8 Girls 13-14 100 IM 11 2 05:30 PM _______ 

Finals 9 Men 15-18 100 IM 7 2 05:35 PM _______ 

Finals 10 Women 15-18 100 IM 2 1 05:40 PM _______ 

Finals 11 Boys 8 & Under 100 Medley Relay 4 1 05:42 PM _______ 

Finals 12 Girls 8 & Under 100 Medley Relay 4 1 05:44 PM _______ 

Finals 13 Boys 9-10 200 Medley Relay 3 1 05:47 PM _______ 

Finals 14 Girls 9-10 200 Medley Relay 5 1 05:51 PM _______ 

Finals 15 Boys 11-12 200 Medley Relay 2 1 05:55 PM _______ 

Finals 16 Girls 11-12 200 Medley Relay 4 1 05:58 PM _______ 

Finals 17 Boys 13-14 200 Medley Relay 2 1 06:02 PM _______ 

Finals 18 Girls 13-14 200 Medley Relay 2 1 06:06 PM _______ 

Finals 19 Men 15-18 200 Medley Relay 3 1 06:10 PM _______ 

Finals 20 Women 15-18 200 Medley Relay 2 1 06:13 PM _______ 

Finals 21P Boys 6 & Under 25 Freestyle 20 5 06:17 PM _______ 

Finals 22P Girls 6 & Under 25 Freestyle 14 4 06:22 PM _______ 

Finals 21 Boys 8 & Under 25 Freestyle 19 5 06:27 PM _______ 

Finals 22 Girls 8 & Under 25 Freestyle 38 8 06:32 PM _______ 

Finals 23 Boys 9-10 50 Freestyle 22 5 06:42 PM _______ 

Finals 24 Girls 9-10 50 Freestyle 24 6 06:50 PM _______ 

Finals 25 Boys 11-12 50 Freestyle 5 1 06:58 PM _______ 

Finals 26 Girls 11-12 50 Freestyle 27 5 07:00 PM _______ 

Finals 27 Boys 13-14 50 Freestyle 7 2 07:07 PM _______ 

Finals 28 Girls 13-14 50 Freestyle 11 2 07:10 PM _______ 

Finals 29 Men 15-18 50 Freestyle 13 3 07:13 PM _______ 

Finals 30 Women 15-18 50 Freestyle 4 1 07:17 PM _______ 

Finals 31 Boys 8 & Under 25 Butterfly 8 2 07:18 PM _______ 

Finals 32 Girls 8 & Under 25 Butterfly 12 2 07:21 PM _______ 

Finals 33 Boys 9-10 50 Butterfly 9 2 07:24 PM _______ 

Finals 34 Girls 9-10 50 Butterfly 11 2 07:27 PM _______ 
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APPENDIX B2 
(Revised 2022) 

How to Save Time in a Swim Meet 
 

• First of all, SECONDS COUNT!  A big meet may have over 180 heats.  For every 
second wasted in a heat, the meet lasts 3 minutes longer.  Waste just 10 seconds per 
heat and, bingo, the meet is 30 minutes longer.  The time interval GOAL for all dual 
meets should be 20 seconds overall or 18 seconds plus 15 seconds for back.  If your 
team is not very close to this, take a hard look at ways to increase efficiency. 

• Have an experienced, well-trained Starter willing to move the meet.  The Starter 
along with the Referee sets the pace for the meet.  An inefficient starter can 
lengthen a meet considerably. 

• Make sure all timers have completed the Timer’s Online Course on jsl.org and 
understand timing of dive-over starts, especially the use of two watches.  Timers 
who cannot keep up are doing it wrong. 

• Have at least one experienced, well-trained Clerk of Course plus as many helpers 
(assistants) as needed.  Delays in getting swimmers to the blocks must not happen. 

• Make sure every volunteer takes the Online Course for their position. 

• Make Assistant or Junior Coaches responsible for getting kids to the Clerk. 

• Locate Clerk of Course area near the starting blocks if possible. 

• Look at the general layout of your pool to see where it is most efficient to locate 
various areas such as team areas, clerk-of-course, scoring table, food sales, etc. 

• Have a good loud-speaker system that reaches all areas of the venue if possible. 

• Ensure that your start system is fully charged the day before the meet. 

• Ensure that you take your fully charged start system to all away meets. 

• Have someone in charge behind the blocks to remind swimmers of dive-over starts, 
encourage kids to blocks, push timers to the opposite end, collect cards for 25 yard 
events, keep area clear of swimmers and parents who are not supposed to be there, 
and generally make sure this area runs efficiently. 

• Be willing to occasionally combine heats if you have an experienced clerk, starter, 
computer operator, etc., but proceed cautiously. 

• Group the 25 yard events together (must be done by meet entry deadline).  This 
could save time by eliminating two “end changes”.  Suggestion would be for the events 
to run as follows: 
Change ends at short free and swim 21, 22, 21P, 22P, (run “P” events second) 
followed by breast 31 and 32, then change ends and go through the normal events 
(rest of free and rest of breast).  At the mid-point, change ends again swim back 41, 42, 
41P, 42P, followed by fly 51 and 52, then change ends and continue rest of meet (rest 
of back and fly, etc.)  This would save about 5-10 minutes in end changes and possibly 
get some younger swimmers home earlier (those whose last event was 51 or 52). 

• Improve dive-over starts by emphasizing that swimmers must remain in the water at 
the finish until told to get out.  Also, Starters should emphasize this to swimmers before 
the start and at the finish if they start to get out too early.   

• Swimmers must be able to complete 25m in a REASONABLE time.  Currently the 
Bylaw says that the swimmer has to be able to swim 25m unassisted. 

• Meet Directors can change order of events, etc.  It may help to change order of 
events to swim events that are not getting swum in previous meets. 
 

THE GOAL IS FOR A MEET TO BE COMPLETED IN 4 HOURS OR LESS 
 

https://www.jsl.org/information2020.php?content=starter&menu=support&section=workers
https://www.jsl.org/information2020.php?content=timer&menu=support&section=workers
https://www.jsl.org/information2020.php?content=courseclerk&menu=support&section=workers
https://www.jsl.org/support2020.php?section=workers
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Appendix C 
(Revised May, 2023) 

JSL DISQUALIFICATION CARD 
(NEW USAS VERSION) 

 

 
 
 

(Two-part form printed on white pressure sensitive paper) 
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Appendix C1 
(Revised, 2011) 

JSL RELAY TAKEOFF SLIP 
 

The Relay Take-Off Slip is used by the Relay Takeoff Judges to record relay takeoffs.  An “O” is 
used to record a legal takeoff and an “X” is used to record an early takeoff.  The slip below shows 
that all swimmers had legal takeoffs except swimmer number 3 in lane 5.  It is important to note 
that the Relay Take-Off slip must agree with the slip on the opposing side before a team can be 
disqualified for an early takeoff. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(Printed as White Slip) 
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Appendix D 
(Revised, 2016) 

JSL SWEEP JUDGE CARD 
 

The properly completed Sweep Judge Card below on the left for Event #3, Heat #2, shows a 
normal uncomplicated finish.  There were NO swimmers in lanes 7 & 8 at the start of the race 
(“X’s” placed over lane numbers 7 & 8 at the top).  The order of finish has been recorded as the 
swimmer in lane 3 finishing first, lane 4 finishing second, lane 1 finishing third, lane 2 finishing 
fourth, followed by lanes 1, 2, 6, and 5. 
 
The properly completed Sweep Judge Card below on the right for Event #3, Heat #2, and 
shows what can happen with difficult finishes: 
Ties = connect places and lane boxes with brackets and write the word “tie” within the brackets 
 (see below right for lanes 3 and 4) 
Didn’t see finish = place a question mark “?” in lane box (do NOT guess at finish) 
 (see below right for lane 6) 
Swimmer did not finish = write “DNF” beside lane box containing that swimmer’s lane position 
 (see below right for lane 5) 

 

                       
(Printed as 110# White Card)  
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Appendix E 
(Revised, 2019) 

 

JEFFERSON SWIM LEAGUE BOYS EVENT TIMERS CARD 

 
 

FOR SORTER USE ONLY 
to mark official place or other information 
by circling appropriately 
 
 
Note that “EXHIB” is only used if an 
exhibition card is not available 
 
 
 
 

FOR CLERK-OF-COURSE USE ONLY 
if timing sticker is not available or Clerk 
needs to make a change to event, heat, or 
lane 
 
 
 
 
 
 
 

FOR COACH USE ONLY IF NO 
STICKER 
The seeding sticker is normally placed 
over this information, but if sticker is not 
available, circle appropriate distance, 
yards or meters, stroke name, and age 
group.  Fill in swimmer’s name and team. 
In 2017 age group names were deleted. 
 
 

FOR MEET DIRECTORS ONLY 
Home and visiting Meet Directors must 
approve all late entries with their initials in 
the appropriate box. 
 

FOR TIMERS ONLY 
Times from all three timers must be 
entered as minutes, seconds, and 
hundredths.  The timer making the entries 
must initial the card. 
 
 

 

FOR SORTER ONLY 
If three times are available, the sorter may 
circle the official time above.  This section 
is used to record the average if only two 
times are available. 

 
 

(Printed as Blue 110# Card)  
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Appendix F 
(Revised, 2019) 

 

JEFFERSON SWIM LEAGUE GIRLS EVENT TIMERS CARD 

 
 

FOR SORTER USE ONLY 
to mark official place or other information 
by circling appropriately 
 
 
Note that “EXHIB” is only used if an 
exhibition card is not available 
 
 
 
 

FOR CLERK-OF-COURSE USE ONLY 
if timing sticker is not available or Clerk 
needs to make a change to event, heat, or 
lane 
 
 
 
 
 
 

FOR COACH USE ONLY IF NO 
STICKER 
The seeding sticker is normally placed 
over this information, but if sticker is not 
available, circle appropriate distance, 
yards or meters, stroke name, and age 
group.  Fill in swimmer’s name and team. 
In 2017 age group names were deleted. 
 

 
 
 

FOR MEET DIRECTORS ONLY 
Home and visiting Meet Directors must 
approve all late entries with their initials in 
the appropriate box. 
 

FOR TIMERS ONLY 
Times from all three timers must be 
entered as minutes, seconds, and 
hundredths.  The timer making the entries 
must initial the card. 
 

FOR SORTER ONLY 
If three times are available, the sorter may 
circle the official time above.  This section 
is used to record the average if only two 
times are available. 

 
 

(Printed as Cherry 110# Card)  
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Appendix F2 
(Revised 2023) 

 

JEFFERSON SWIM LEAGUE UNISEX EXHIBITION TIMERS CARD 

 
 

FOR EXHIBITION USE ONLY 
 
 
 
 
 
 
 
 
 

FOR CLERK-OF-COURSE USE ONLY 
if timing sticker is not available or Clerk 
needs to make a change to event, heat, or 
lane 
 

 
 
 
 

FOR COACH USE ONLY IF NO 
STICKER 
BE SURE TO MARK OUT BOYS OR 
GIRLS at top so it is clear which sex the 
card is used for.  The seeding sticker is 
normally placed over the center, but if 
sticker is not available, circle appropriate 
distance, yards or meters, stroke name, 
and age group.  Fill in swimmer’s name 
and team. 
In 2017 age group names were deleted. 
 

FOR MEET DIRECTORS ONLY 
Home and visiting Meet Directors must 
approve all late entries with their initials in 
the appropriate box. 
 

FOR TIMERS ONLY 
Times from all three timers must be 
entered as minutes, seconds, and 
hundredths.  The timer making the entries 
must initial the card. 
 

 

FOR SORTER ONLY 
If three times are available, the sorter may 
circle the official time above.  This section 
is used to record the average if only two 
times are available. 

 

 Use previous light orange card first until 
                        supplies are exhausted                                            (Printed as Canary Yellow Card) 
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Appendix G 
(Revised, 2014) 

 
RECOMMENDED TIMING PROCEDURES FOR JEFFERSON SWIM LEAGUE 

 
In dual meets there MUST be three timers in each lane PLUS the designated head timer(s) 
otherwise the event can’t be swum.  Beginning with the 2005 season, the official times are the 
primary determination of place (finish position) with sweep judges as secondary.  The Head Timer 
organizes timers prior to the meet, gives out watches, gives instructions, answers questions, 
assigns lanes, and serves as a backup timer. 
 
Beginning in 2007, a new method of timing and recording was developed using TWO watches 
(ideally two different colors) per timer.  This is commonly known as “dive-over starts” and is used 
in all but the 8&U age groups.  The timer starts one watch (e.g. blue) for heat #1 and that watch is 
stopped, but not cleared, at the end of the heat.  The following heat #2 is then started on the 
other cleared watch (e.g. green).  Once that heat #2 is in the water, the times from the previous 
heat #1 are recorded from the blue watch and that watch is cleared.  When the following heat #2 
is complete, the green watch is stopped, but not cleared.  The next heat #3 is started on the 
cleared blue watch.  Once that heat #3 is in the water, times from heat #2 are recorded from the 
green watch and that watch is cleared.  This process continually repeats itself throughout the 
meet with the timers not recording times from heats until the following heat is started with another 
watch.  Timers must keep one cleared watch available at all times so as not to delay the start of 
any heat. 
 

I. One timer in each lane should have a small clipboard and a pencil.  This timer takes the timing 
card from the swimmer and verifies name, event, heat and lane and initials the card in the upper 
right-hand corner to confirm this information.  In addition, this timer will record all times given by 
each timer at the end of the race and initial the “Initials” box verifying the accuracy of those times. 

 
2. All timers should clear their watches after the time has been recorded and pay attention to the 

Starter.  If you are not prepared to time or cannot see the CTS start system when the Starter 
asks, “Timers and Judges ready?” you should raise your hand and attract the starter. 

 
3. All timers should concentrate on the strobe light of the CTS starting system and not rely on the 

sound. 
 
4. Start your watch from the flash of the strobe light (or flash of the gun, if used).  As stated above, 

you should not rely on the sound as a partial second will be lost.  If you miss the start or your 
watch is not running properly, you should call for the head timer to take your place.  It is not 
possible to guess time missed at the start. 

 
5. Stop your watch at the end of the race when any part of your swimmer’s body touches the end 

wall.  Keep in mind that many races are multi-lap events – do not stop your watch until the 
completion of the last lap. 

 
6. Remember that times are not given to the time recorder until AFTER THE BEGINNING OF THE 

NEXT HEAT when using dive-over starts.  Do NOT clear your watch until all of the times are 
recorded.  Obviously common sense must prevail if a swimmer has finished well before the end 
of the heat, times may be recorded prior to the start of the next heat. 

 
7. Times should be given to the timer holding the swimmer’s card by calling out readings completely 

(e.g. “2 minutes, 8 seconds, and 34 hundredths.  Do not clear your watch until all times are 
recorded.  You may tell a swimmer his/her time, but be certain to say that it is unofficial. 

 
8. The timer holding the swimmer’s card must initial the card and give it to the runner.  
 

More details on timing procedures may be found at Timer's Online Course. 
Examples of current watches are on the following page. 

  

https://www.jsl.org/information2020.php?content=timer&menu=support&section=workers
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Appendix G1 
CURRENT JSL WATCHES 

 

                            

          Original JSL Watch Style                           New JSL Watch Style 

            (Uses Maxell 2032CR or equivalent)                            (Uses Duracell LR1130 or equivalent) 
 

                   
 

CHANGING BATTERIES OR REPLACING WATCHES 
Depending on which watch you have, they take different batteries; see above.  A small electric screwdriver 
is very helpful.  There are about 6 very small Phillips head screws on the back.  Loosen and remove all of them 
and carefully remove the back.  On the original watches, some backs are pretty well stuck to the rubber sides, so 
you may have to carefully pry them off.  Replace the battery, obviously paying attention to polarity, and reattach 
the back, being careful to position it correctly.  Tighten the screws securely, but don't over tighten.  Verify that the 
watch and especially all of the buttons are working correctly.  Return the watch to stopwatch mode.   
Replacing watches requires an Internet search for comparable products.  Teams are responsible for 
replacing watches originally supplied by JSL. 
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Appendix G2 
(Revised, 2015) 

Official Time and Order of Finish 
 

Jefferson Swim League follows USA Swimming Rules and Regulations (102.24) regarding 
how to determine the official time and order of finish.  Because the official time normally 
determines the order of finish, it is critical that 3 timers be assigned to each lane and 
that those timers are well trained (Appendix G and Timer's Online Course).  The 
following procedures apply: 
 
3 Valid Watch Times 

If there are 3 valid watch times, the official time is the middle of the 3 times.  
However, if two of those times agree, that is the official time.  Ideally all times should 
be within 0.3 second of one another, but in summer league swimming that may not 
occur.  For example, if one time is several seconds away from the other two, the 
middle time is still used. 
 

2 Valid Watch Times 
If there are only 2 valid watch times, the official time is the average of the 2 times 
(thousandths are dropped with no rounding).  As noted above there should always 
be three timers on each lane, but occasionally a start or finish is missed resulting in 
only two valid times.  Timers should always be willing to admit when they mess up.  
If there are only two timers in more than half of the lanes, balloting is used.  (see G3) 
 

1 Valid Watch Time 
If there is only 1 valid watch time, the official time is that time, provided it’s supported 
by other information (e.g. the Sweep Judges).  Hopefully this is a rare occurrence. 
 

No Valid Watch Times 
If there is no valid watch time, a coach’s time may be used to determine the 
swimmer’s time, but NOT the order of finish.  The Sweep Judge cards should be 
consulted to determine the order of finish.  If the Sweep Judge cards agree and the 
coach’s time is consistent with the order of finish, the coach’s time is used.  If there 
is no coach’s time or it is not consistent with the Sweep Judge cards, then the 
average time of the two swimmers who finished before and after the “no time” 
swimmer is used as the official time.  If there are no times whatsoever and the 
sweep judge cards do not agree, the swimmer may be offered a re-swim at a later 
time during the meet. 
 

Sweep Judge Cards 
As noted above, the official times normally determine the order of finish (placement).  
There are times when the Sweep Judge Cards may be consulted to confirm or clarify 
the order of finish.  However, the watch times are considered to be primary and 
Sweep Judge Cards are secondary. 
 

Automatic and Semi-Automatic Timing Equipment 
Consult the current USAS Rule Book (USA Swimming Rules and Regulations) for full 
text of Section 102.24 TIMING RULES 

  

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.jsl.org/information2020.php?content=timer&menu=support&section=workers
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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JSL BALLOT FORM                               Appendix G3 
(Revised, 2023) 

 

IMPORTANT NOTE: This form should only be used when there are three timers in less than half of the 
lanes.  If there are three timers in half or more of the lanes, the times will be the primary determination of 
place (order of finish), not the Sweep Judges, and balloting is not necessary UNLESS there is a problem 
with the times. 
 

 

(Printed as Lt. Blue 8 1/2” x 11”) 

EVENT#________               ONLY FOR QUESTIONABLE FINISHES HEAT #__________

     REFEREE MUST BE CONSULTED FOR ALL BALLOTS

LANE JUDGE 1 JUDGE 2 TIME TOTAL JUDGE'S

NUMBER PLACEMENT PLACEMENT PLACEMENT POINTS DECISION

DIRECTIONS FOR RESOLVING FINISHES WITH NOT ENOUGH TIMERS

EXAMPLE:

Both Sweep Judges say Lane 3 is first, Lane 6 is 5th, and Lane 1 is 6th.  Lanes 3, 6, and 1  

will not be involved in the ballot.  The judges disagree on Lanes 2, 4, & 5 (2nd, 3rd,& 4th)  

and a ballot is required.  Use the blank form above and list the lanes involved in balloting in 

the left column and corresponding position placements in the proper columns.  Add all 

placements across and put total in "Total Points" column.  Rank is determined as LOWEST

number of points is the highest place finish in ballot, etc. down to highest number of points

is the lowest place finish in ballot.  If two totals are equal, it is a tie for that place.

finish.  If two totals are equal, it is a tie for that place.

EXAMPLE: Judge 1 Card Judge 2 Card Timers Card

1st = Lane 3 1st = Lane 3 1st = Lane 3 (29.20)      Sweep Judges agree

2nd = Lane 4 2nd = Lane 2 2nd = Lane 4 (31.00)     Must Ballot

3rd = Lane 2 3rd = Lane 5 3rd = Lane 5 (31.10)      Must Ballot

4th = Lane 5 4th = Lane 4 4th = Lane 2 (31.15)      Must Ballot

5th = Lane 6 5th = Lane 6 5th = Lane 6 (32.65)      Sweep Judges agree

6th = Lane 1 6th = Lane 1 6th = Lane 1 (34.80)      Sweep Judges agree

LANE JUDGE 1 JUDGE 2 TIME TOTAL JUDGE'S

NUMBER PLACEMENT PLACEMENT PLACEMENT POINTS DECISION

2 3 2 4 9 3rd

4 2 4 2 8 2nd

5 4 3 3 10 4th

Actual order of finish for example heat is:
1st = Lane 3 (Mark card as first)
2nd = Lane 4 (Mark card as 2nd and Judges Decision "JD")
3rd = Lane 2 (Mark card as 3rd and Judges Decision "JD")
4th = Lane 5 (Mark card as 4th and Judges Decision "JD")
5th = Lane 6 (Mark card as 5th)
6th = Lane 1 (Mark card as 6th)
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Appendix H 
(Revised, 2016) 

JSL Guidelines for Special Needs Swimmers 
 
 
The Jefferson Swim League has a long history of accommodating swimmers with special needs.  In 
fairness to these swimmers and the other swimmers who participate, the following guidelines were 
adopted by the JSL Board at its April 3, 2005 meeting: 
 
Under Article VI of the JSL Rules & Regulations: 
14. The Meet Director has the authority to modify the rules for the swimmer with a disability using 

the guidelines under Article 105 of USA Swimming Rules and Regulations.  Additional 
modifications may not be made unless the swimmer swims as exhibition.  (Revised, 2005)  

 
The Board confirmed that the following additional modifications beyond those allowed by Article 105 
of the USA Swimming Rules and Regulations will result in the swimmer being classified as 
exhibition: 
 

➢ Obtaining physical assistance (e.g., kickboard, flotation device, etc.) 
➢ Obtaining personal assistance (e.g., another swimmer assisting the swimmer in the water 

during the race) 
➢ Swimming down in a lower age group (e.g., a 9-year old swimming as a 8&U) 
➢ Swimming a shorter distance (e.g., swimming 25m in a 50m race) 

 
Additionally the Executive Committee (via email to the President) must be notified that a child will 
need to be accommodated and the special needs of that child.  That information will be 
communicated to the full Board.  NOTE THAT THE CHILD’S NAME IS NOT PROVIDED TO THE 
PRESIDENT OR THE BOARD.   
 
Swimmers who have been granted additional modifications beyond those allowed by Article 105 of 
the USA Swimming Rules and Regulations are eligible for time improvement or super swimmer 
ribbons, but not place ribbons or points.  The coach is responsible for ensuring that the swimmer is 
entered as exhibition and that an exhibition timing card is used.  These swimmers are also eligible to 
swim in the Championship provided they have swum in at least two League meets (one of which may 
be a JSL scheduled time trial).  It is important to note that special needs swimmers who are only 
granted accommodations as described under Article 105 of the USA Swimming Rules and 
Regulations are fully eligible for all awards and points and are, of course, eligible to swim the 
Championship provided they have swum in at least two League meets (one of which may be a JSL 
scheduled time trial). 
 
Coaches are responsible for notifying the appropriate officials (Referee, Meet Directors, Starter, Head 
Stroke-&-Turn Judge, etc.) of the name, team, and accommodation of any special needs swimmers 
prior to the start of the meet.  This will prevent unnecessary embarrassment to the swimmer or 
officials due to inappropriate disqualifications. 

  

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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Appendix H1 
(Added, 2007) 

 
 

Procedure for Entering Special Needs Swimmers 
 
 
The swimmer must be registered with his/her correct birth date with the JSL. 
 
The President of the JSL must be notified via email of the swimmer’s team, and 
special accommodation prior to the first meet of the season. 
 
The team entering the special needs swimmer(s) must notify the team hosting the 
meet so that the swimmer(s) can be appropriately placed in the proper event. 
 
The swimmer(s) must be entered by his/her team in an event in the meet so that the 
swimmer(s) will be on the Meet Entries file submitted to the JSL by the appropriate 
meet entry deadline. 
 
The entering team must inform the host team which event the swimmer(s) should be 
entered into and remind the host team to seed the swimmer(s) into an outside lane if 
desirable.  This can be done in a word for windows document that can be submitted 
at the time of meet entries. 
 
The person who is responsible for the pre-meet work in Meet Manager must do the 
following: 
 
1. Locate the swimmer(s) in the Meet Manager database. 
2. At the top of the screen a section called “entries” can be seen. 
3. Select “All entries”.  This selection will allow the swimmer(s) to be entered in any 

event regardless of event age. 
4. Make sure that the swimmer is removed from the event in which he/she was 

originally entered. 
5. When entering the swimmer in the desired event, make sure that the swimmer is 

entered as an exhibition swimmer if any accommodations are made which 
exceed those in Article 105 of the USA Swimming Rules. 

6. Exhibition swimmers are always seeded last (in the slowest heat), but the event 
will have to be adjusted to ensure that the swimmer is seeded into an outside 
lane if so desired by the entering team.  

7. If the swimmer is entered in any event other than the short free, that swimmer 
counts toward the team’s total entry for that event.  If the swimmer is swimming 
out of age group or receives any accommodations which exceed those in Article 
105 of the USA Swimming Rules, he/she must be entered as exhibition. 

 
It is the coach’s responsibility to notify the referee and all appropriate officials of 
swimmers who are receiving any special accommodations before the start of the 
meet. 
 

Please direct any questions to Jessica Simons 
at jrsimons@comcast.net or 295-1582 

  

mailto:jrsimons@comcast.net
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Appendix I 
(Revised June, 2022) 

HELPFUL HINTS FOR COACHES 
(Please consult the Rules & Regulations for the complete and official rules for JSL.) 

 

Thanks to Jann Balmer and Tommy McFarland for their suggestions for this section. 
 

Deadlines for Registration 
1) All registrations for new swimmers must be submitted to the JSL by 9 PM two days prior to their first 

scheduled meet (each week).  Swimmers missing this deadline may NOT swim under any conditions. 

2) Payment for registered swimmers must be submitted to the JSL at the same time as the roster.  Teams can 

elect to pre-pay for registered swimmers to avoid the hassle of multiple checks to JSL. 
 

Meet Entry Requirements 
1) All meet entries are due by 9 PM two days prior to the scheduled meet. 

2) Swimmers can be entered as official in three (3) individual events and the scheduled relay. 

3) Coaches must use the fastest official JSL time for the event or relay of the current season. 

4) No relay split or lead-off times are considered official. 

5) Coaches can only enter the number of official swimmers/event for their portion of the available lanes (e.g. 3 

heats in a 6-lane pool = 18 swimmers or 9 from each team in a dual meet).  See 1 & 2 below for exceptions. 

6) Swimmers can swim up (in age group) for relays but NOT for individual events. 

7) Any meet entry changes after the entry deadline (other than deletions) must be made before the start of the 

meet and require the approval of all participating Meet Directors.  

8) Coaches must use EXHIBITION timing cards for exhibition swimmers entered in the meet and all reports, 

entries, and cards must clearly identify exhibition swimmers.  If Exhibition cards are not available, circle 

“EXHIB” on regular card. 

9) Late entries for empty lanes can be added for existing lanes/events with mutual approval of the Meet 

Directors PRIOR to the start of the meet. 

10) If a meet is suspended and rescheduled due to inclement weather, coaches may make some changes for 

the remainder of the meet including changing swimmers from exhibition to official, deleting swimmers, and 

adding new swimmers.  Swimmers may NOT change events under any circumstances. 
 

Swim Meet Procedures 
1) There is a maximum of three (3) heats for all individual events EXCEPT P21, P22, and Events 21-30 – 

Short Freestyle events where unlimited heats of official swimmers are allowed. 

2) There is a five (5) heat maximum for official swimmers in events 41 and 42 (8 and under backstroke). 

3) No heats can be added to accommodate exhibition swimmers. 

4) Available lanes for exhibition swimmers should be equally divided between the teams. 

5) Any requests for increases or decreases in the number of heats for an event must be negotiated by the 

Meet Directors PRIOR to the start of the meet. 

6) Ineligible swimmers will forfeit any awarded points for that event along with a penalty of an additional 25 

points. 

7) If a swimmer swims in place of another swimmer (that is, using the wrong name), all points awarded will be 

forfeited and a 100 point penalty will be issued per infraction.  

8) Swimmers cannot be changed from one event to another once the meet entries are submitted. 

9) Swimming Meets end at 10 PM except when a delay occurs due to weather OR by mutual agreement of the 

Meet Directors PRIOR to the start of the meet. 

10)  Teams can finish an event if mutually agreed upon by the Meet Directors prior to the start of the meet. 

11) If a meet is suspended due to inclement weather, the teams cannot re-swim the completed events. 
 

Champs Eligibility 
1) Swimmers must swim in two (2) regular season meets to be eligible to swim in the JSL Championship meet. 

2) Participation in a JSL sanctioned time trial counts for 1 of the 2 meet requirement for Champs eligibility. 
 

Exhibition Swimmer is a swimmer who is  

• not included as part of the allowable official entries per event 

• is entered in an event for time only 

• has exceeded their maximum number of allowable official entries, or 

• missed the entry deadline (however, they must be a registered swimmer prior to the deadline) 
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Appendix J 
(Revised May, 2024) 

Digital Media Policy for the Jefferson Swim League 

 
Part of the Jefferson Swim League’s (JSL) responsibility to safety is ensuring that we protect 
our swimmers and swimming families in our processes for publishing visual content, whether 
it is a video for the local news or a photograph on our Facebook page.  
 
The JSL Board has enacted the following policies for the League and its member teams.  
These policies apply to the use of images and video for social media, including but not 
limited to Facebook, Twitter, and Instagram.  [Hereafter: “League Digital Media”] 
 

POLICY FOR USER-GENERATED CONTENT 
 

1. The JSL accepts photographs, illustrations, and video [hereafter “Image(s)”] of JSL 
activities and events from Member teams and team families for posting on League digital 
media, in accordance with the following guidelines. 

(a) Image(s) must be directly related to JSL activities. 
(b) Image(s) reflect a positive "message" that supports the League's Mission 

Statement. 
(c) Image(s) comply with USA Swimming rules (e.g., no pictures behind the blocks, no 

images of child getting out of the water). 
(d) Image(s) of children Under 18 requires written approval of all depicted minors. 
(e) Images do not include licensed or trademarked images or statements. 
(f) Video does not include music protected by copyright.* 
(g) You must be or have permission of the photographer/videographer of the image(s). 

 

All submissions must be sent first to the Team’s designated digital media representative, 
who will then forward it to the League’s Digital Media Advisor for posting on appropriate 
League Digital Media. 
 

It is incumbent on the person submitting this image/illustration/video to adhere to these 
rules.  Failure to comply with all of the applicable criteria will result in disapproval of the 
request to post on social media. 
 
2. The JSL accepts for consideration requests from Member teams to publish/post team-
specific content such as flyers for registration, team events, swimmer recognition, et al.  The 
following criteria apply: 
 

(a) Content must be directly related to JSL activities. 
(b) Content that includes images of children under 18 has the approval of the parents/ 

guardians of all depicted minors. 
(c) There is no personally identifying information of a child (e.g., school, hometown, full 

name). 
(d) No trademarked or licensed images, logos, slogans, or music.* 
(e) Represent the JSL in an inclusive, positive manner. 
(f) Team has approval of the creator to post this material on social media. 

 

Each submission is reviewed on a case-by-case basis, with a decision for posting rendered 
by Digital Media Advisor, in coordination with the JSL Board President and Immediate Past 
President, as needed.  Requestors will not receive personal notification for disapproved 
materials.  

 

*Video may include a sample (5-10 seconds) of copyrighted music.  Full songs or song montages are not permitted. 
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Appendix J 
(continued) 

PROCEDURE FOR SUBMITTING DIGITAL MEDIA 
 

Teams that want to use League Digital Media platforms must have a designated digital 
media representative.  The name of the representative should be sent via the JSL 
Representative to the social media contact by June 1 of each year. 
 

Content must be submitted to the social media contact by the team-designated 
Representative to be reviewed and considered for posting.  Requestors will not receive 
personal notification for disapproved materials. 
 

RIGHT OF REFUSAL TO USE IMAGES 
 

If a parent or caregiver does NOT want their child(ren)’s image(s) used on JSL social media, 
they must advise their JSL Representative who then must notify the League.  
 

It is the responsibility of each team to ensure that any content submitted to the JSL for 
posting does not include a photograph or name of any swimmer or child whose parent has 
opted out of any use of their child’s image.  
 

FAILURE TO CHECK “PHOTO RELEASE” BOX 
 

Parents who fail to check the “Photo Release” box should be sent the following 
communication signed by the Rules Judge or JSL President: 
 
We note with regret that you failed to check the "Photo Permission" box on the JSL Registration form.  We 
don't know whether that was intentional or not.  If it was intentional and you want to eliminate the 
possibility that your child(ren) may be photographed and the small possibility that such photograph may end 
up being published in the various print and digital media, we can only suggest that your child(ren) not attend 
any JSL Swim Meets, including the Championship.  As stated in our photo release paragraph, we consider 
JSL meets to be "public events" and it is neither possible nor practical to control what pictures are taken of 
which swimmers.  The purpose of this check-off box is to make sure parents realize that JSL swim meets are 
"public events" and privacy cannot be guaranteed.  As long as it remains unchecked, we will not be able to 
allow your swimmer(s) to participate in a JSL swim meet. 
 
Regarding pictures taken at the Team level (practice, parties, events, etc.) you will have to take this up with 
you team as JSL has no jurisdiction over what occurs at the Team level other than when another team arrives 
on the premises for a swim meet, then JSL Bylaws, Rules and Regulations, and Procedures apply.   All teams 
participating in JSL have agreed to this requirement. 
 
We hope you will reconsider this choice in order for your child(ren) to enjoy the full benefits of everything JSL 
has to offer. 
 
You may direct any further questions or concerns to me. 

 
LEAGUE COMMITMENT 

 

The Jefferson Swim League is committed to ensuring that all Teams and members families 
are aware of League policies and procedures for Digital Media.  

 

● League policies will be published on the Website and provided to Team 

Representatives on an annual basis for distribution to their teams. 

● Additional signage will be posted in multiple locations at the JSL Championship. 

● All Team Photographers will receive a copy of the policies and the submission 

procedures each year. 
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Appendix J 
(continued) 

*** SAMPLE TEAM PHOTO CONSENT FORM *** 
 

One of the ways that we celebrate our team and swimmer achievements is via photography 
and/or video. We [team name] are committed to ensuring that even as we recognize our 
accomplishments, we also protect your swimmer(s). 
 

[Team name] uses photographs and video (individuals, groups) of swimmers under the age of 
18 that may include your child during their membership with our team. All photographs will be 
taken and published in line with Team policy. 
 

The team requires parental / guardian  consent to take and use those images. Parents and 
guardians have a right to refuse photographing / videographing their child. 
 

I am the parent / guardian of (include First and Last Name for each child): 
 
_____________________________              _____________________________ 
 
_____________________________              _____________________________ 
 
_____________________________              _____________________________ 
 
For the child/children listed above, I give the following permissions 
 

 
PHOTOGRAPHIC EVENT 

CONSENT 
GIVEN 

CONSENT 
REFUSED 

Take photograph video to use on the team’s secure website    

Take photograph / video to use on the team’s social media 
[specify] 

  

Take photograph / video to use on the team notice boards   

Video for training purposes only.   

Submit images / video to the JSL for use on League Digital 
Media (inclusive of website, Facebook, Instagram, Twitter) 

  

 
 
_________________________________               ___________________ 
Signature       Date 
 
________________________________ 
Printed Name 
 
Please return this form to : _____________________________________ 
 
Received by: _______________________  Date: ___________________ 
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Appendix K 
(Revised, 2004) 

 

JEFFERSON SWIM LEAGUE AWARD LABEL 
 

Individual Event Label 
Examples 

(one for each swimmer 1st – 16th) 
 

Place:  1st    Time:  1:29.96 

#3  Boys 9-10 100 SC Meter IM 

Spinosa, Michael D   10 

Boar’s Head Swim Team – 07/19/2000 

FCC@BHSC 

 

Place:  2nd    Time:  1:35.62 

#3  Boys 9-10 100 SC Meter IM 

Timko, Matthew O    9 

Farmington Country Club – 07/19/2000 

FCC@BHSC 

 

Place:  3rd    Time:  1:37.71 

#3  Boys 9-10 100 SC Meter IM 

Luck, William A   10 

Boar’s Head Swim Team – 07/19/2000 

FCC@BHSC 

 

 
 

Relay Event Label Examples 
(1 label for each swimmer, 4 / team) 

 

Place:  1st    Time:  1:53.13 

#1P  Mixed 6 & Under 100 SC Meter Frees 

Von Quillfeldt, Anniken H    6 

Farmington Country Club – C   07/19/200 

FCC@BHSC 

 

Place:  1st    Time:  1:53.13 

#1P  Mixed 6 & Under 100 SC Meter Frees 

White, James J    6 

Farmington Country Club – C   07/19/200 

FCC@BHSC 

 

Place:  1st    Time:  1:53.13 

#1P  Mixed 6 & Under 100 SC Meter Frees 

Satterfield, Calvin    6 

Farmington Country Club – C   07/19/200 

FCC@BHSC 

 

Place:  1st    Time:  1:53.13 

#1P  Mixed 6 & Under 100 SC Meter Frees 

Lesemann, Katie    5 

Farmington Country Club – C   07/19/200 

FCC@BHSC 
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Appendix L 
(Added, 2008) 

NOAA RADIO INFORMATION AND GUIDELINES 
(adopted by the JSL Board at its June 1, 2008 meeting) 

 

JSL provides all teams with a First Alert WX-150 Radio for use during swim meets.  This radio displays 
National Oceanic and Atmospheric Administration (NOAA) civil and emergency alert text messages on its 
LCD screen.  When an alert is received, a siren sounds and the radio automatically switches to voice 
broadcast.  Messages are identified by one of three color-coded LED lights as follows: “Advisory” (yellow), 
“Watch” (orange), or “Warning” (red).  Meet Directors are expected to be familiar with its operation and 
have the radio on and fully operational during arrival, warm-ups, swim meet, and the period immediately 
following the meet.  A complete User’s Manual (Model WX-150 User's Manual) has been distributed along 
with the radios and is also attached as Appendix M.  As with other equipment, the radios remain the 
property of JSL and repair or replacement is the responsibility of the individual team. 
 

The NOAA Radio will be properly programmed and must be tuned to Weather Band Channel 3 (162.450 
MHz) to receive NOAA broadcasts for most of the areas where there will be JSL Swim meets.  For teams 
outside of Albemarle County, a different channel may have to be selected if the NOAA Radio is not 
properly receiving the broadcast.  There are also Specific Area Message Encoding (S.A.M.E. or FIPS) 
codes which enable the radio to receive messages relevant to the specific area for all JSL home meet 
locations.  JSL will preset each team’s radio based on the expected needs and location of home meets, 
however teams may choose to add more “SAME” or “FIPS” codes to cover more of their surrounding 
areas.  A complete list of all Radios and pre-programmed codes is on the following page. 
 

Meet Directors weather-related decisions are still governed by JSL Rules & Regulations under Article VI 
#18, #19, and #20.  The radio is used to supplement, but not replace, the normal common sense clues 
that there is a weather condition approaching which may be potentially dangerous for swim meet 
participants.  Additionally the radio may be helpful in deciding whether to cancel a meet or wait for a 
storm to pass over.  As always, these decisions should be made with the safety of the swimmers and 
participants as the main determining factor. 

1. The Host Team’s NOAA Radio must have working batteries installed (battery warning light off) and plugged 
into a working power outlet at poolside (specifically the scoring table) where a number of officials would be 
able to monitor & hear any alert sirens.  The radio should always be accessible to the Visiting Team Meet 
Director and Coach. 

2. The Host Team’s NOAA Radio must be turned on, have the antenna extended, and be fully operational 
during arrival, warm-ups, swim meet, and the period immediately following the meet until the participants 
have generally left the area. 

3. The Host Team Meet Director must push the “Listen” button to confirm that a signal is being received and 
adjust the antenna for maximum signal.  (The “listen” button may be pushed again to cut the voice broadcast 
off during the meet.) 

4. Immediately after the sound of any alert siren, the Meet Directors must be notified and listen to any voice 
alerts. 

5. Depending on the nature of an alert or current weather observations, “The Host Team Meet Director in 
conference with the Visiting Team Meet Director(s) shall be responsible for making and implementing all 
decisions regarding weather issues.”  (Article VI, #18).  These decisions include, but are not necessarily 
limited to: 

a. when to stop the meet in the event of thunder or lightning 
b. how long to stop the meet after the observation of thunder or lightning or rain hard enough to 

obscure the bottom of the pool (minimum 15 minutes after thunder or lightning) 
c. where to direct participants when the pool area needs to be cleared 
d. when to resume the meet after a weather delay 

Note that host pools may have stricter policies which must be followed regarding the above. 
6. In the event that a meet may not be able to continue, “The Home Meet Director in conference with the 

Visiting Team Meet Director(s) will decide when a meet shall be suspended due to inclement weather or 
other circumstances (Article VI, #19). 

7. It is expected that the Meet Directors will jointly reach the best decision for the safety of the meet 
participants based on all available information, not just the NOAA Radio. 

8. It is recommended that visiting teams always take their NOAA Radios to away meets to serve as a backup. 
9. Although the NOAA Radios have been specifically issued for use at JSL swim meets, the JSL Board does 

not discourage further use of the radios on the team’s premises for other functions such as daily practices, 
etc.  

  

http://cdn-docs.av-iq.com/other/WX-150%20_Manual.pdf
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Appendix L (continued) 

(Revised, 2009) 

 

Originally Prepared By 
Farid Jazouli 

  

Team Unit Serial No
Home Meets 

County / City

Weather Band 

Channel

SAME -  

FIPS Code

SAME -  

FIPS Code 2

SAME -  

FIPS Code 3

SAME -  

FIPS Code 4

ACAC 071012558 Albemarle 3 051540 051003 - -

BHSC 071012559 Albemarle 3 051003 051540 - -

CGST 071012053 Albemarle 3 051003 051540 051820 -

CITY 071012547 Charlottesville 3 051540 051003 - -

ELKS 071012629 Albemarle 3 051003 051540 - -

FAST 071012584 Louisa 3 051109 051003 051065 051029

FCC 071012565 Albemarle 3 051003 051540 - -

FLST 070709885 Albemarle 3 051003 051540 - -

FSBC 071012552 Charlottesville 3 051540 051003 - -

FV 071012587 Albemarle 3 051003 051540 - -

GCC 071012350 Albemarle 3 051003 051540 051065 051029

GHG 070709880 Greene 3 051079 051003 051137 051540

HM 071012588 Albemarle 3 051003 051540 - -

KWC 071012551 Albemarle 3 051003 051540 051109 -

LG 071012349 Louisa 3 051109 051003 051137 051540

LMST 071012361 Fluvanna 3 051065 051003 051029 051540

F.I.P.S./ S.A.M.E. Codes FREQUENCY

Albemarle 051003 162.450

Augusta 051015 162.450 162.400

Buckingham 051029 162.450 162.550

Charlottesville 051540 162.450

Fluvanna 051065 162.450 162.475

Greene 051079 162.450

Louisa 051109 162.450 162.475

Orange 051137 162.450 162.550

Staunton 051790 162.450 162.400

Waynesboro 051820 162.450 162.400

Weather Band Channel 3: 

Covesville - Frequency 162.450 MHz        Richmond - Frequency 162.475

NOAA Radios, Codes & Serial Numbers
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Appendix M 
(Added, 2008) 

FIRST ALERT WX-150 NOAA RADIO USER’S MANUAL 
 

A full PDF version of this manual should be in your Team’s JSL Computer as a separate file labeled as: 

“WX-150 User Manual for JSL” 

 

A complete online version may be found here: 

Model WX-150 User's Manual  

 

  

http://cdn-docs.av-iq.com/other/WX-150%20_Manual.pdf
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Appendix N 
(Revised 2023) 

 
 

CONCUSSION INFORMATION SHEET 
FOR JSL PARENTS, SWIMMERS, COACHES AND OFFICIALS 

(Developed by USA Swimming) 
Dear Parent/Guardian and Athletes, 
 

This information sheet is provided to assist you and your child in recognizing the signs and symptoms of a 
concussion. Every athlete is different and responds to a brain injury differently, so seek medical attention if you 
suspect your child has a concussion. Once a concussion occurs, it is very important your athlete returns to normal 
activities slowly, so he/she does not do more damage to his/her brain. 
 

What is a Concussion? 
A concussion is an injury to the brain that may be caused by a blow, bump, or jolt to the head. Concussions may 
also happen after a fall or hit that jars the brain. A blow elsewhere on the body can cause a concussion even if an 
athlete does not hit his/her head directly. Concussions can range from mild to severe. 
 

Signs and Symptoms of a Concussion 
Athletes do not have to be “knocked out” to have a concussion. In fact, less than 1 out of 10 concussions result in 
loss of consciousness. Concussion symptoms can develop right away or up to 48 hours after the injury. Ignoring 
any signs or symptoms of a concussion puts your child’s health at risk! 
 

Signs Observed by Coaches, Officials, Parents or Guardians Appears dazed, stunned or confused 

• Unsure about event, location of name of meet Moves clumsily 

• Answers questions slowly 

• Loses consciousness (even briefly) 

• Shows behavior or personality changes – irritability, sadness, nervousness, emotional Can’t recall events 
before or after incident 

 

Symptoms Reported by Athlete 

• Any headache or “pressure” in head - how badly it hurts does not matter Nausea or vomiting 

• Balance problems or dizziness Double or blurry vision Sensitivity to light and/or noise 

• Feeling sluggish, hazy, foggy or groggy Concentration or memory problems Confusion 

• Does not “feel right” Trouble falling asleep 

• Sleeping more or less than usual 
 

Be Honest 
Encourage your athlete to be honest with you, his/her coach and your health care provider about his/her 
symptoms. Many young athletes get caught up in the moment and/or feel pressured to return to sports before they 
are ready. It is better to miss practice or meets than the entire season… or risk permanent damage! 
 

Seek Medical Attention Right Away 
Seeking medical attention on the day of the event is an important first step if you suspect or are told your swimmer 
has a concussion. A qualified health care professional will be able to determine how serious the concussion is and 
when it is safe for your child to return to sports and other daily activities: 

• No athlete should return to activity on the same day he/she gets a concussion 

• No athlete may return to training, regardless of sport, until he/she is cleared by a heath care professional 
with a note specifying clearance. Athletes should NEVER return to the pool if they still have ANY 
symptoms……. in case an athlete returns with a note and then during the practice complains of a 
headache or other symptoms 

• Parents and coaches should never pressure any athlete to return to play 
 

The Dangers of Returning Too Soon 
Returning to the pool too early may cause Second Impact Syndrome (SIS) or Post-Concussion Syndrome (PCS). 
SIS occurs when a second blow to the head happens before an athlete has completely recovered from a 
concussion. This second impact causes the brain to swell, possibly resulting in brain damage, paralysis, and even 
death. PCS can occur after a second impact. PCS can result in permanent, long-term concussion symptoms. The 
risk of SIS and PCS is the reason why no athlete should be allowed to participate in any physical activity before 
they are cleared by a qualified health care professional. 

(CONTINUED ON BACK) 
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Appendix N (continued) 
Recovery 
A concussion can affect school, work, and sports. Along with coaches and teachers, the school nurse, athletic 
trainer, employer, and other school administrators should be aware of the athlete’s injury and their roles in helping 
the child recover. During the recovery time after a concussion, physical and mental rest is required. A concussion 
upsets the way the brain normally works and causes it to work longer and harder to complete even simple tasks. 
Activities that require concentration and focus may make symptoms worse and cause the brain to heal slower. 
Studies show that children’s brains take several weeks to heal following a concussion. 
 

Returning to Daily Activities 
1. Be sure your child gets plenty of rest and enough sleep at night – no late nights. Keep the same bedtime 

on weekdays and weekends. 
2. Encourage daytime naps or rest breaks when your child feels tired or worn-out. 
3. Limit your child’s activities that require a lot of thinking or concentration (including social activities, 

homework, video games, texting, computer, driving, job‐related activities, movies, parties). These 
activities can slow the brain’s recovery. 

4. Limit your child’s physical activity, especially those activities where another injury or blow to the head may 
occur. 

5. Have your qualified health care professional check your child’s symptoms at different times to help guide 
recovery. 

 

Returning to School 
1. Your athlete may need to initially return to school on a limited basis, for example for only half-days, at first. 

This should be done under the supervision of a qualified health care professional. 
2. Inform teacher(s), school counselor or administrator(s) about the injury and symptoms. School personnel 

should be instructed to watch for: 
a. Increased problems paying attention. 
b. Increased problems remembering or learning new information. 
c. Longer time needed to complete tasks or assignments. 
d. Greater irritability and decreased ability to cope with stress. 
e. Symptoms worsen (headache, tiredness) when doing schoolwork. 

3. Be sure your child takes multiple breaks during study time and watch for worsening of symptoms. 
4. If your child is still having concussion symptoms, he/she may need extra help with school‐ related 

activities. As the symptoms decrease during recovery, the extra help can be removed gradually. 
 

Returning to the Pool 
1. Returning to the pool is specific for each person. As an example, California law requires written 

permission from a health care provider before an athlete can return to play. Follow instructions and 
guidance provided by a health care professional. It is important that you, your child and your child’s coach 
follow these instructions carefully. 

2. Your child should NEVER be on deck, practice, or participate in competition if he/she still has ANY 
symptoms. (Be sure that your child does not have any symptoms at rest and while doing any physical 
activity and/or activities that require a lot of thinking or concentration). 

3. Be sure that the athletic trainer, coach and physical education teacher are aware of your child’s injury and 
symptoms. 

4. Your athlete should complete a step-by-step exercise-based progression, under the direction of a qualified 
healthcare professional. 

 

Resources: 
 

Insurance - USA Swimming provides an excess accident medical insurance policy for USA Swimming members 
while participating or volunteering in a USA Swimming sponsored or sanctioned event. Details of the insurance 
coverage are on the USA Swimming website under Insurance and Risk Management. 
Centers for Disease Control and Prevention - https://www.cdc.gov/headsup/index.html  
Zurich Concussion Conference (2012) - http://bjsm.bmj.com/content/47/5/250.full 

Consensus statement on concussion in sport: the 4th International Conference on Concussion in Sport held in 
Zurich, November 2012.  

There are very useful Heads Up apps available from Google Play 

https://play.google.com/store/apps/details?id=gov.cdc.headsup&hl=en 

or from the Apple App Store 

https://apps.apple.com/us/app/cdc-heads-up-concussion-helmet/id999504040 
 

https://www.cdc.gov/headsup/index.html
http://bjsm.bmj.com/content/47/5/250.full
https://play.google.com/store/apps/details?id=gov.cdc.headsup&hl=en
https://apps.apple.com/us/app/cdc-heads-up-concussion-helmet/id999504040
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Appendix N1 
 (Added 2022) 

 

JSL PROCEDURE FOR HEAD STRIKES OR BUMPS 

 

JSL requires that Referees review the following head strikes and bumps 

procedure at the pre-meet Stroke and Turn briefing: 

• All Stroke and Turn Judges are to watch for head strikes or bumps. 

• When a S&T Judge observes a head strike or bump, if the swimmer appears 

hurt, the observing S&T Judge will get another Judge to immediately cover 

their position. 

• The observing S&T Judge will take the swimmer to the Meet Referee. 

• The Meet Referee will ensure that the swimmer is seen by their Coach and 

the swimmer’s parent(s).  (ALL JSL Coaches are certified in concussion 

protocol.) 

• The Coach and parent(s) will make a decision about “return to play” or go to 

the Emergency Room. 

• If the decision is to go to the ER or set out a few days, JSL requires a note 

from the swimmer’s physician to return to practice or a meet. 

• It is the intent of JSL that, if a swimmer is hurt, we do not want them to 

continue with the meet and will need documentation from their physician to 

return to play and at what level. 

 

CDC Concussion Training 

JSL requires all coaches to complete the online CDC Heads Up concussion 
training once as per USAS policy.  JSL Referees are required to complete this 
course or have an equivalent USAS certification.  Training takes approximately 
45 minutes.  Instructions for completing this certification are below: 

Go to the Training Site at: 
https://www.cdc.gov/headsup/youthsports/training/index.html . 
Create a new account if you are a first time user. 
A link for accessing the course will be sent to the email address you provided. 
Select the link to access the course. 
Select “Launch Training”. 
Select “Youth Sports Coach” in the Pre-test. 
At the end, enter your name as it should appear on your certificate. 
Download either the full or wallet size certificate. 
Send the .pdf of the certificate as an attachment to bgarlandjr@gmail.com.  
 

There are very useful Heads Up apps available from Google Play 
https://play.google.com/store/apps/details?id=gov.cdc.headsup&hl=en 

or from the Apple App Store 
https://apps.apple.com/us/app/cdc-heads-up-concussion-helmet/id999504040 

 
  

https://www.cdc.gov/headsup/youthsports/training/index.html
mailto:advisor@jsl.org
https://play.google.com/store/apps/details?id=gov.cdc.headsup&hl=en
https://apps.apple.com/us/app/cdc-heads-up-concussion-helmet/id999504040
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                    JSL Online Sportsmanship Survey                               Appendix O 
(Revised June 15, 2016)                                                                                                  (Revised, 2016) 

 

Meet Directors and Head Coaches will get a link to the Survey every Tuesday night.  
Contact bgarlandjr@gmail.com if not received.  There is basic information collected about 
the meet including location, date, timeline, ending time, weather delays, etc. but only the 
following questions are part of the sportsmanship rating.  Failure to complete a survey for 
each meet will result in points deducted from a team’s final sportsmanship rating.   
 

The following seven questions are answered by both Meet Directors and Coaches: 

 

 

 

 

 

 
The last three questions are answered by Meet Directors only. 

 

 

 
 

Below every sportsmanship question is a comment box: 

 
At the end of the survey is a free form comment box: 

 

mailto:bgarlandjr@gmail.com
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Tidbits for the Referee                                               Appendix P 
(Contributed by Kevin Hogan)                                                                          (Added, 2006) 

 

1. Know the rules, know the interpretations, know them cold. 

 If you are unsure of what something means, find out before you need to know. 

2. Coaches aren’t stupid. 

 But coaches don’t always know the rules either.  See #1 above.  Knowledge is power. 

3. Referees aren’t god (god on deck). 

 Power is tempered with responsibility. 

4. Questions of S&T Judges should be in the context of the “three questions.” 

 What was your jurisdiction? 

 What did you see? 

 What rule was violated? 

5. Use rule-specific descriptions and not “short-hand” to describe a violation. 

 It is illegal to finish the backstroke leg of the IM on stomach; it is not illegal to perform a flip turn at 

the back-to-breast transition.  Saying that someone was disqualified for performing a flip turn under 

such circumstances is wrong, they should be disqualified for not finishing the backstroke leg on their 

back. 

6. Almost illegal IS legal. 

 Let it go.  Pushing the limits of the rules is okay as long as the action is within the rules. 

7. Coaches are paid to be advocates for their athletes. 

 Expect and allow coaches to be passionate advocates.  Passion should not, however, translate into 

tirades, abuse, or other disrespectful behavior. 

8. Listen, repeat, explain.  

 Listen and focus on what the coach is saying. 

 Repeat back the gist of what was said. 

 Explain your ruling in the context of the rules. 

 Do NOT be dismissive. 

9. Treat every discussion with a coach as a unique encounter. 

 Some argue less, some argue more, but each problem should be handled in the context of its own 

merits. 

10. If you make a mistake, admit it, fix the problem, and move on. 

 Wrong and stubborn doesn’t make you a better Referee. 

 If you learn from your mistakes you’ll grow as an official. 

11. Be proactive, not reactive. 

A problem prevented is an issue that doesn’t have to be fixed later. 

12. If it isn’t prohibited by the rules it is legal. 

Unless the rules specifically prohibit something that is new, novel, different, unexpected, etc., it is 

legal. See also #5 above. 
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Stroke-and Turn Judge Guidelines                            Appendix Q 

(Contributed by Kevin Hogan)                                           (Added, 2006) 

Philosophy of Officiating 

• The rules “are designed to provide 
fair and equitable conditions of 
competition and promote uniformity 
in the sport so that no swimmer shall 
obtain unfair advantage over 
another.” 

o Judging should be consistent 
among different officials at a 
meet 

o Judging should be consistent at 
different meets 

o All of the rules are enforced, we 
don’t individually choose to 
enforce some rules and ignore 
others 

o The rules are enforced across all 
age groups and levels of ability 

o Officials should be neutral in their 
enforcement of the rules; don’t 
favor your team over teams, don’t 
favor your child over other 
children 

• The benefit of the doubt always goes 
to the swimmer 

o Rule infractions don’t result in a 
loss of yardage, foul shots, time 
in a penalty box, time penalties, 
etc.; they result in disqualification 

• Call what you see, not what you 
don’t see 

• Ugly ain’t (necessarily) illegal 

• If it isn’t specifically prohibited by the 
rules, it is legal 

• Know the rules; review the rules 
before meets 

Dress 

• White shirt/blouse 

• Blue shorts/pants/skirt  

• White socks and shoes, or sandals 

Placement, Jurisdiction and Rotation 

• Will be determined by the Referee or Chief 
Judge at meet 

• Stroke and Turn Judge jurisdiction is from 
end of pool to middle of pool. 
o Cover 2-4 lanes as assigned.  

o Stand at the middle of the lanes being 
covered.  

• Rotation is determined by the Referee or 
Chief Judge, but generally occurs after 
each girls event and in a clockwise 
direction 

• Equal time should be spent observing each 
of the swimmers within your jurisdiction 

o If one or more lanes are empty, an 
equal amount of time should be spent 
on the empty lane(s) 

o Observe similar aspects of the swim 

• When working, your full attention should be 
on the swimmers when they are within your 
jurisdiction 

• Don’t wonder off when you’re supposed to 
be working 

Disqualifications 

• Most disqualifications will be for violations 
of the technical rules governing the basic 
strokes, although additional DQs include 
the following: 

o Not starting and finishing in the same 
lane (otherwise any portion of the swim 
may be completed in a different lane) 

o Obstructing another swimmer by 
swimming across or interfering with 
them 

o Grasping the lane dividers to assist 
forward motion 

o Standing on the bottom is prohibited in 
any race except freestyle, and the 
swimmer may not walk or spring from 
the bottom 
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Stroke-and Turn Judge Guidelines                               Appendix Q 

(continued) 

 

• Raise hand overhead on observing a 
violation of the rules that occurs 
within your jurisdiction 

o If you’re hesitant in raising your 
hand, the call was probably too 
close to make, the benefit of the 
doubt goes to the swimmer, 
therefore no call 

o If you raise your hand and then 
decide that it was not an 
infraction, you do not have to 
make the call 

o Serves to notify the Referee and 
coaches that a call has been 
made 

• After signaling a DQ, continue to 
observe all swimmers until they are 
no longer within your jurisdiction as 
additional violations by the same or a 
different swimmer may be observed 

• Fill out DQ slip and note swimmers 
name (if at all possible), event #, 
heat #, lane #, infraction, and your 
name 

• Confirm the name of the swimmer 
with the seed card (if possible) 

o Do not have to explain DQ to 
swimmer 

• At meets without a Referee the DQ 
slips should be left with the timer or a 
runner 

• At meets with a Referee all potential 
disqualifications must be reported to 
the Referee who will either accept or 
deny the disqualification 

o Be prepared to report: (1) your 
jurisdiction; (2) what you saw; 
and (3) what rule was violated 

o If your call is questioned by the 
Referee, please remember that it 
is not personal; the Referee is 
doing his/her job 

o If your call is overturned, take it as a 
learning experience 

• Disagreements over calls 

o Coaches should dispute a call, not 
parents 

o When it does not interfere with your 
ability to judge swimmers within your 
jurisdiction, you may explain the rule 
and your call to anyone who is being 
reasonable 

o Anything other than a simple inquiry 
should be directed to the Referee or the 
Host Meet Director (meet without a 
Referee) who have the authority to 
uphold or overturn disqualifications 

o Listen, you might learn something 

o Don’t be afraid to withdraw a 
disqualification if you made a mistake, 
but don’t feel the need to back down 
from a call that you believe was made 
correctly 

Relay Takeoff Judging 

• Dual confirmation is used in which two 
officials, preferably from different vantage 
points, observe the relays for early takeoffs 

• When the toes of the outgoing swimmer 
leave the blocks, look down to determine if 
the incoming swimmer has touched the wall 

• If you observe an early takeoff, mark the 
corresponding swimmer and lane number 

• At the end of the race, compare your 
observations with the observations of the 
other official covering the same lanes 

• If both officials agree that the same 
swimmer took off early, it is a 
disqualification, if only one official observed 
an early take off, it is not a disqualification 

• When dual confirmation is being used to 
judge takeoffs, the hand is not raised on 
observing an early takeoff 
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Good Starting Procedure                                       Appendix R 

(Contributed by Kevin Hogan)                                                                             (Added, 2006) 
 
• Work with the Referee and Clerk of 

Course to ensure a steady flow of 
swimmers 

• Speak in a conversational tone (“take your 
mark” should be said with the same 
emphasis as “shut the door”) 

• Invite the swimmers to swim, do not 
command them 

• For the forward start, the feet can be 
anywhere on the block prior to “take your 
mark”, but at least one foot must be at the 
front of the block after the “take your 
mark” command has been given 

• The forward start may be from the block, 
the deck, or in the water (for the latter start 
at least one hand must be in contact with 
the wall or starting platform 

• For the backstroke start, the hands must 
be placed on the gutter or on the starting 
grips 

• For the backstroke start the toes must not 
be over the lip of the gutter before or after 
the start 

• Before the start, the starter is responsible 
for toes not being over the lip of the gutter, 
after the start the turn judge is responsible 
for toes over the gutter 

• When the swimmers are stationary, give 
the starting signal (note: “stationary” not 
“motionless”) 

• Do not attempt to “catch” swimmers on 
their starts 

• A swimmer accidentally falling off the 
blocks prior to the “take your mark” 
command should not be penalized with a 
false start 

• If one or more swimmers are slow to take 
their mark, or are otherwise unstable, say 
“stand” (forward starts) or “relax” 
(backstroke starts) and allow the 
swimmers to regroup. 

o If the heat is stood up again for the 
same problem, issue a generic 
warning, for example “please respond 
promptly to my command and remain 
motionless for the start” 

o If the heat is stood up a third time for 
the same problem, warn the individual 
swimmer if it is the same person, for 
example “lane 3, please…. 

o Additional problems with the same swimmer 
may result in a delay of meet disqualification 

• If a swimmer leaves their mark early and the 
starting signal is subsequently given, the heat 
must be recalled by activating the recall horn 
(note that the Referee may also initiate a recall by 
blowing his/her whistle) 

• If a heat is recalled for a false start: 

o Determine if there is a dual confirmation; if 
not, no false start has occurred 

o Swimmers 13-&-over are DQ’d after one 
false start.  If it is a 12-&-Under swimmer’s 
second false start, the swimmer is DQ’d 
and may not swim.   

o Step the swimmers back up/in and if there 
was a false start announce “false start, 
lane #”, and restart as usual 

• If a swimmer leaves their mark prior to the 
sounding of the starting signal 

o Stand the heat 

o Determine if there is dual confirmation that 
a false start has occurred (slipping off the 
block, for example, is not a false start) 

o Swimmers 13-&-over are DQ’d after one 
false start.  If it is a 12-&-Under swimmer’s 
second false start, the swimmer is DQ’d 
and may not swim.   

o step the offending swimmer back up/in if it 
is their first false start (or not a false start), 
announce “false start, lane #”, and restart 
as usual 

• If  a swimmer leaves their mark early in reaction to 
the movement of another swimmer, or in reaction 
to the “stand” or “relax” command, that swimmer 
may be relieved of a false start 

• False starts are called on the individual swimmer, 
not on the field 

• If a swimmer is charged with two false starts in the 
same heat, the swimmer is disqualified and may 
not swim in the race 

• A swimmer who deliberately enters the water 
early (for example, before the “take your mark” 
command is completed) may be disqualified for 
delay of meet (this is NOT a false start and only 
has to occur once for a DQ) 
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Whistle Starts                                         Appendix S 
(Contributed by Kevin Hogan)                                                       (Revised, 2008) 

General 
The Referee should stand next to the Starter, with the Starter given first preference as to where 
he/she is positioned. The Referee controls the flow of the meet and is responsible for getting the 
swimmers onto the blocks. The Starter is responsible for ensuring that all swimmers get a fair 
start. 
 
Verbiage 
With the exception of making needed meet announcements (for example, events to report to 
Clerk of Course), the Starter should try to limit any verbiage to that given below. Routine use of 
“step up” for example generally results in swimmers ignoring the whistle commands. 
The announcement of event #, gender, distance, and stroke should immediately follow the 4-5 
whistle chirps. Use the singular for distance (yard, not yards; meter, not meters). Use the 
complete event name, not an abbreviation (Individual Medley, not IM; Freestyle, not Free; 
Breaststroke, not Breast; Backstroke, not Back; Butterfly, not Fly or Butter).  
 
Closing the Heat 
When all the swimmers in a heat have stepped onto the blocks/into the water, the Referee fully 
extends his/her arm (the one closest to the Starter) towards the Starter which then gives control 
of the heat to the Starter. It is then the Starter’s responsibility to ensure a fair start for all the 
swimmers. 
Once the Referee’s arm has been fully extended towards the Starter the heat is said to be closed. 
Swimmers stepping onto the blocks/into the pool after this point can be disqualified for a delay of 
meet. For this reason it is extremely important that the Referee not rush this procedure if all the 
expected swimmers are not immediately on the blocks/in the water. Waiting a reasonable amount 
of time is all it usually takes for the missing swimmer to show up. In practice, unless a swimmer 
arrives after the Starter has begun saying “take your mark”, it is best to keep moving. Also, we 
don’t penalize swimmers for mistakes made by officials. If a swimmer is told the wrong heat 
number by a timer, blocked in their ability to get to the block (three large adult timers, exiting 
swimmers, runners, etc. can all be intimidating roadblocks for a six year old) etc., the swimmer 
should be allowed to swim, even if it means swimming them in a different or extra heat. 
Common sense should prevail, particularly as we implement this new starting procedure. 
Everyone would prefer that the swimmers swim rather than miss their heat. The bottom line is 
that unless a swimmer is willfully ignoring the starting signals or is otherwise involved in 
extracurricular activities behind the blocks, it is best to let them swim. If a delay of meet 
disqualification is made (or not made), however, it is important that any similar circumstances be 
treated the same way throughout the meet. 
 
False Starts 
False starts should be recalled, and the recall can be initiated by either the Referee or Starter. 
Dual confirmation by both the Referee and Starter is required to charge a swimmer with a false 
start. The Referee and Starter should independently mark their heat sheets as to the lane(s) false 
starting and a false start should be called only if there is agreement between the two officials. The 
Starter initiates the call by asking the Referee if s/he observed a false start.  No discussion should 
take place, there is either agreement or there isn’t. 
A 12-& Under swimmer must false start twice to be disqualified for a false start.  Swimmers who 
are 13-&-Over are DQ’d after one false start.  False starts are charged to the individual swimmer 
and not to the field, thus more than one recall could occur without a swimmer being disqualified 
for a false start. 
 
Delay of Meet vs. False Start 
A swimmer who delays the start by entering the water “just for the fun of it” (for example, 
purposely dives in before the Starter finishes saying “Take your mark”) can be disqualified for 
“delay of meet.” This is not the same as a false start and does not require two instances for it to 
be a disqualification. The Referee must be certain that this was a case of “hot dogging” and not a 
legitimate false start. 
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Whistle Start Protocol                         Appendix S1 
(Contributed by Kevin Hogan)                                        (Revised, 2008) 

 

For the first heat of an event: 

Referee: 

4-5 whistle chirps (modulate volume as needed and appropriate). 
The whistle blasts signify that it is time for the next heat to get ready to step onto the 
blocks or into the water. These should generally occur about the time the slowest 
swimmer in the water is crossing under the backstroke flags at the start end of the pool. If 
the last heat of an event is swimming the blasts can come a little earlier so that the Starter 
has more time to announce the event number, gender, distance, stroke and heat number. 

Starter: “Event (number), (gender), (distance), (stroke). Heat 1.” 

Referee: 

1 long whistle (modulate volume as needed but must be loud enough to be heard). 
This is the signal for the swimmers to step onto the blocks or into the water. This whistle 
should occur when the slowest swimmer in the water finishes. 

Additional long whistle if backstroke or medley relay. 
This is the signal for the swimmers to return to the wall and to position their feet. You 
shouldn’t wait until all the swimmers are at the wall; it doesn’t mean place your feet, it 
means get to the wall and get ready to swim. 

When all the swimmers are on the blocks/at the wall, fully extend your arm towards 
the Starter. 
This signals that the heat is closed and the swimmers are now under the control of the 
Starter.  

Starter: 
“Take your mark.”  

When all the swimmers become stationary, sound the starting signal “BEEP”. 

 Swimmers swim… 

  

For subsequent heats of the same event number (note that italicized comments above apply 
to the corresponding signals below): 

Referee: 4-5 whistle chirps. 

Starter: 
“Heat (number).”  
Starting with heat 2, only the heat # is announced. Do not announce gender, distance, or 
stroke. 

Referee: 

1 long whistle. 

Additional long whistle if backstroke or medley relay. 

When all the swimmers are on the blocks/at the wall, fully extend your arm towards 
the Starter. 

Starter: “Take your mark.” Starting signal. 

 Swimmers swim…. 

Continue in this pattern until all heats of this event have been swum. 

After all heats of a given event have been swum, recycle back to the instructions for the first 
heat of the next event. 
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MEET COMPUTER CHECKLIST               APPENDIX T 
(Added, 2019) 

Thanks to Terry Doherty (GCC) for writing this guide and Jessica Simons (BHSC) for editing. 

 
BEFORE ALL MEETS 

1. In TEAM Manager, create a “meet” for the current week.  It is always good to have the 
date [sample: FSBC @ GCC Jun 1]  To avoid confusion, it is known as CURRENT MEET 
in the rest of this document. 
 

2. Confirm the meet format for the week [Medley Relay/Long Free or IM/Free Relay] 
a. Go to Meet>Set-up to copy a meet event file that matches the correct format AND the 

correct pool length [SCY, SCM, LCM] 
b. Copy the events only from the old meet into the Current Meet you are preparing for. 
c. Make sure that the meet reflects that breaststroke events are “30s” and butterfly 

events “50s.” 
 

3. Enter swimmers in events for the Current Meet. 
a. Go to Meets > Highlight the appropriate week [i.e., Current Meet]. 

i. Week 1 - Each swimmer is limited to 2 individual events and 1 relay. 
ii. Weeks 2 to 6 - Each swimmer is limited to 3 individual events and 1 relay for 

scoring. 
b. Go to “Entries” to add swimmers to events 

i. OPTION 1: Entries > By Event - to get an event-order list of events. 
ii. OPTION 2: Entries > by Name - to get an alphabetical list of swimmers & eligible 

events. 
c. If using “Enter swimmers by Name,” you cannot enter them in Relays.  Go to “Entries 

> By Event” to do that. 
d. Exhibition - Swimmers can swim Exhibition for additional events, at the Head 

Coach’s discretion, and with the approval of both Meet Directors. 
e. Relays may be entered using Option 1 under b, i.  Choose relays by checking the 

“bra box”. 
 

4. Once all swimmers are added to events, create an Entry Report. 
a. Go to Reports > Entry Report. 
b. Select “Males” and “Create Report.” 
c. Select “Females” and “Create Report.” 

 

5. Review the Entry Report for anomalies or errors, including but not limited to  
a. swimmer entered but not swimming 
b. swimmer not entered but swimming  
c. swimmer entered in too few events 
d. swimmer entered in too many events (i.e., for scoring, not Exhibition). 
e. eligible swimmers entered in a relay, as appropriate. 

 

6. Once you are satisfied with the entries, export the meet entry file and export to the JSL 
file Upload. 
a. File > Export > Entries to export an entry file with the team’s entries for the Current 

Week. 
b. File > Export > Athletes to export a roster file of the eligible swimmers. 

 

7. Open MEET Manager to select the pre-formatted meet file for the CURRENT MEET.  
[NOTE: All Meet Setup Files are prepared and downloaded from www.jsl.org]  They 
should be “pre-loaded” into MM at the beginning of the season by Computer Operator 
and will be listed at the bottom of the “File” menu.] 
a. From the left sidebar to go Computers > Meet Format Files. 
b. File > bottom of that menu list > select the correct file. 
c. Confirm that the file is open by checking the top of your screen.  It should have the 

title of the Current Meet listed on the very top line. 

  

https://www.jsl.org/index.php
https://www.jsl.org/support2020.php?section=computers&content=meetformatfiles
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APPENDIX T 
(continued) 

8. Upload the Entries for your team 
a. File > Import > Meet Entries 
b. Find the file [.zip] you saved and highlight it for Import. 
c. Select “your team name” from the team dropdown for the file. 
d. If there are no errors … 

 

9. Download the official Meet Entries file: File > Export > Meet Entries. 
 

10. Once the Meet Entries file is downloaded, go to www.jsl.org 
a. From the left sidebar go to Meets > Meet Entries > Meet Entries Upload Page. 
b. Select the correct meet from the dropdown list and click “Submit Query.” 
c. Repeat to upload the current roster file at this time, too. 

 

BEFORE HOME MEETS 
1. Confirm with Meet Director Visiting team’s lane preference and any swimmer 

accommodations. 
2. The Day before the meet, go to www.jsl.org to obtain the visiting team’s entry file. 

a. From the left sidebar to go Meets > Meet Entries > Meet Entries Upload Page. 
b. Select the correct meet from the dropdown menu and click “Submit Query.”  Both 

team’s (home and visiting) files should be listed there. 
 

3. Right-click the visiting team file to “save link as.”  This downloads the file to the team 
computer. 

 

4. Open MEET Manager to import the opposing team’s entries. 
a. File > Import > Entries and select the .zip file for the visiting team. 
b. On the Import Entries Screen select (a) Match on Event Numbers; (b) Include NT 

entries. [all else blank] 
 

5. Go to Set-Up > Seeding Preferences to seed the meet. 
a. Click “Dual Meets” tab and set Lane Assignments, as discussed with Meet Director. 
b. DO NOT select “strict odd/even seeding” because that adds extra heats.  Use lane 

assignment above as the seeding option. 
c. Click “OK” to finish setup. 

 

6. Go to Seeding > Seeding the Meet. 
a. Click “Select All” so that all events turn yellow. 
b. Click “Start Seeding.” 
c. Click “OK”. 

 

7. Review the Meet Program to verify lane assignments and correct seeding (e.g., fastest 
swimmers in middle of the pool).  [There are times when a meet has to be re-seeded.] 
a. Reports > Meet Program. 
b. View Male, Female, or All - Coach’s choice. 
c. Click “Create Report” to view and print report for quality control review. 

 

8. As appropriate / necessary, make adjustments for swimmers with special needs. 
a. Go to Athletes to find the swimmer.  Highlight their name. 
b. In “Entries” box select “All Events.” 
c. Select event you want for swimmer.  MAKE SURE that “Exh” has a checkmark! 
d. Remove the swimmer from event originally entered in and carry the entered time to 

the new event 
e. REVIEW heat sheet to determine heat and lane for this swimmer.  Adjust the event 

so that swimmer 
i. is in the slowest heat 
ii. Seeded in an outside lane. 

f. Go to “Seeding the Meet” and highlight the event. 
g. Select “Preview” so that you can see the event and swimmers. 
h.  Select “Team” and then “Eligible swimmers” to find that swimmer. 
i. Add Swimmer and/or adjust lanes for the slowest heat. 

 

  

https://www.jsl.org/index.php
https://www.jsl.org/general2020.php?menu=meets&section=entries&content=entriesup
https://www.jsl.org/index.php
https://www.jsl.org/index.php
https://www.jsl.org/general2020.php?menu=meets&section=entries&content=entriesup
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(continued) 

9. Print Heat Sheets for workers. 
a. Go to Reports > Meet Program.  Select All (events turn yellow). 
b. Click “Include in Meet Program Tab. 

i. Meet Director / Referee / Starter get a heat sheet with Event timeline. 
ii. Everyone else gets a heat sheet without the Event timeline. 

c. Click “Create Report” to print each of the two reports. 
 

10.  “Print” one heat sheet as a PDF.  [Printer is called Microsoft Print to PDF; save to 
computer.]  
a. Send that file to Meet Director for distribution to home team and the visiting team’s 

Meet Director prior to start of the meet. 
b. This is optional. 

 

11. Go to Labels > Entry Cards/Labels to print event labels for swimmers. 
a. Select Team and gender to run entry labels that are pre-sorted for Clerk of Course.  

There will be 5 sets: Mixed, Home-Girls, Home-Boys, Visitor-Girls, Visitor-Boys 
b. Before printing, check “Sort by Event Number” and label format [3x10]. 
c. Select All Events > Create Labels to view the label report. 
d. Load printer with label sheets and print. 

 

12. Print Entry Reports for coaches.  There are four reports: Visiting Male, Visiting Female, 
Home Male, and Home Female. 
a. Go to Reports > Entry Lists 
b. In Gender box select Male or Female  
c. In Filters box select Team. 
d. In Sort box select “Alphabetical” 
e. In Options Box select “Athletes + Relays” 
f. In “Include in Report” tab uncheck “Show Check-in Req” 
g. Click “Create Report.” 
h. This is optional. 

 
AFTER ALL MEETS 
Computer operators exchange Boy/Girl merge meet results file of same meet to create a 
complete record of the meet.  They will then create a meet backup and a meet result file for 
export. 
 

To ensure that you don’t lose files, there should be a copy in two places: c: / and a thumb drive. 
 

1. From MEET Manager 
a. Export the backup file and Meet Results file (both zip) to your team’s Thumb Drive 

AND the C:/ drive. 
b. Be sure that there is a Meet Results file “for SWIMS …” format. 

 

2. In TEAM Manager 
a. Check the title line to ensure it is the most recent meet. 
b. Import > Meet Results. 
c. Select “Match on Swim ID” - because some swimmers’ nicknames appear on the 

cards, but their official names are in the Registration. 
 

AFTER HOME MEETS 
1. Get backup file and Meet Results file (both zip).  These are “exported” from MEET 

Manager. 
 

2. Upload the zip files (one at a time) to the JSL Meet Results Upload Page on 
www.jsl.org  
a. From the left sidebar to go Meets > Meet Results > Meet Results Upload Page 
b. The Meet Results file [looks like this: Meet Results-FCC @ GCC 2011-16Jun2010-

004.zip] 
c. The Backup file [looks like this: Swmm2BkupGCC @ CGST 2011-01.zip] 

  

https://www.jsl.org/meet-results-uploads2020.php
https://www.jsl.org/index.php
https://www.jsl.org/index.php
https://www.jsl.org/meet-results-uploads2020.php
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(continued) 

3. Send an email version of the Meet Results to the Daily Progress.  
a. Go to Reports > Results. 
b. Top of the screen: The following items should already be selected: All, All Rounds, 

and Indiv + Relay.  Ignore Age Range and LSC 
c. Bottom of screen. 

i. Columns/Format Tab: AP News and Results by Heat should be already checked.  
Also make sure that “Top How Many” is empty and “Relay Names” is 4. 

ii. On Include in Results Tab: “Combined” should be checked.  All else left blank. 
iii. Ignore Splits / Sort Order / Selected Teams Tab. Should already be checked as 

None, Event # Order, and All Teams. 
d. At top, hit “Select All.” 
e. Click “Create Report” and “Save in” to identify location for file named results.txt. 
f. Create email to sports@dailyprogress.com and sportsdailyprogress@gmail.com. 

Include team names and final scores in the email and ATTACH the results.txt file. 
 

TIME IMPROVEMENT LABELS 
1. Open TEAM Manager and confirm that the most recent meet results are in the system. 

 

2. Go to Labels > Improvement Labels to print Time Improvement ribbons.  Review the 
boxes.  
a. Check only “Time Standards” 
b. Check “conversions” - this ensures best time across pool sizes (LCM, SCY, SCM) i.

 Head Coach’s Call: Check (or uncheck) “First Time Swim.” 
c. Make sure that “Best” is the selected option.  
d. Check print format (3 x 10 is what you want). 

 

3. Click “Create labels” to get a preview of the labels.  Click >| to see how many pages of 
labels are needed, and put them in the printer. 

 

4. Print. 
 

Notes for printing time improvement labels: 
- For the first two meets of the year, you will need to “play with” [check or uncheck] the 

“Use Since Date” (06/01/current year).  Reason: sometimes the system wants to pull 
improvements from the previous season. 

- You may also need to “play with” the conversion box.  It is helpful to have a Meet Results 
report with actual times for swimmers before printing labels.  It is a good check / balance 
for actual improvements. 

 

IMPORTANT 
The instructions above are meant only as a guide and checklist.  More detailed information may 
be found in the JSL Computer Manual which may be viewed and downloaded. 
 
There are also Up to date manuals available from 
Hy-Tek User Guides or Demos for Meet Manager or Team Manager 

  

mailto:sports@dailyprogress.com
mailto:sportsdailyprogress@gmail.com
mailto:sportsdailyprogress@gmail.com
https://www.jsl.org/documents/bin/Current/JSLComputerManual.pdf
https://hytek.active.com/downloads.html
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USA Swimming Rules & Regulations               Appendix U 
Changes and Interpretations for Current Year   (Revised May, 2024) 

 

Per JSL Bylaws under Article II: 
10. Rules and Regulations will be in accordance with current USA Swimming Rules and 

Regulations except as noted otherwise.  Rules and Regulation changes in conflict with 
USAS Rules and Regulations require a 75% approval from all Representatives.  (Revised, 

2016) 

 

There are no known USA Swimming Rule Changes for 2024 

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations


Jefferson Swim League Procedure Manual - Revised July 5, 2024 

[JSL MAN sec 3 appendices]                                       © 2024 JSL - Team Manual Section III - Appendices  

Appendix V 
(Revised, 2023) 

PROTESTS 
 

In swimming, as with any sport, there may occasionally be differences of opinion 
concerning official’s calls and rulings as well as rulings by the JSL Board, its 
Officers, or the Rules Judge.  JSL defers to USA Swimming Rules regarding 
protests which may occur at a swim meet if the situation is not otherwise covered 
by JSL Rules & Regulations.  The USA Swimming rules for protests are outlined 
in Section 102.23 in the current copy of the USA Swimming Rulebook (USA 

Swimming Rules and Regulations).  What follows below is an attempt to apply the 
various paragraphs in that section to JSL rules and procedures. 

It must be noted that it is never appropriate, and may be considered as 
unsportsmanlike conduct, for a parent or swimmer to question a ruling directly 
with any official.  Rather, questions regarding rulings should be directed to the 
swimmer’s coach who may then ask for a clarification or possibly file a protest 
with the referee.   

102.23 PROTESTS 

.1 Protests against the judgment decisions of starters, stroke, turn, place and relay take-

off judges can only be considered by the Referee and the Referee’s decision shall be final. 

This means that a protest against a JUDGMENT decision can only be taken 
to the Referee and the Referee will make the final decision.  This decision 
cannot be appealed to anyone including the JSL Board, its officers, or the 
Rules Judge.  Examples of “judgment” decisions include disqualifications 
based on observing the swimmer’s technique, etc. by any of the above 
named officials.  JSL Rules & Regulations contain this exact same wording 
for regular season swim meets as well as for the Championship. 

.2 For consideration of all other protests lodged at the meet, the Referee may appoint a 

meet jury.  The jury shall consist of not fewer than three (3) and not more than five (5) 

persons, at least one of whom shall be a coach and one an athlete. 

A meet jury is rarely used in JSL as the Bylaws designate the Rules Judge to 
have “…sole authority in rules and Bylaw interpretations…”.  However, if the 
Referee or Rules Judge prefer to have a meet jury decide on a protest at the 
Championship (not a dual meet), one may be appointed by either or both 
using the USAS guidelines above.  It is strongly recommended that 3 or 5 
persons be appointed, not 4; that in addition to a coach and an athlete, a 
Stroke & Turn official be appointed; and that none of the persons be from the 
team(s) involved in the protest.  The meet jury will serve for an individual 
session of the Championship and their decision shall be final. 

.3 Protests made prior to the race contesting the eligibility of a swimmer to compete or to 

represent an organization shall be made to the Referee in writing.  If a protest is not 

resolved, the Referee or the meet jury shall allow the swimmer to compete under protest 

and it shall be so announced before the race. 

Ideally, this situation should be resolved well before the meet begins and the 
President of the League in conjunction with the Registrar should be able to 
determine eligibility.  However, if the situation occurs at the meet, the 
previous procedure under “.2” should be followed realizing that there are 
potential penalties for swimming a non-eligible swimmer. 

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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(Revised, 2023) 

PROTESTS (continued) 
 

.4 All other competition-related protests, including protests concerning eligibility and 

representation, must be made to the Referee and submitted in writing within 30 minutes 

after the race in which the alleged infraction occurred. 

The above procedure should be followed and email is considered “in writing”.  
Copies should also be sent to the JSL President and JSL Rules Judge.  In 
this example, the Referee’s ruling could be appealed to and confirmed or 
overturned by the Rules Judge.  The Rules Judge’s ruling could be further 
appealed and “…overturned by a 75% majority of all Representatives”. 

.5 Except as provided in 102.23.1, the Referee’s or the meet jury’s ruling may be 

appealed as follows: 

A Protests concerning interpretation of the rules in Part One and Part Seven of the USA 

Swimming Rules and Regulations shall be submitted in writing within ten (10) days to the 

Chairman of the USA Swimming Rules & Regulations Committee who shall issue a ruling 

within five (5) days from the date of the receipt of such protest. This ruling shall be final 

and binding on all parties. 

B All other protests, together with the Referee’s or the jury’s written decision, shall be 

submitted to the General Chairman, or designee, of the sanctioning LSC or, in the case of 

a National Championship or trials class meet, to the National Board of Review, in 

accordance with Part 4 of the USA Swimming Rules and Regulations. 

As noted previously, JSL Bylaws designate the Rules Judge as having 
“…sole authority in rules and Bylaw interpretations…” so any appeals go first 
to the Rules Judge.  Decisions by the Rules Judge may be appealed to the 
JSL Board and “…may be overturned by a 75% majority of all 
Representatives”. 

.6  The official results of any protested race shall not be announced, the affected awards 

shall not be given, and points scored shall not be allocated until the protest is resolved or 

is withdrawn in writing. 

JSL follows this procedure on its web page by not posting the meet results or 
by noting that the results are under protest.  Because of normal time 
constraints, it is possible that results may be posted before it is realized that a 
protest has been filed. 

 

All participants in JSL must realize that JSL is a summer swim league and its 
meets are administered and run by non-paid volunteers doing the best they can 
under sometimes difficult situations.  No one in JSL wants to see anyone treated 
unfairly, but enforcement of applicable rules is necessary for success and 
enjoyment of the sport.  As noted in the first sentence, we realize that there may 
be occasional differences of opinion, but all of those involved are expected to 
resolve any issues in a polite and respectful manner. 

 

(Approved by the JSL Board, May, 2011 and Revised in 2017, 2020, and 2023.) 

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
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(Revised, 2023) 

Jefferson Swim League Background Check Directions 
 

Per JSL Rules and Regulations, “…coaches on deck 18 years old and over prior to June 1st of the current 
season must have successfully passed a USA Swimming, JSL approved, or Virginia State Police criminal 
background check within the last two years… 
Current JSL Approved Background Checks include Checkr, IntelliCorp, PayCom, Pre-employ, 
Sterling, Virginia State Police, and Verifications.  The background check must be nationwide and include 
all city, county, state, and federal criminal records and sex offender registries.  Teams may apply to the 
Executive Committee prior to June 1st for a waiver to use other national background checks.  No coach who 
has been convicted of any "Barrier Crime", as defined by the state of Virginia, will be allowed in any area 
where swimmers are present at a JSL sanctioned event. 
 

For those Coaches whose teams do not conduct background checks, JSL is pleased to offer a new, 
cheaper, and easier background check through IntelliCorp.  The charge is $38.80 for an INITIAL 
background check and $23.00 for a RENEWAL (Your previous background check has expired or will expire 
before the end of the season.).  However, JSL does NOT pay either fee.  Coaches who have ever lived in 
the New York City area may incur an additional $95.00 fee charged by that area. 
 

PLEASE ALLOW 7 TO 10 DAYS (sometimes longer) FOR YOUR BACKGROUND CHECK 
 

Follow these directions carefully: 
1. Request a password for the JSL Background Check from your JSL Rep, Head Coach, or 

bgarlandjr@gmail.com.  You should receive a reply within 12 hours or less, but if not, you may 
call Bob Garland at (434) 293-2045 between the hours of 9AM to 9PM. 

2. Have a credit card ready. 
3. On a DESKTOP or LAPTOP computer (there is no phone or tablet app) 

Log on to https://jslinitial.volunteerportal.net if this is your FIRST time or 
Log on to https://jslrenewal.volunteerportal.net if this a RENEWAL of a previous 
IntelliCorp background check.  BE SURE TO SELECT THE CORRECT PORTAL. 

4. Review text on the Welcome Page; make sure you are on the correct “INITIAL” or 
“RENEWAL” portal, enter the password provided, and click “Agree and Consent”. 

5. Enter Personal Information.  (Address is your current mailing address.) 

6. All fields marked with a “ ” are required. 
7. Select Virginia as “State/Province of Work”. 
8. Select Your Team Name as “Reference”. 
9. Click “Next”. 
10. Carefully review all information to ensure its accuracy before proceeding. 

If you submit inaccurate information you will have to pay for a second check. 
11. If you need to make any corrections you can click on the “Edit” link or the “Previous” 

button to return to the Personal Information page. 
12. Click “Next” or “Complete” to process your search. 
13. Enter payment information on pop-up screen. 
14. Click “Submit”. 
15. You MUST select “Request a Copy of Your Report” to get a copy emailed to you for your 

records or to send to your team. 
16. Fill out information form to receive your copy which you will send to your team if they 

request it.   
17. It is NOT necessary to send a copy to JSL.  We are directly notified by IntelliCorp. 

 

FAQ’s 
• What if I couldn’t finish my background check? 

If you “quit” or “save” in the middle, a pop-up window will appear with a code to be used to resume your search at a later time. 

• What if I’m not sure my background check went through after submitting? 
Do NOT resubmit; call IntelliCorp at (888) 946-8355 for assistance. 

• Will I get a receipt for payment? 
Yes, a receipt will be emailed to you, but this is only proof of payment, not a successful check. 

• What if I forgot to select “Request a Copy of Your Report”? 
Select this link https://consumer.intellicorp.net/ and “Submit Request”. 

• What if there is an error in my background check? 
Select this link https://www.intellicorp.net/marketing/applicantinquiries.aspx, scroll down, and follow directions for disputing a 

background check report. 

• Why does JSL NOT need a copy of my background check? 
JSL can view your background check online in a secure portal as soon as it is complete.  Only the last four digits of your Social 

Security number are visible on your background check. 

  

mailto:bgarlandjr@gmail.com
https://jslinitial.volunteerportal.net/
https://jslrenewal.volunteerportal.net/
https://consumer.intellicorp.net/
https://www.intellicorp.net/marketing/applicantinquiries.aspx
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JSL Coaches Athlete Protection and Concussion Training Directions 
 

Per JSL Rules and Regulations,“…will have successfully completed a JSL approved Athlete Protection 
Program within the past two years…” 
 

INSTRUCTIONS FOR ATHLETE PROTECTION CERTIFICATION 
 

Athlete Protection Training (sexual harassment prevention), now provided by “SafeSport”, is required 
for all coaches every year on a 4-year cycle.  USAS certified coaches have met this requirement. Other 
JSL Coaches, whose certification has expired, must take the first year “Core Course” which takes about 
90 minutes. Subsequent “Refresher Courses”, which take 30-45 minutes, must be taken annually over 
the next three years following the first year “Core Course”, then the cycle repeats itself.  If a year is 
skipped, the cycle must be restarted from the beginning “Core Course”.  JSL pays for this certification 
for bonafide JSL Coaches, but you must have an enrollment key obtained from bgarlandjr@gmail.com.   

YOU MUST BE REGISTERED IN JSL BY YOUR HEAD COACH OR TEAM REPRESENTATIVE 

TO OBTAIN AN ENROLLMENT KEY! 
ENROLL IN COURSE 

1. Obtain the enrollment key from bgarlandjr@gmail.com. 
2. New learners go to https://safesporttrained.org/#/signup-form. 
3. Complete the signup window (see #4 below) which appears and select “Sign Up”. 
4. In the sign up window, under “Organization Member ID”, enter your team abbreviation. 
5. If you have an account, simply login using your email address and password. 
6. In your dashboard enter the enrollment key code obtained from bgarlandjr@gmail.com. 
7. From your Home Page, go to “My Courses” and select the correct course. 
8. All Coaches taking for the first time must start with the “SafeSport Trained Core” course. 
9. Select “Start” to begin training.  You may pause and resume as needed to complete the course. 
10. If you are under 18, your parent will need to send a permission email to bgarlandjr@gmail.com stating 

your name, team, a brief permission statement, and parent’s name. 
11. From the menu in the top right, select “Transcript”, then select the “Download” button at the top 

right of the completed course to download and save the completion certificate as a PDF. 
12. Send the certificate PDF via email attachment to bgarlandjr@gmail.com. 
IMPORTANT NOTES 

• JSL is charged as soon as you enter your enrollment key code.  Failure to complete the course or 
failure to coach will result in a charge-back to your team.  JSL only pays for bonafide JSL Coaches 
who coach at JSL meets. 

• USAS certified swim coaches have this certification and do NOT take this course through JSL.  If a 
USAS certified coach takes the course through JSL, your team will be charged. 

• If you need help from SafeSport, contact their HELP PORTAL. 

• If you have JSL Questions, contact bgarlandjr@gmail.com. 
 

Per JSL Rules and Regulations, “A one-time certification in Concussion Protocol Training is required.” 

INSTRUCTIONS FOR CONCUSSION CERTIFICATION 

JSL requires all coaches to complete the online CDC Heads Up concussion training for coaches one 
time.  There is no expiration date.  JSL Referees are required to complete this course or have an 
equivalent USAS certification.  There is no charge.  Training takes approximately 45 minutes and 
instructions for completing this certification are below: 
  
1. Go to the Training Site at https://www.cdc.gov/headsup/youthsports/coach.html 
2. Create a new account if you are a first time user. 
3. A link for accessing the course will be sent to the email address you provided. 
4. Select the link to access the course. 
5. Select “Launch Training”. 
6. Select “Youth Sports Coach” in the Pre-test. 
7. At the end, enter your name as it should appear on your certificate. 
8. Download either the full or wallet size certificate. 
9. Send the .pdf of the certificate as an attachment to bgarlandjr@gmail.com. 

  
There are very useful Heads Up apps available from Google Play 

https://play.google.com/store/apps/details?id=gov.cdc.headsup&hl=en 

or from the Apple App Store 

https://apps.apple.com/us/app/cdc-heads-up-concussion-helmet/id999504040 

  

mailto:bgarlandjr@gmail.com
mailto:bgarlandjr@gmail.com
https://safesporttrained.org/#/signup-form
mailto:bgarlandjr@gmail.com
mailto:bgarlandjr@gmail.com
mailto:bgarlandjr@gmail.com
https://safesport.atlassian.net/servicedesk/customer/portal/4/group/9/create/32
mailto:bgarlandjr@gmail.com
https://headsup.cdc.gov/
https://www.cdc.gov/headsup/youthsports/coach.html
mailto:bgarlandjr@gmail.com
https://play.google.com/store/apps/details?id=gov.cdc.headsup&hl=en
https://apps.apple.com/us/app/cdc-heads-up-concussion-helmet/id999504040
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Appendix X 
(Revised 2020) 

 
The JSL Injury and Incident Form is used to report injuries and/or incidents to the President of the 
League.  Any responsible official, volunteer, coach, or lifeguard may complete the form, but it is 
the Meet Director’s responsibility to ensure that it gets completed and a copy sent via email to the 
President of the League within 48 hours of the occurrence.  Some judgment is required in 
determining what injuries and incidents are reported.  However, “When in doubt, fill it out”. 
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Appendix X (continued) 
(Revised 2020) 
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Appendix X (continued) 
(Revised 2020) 
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JSL Swimmer Registration Form               Appendix Y 
(Revised 2020) 

 
The JSL Swimmer Registration Form is used to register swimmers into the League.  A completed 
form (along with an updated team roster file) must be received by JSL by 9PM two days before 
the swimmer can participate in a JSL swim meet or sanctioned event.  Teams using 
computerized online registration are not required to submit these forms, but are required to collect 
all of the information on the form. 
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JSL Registration Fee Waiver (Scholarship) Form               Appendix Y1 
(Added 2021) 

 

Occasionally, JSL Teams will waive their team fee for swimmers who do not 

have the financial ability to pay, or the fee may be paid by a third party.  In those 

situations, JSL will waive the League Registration fee per Article IV, #11 of the 

JSL Rules and Regulations.  To apply for this waiver, the form below is 

completely filled out and submitted to the Treasurer by June 30th. 

  

Team Name:

Name of Applicant for Team:

Applicant email address: 

Date of Application: 

List swimmer name, and check appropriate box for each swimmer waiver is requested. 

A maximum of 10 waivers per team may be requested. 

The fund for waivers is limited and funds are available on a first come first served basis. 

Applications will be acknowledged upon receipt and notice of status will be provided 

as soon as practical. 

Application # Swimmer Name Te
am

 F
ee

 w
ai

ve
d

 

3
rd

 P
ar

ty
 S
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o

n
so

rs
h

ip
 

* Team fee waived

1   All team fees have been waived

2  * 3rd party sponsorship

A benefactor (agency/individual)

3  has paid all fees for listed

 swimmer

4   

 

5  

 

6  

7  Date Received:

Received by: 

8  Fund Balance:

 Date Approved:  

9  Amount Approved:

 

10  New Fund Balance:

 

I hereby certify all team fees have been waived or paid by a third party for each swimmer listed herein.  

 

Signed: (electronic signature ok)

For League Use Only:
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Appendix Z 
(Revised, July 2024) 

 

Guidelines for Swimwear, Taping, Braces, etc. 
(Approved by the JSL Board July 10, 2016) 

 

Frequent questions arise regarding allowable swimwear, various 
types of taping, or the wearing of various types of braces or supports 
for JSL competition.  The following modified USAS guidelines apply: 
 

Swimwear 
• For boys, the swimsuit shall not extend above the navel or below the knees. 

• For girls, the swimsuit shall not cover the neck, extend past the shoulder, nor 
extend below the knees.  Per USAS Memo, tieback suits are not allowed. 

• Swimwear may only include 1 swimsuit, not more than 2 caps, and 1 pair of 
goggles. 

• Swimwear may only display the logo and insignia of the swimmer’s JSL team or 
normal manufacturing logos and insignias. 

• The swimsuit may NOT be a “Tech Suit” for all 12 and under swimmers.  FINA 
suits bearing a green checkmark next to the FINA logo are allowed.  More 
information is available at: 
12 & Under Restricted Suits 9/2/2020 
12 & Under Approved Suits 8/25/2020 
Tech Suit Information for Officials 9/1/2020 

• Exemptions to ALL Guidelines may only be granted by the Referee for conflicts 
due to the swimmer’s verified religious beliefs, medical conditions, or other 
reasons deemed appropriate by the Referee PRIOR to the start of the meet. 

• No exemption will be granted for a swimsuit that will give the swimmer a 
competitive advantage unless that swimmer is swimming as Exhibition. 

• No swimmer is permitted to wear or use any device to help his/her speed, pace, 
buoyancy, or endurance unless that swimmer is swimming as Exhibition. 
 

Taping, Devices, Braces, and Supports 
• Incidental wound taping, Band-Aids, adhesive tape over gauze, etc. are allowed 

to cover non-bleeding cuts, scrapes, etc. 

• Any kind of tape, device, brace, or support on the body is not permitted unless 
approved by the Referee PRIOR to the start of the meet. 
 

Medical Exceptions for Devices, Braces and Supports 
• Approval may only be granted by the Referee if the swimmer or Coach presents 

a signed statement on a prescription or letterhead stationary from a duly licensed 
medical professional.  This must be submitted to the Referee PRIOR to the start 
of the meet and state the reason for and location of the tape, device, brace, or 
support.  If the signed statement is submitted by a non-medical professional the 
letter must also include the name of the referring medical professional. 

• Medically necessary equipment such as continuous glucose monitors (CGM), 
insulin pumps, and similar equipment are exempt. 

• No tape, device, brace, or support shall be allowed, regardless of medical 
reason, which may give the swimmer a competitive advantage (e.g. taping all 
fingers together) unless that swimmer is swimming as Exhibition. 
 

Appeal 
• The decision of the Referee shall be final. 

https://www.gomotionapp.com/MI/UserFiles/Image/MEMO%20from%20National%20USA%20regarding%20tie-back%20suits.pdf
https://reachforthewall.org/2017/01/08/are-jolyn-swimsuits-legal/
https://websitedevsa.blob.core.windows.net/sitefinity/docs/default-source/rules-regulations/tech-suit-restrictions/12-under-restricted-suits-12-2-20.pdf?sfvrsn=cce43d32_8
https://websitedevsa.blob.core.windows.net/sitefinity/docs/default-source/rules-regulations/tech-suit-restrictions/12-under-approved-suits-2-18-21.pdf?sfvrsn=7d3b3232_6
https://websitedevsa.blob.core.windows.net/sitefinity/docs/default-source/officialsdocuments/misc-officials/tech-suit-for-officials.pdf?sfvrsn=76303b32_8
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When viewing online, use “Ctrl + click on link” to open in new tab. 
 

 

 

Team Procedure Manual 
(Revised July 5, 2024) 

 

Section IV 
 

SECTION IV POOL INFORMATION (All changes for current season are highlighted) 
Page 1 Suggestions for Use of Directions and Maps & Pool Descriptions 
Page 2 Shallow Water Racing Dives (Revised 2024) 
Page 3 Exemptions to USA Swimming Facilities Standards 
Page 4-8 Corner Protection for NON-Rectangular JSL Pools 
Page 9 General Rules of Conduct for All Pools 
Page 10 Team Abbreviations and Locations of All Pools 
Page 11 Directions to ACAC 
Page 12 Directions to BHSC 
Page 13 Directions to CBST 
Page 14 Directions to CGST 
Page 15 Directions to CITY 
Page 16 Directions to ELKS 
Page 17 Directions to FCC 
Page 18 Directions to FLST 
Page 19 Directions to FSBC 
Page 20 Directions to FUMA Pool (Occasionally used for Champs) 
Page 21 Directions to FV 
Page 22 Directions to GHG 
Page 23 Directions to GLEN  
Page 24 Directions to HM 
Page 25 Directions to KWC 
Page 26 Directions to LG 
Page 27 Directions to LMST 
Page 28 Directions to Spring Creek Pool (Not Currently Used) 
Page 29 Directions to UVa Aquatic and Fitness Center (Not Currently Used) 
Page 30 Directions to Brooks Family YMCA (Champs Only 
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SUGGESTIONS FOR USE OF DIRECTIONS AND MAPS 
 

The following pages have been provided to describe all pools and assist in giving directions to away meets to 
coaches, swimmers, and parents.  It must be realized that everyone may have their own idea of the "best way to go".  
These directions were selected for ease of following and safety of travel, as well as time and distance.  Selecting the 
pool address on each page will display a Goggle map and an opportunity to select Directions.  A quick glance at the 
team's current year's schedule will indicate which meets will require directions as there are normally no more than 
three away meets each season.  Corrections and suggestions should be directed to Bob Garland at (434) 293-2045 
or bgarlandjr@gmail.com. 
 

Exemptions to USA Swimming Facilities Standards for All Pools have been included on page 3.  These are the 
only exemptions to facilities standards granted by the JSL Board. 
 

PLEASE NOTE:  Event P1 (5-6y.o. 100 FR), Events 3-10 (all ages IM) and Events 11-12 (8 & Under MR) are 
NOT swum in the long course pools at ACAC and FSBC.  Additionally at those pools, all 25m events are 
swum to a rope in the middle of the pool.  Please prepare accordingly. 
 

General Rules of Conduct for All Pools have been included on page 4.  In addition to these rules there may be 
specific rules at the end of the direction page for each club.  It may be wise to include the Rules of Conduct in 
handouts with directions.  Team Abbreviations have been included on page 5. 
 

IMPORTANT NOTE ON POOL DEPTHS:  The following pool depths & block heights have been 
provided by the home team to ensure that each complies with USA Swimming’s Facilities 
Standards.  Making a racing dive into shallow water requires skill & training & should only be 
attempted by a swimmer who has been properly trained by his/her coach.  SEE “SHALLOW 
WATER RACING DIVES” ON PAGE 2.  Every swimmer’s first entry into a strange pool during 
practice should be a cautious feet-first JUMP rather than a dive to determine the depth. 
 

Pool depths which have been designated as NO DIVING ALLOWED AT ANY TIME by the JSL or 
the pool are noted as “NDA”.  Effective with the 2013 season, 8 & Under 100m(y) Relay swimmers 
must START FROM WITHIN THE WATER AT THE NON-BLOCKS END OF ALL JSL POOLS EXCEPT 
THE UVA AQUATIC AND FITNESS CENTER.  Note that the 8 & Under 100m(y) Relay events are 
NOT swum in long-course pools (ACAC & FSBC).   

It is important that pool depths be maintained during a meet. 
 

The following pool descriptions are provided for your convenience (fraction inches dropped): 
 

 POOL DEPTHS AT ENDS BLOCK 
TEAM LENGTH LANES SHAPE SHALLOW DEEP BLOCKS HEIGHT PAGE 
 

ACAC ............. 50m (L) ...... 8 ....... rectangular 4’0” ............... 12’0”...... 12’0” .......... 32” ...... 10 
BHSC .............. 25y (Y) ....... 8 ....... rectangular 4’3”NDA ......... 8’+ ......... 8’+ ........... 30” ...... 11 
CBST .............. 25m (S) ...... 6 ....... cross 3’6”NDA ........ 3’6”NDA 3’6”NDA .... none ... 12 
CGST .............. 25m (S) ...... 8 ....... rectangular 3’0”NDA ........ 7’0”........ 7’0” ........... 18” ...... 13 
CITY ................ 25m (S) ...... 8 ....... rectangular 3’6”->4’*NDA4’6”–6’6” . 4’6” ........... 24” ...... 14 
ELKS .............. 25m (S) ...... 6 ....... L - shaped 3’0”NDA ........ 5’0” ....... 5’0” ........... 27” ...... 15 
FAST .............. No Home Pool 
FCC ................ 25m (S) ...... 8 ....... Z - shaped 3’6”NDA ........ 4’6”........ 4’6” ........... 17” ...... 16 
FLST ............... 25m (S) ...... 6 ....... L - shaped 3’6”NDA ........ 4’6”........ 4’6” ........... 30” ...... 17 
FSBC .............. 50m (L) ...... 7 ....... trapezoid 4’1” ................. >6’ ........ 4’1” ........... 22” ...... 18 
FUMA ............. 25m (S) ...... 8 ....... rectangular 4’0”NDA ....... 12’0”...... 12’0” .......... 30” ....... 19 Occasional Champs 
FV ................... 25m+ (S) ... 6 ....... L - shaped 3’6”NDA ........ 5’4”........ 5’4” ........... 29” ...... 20 
GHG ................ 25m (S) ...... 6 ....... L - shaped 3’6”NDA ........ 4’6”........ 4’6” ........... 28” ...... 22 
GLEN .............. 25m (S) ...... 6 ....... L - shaped 3’6”NDA ........ 4’8”........ 4’8” ........... 27” ...... 21 
HM .................. 25m (S) ...... 6 ....... L - shaped 3’6”NDA ........ 4’6”........ 4’6” ........... 30” ...... 23 
KWC ............... 25y (Y) ....... 5 ....... L - shaped 3’6”NDA ........ 4’8”........ 4’8” ........... 27” ...... 24 
LG ................... 25y (Y) ....... 6 ....... rectangular 4’0”NDA ........ 6’0”........ 6’0” ........... 14” ...... 25 
LMST .............. 25m (S) ...... 6 ....... L - shaped 4’1”NDA ......... 5’4’ ........ 5’4” ........... 27” ...... 26 
Sprg Crk Pool 25m (S) ...... 6 ....... L - shaped 3’7”NDA ........ 4’7”........ 4’7” ........... 30” ....... 27 NOT USED 
UVa A & F ...... 25y (S) ....... 10 ..... rectangular 7’0 .................. 14’ ....... 7’-14’ ......... 30” ....... 28 NOT USED 
YMCA ............. 25y (S) ....... 10 ..... rectangular  .........................  ..............  .............. 30” ....... 29 CHAMPS 
 

ALL pools highlighted in red above are required by JSL to have an adequate physical barrier (lane 
lines or divider ropes) configured as illustrated on pages 4-8 to absolutely prevent the possibility 
of a swimmer inadvertently colliding with an exposed corner. 

 

mailto:mailtobgarlandjr@gmail.com
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Shallow Water Racing Dives 
(Approved by the JSL Board, March 4, 2012) 

 
1. It is EVERY COACH'S responsibility to properly instruct all swimmers on 

how to successfully perform a shallow water racing dive.  No swimmer 
should be allowed to dive from the blocks or deck during a JSL swim 
meet, until s/he is CONSISTENTLY able to perform a shallow water racing 
dive.  Coaches will note USA Swimming (Article 103.2.2) requires a 
minimum depth of 6 feet to TEACH racing starts. 

 
2. Swimmers who cannot consistently perform a shallow water racing dive 

must NEVER be allowed to dive into water of an unsafe depth.  With the 
exception of ACAC and LMST, ALL JSL member pools (including the 
YMCA) are considered unsafe at the deep (blocks) end as well as the 
shallow end for any diving other than a shallow water racing dive.  At least 
seven JSL pools are 5 feet or less at the DEEP (blocks) end.  This is 
absolutely an unsafe depth for anything other than a shallow water racing 
dive. 

 
3. At NO time should a swimmer be allowed, encouraged, cajoled, forced, or 

in any way made to think that they have to dive into water of an unsafe 
depth from the blocks or the deck.  Those swimmers MUST start in the 
water or carefully jump into the water feet first. 

 
4. Any parent may prohibit their children from diving into any depth, in any 

pool, for any reason, at any time, without fear of repercussion.  JSL has 
always permitted swimmers to start in the water or jump into the water feet 
first from the starting blocks or deck. 

 
5. All coaches are expected to be very familiar with Section IV, Page 1, of 

the Team (blue) Manual which gives a full description of all pools and the 
diving rules for each. 

 
6. As a matter of safety, all pools should have "NO DIVING ALLOWED" 

signs posted where the water depth is unsafe for recreational diving.  
Although these signs are helpful, Coaches have an obligation to educate 
their swimmers on the dangers of diving into unknown depths at any time. 
 

Failure to observe these minimum rules for diving 
safety could have catastrophic consequences. 
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CLARIFICATIONS AND EXEMPTIONS TO USA SWIMMING FACILITIES STANDARDS 
(Revised February 18, 2015) 

 

In 2003 USA Swimming increased the minimum depth requirement for racing starts from 3’6” to 
4’0”.  This caused JSL to disallow diving in water depths less than 4 feet (see chart on page 1 of 
this section).  Effective with the 2013 season, JSL disallowed diving for 8-and-under relays at the 
non-blocks end of all member pools (except UVa AFC).  The JSL Board clarifications of the USA 
swimming facilities standards for member pools are found below.  Swimmers and parents can be 
assured that safety has not been compromised by the Board in granting some exemptions.  A 
current USA Swimming Rule book should be consulted for complete standards. 

 

The following clarifications and exceptions for the USA Swimming Standards are identified by the 
paragraph number used in the current USA Swimming Rulebook (USA Swimming Rules and 
Regulations): 
 

103.2 /M/WATER DEPTH - All pools will be considered to meet the requirements provided they meet the depth 

requirements of 103.2.3 

103.3 /M/ RACING COURSE DIMENSIONS 

 .1 Length - Pools measuring within + or - 12” of the stated length on page 1, Section IV will be exempt. 

 .2 Width - Pools not meeting the minimum lane width requirement of 7’ will be exempt. 

103.4 /M/ RACING COURSE WALLS 

 .1 Permanent Course Walls - All properly constructed walls will be considered to meet the requirements. 

103.5 POOL AND BULKHEAD MARKINGS 

 .1 Pool bottom lane markers - All bottom lane markers will be considered to meet the requirements. 

 .2 End wall targets: All end wall targets will be considered to meet the requirements. 

103.6 /M/ OVERFLOW RECIRCULATION SYSTEM - All pools will be considered to meet the requirements.  

103.7 WATER AND AIR TEMPERATURE - All pools will be considered to meet the requirements. 

103.8 /M/ LADDERS - Pools without removable ladders will be considered to meet the requirements. 

103.9 /M/ OTHER DECK EQUIPMENT - All pools will be considered to meet the requirements. 

103.10 /M/ LIGHTING - All pools will be considered to meet the requirements. 

103.11 /M/ TOBACCO PRODUCTS - Smoking and use of other tobacco products is prohibited in all areas of the 

venue.  Exceptions to this provision may be made only with the approval of the JSL Board. 

103.12 /M/ ALCOHOLIC BEVERAGES — Alcoholic beverages are prohibited in all areas of the venue.  Exceptions 

to this provision may be made only with the approval of the JSL Board. 

103.13 /M/ STARTING PLATFORMS - All pools having a block height equal to or less than 30 inches from the 

surface of the water will be considered to meet the requirements provided the water depth at that end of the pool is at 

least 4’ as defined by paragraph 103.2.  The blocks must be secure.  

103.14 /M/ BACKSTROKE LEDGE - All pools will be considered to meet the requirements. 

103.15 /M/ FLOATING LANE DIVIDERS - All pools will be considered to meet the requirements, however lane 

dividers must be used.  

103.16 /M/ BACKSTROKE FLAGS & LINES - All pools will be considered to meet the requirements, however 

backstroke lines must be used. 

103.17 /M/ LOUDSPEAKER START SYSTEM - All pools will be considered to meet the requirements provided 

that a JSL approved device is used. 

103.18 /M/ RECALL DEVICE - All pools will be considered to meet the requirements provided that an appropriate 

device is used. 

103.19 /M/ PACE CLOCKS - All pools will be considered to meet the requirements (Pace clocks are not required in 

JSL). 

103.20 AUTOMATIC OFFICIATING EQUIPMENT - All pools using this equipment will be considered to meet 

the requirements provided the equipment is functioning safely and properly. 

103.21 ELECTRICAL SAFETY - All permanent or temporary electrical connections to the electronic loudspeaker 

start system, automatic officiating equipment, and other electrical or electronic devices operating online voltages in the 

vicinity of the racing course shall be made only from a ground-fault circuit interrupter (GFCI) protected convenience 

receptacles or circuits. 

 

In addition, the following pools are exempted from the USA Swimming Standards identified by the 
paragraph number used in the current USA Swimming Rulebook (USA Swimming Rules and 
Regulations): 

 

ACAC: 
103.13 /M/ STARTING PLATFORMS - Starting blocks are 32” from the surface of the water, but 

depth at that end is 12’ providing an adequate margin of safety. 

  

https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations
https://www.usaswimming.org/officials/rules-regulations


Jefferson Swim League Procedure Manual - Revised July 5, 2024 

[JSL Man – sec 4 pool information                                    © 2024 JSL - Team Manual Section IV - Page 4 

CORNER PROTECTION FOR NON-RECTANGULAR JSL POOLS 
 

   
BHSC Lane line protects step entry corner. 

 

   
CBST All four corners are protected as above. 

 

   
CGST Lane lines protect steps and entry corners. 
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CORNER PROTECTION FOR NON-RECTANGULAR JSL POOLS (continued) 

   
CITY All points of entry are protected by lane lines. 

 

   
ELKS Lane line at edge of corner and pad protects diving well corner. 

 

   
ELKS steps corner and corner. 
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CORNER PROTECTION FOR NON-RECTANGULAR JSL POOLS (continued) 

   
FCC Lane lines on both sides protect corners. 

 

   
FLST Lane line protects diving well corner. 

 

   
FSBC Lane line protects irregular edge. FV Lane line protects diving well corner. 
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CORNER PROTECTION FOR NON-RECTANGULAR JSL POOLS (continued) 
 

   
GHG Cable covered with noodles protects diving well corner. 

 

   
GLEN Lane lines protect corners beside lanes 1 (diving well) and 6 (steps). 

 

   
HM Lane line protects diving well and step corners beside lane 6. 
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CORNER PROTECTION FOR NON-RECTANGULAR JSL POOLS (continued) 

   
KWC Rope divider with floats protects corner of diving well. 

 

   
LMST Outside lane dividers on both sides of racing pool. 
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GENERAL RULES OF CONDUCT FOR ALL POOLS 
 

It must be emphasized that visiting teams must behave as guests and be treated as 
guests during League swim meets.  Many clubs have rules unique to their facility as 
noted on the direction sheets.  However, the general rules below apply to all coaches, 
swimmers, parents, and spectators at all pools.  FAILURE TO ABIDE BY THESE 
RULES MAY RESULT IN PENALTY SANCTIONS AGAINST A TEAM AND THE 
OFFENDING SWIMMER BEING REMOVED FROM THE MEET. 
 

• Always conduct yourself in a courteous sportsman-like manner prior to, during, and 
immediately following swim meets.  (this is a JSL Bylaw) 

• Do not smoke, drink alcoholic beverages, or use illicit drugs in the pool area.  (this is 
a JSL Bylaw which applies during swim meets) 

• Park in designated areas only and observe all speed limits. 

• Do NOT park, idle, or unload in a designated handicapped space unless you have a 
valid handicap parking permit. 

• Do not run, push, wrestle, etc. in the pool area nor climb or hang on objects which 
are not designed for play. 

• Do not hang or sit on lane lines. 

• Do not enter or swim in other pools unless directed to do so by the host team. 

• Do not enter or use other facilities (golf courses, restaurants, recreation or play 
areas, etc.) unless directed to do so by the host team.  Do not use, borrow, or play 
on equipment (golf carts, maintenance equipment, etc.) unless directed to do so by 
the host team. 

• Do not bring glass containers into the pool area. 

• Always wear proper swimming attire (a bathing suit) if swimming. 

• Do not bring flotation devices into the pool, unless approved. 

• Do not enter the pool with open wounds, infections, etc. 

• Be aware of shallow diving areas in all pools. 

• Do not bring animals to the pool area unless directed to do so by the host team. 

• Do not allow small children to run free where they may be a danger to themselves 
or others. 

• Throw all trash into trash cans. 

• Help with the clean-up of your area at the end of the meet - try to leave the host 
team’s pool area as neat as you found it. 

• Pool Facility Managers or Head Lifeguards will always have responsibility for closing 
pools due to inclement weather.  As noted in JSL Rules & Regulations, Meet 
Directors would only enforce the JSL policy if it is STRICTER than the prevailing 
club's policy. 

• Obey all posted rules at every member club. 
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JSL TEAM ABBREVIATIONS and LOCATIONS 
 

ACAC - The ATLANTIC COAST ATHLETIC CLUB’S 50 meter 8-lane home pool is located in the 
Four Seasons sub-division between Hydraulic Road and Rt. 29 North.  The pool is behind the 
clubhouse.  (page 10) 
 

BHSC - The BOARS HEAD SPORTS CLUB is located off of Rt. 250 on the west side of 
Charlottesville.  The entrance is marked as the Boars Head Resort and Sports Club.  The Sports 
Club complex and 25 yard 8-lane pool are behind the Hotel.  (page 11) 
 

CBST - The CULPEPER BARRACUDAS SWIM TEAM 25 meter 6-lane home pool is located on 
Country Club Road off of Business Route 29 in Culpeper.  (page 12) 
 

CGST - The CROZET GATORS SWIM TEAM’S 25 meter 8-lane home pool is located in 
Claudius Crozet Park in Crozet.  (page 13) 
 

CITY - The CITY SWIM TEAM’S 25 meter 8-lane home pool is located in Washington Park at the 
corner of  Preston Ave. and 10th St. in Charlottesville.  (page 14) 
 

ELKS - The ELKS LODGE is located off Rt. 20 north on the east side of Charlottesville.  The 
entrance is marked on the left and the 25 meter 6-lane pool is to the left of the main building.  
(page 15) 
 

FAST - The FLUVANNA AQUATIC SPORTS TEAM is located in Fluvanna County, but does not 
have a home pool at the present time and swims all meets away. 
 

FCC - The FARMINGTON COUNTRY CLUB is located off of Rt. 250 on the west side of 
Charlottesville.  The entrance is marked as Farmington Country Club.  The 25 meter 8-lane pool 
is to the left of the main building.  (page 16) 
 

FLST - The FOREST LAKES SWIM TEAM’S 25 meter 6-lane home pool is located off Rt. 29 
north of Charlottesville in the Forest Lakes SOUTH sub-division.  (page 17) 
 

FSBC - The FRY’S SPRING BEACH CLUB is located off Jefferson Park Ave. in the southern part 
of Charlottesville.  The entrance is marked as Fry’s Spring Beach Club and the 50 meter 7-lane 

pool is behind the main building.  (page 18) 
 

FV - The FAIRVIEW SWIM & TENNIS CLUB is located off highway #651 on the north side of 
Charlottesville.  The 25 meter 6-lane pool can be seen from the road on the left.  (page 20) 
 

GHG - The GREENE HILLS GATOR’S CLUB is located off of Rt. 230 on the north side of 
Stanardsville.  The 25 meter 6-lane pool is to the left of the main building.  (page 22) 
 

GLEN - The GLENMORE SWIM TEAM is located off of Rt. 250 east of Charlottesville.  The 25 
meter 6-lane pool is to the right of the main clubhouse.  (page 21) 
 

HM - The HOLLYMEAD home pool is located in the Hollymead subdivision off of Rt. 29 north of 
Charlottesville.  The 25 meter 6-lane pool is next to the parking lot in front of the Silver Thatch 
Inn.  (page 23) 
 

KWC - The KEY WEST CLUB 25 yard pool is located in the Key West subdivision off of Rt. 20 
north on the east side of Charlottesville.  (page 24) 
 

LG - The LOUISA GATORS use the Louisa County pool which is located at the Betty Queen 
Intergenerational Center on Industrial Drive in Louisa County.  The entrance is marked with a sign 
and the 25 yard 6-lane pool is at the back of the building.  (page 25) 
 

LMST - The LAKE MONTICELLO SWIM TEAM 25 meter 6-lane pool is located at Lake 
Monticello approximately 45 minutes to the east of Charlottesville.  (page 26) 
 

https://www.jsl.org/acac2020.php
https://www.jsl.org/bhsc2020.php
https://www.jsl.org/cbst2020.php
https://www.jsl.org/cgst2020.php
https://www.jsl.org/city2020.php
https://www.jsl.org/elks2020.php
https://www.jsl.org/fast2020.php
https://www.jsl.org/fcc2020.php
https://www.jsl.org/flst2020.php
https://www.jsl.org/fsbc2020.php
https://www.jsl.org/fv2020.php
https://www.jsl.org/ghg2020.php
https://www.jsl.org/gcc2020.php
https://www.jsl.org/hm2020.php
https://www.jsl.org/kwc2020.php
https://www.jsl.org/lg2020.php
https://www.jsl.org/lmst2020.php
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DIRECTIONS TO ATLANTIC COAST ATHLETIC CLUB (ACAC) 
 

 Enter into your GPS 
 200 Four Seasons Drive 
 Charlottesville, VA 22901 
          

 
 

8&U relays are 
NOT swum at 

ACAC 

 
 
 
  ACAC on jsl.org  
 
 
 
 
 
 

ACAC requests that all swimmers shower before entering pool. 
 

Parking is allowed on the pool side of the street from the dam to the pool entrance.  
Parking is NOT allowed on the dam, blocking the emergency entrance or in the Four 
Seasons lot across the street.  Cars parked in these locations will be subject to towing.   

 
From North of Charlottesville, follow Rt. 29 South to the intersection with Rio Rd (Fashion 
Square Mall is just beyond on the left).  Turn right onto Rio Rd. and continue through one stop 
light. Turn left at the second light onto Four Seasons Drive and follow this until there is a sign for 
ACAC on the left.  Turn left into the parking lot and the pool entrance is on the right before the 
clubhouse entrance. 
 

From South of Charlottesville follow 29 north to the intersection at Hydraulic Road (K-mart is on 
right).  Turn left onto Hydraulic road and go approximately 2 miles.  You will go through 4 traffic 
lights, the final one being at Summer’s Market.  The next light after Summer’s Market is at Four 
Seasons Drive.  Turn right.  Follow this until there is a sign for ACAC on your left.  Turn left into 
the parking lot and the pool entrance is on the right before the clubhouse entrance. 
 

From East of Charlottesville follow the Rt. 250 Bypass West until it intersects with Rt. 29 North.  
Take Rt. 29 north to the intersection at Hydraulic Road (K-mart is on right).  Turn left onto 
Hydraulic road and go approximately 2 miles.  You will go through 4 traffic lights, the final one 
being at Summer’s Market.  The next light after the Rock Store is at Four Seasons Drive.  Turn 
right.  Follow this until there is a sign for ACAC on your left.  Turn left into the parking lot and the 
pool entrance is on the right before the clubhouse entrance. 
 

From West of Charlottesville follow the Rt. 250 Bypass East (or Interstate 64 East) until it 
intersects with Rt. 29 North (or Rt. 29 North Bypass).  Take Rt. 29 north to the intersection at 
Hydraulic Road (K-mart is on right).  Turn left onto Hydraulic road and go approximately 2 miles.  
You will go through 4 traffic lights, the final one being at Summer’s Market.  Just past the Rock 
Store is a sign for Four Seasons Sub-division on the right.  The next light after Summer’s Market 
is at Four Seasons Drive.  Turn right.  Follow this until there is a sign for ACAC on your left.  Turn 
left into the parking lot and the pool entrance is on the right before the clubhouse entrance. 

https://www.google.com/maps/place/200+4+Seasons+Dr,+Charlottesville,+VA+22901/@38.080649,-78.4879629,17z/data=!3m1!4b1!4m5!3m4!1s0x89b387fa1f02921f:0xfcf8720f95fd0762!8m2!3d38.080649!4d-78.4857742
https://www.google.com/maps/place/200+4+Seasons+Dr,+Charlottesville,+VA+22901/@38.080649,-78.4879629,17z/data=!3m1!4b1!4m5!3m4!1s0x89b387fa1f02921f:0xfcf8720f95fd0762!8m2!3d38.080649!4d-78.4857742
https://www.jsl.org/acac2020.php
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DIRECTIONS TO BOARS HEAD SPORTS CLUB (BHSC) 
 

 Enter into your GPS 
 200 Wellington Drive. 
 Charlottesville, VA 22901 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  BHSC on jsl.org 
 
 
 
 

There is NO PARKING ALLOWED ON ANY STREET within the club area.  Follow parking 
attendant directions and park in designated areas only.  There is parking behind the main 
building. 
Zero-depth and Lazy River pools are closed during swim meets. 
Bathrooms are now on the deck in the snack bar building. 
BHSC is a smoke-free facility, smoking is not allowed on the property.   
If the deck must be cleared during adverse weather, follow directions to enter the club 
building. 

 
From North of Charlottesville follow Rt. 29 South to the Rt. 29 South-250 West Bypass which is 
a right hand ramp.  Follow signs to Rt. 250 West and go out of town.  Watch for signs to the 
Boars Head Resort.  The Boars Head Resort will be on the left on Rt. 250 West.  Enter here and 
take another left onto Boars Head Dr. just in front of the Resort.  Follow this road, turn right onto 
Wellington Dr., and there will be parking on the right.  Additional parking may be found by 
continuing straight on Boars Head Dr., going past all tennis courts, and taking a right. 
 

From South of Charlottesville follow Rt. 29 North to the Rt. 250 West intersection which is a 
right hand ramp.  At the top of the ramp, Take Rt.250 West (left) and watch for signs to the Boars 
Head Resort.  The Boars Head Resort will be on the left on Rt. 250 West.  Enter here and take 
another left onto Boars Head Dr. just in front of the Resort.  Follow this road, turn right onto 
Wellington Dr., and there will be parking on the right.  Additional parking may be found by 
continuing straight on Boars Head Dr., going past all tennis courts, and taking a right. 
 

From East of Charlottesville follow Rt. 250 West Bypass through town until you are on the west 
side of Charlottesville.  Watch for signs to the Boars Head Resort.  The Boars Head Resort will be 
on the left on Rt. 250 West.  Enter here and take another left onto Boars Head Dr. just in front of 
the Resort.  Follow this road, turn right onto Wellington Dr., and there will be parking on the right.  
Additional parking may be found by continuing straight on Boars Head Dr., going past all tennis 
courts, and taking a right. 
 

From West of Charlottesville follow Rt. 250 East and watch for signs to the Boars Head Resort 
before entering Charlottesville.  The Boars Head Resort will be on the right on Rt. 250 East.  
Enter here and take a left onto Boars Head Dr. just in front of the Resort.  Follow this road, turn 
right onto Wellington Dr., and there will be parking on the right.  Additional parking may be found 
by continuing straight on Boars Head Dr., going past all tennis courts, and taking a right. 
 

From West of Charlottesville Using Interstate 64 East get off at the Rt. 29 North exit.  Follow 
29 North Bypass to Rt. 250 West (right hand ramp).  At the top of the ramp, Take Rt.250 West 
(left) and watch for signs to the Boars Head Resort.  The Boars Head Resort will be on the left on 
Rt. 250 West.  Enter here and take another left onto Boars Head Dr. just in front of the Resort.  
Follow this road, turn right onto Wellington Dr., and there will be parking on the right.  Additional 
parking may be found by continuing straight on Boars Head Dr., going past all tennis courts, and 
taking a right. 

https://www.google.com/maps/place/200+Wellington+Dr,+Charlottesville,+VA+22903/@38.046548,-78.5412267,17z/data=!3m1!4b1!4m5!3m4!1s0x89b386e1733ceb6b:0xf0c71bb323d4a6cf!8m2!3d38.046548!4d-78.539038
https://www.google.com/maps/place/200+Wellington+Dr,+Charlottesville,+VA+22903/@38.046548,-78.5412267,17z/data=!3m1!4b1!4m5!3m4!1s0x89b386e1733ceb6b:0xf0c71bb323d4a6cf!8m2!3d38.046548!4d-78.539038
https://www.jsl.org/bhsc2020.php
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DIRECTIONS TO COUNTRY CLUB OF CULPEPER POOL (CBST) 
 

Enter into your GPS CBST on jsl.org 
2100 Country Club Rd. (use GPS link, not address) 
Culpeper, VA 22710 

Diving 
NOT ALLOWED 
at EITHER end 

 

  
 

All swimmers must stay clear of the golfing greens and tee areas.  During meets - the 
following are closed to ALL swimmers - shallow end of pool, diving well, baby pool and 
playground (adjacent to the pool).  The playground is locked and we place all of the 
ladders for the pool into the baby pool to deter kids from getting in it - the baby pool area 
is where we have our concessions in order to maximize seating space for swimmers and 
families - so we can't lock that gate.  There is ample parking, but there may be reserved 
parking spaces that cannot be used. 
 
Smoking is only allowed completely outside of the gates to the pool. 

 
From Charlottesville proceed onto Route 29 North for approximately 40 miles and merge right 
onto Route 29 North Business Route (Madison Rd) toward Culpeper (1st Culpeper Exit – Route 
29 Business, Culpeper).  Continue for 1.2 miles, (do not turn at Golf Dr) and then turn left onto 
Country Club Road (just past Powell Wellness Center).  Continue 0.4 miles straight ahead into 
the parking area for CBST. 
 
From Gordonsville at the roundabout, take the exit onto Route 15 North (James Madison 
Highway), and continue 8.5 miles.  In Orange, turn right onto South Madison Rd (Route 15 North) 
and continue to follow Route 15 for 16.5 miles.  Turn left onto Madison Rd and continue for 1.9 
miles (do not turn at Golf Dr).  Turn left onto Country Club Rd (just past Powell Wellness Center).  
Continue 0.4 miles straight ahead into the parking area for CBST 
 
From Louisa proceed onto Louisa Ave (US Route 522 and VA-208).  Continue to follow Route 
522 for 34 miles.  Turn left onto Germanna Hwy (US Route 522 North and VA 3 West).  Continue 
to follow US Route 522 North for 1.8 miles.  Turn left onto Madison Rd (Route 29 Business Route 
South) and go 0.6 miles.  Turn right onto Country Club Rd (just up a slight hill past the Church & 
Shopping Center) and continue 0.4 miles straight ahead into the parking area for CBST. 
  

https://www.jsl.org/cbst2020.php
https://www.google.com/maps/place/38%C2%B027'54.0%22N+78%C2%B000'50.4%22W/@38.465013,-78.0145582,19z/data=!3m1!4b1!4m14!1m7!4m6!1m0!1m3!2m2!1d-78.0136726!2d38.4656506!3e0!3m5!1s0x0:0x0!7e2!8m2!3d38.4650121!4d-78.0140106
https://www.google.com/maps/place/Country+Club+of+Culpeper/@38.464674,-78.0215047,17z/data=!4m13!1m7!3m6!1s0x89b426a81ce57e3b:0xa1ff02da2c2e7907!2s2100+Country+Club+Rd,+Culpeper,+VA+22701!3b1!8m2!3d38.464674!4d-78.019316!3m4!1s0x0000000000000000:0x1ee7bf68a3bff2cf!8m2!3d38.4655751!4d-78.0141634
https://www.google.com/maps/place/Country+Club+of+Culpeper/@38.464674,-78.0215047,17z/data=!4m13!1m7!3m6!1s0x89b426a81ce57e3b:0xa1ff02da2c2e7907!2s2100+Country+Club+Rd,+Culpeper,+VA+22701!3b1!8m2!3d38.464674!4d-78.019316!3m4!1s0x0000000000000000:0x1ee7bf68a3bff2cf!8m2!3d38.4655751!4d-78.0141634
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DIRECTIONS TO CLAUDIUS CR0ZET PARK POOL (CGST) 
 

 Enter into your GPS 
 1075 Claudius Crozet Park 
 Crozet, VA 22932 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  CGST on jsl.org 
 
 
 
 
 
 

No alcoholic beverages allowed in Park. 

 
From North of Charlottesville follow Rt. 29 South to the Rt. 29 South - 250 West Bypass which 
is a right hand ramp.  Follow signs to Rt. 250 West and go out of town (follow signs to Staunton).  
Go about 10 miles to the stop light at Rt. 240.  Turn right onto Crozet Ave. (Rt. 240) and follow 
this about 1.2 miles.  Turn right onto Tabor St. (Rt. 691) and another right onto High St.  Follow 
High St. about 0.4 miles and turn left onto Park Rd. You will see Claudius Crozet Park on your 
left.  The pool is in the park on the right. 
 
From South of Charlottesville follow Rt. 29 North to the Rt. 250 West intersection which is a 
right hand ramp.  At the top of the ramp, Take Rt.250 West (left) and go out of town (follow signs 
to Staunton).  Go about 10 miles to the stop light at Rt. 240.  Turn right onto Crozet Ave. (Rt. 240) 
and follow this about 1.2 miles.  Turn right onto Tabor St. (Rt. 691) and another right onto High St.  
Follow High St. about 0.4 miles and turn left onto Park Rd. You will see Claudius Crozet Park on 
your left.  The pool is in the park on the right. 
 
From East of Charlottesville follow Rt. 250 West Bypass through town until you are on the west 
side of Charlottesville (follow signs to Staunton).  Go about 10 miles to the stop light at Rt. 240.  
Turn right onto Crozet Ave. (Rt. 240) and follow this about 1.2 miles.  Turn right onto Tabor St. 
(Rt. 691) and another right onto High St.  Follow High St. about 0.4 miles and turn left onto Park 
Rd. You will see Claudius Crozet Park on your left.  The pool is in the park on the right. 
 
From East of Crozet using Interstate 64 West take Crozet Exit #107, turn right onto Rt. 250 
East, and go about 1.5 miles to the stop light at Rt. 240.  Turn left onto Crozet Ave. (Rt. 240) and 
follow this about 1.2 miles.  Turn right onto Tabor St. (Rt. 691) and another right onto High St.  
Follow High St. about 0.4 miles and turn left onto Park Rd. You will see Claudius Crozet Park on 
your left.  The pool is in the park on the right. 
 
From West of Crozet using Interstate 64 East take Crozet Exit #107, turn left onto Rt. 250 
East, and go about 1.5 miles to the stop light at Rt. 240.  Turn left onto Crozet Ave. (Rt. 240) and 
follow this about 1.2 miles.  Turn right onto Tabor St. (Rt. 691) and another right onto High St.  
Follow High St. about 0.4 miles and turn left onto Park Rd. You will see Claudius Crozet Park on 
your left.  The pool is in the park on the right. 
 

https://www.google.com/maps/place/1075+Claudius+Crozet+Park,+Crozet,+VA+22932/@38.0644622,-78.6976077,17z/data=!3m1!4b1!4m13!1m7!3m6!1s0x89b37f079665d87f:0xf04c739f00da7859!2s1075+Park+Ln,+Crozet,+VA+22932!3b1!8m2!3d38.0637912!4d-78.6922553!3m4!1s0x89b37f075c46bc81:0x9ef32c66c4bb07ad!8m2!3d38.064458!4d-78.695419
https://www.google.com/maps/place/1075+Claudius+Crozet+Park,+Crozet,+VA+22932/@38.0644622,-78.6976077,17z/data=!3m1!4b1!4m13!1m7!3m6!1s0x89b37f079665d87f:0xf04c739f00da7859!2s1075+Park+Ln,+Crozet,+VA+22932!3b1!8m2!3d38.0637912!4d-78.6922553!3m4!1s0x89b37f075c46bc81:0x9ef32c66c4bb07ad!8m2!3d38.064458!4d-78.695419
https://www.jsl.org/cgst2020.php
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DIRECTIONS TO WASHINGTON PARK POOL (CITY) 
 

 Enter into your GPS 
 1001 Preston Avenue 
 Charlottesville, VA 22903 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  CITY on jsl.org 
 
 
 
 
 
 

There is additional parking behind Burley Middle School on Rosehill Drive and also on the 
lower level of Washington Park near the baseball fields. 
 

There is NO swimming allowed in the walk-in (“beach” or wading) area.  The slides and 
“mushroom” are also closed during swim meets. 

 
From North of Charlottesville follow Rt. 29 South to the Rt. 29 South (Emmet St.) and Barracks 
Rd intersection.  Take a left onto Barracks Rd and follow this up the hill about 0.4mi.  At the top of 
the hill the road turns to the right and becomes Preston Ave.  Continue on Preston Ave. through 2 
quick stoplights, down the hill, past a baseball field on left, and up the hill.  Take a left at the 
stoplight onto 10th St.  The pool is about 1 block on the left behind the pool building.  There is 
limited parking in the lot on the left. 
 

From South of Charlottesville follow Rt. 29 North Bypass to the Barracks Rd. exit which is a 
right hand ramp.  At the end of the ramp, turn right onto Barracks Rd and go through two 
stoplights.  Continue up the hill about 0.4mi.  At the top of the hill the road turns to the right and 
becomes Preston Ave.  Continue on Preston Ave. through 2 quick stoplights, down the hill, past a 
baseball field on left, and up the hill.  Take a left at the stoplight onto 10th St.  The pool is about 1 
block on the left behind the pool building.  There is limited parking in the lot on the left. 
 

From East of Charlottesville follow Rt. 250 West Bypass to the stoplight at the intersection with 
McIntire Rd.  Turn left onto McIntire Rd and continue about 0.8mi to the first stoplight at Preston 
Ave.  Turn right onto Preston Ave., go through 4 stoplights, and turn right at the fifth stoplight onto 
1Oth St.  The pool is about 1 block on the left behind the pool building.  There is limited parking in 
the lot on the left. 
 

From the West of Charlottesville follow Rt. 250 Bypass East to the Barracks Rd exit which is a 
right hand ramp.  At the end of the ramp, turn right onto Barracks Rd and go through two 
stoplights.  Continue up the hill about 0.4mi.  At the top of the hill the road turns to the right and 
becomes Preston Ave.  Continue on Preston Ave. through 2 quick stoplights, down the hill, past a 
baseball field on left, and up the hill.  Take a left at the stoplight onto 10th St.  The pool is about 1 
block on the left behind the pool building.  There is limited parking in the lot on the left. 
 

https://www.google.com/maps/place/Washington+Park+Pool/@38.0392691,-78.4935176,17z/data=!4m5!3m4!1s0x0000000000000000:0x2b4996b8f79fdb31!8m2!3d38.0400235!4d-78.4904239
https://www.google.com/maps/place/Washington+Park+Pool/@38.0392691,-78.4935176,17z/data=!4m5!3m4!1s0x0000000000000000:0x2b4996b8f79fdb31!8m2!3d38.0400235!4d-78.4904239
https://www.jsl.org/city2020.php
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DIRECTIONS TO ELKS LODGE (ELKS) 
 

 Enter into your GPS 
 389 Elk Dr 
 Charlottesville, VA 22902 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
 
  ELKS on jsl.org 
 
 
 
 
 

The shelter is available unless being used by another group. 

 
From North of Charlottesville follow Rt. 29 South to the Hydraulic Rd intersection (K-mart is on 
left).  Turn left onto Hydraulic Rd and follow this to the second traffic light and turn left onto the Rt. 
250 Bypass East.  Stay on Rt. 250 Bypass East through town and cross the Rivanna River Bridge 
on the east side of town.  Turn left at the first traffic light after the bridge onto Rt. 20 North.  Go 
about 1 mile and turn left at the light onto Elk Drive (Elks sign is on left).  Entrance to the parking 
lot is the first left and pool is to the left side of the main building. 
 
From the South of Charlottesville follow Rt. 29 North (or Bypass) to the Rt.250 East Bypass 
intersection.  Take the Rt. 250 Bypass East through town and cross the Rivanna River Bridge on 
the east side of town.  Turn left at the first traffic light after the bridge onto Rt. 20 North.  Go about 
1 mile and turn left at the light onto Elk Drive (Elks sign is on left).  Entrance to the parking lot is 
the first left and pool is to the left side of the main building. 
 
From the East of Charlottesville follow Rt. 250 West coming down Pantops Mountain and take 
a right at the first light onto Rt. 20 North.  Go about 1 mile and turn left at the light onto Elk Drive 
(Elks sign is on left).  Entrance to the parking lot is the first left and pool is to the left side of the 
main building. 
 
From the West of Charlottesville follow Rt. 250 Bypass East through town and cross the 
Rivanna River Bridge on the east side of town.  Turn left at the first traffic light after the bridge 
onto Rt. 20 North.  Go about 1 mile and turn left at the light onto Elk Drive (Elks sign is on left).  
Entrance to the parking lot is the first left and pool is to the left side of the main building. 
 
 

  

https://www.google.com/maps/place/389+Elk+Dr,+Charlottesville,+VA+22911/@38.0390842,-78.4531151,17z/data=!3m1!4b1!4m5!3m4!1s0x89b388f517b7f4b9:0x9c17385c635eafa8!8m2!3d38.0390842!4d-78.4509264
https://www.google.com/maps/place/389+Elk+Dr,+Charlottesville,+VA+22911/@38.0390842,-78.4531151,17z/data=!3m1!4b1!4m5!3m4!1s0x89b388f517b7f4b9:0x9c17385c635eafa8!8m2!3d38.0390842!4d-78.4509264
https://www.jsl.org/elks2020.php


Jefferson Swim League Procedure Manual - Revised July 5, 2024 

[JSL Man – sec 4 pool information                                    © 2024 JSL - Team Manual Section IV - Page 17 

DIRECTIONS TO FARMINGTON COUNTRY CLUB (FCC) 
 

 Enter into your GPS 
 1625 Country Club Circle 
 Charlottesville, VA 22901 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  FCC on jsl.org 
 
 
 
 
 
 

Diving and baby pools are off limits during swim meets 

 
From North of Charlottesville follow Rt. 29 South to the Rt. 29 South - 250 West Bypass which 
is a right hand ramp.  Follow signs to Rt. 250 West and go out of town.  Farmington Country Club 
will be on the right on Rt. 250 West.  Turn right at the stoplight into Farmington Country Club, 
follow this narrow road across the railroad tracks, and go about 3/4 mile.  Parking is available in 
the large circular drive in front of the Clubhouse on the left or the lot off Tennis Rd.  The pool is to 
the front-left of the Clubhouse. 
 
From South of Charlottesville follow Rt. 29 North to the Rt. 250 West intersection which is a 
right hand ramp.  At the top of the ramp, take Rt.250 West (left) and go out of town.  Farmington 
Country Club will be on the right on Rt. 250 West.  Turn right at the stoplight into Farmington 
Country Club, follow this narrow road across the railroad tracks, and go about 3/4 mile.  Parking 
is available in the large circular drive in front of the Clubhouse on the left or the lot off Tennis Rd.  
The pool is to the front-left of the Clubhouse. 
 
From East of Charlottesville follow Rt. 250 West Bypass through town until you are on the west 
side of Charlottesville.  Farmington Country Club will be on the right on Rt. 250 West.  Turn right 
at the stoplight into Farmington Country Club, follow this narrow road across the railroad tracks, 
and go about 3/4 mile.  Parking is available in the large circular drive in front of the Clubhouse on 
the left or the lot off Tennis Rd.  The pool is to the front-left of the Clubhouse. 
 
From West of Charlottesville follow Rt. 250 East just past the entrance to the Boars Head 
Resort on the right.  Turn left at the stoplight into Farmington Country Club, follow this narrow 
road across the railroad tracks, and go about 3/4 mile.  Parking is available in the large circular 
drive in front of the Clubhouse on the left or the lot off Tennis Rd.  The pool is to the front-left of 
the Clubhouse. 
 
From West of Charlottesville Using Interstate 64 East get off at the 29 North exit.  Follow 29 
North Bypass to Rt. 250 West (right hand ramp).  Go left on Rt. 250 West out of town.  
Farmington Country Club will be on the right on Rt. 250 West.  Turn right at the stoplight into 
Farmington Country Club, follow this narrow road across the railroad tracks, and go about 3/4 
mile.  Parking is available in the large circular drive in front of the Clubhouse on the left or the lot 
off Tennis Rd.  The pool is to the front-left of the Clubhouse. 

https://www.google.com/maps/place/1625+Country+Club+Cir,+Charlottesville,+VA+22901/@38.0625044,-78.5435354,17z/data=!3m1!4b1!4m5!3m4!1s0x89b38717a5ca63c3:0xb88bd28d44697e2c!8m2!3d38.0625044!4d-78.5413467
https://www.google.com/maps/place/1625+Country+Club+Cir,+Charlottesville,+VA+22901/@38.0625044,-78.5435354,17z/data=!3m1!4b1!4m5!3m4!1s0x89b38717a5ca63c3:0xb88bd28d44697e2c!8m2!3d38.0625044!4d-78.5413467
https://www.jsl.org/fcc2020.php
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DIRECTIONS FOR FOREST LAKES (FLST) 
(Using SOUTH Pool) 

 

 Enter into your GPS 
 1650 Ashwood Blvd. 
 Charlottesville, VA 22911 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
 
  FLST on jsl.org 
 
 
 
 
 

Recreational area is closed during swim meets 
Please park in lot and alongside main road if needed. 

 
From North of Charlottesville (Ruckersville) follow Rt. 29 South through the traffic light at 
Airport Rd and go past the main entrance to Forest Lakes.  From the main entrance, continue 
1.3mi on Rt. 29 South through the light at Hollymead and turn left at the light for the entrance to 
Forest Lakes South.  Go 0.7mi on this winding road and the Pool will be on the left.   
 
From South of Charlottesville follow Rt. 29 North several miles out of town (1.3mi past the light 
at Wal-Mart).  Take a right at the traffic light into Forest Lakes South.  Go 0.7mi on this winding 
road and the Pool will be on the left 
 
From East of Charlottesville follow the Rt. 250 Bypass West and exit onto Rt.29 North.  Follow 
Rt. 29 North several miles out of town (1.3mi past the light at Wal-Mart).  Take a right at the traffic 
light into Forest Lakes South.  Go 0.7mi on this winding road and the Pool will be on the left 
 
From West of Charlottesville follow the Rt. 250 Bypass East and take Rt. 29 North exit (to 
Washington).  Follow Rt. 29 North several miles out of town (1.3mi past the light at Wal-Mart).  
Take a right at the traffic light into Forest Lakes South.  Go 0.7mi on this winding road and the 
Pool will be on the left 

https://www.google.com/maps/place/1650+Ashwood+Blvd,+Charlottesville,+VA+22911/@38.108668,-78.4423256,17z/data=!4m5!3m4!1s0x89b477b0bc76a2ed:0xf87b90944ce0fb4d!8m2!3d38.108668!4d-78.4401369
https://www.google.com/maps/place/1650+Ashwood+Blvd,+Charlottesville,+VA+22911/@38.108668,-78.4423256,17z/data=!4m5!3m4!1s0x89b477b0bc76a2ed:0xf87b90944ce0fb4d!8m2!3d38.108668!4d-78.4401369
https://www.jsl.org/flst2020.php
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DIRECTIONS TO FRY’S SPRING BEACH CLUB (FSBC) 
 

 Enter into your GPS 
 2512 Jefferson Park Ave 
 Charlottesville, VA 22903 

 
 

 

8&U relays are 
NOT swum at 

FSBC 

 
 
 
  FSBC on jsl.org  
 
 
 
 
 
 

Middle and baby pools are off limits during swim meets 
 
From North of Charlottesville follow Rt. 29 South to the Rt. 29 South - 250 West Bypass which 
is a right hand ramp.  Stay on Rt. 29 South past Rt. 250 exit to the next exit which is 29 North 
business or Fontaine Ave.  Take a left at the bottom of the ramp, go to the second stop light, and 
take a right onto Jefferson Park Ave.  Go over the bridge and continue on Jefferson Park Ave.  
The entrance to Fry’s Spring is between two stone pillars about 3/4 mile directly in front of you.  
The pool is behind the main building. 
 
From South of Charlottesville follow Rt. 29 North to Rt. 29 North business exit and take a right 
at the end of the ramp onto Fontaine Ave.  Go to the second stop light, and take a right onto 
Jefferson Park Ave.  Go over the bridge and continue on Jefferson Park Ave.  The entrance to 
Fry’s Spring is between two stone pillars about 3/4 mile directly in front of you.  The pool is behind 
the main building. 
 
From East of Charlottesville follow Rt. 250 West Bypass until it becomes the Rt. 250 West - 29 
South Bypass.  Stay on Rt. 29 South past Rt. 250 exit to the next exit which is 29 North business 
or Fontaine Ave.  Take a left at the bottom of the ramp, go to the second stop light, and take a 
right onto Jefferson Park Ave.  Go over the bridge and continue on Jefferson Park Ave.  The 
entrance to Fry’s Spring is between two stone pillars about 3/4 mile directly in front of you.  The 
pool is behind the main building. 
 
From West of Charlottesville follow Rt. 250 East to Rt. 29 South.  Follow Rt. 29 South to the 
next exit which is 29 North business or Fontaine Ave.  Take a left at the bottom of the ramp, go to 
the second stop light, and take a right onto Jefferson Park Ave.  Go over the bridge and continue 
on Jefferson Park Ave.  The entrance to Fry’s Spring is between two stone pillars about 3/4 mile 
directly in front of you.  The pool is behind the main building. 
 
From West of Charlottesville using Interstate 64 East get off at the Rt. 29 North exit.  Go to 
the next exit (Rt. 29 North business) and take a right at the end of the ramp onto Fontaine Ave.  
Go to the second stop light, and take a right onto Jefferson Park Ave.  Go over the bridge and 
continue on Jefferson Park Ave.  The entrance to Fry’s Spring is between two stone pillars about 
3/4 mile directly in front of you.  The pool is behind the main building. 

https://www.google.com/maps/place/2512+Jefferson+Park+Ave,+Charlottesville,+VA+22903/@38.0180239,-78.5167667,17z/data=!3m1!4b1!4m5!3m4!1s0x89b386648470454d:0x2455fdadcd878315!8m2!3d38.0180239!4d-78.514578
https://www.google.com/maps/place/2512+Jefferson+Park+Ave,+Charlottesville,+VA+22903/@38.0180239,-78.5167667,17z/data=!3m1!4b1!4m5!3m4!1s0x89b386648470454d:0x2455fdadcd878315!8m2!3d38.0180239!4d-78.514578
https://www.jsl.org/fsbc2020.php
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DIRECTIONS TO FORK UNION MILITARY ACADEMY POOL 
JSL Championship is occasionally held at Fork Union Military Academy (FUMA) 

 

Enter into your GPS 
4646 James Madison Highway 

Fork Union, VA 23055 
 

Diving 
NOT ALLOWED 
at shallow end 

 

     
Map of General Area                                    Detail of Fork Union Military Academy 

 

Fork Union Military Academy prohibits the use of alcohol or tobacco products on its 
grounds.  Swim meet participants and guests are restricted to the pool area, locker rooms, 
and balcony and may not go in other areas nor use the diving board.  There is no glass 
allowed on pool deck, locker rooms, or in spectator stands.  There is no food allowed on 
pool deck or locker rooms.  Everyone is requested to clean up after themselves. 

 
From North of Charlottesville using Route 29 South to the Route 250 East Bypass (to 
Richmond).  Follow Rt. 250 East to Interstate 64 East and turn left.  Stay on Interstate 64 East for 
about 12 miles to exit 136 and take a right onto Route 15 South.  Stay on Route 15 for about 17 
miles, and take the first left PAST the main entrance to FUMA onto Pettit-Foster Drive.   
Turn left into the Estes Athletic Center Parking Area and continue around the building to 
the north parking area which is parking for the Aquatic Center. 
 

From Northeast of Charlottesville using Route 15 South continue past Interstate 64 for about 
17 miles, and take the first left PAST the main entrance to FUMA onto Pettit-Foster Drive.  Follow 
directions in boxed area above. 
 

From South of Charlottesville follow Route 29 North and merge onto Interstate 64 East.  
Continue for about 18 miles to exit 136 and take a right onto Route 15 South.  Stay on Route 15 
for about 17 miles, and take the first left PAST the main entrance to FUMA onto Pettit-Foster 
Drive.  Follow directions in boxed area above. 
 

From Charlottesville or West of Charlottesville follow Rt. 250 East thru Charlottesville to 
Interstate 64 East and turn left.  Stay on Interstate 64 East for about 12 miles to exit 136 and take 
a right onto Route 15 South.  Stay on Route 15 for about 17 miles, and take the first left PAST the 
main entrance to FUMA onto Pettit-Foster Drive.  Follow directions in boxed area above. 

https://www.google.com/maps/place/37%C2%B045'42.5%22N+78%C2%B015'28.2%22W/@37.7618095,-78.2586205,18z/data=!3m1!4b1!4m5!3m4!1s0x0:0x0!8m2!3d37.761808!4d-78.257846
https://www.google.com/maps/place/37%C2%B045'42.5%22N+78%C2%B015'28.2%22W/@37.7618095,-78.2586205,18z/data=!3m1!4b1!4m5!3m4!1s0x0:0x0!8m2!3d37.761808!4d-78.257846
https://www.google.com/maps/place/37%C2%B045'42.5%22N+78%C2%B015'28.2%22W/@37.7618095,-78.2586205,18z/data=!3m1!4b1!4m5!3m4!1s0x0:0x0!8m2!3d37.761808!4d-78.257846
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DIRECTIONS TO FAIRVIEW (FV) 
 

 Enter into your GPS 
 707 Belvedere Blvd. 
 Charlottesville, VA 22901 

  
 

 
 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  FV on jsl.org 
 
 
 
 
 

During storms, spectators and swimmers MUST wait in their cars rather than in the shelter 
area. 
 
From North of Charlottesville follow Rt. 29 South and take a left at the stop light at Rio Rd (just 
past Albemarle Square Shopping Center).  Go 1.3 miles (past Huntington Rd. on left and past BP 
gas station on left).  Go across the bridge and immediately after crossing the bridge, turn left onto 
Belvedere Blvd..  Covenant Church will be on the left after making the turn.  Continue on that 
road for approximately 1 mile.  Fairview will be on the left. 
 
From South of Charlottesville follow Rt. 29 North (or Bypass) and take a right at the stop light 
at Rio Rd (just past Fashion Square Mall).  Go 1.3 miles (past Huntington Rd. on left and past BP 
gas station on left).  Go across the bridge and immediately after crossing the bridge, turn left onto 
Belvedere Blvd..  Covenant Church will be on the left after making the turn.  Continue on that 
road for approximately 1 mile.  Fairview will be on the left. 
 
From East of Charlottesville follow Rt. 250 West Bypass through town to Rt. 29 North (to 
Washington).  Stay on Rt. 29 North (or Bypass) and take a right at the stop light at Rio Rd (just 
past Fashion Square Mall).  Go 1.3 miles (past Huntington Rd. on left and past BP gas station on 
left).  Go across the bridge and immediately after crossing the bridge, turn left onto Belvedere 
Blvd..  Covenant Church will be on the left after making the turn.  Continue on that road for 
approximately 1 mile.  Fairview will be on the left. 
 
From West of Charlottesville follow Rt. 250 East Bypass to Rt. 29 North (to Washington).  Stay 
on Rt. 29 North and take a right at the stop light at Rio Rd (just past Fashion Square Mall).  Go 
1.3 miles (past Huntington Rd. on left and past BP gas station on left).  Go across the bridge and 
immediately after crossing the bridge, turn left onto Belvedere Blvd..  Covenant Church will be on 
the left after making the turn.  Continue on that road for approximately 1 mile.  Fairview will be on 
the left. 
 
From West of Charlottesville using Interstate 64 East get off at the Rt. 29 North Exit and 
follow the Rt. 29 North Bypass (to Washington).  Stay on Rt. 29 North and take a right at the stop 
light at Rio Rd (just past Fashion Square Mall).  Go 1.3 miles (past Huntington Rd. on left and 
past BP gas station on left).  Go across the bridge and immediately after crossing the bridge, turn 
left onto Belvedere Blvd..  Covenant Church will be on the left after making the turn.  Continue on 
that road for approximately 1 mile.  Fairview will be on the left. 

https://www.google.com/maps/place/707+Belvedere+Blvd,+Charlottesville,+VA+22901/@38.07285,-78.4640507,17z/data=!3m1!4b1!4m5!3m4!1s0x89b3881070fce1bd:0x1257fe63a123763f!8m2!3d38.07285!4d-78.461862
https://www.jsl.org/fv2020.php
https://www.google.com/maps/place/707+Belvedere+Blvd,+Charlottesville,+VA+22901/@38.07285,-78.4640507,17z/data=!3m1!4b1!4m5!3m4!1s0x89b3881070fce1bd:0x1257fe63a123763f!8m2!3d38.07285!4d-78.461862
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DIRECTIONS TO GREENE HILLS (GHG) 

 

 Enter into your GPS 
 3858 Dundee Rd 
 Stanardsville, VA 22973 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  GHG on jsl.org 
 
 
 
 
 
 

Golf is not available to swim meet guests 

 
From Charlottesville take Rt. 29 North to Ruckersville and turn left at the light onto Rt. 33 West.  
Travel on Rt. 33 West for approximately 4 miles.  Turn right at the first traffic light onto Rt. 33 
Business.  Travel on Rt. 33 Business for approximately 1½ miles.  Just as you are going into 
Stanardsville, turn right onto Rt. 230 East (Madison Road).  Follow this for 3 miles to Rt. 619 
(Dundee Road) and turn right.  The club entrance is 500 yards on the left.   

 
 

https://www.google.com/maps/place/38%C2%B019'25.6%22N+78%C2%B024'18.1%22W/@38.3237832,-78.4072267,17z/data=!4m5!3m4!1s0x0:0x0!8m2!3d38.323779!4d-78.405038
https://www.google.com/maps/place/38%C2%B019'25.6%22N+78%C2%B024'18.1%22W/@38.3237832,-78.4072267,17z/data=!4m5!3m4!1s0x0:0x0!8m2!3d38.323779!4d-78.405038
https://www.jsl.org/ghg2020.php
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DIRECTIONS TO THE CLUB AT GLENMORE (GLEN) 
 

 Enter into your GPS 
 1750 Piper Way 
 Keswick, VA 22947 
  

 
 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  GLEN on jsl.org 
 
 
 
 
 
 

Baby pool and diving area are closed during swim meets.  Club facilities (other than pool 
and deck) are also off limits during swim meets.  Parking is allowed in parking area beside 
pool and along main road only if needed. 

 
From North of Charlottesville follow Route 29 South to the Route 250 East Bypass (to 
Richmond).  Follow Rt. 250 East to the Interstate 64 interchange.  Continue on Route 250 East 
for an additional 3 miles past the Interstate 64 interchange and a sign to Glenmore can be seen 
on the right.  Turn right onto Glenmore Way and then right onto Piper Way.  STOP at the 
Gatehouse and give name and function.  Continue on Piper Way for approximately 1.3 miles and 
the Clubhouse and parking lot will be on the right.  The pool is to the right of the Clubhouse. 
 

From South of Charlottesville turn onto Interstate 64 East and go to the Shadwell exit.  Turn 
right onto Route 250 East and continue on Route 250 East for an additional 3 miles and a sign to 
Glenmore can be seen on the right.  Turn right onto Glenmore Way and then right onto Piper 
Way.  STOP at the Gatehouse and give name and function.  Continue on Piper Way for 
approximately 1.3 miles and the Clubhouse and parking lot will be on the right.  The pool is to the 
right of the Clubhouse. 
 

From Charlottesville or West of Charlottesville, using Rt. 250 East to the Interstate 64 
interchange.  Continue on Route 250 East for an additional 3 miles past the Interstate 64 
interchange and a sign to Glenmore can be seen on the right.  Turn right onto Glenmore Way and 
then right onto Piper Way.  STOP at the Gatehouse and give name and function.  Continue on 
Piper Way for approximately 1.3 miles and the Clubhouse and parking lot will be on the right.  
The pool is to the right of the Clubhouse. 
 

From Charlottesville or West of Charlottesville, using Interstate 64 East to the Shadwell exit.  
Turn right onto Route 250 East and continue on Route 250 East for an additional 3 miles and a 
sign to Glenmore can be seen on the right.  Turn right onto Glenmore Way and then right onto 
Piper Way.  STOP at the Gatehouse and give name and function.  Continue on Piper Way for 
approximately 1.3 miles and the Clubhouse and parking lot will be on the right.  The pool is to the 
right of the Clubhouse. 
 

https://www.google.com/maps/place/37%C2%B059'15.5%22N+78%C2%B023'06.7%22W/@37.9879814,-78.3879033,16.51z/data=!4m5!3m4!1s0x0:0x0!8m2!3d37.987633!4d-78.385192
https://www.google.com/maps/place/37%C2%B059'15.5%22N+78%C2%B023'06.7%22W/@37.9879814,-78.3879033,16.51z/data=!4m5!3m4!1s0x0:0x0!8m2!3d37.987633!4d-78.385192
https://www.jsl.org/gcc2020.php
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DIRECTIONS TO HOLLYMEAD POOL (HM) 
 

 Enter into your GPS 
 Hollymead Swim Club 
 Charlottesville, VA 22911 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  HM on jsl.org 
 
 
 
 
 
 

No alcoholic beverages are allowed.  Please park in the parking lot but NOT close to The 
Silver Thatch Inn.  The Silver Thatch Inn portion of the parking lot should be marked.  
Additional parking is available at Peace Lutheran Church located one block Northwest of 
the Pool off Hollymead Drive. 

 
From North of Charlottesville (Ruckersville) follow Rt. 29 South about 10 miles through the 
traffic lights at Airport Rd and at Forest Lakes to the Hollymead entrance.  Turn left at this third 
light and the pool is about 1/4 mile from Rt. 29 next to the parking lot in front of The Silver Thatch 
Inn. 
 
From South of Charlottesville follow Rt. 29 North (or Bypass) about 4 miles past Fashion 
Square Mall on the right.  Turn right at the sign for Hollymead.  The pool is about 1/4 mile from Rt. 
29 next to the parking lot in front of The Silver Thatch Inn. 
 
From East of Charlottesville follow Rt. 250 West Bypass through town to Rt.29 North (to 
Washington).  Stay on Rt. 29 North about 4 miles past Fashion Square Mall on the right.  Turn 
right at the sign for Hollymead.  The pool is about 1/4 mile from Rt. 29 next to the parking lot in 
front of The Silver Thatch Inn. 
 
From West of Charlottesville follow Rt. 250 East Bypass to Rt. 29 North (to Washington).  Stay 
on Rt. 29 North about 4 miles past Fashion Square Mall on the right.  Turn right at the sign for 
Hollymead.  The pool is about 1/4 mile from Rt. 29 next to the parking lot in front of The Silver 
Thatch Inn. 
 
From West of Charlottesville Using Interstate 64 East get off at the Rt. 29 North Exit and 
follow the Rt. 29 North Bypass (to Washington).  Stay on Rt. 29 North about 4 miles past Fashion 
Square Mall on the right.  Turn right at the sign for Hollymead.  The pool is about 1/4 mile from Rt. 
29 next to the parking lot in front of The Silver Thatch Inn. 

https://www.google.com/maps/place/Hollymead+Swim+Club/@38.1181287,-78.4473491,17z/data=!4m13!1m7!3m6!1s0x89b477afe860283d:0x1648532640e30fd7!2s2000+Hollymead+Dr,+Charlottesville,+VA+22911!3b1!8m2!3d38.1135516!4d-78.4397832!3m4!1s0x0000000000000000:0xc05d08f737bd8c64!8m2!3d38.1187198!4d-78.444593
https://www.google.com/maps/place/Hollymead+Swim+Club/@38.1181287,-78.4473491,17z/data=!4m13!1m7!3m6!1s0x89b477afe860283d:0x1648532640e30fd7!2s2000+Hollymead+Dr,+Charlottesville,+VA+22911!3b1!8m2!3d38.1135516!4d-78.4397832!3m4!1s0x0000000000000000:0xc05d08f737bd8c64!8m2!3d38.1187198!4d-78.444593
https://www.jsl.org/hm2020.php
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DIRECTIONS TO KEY WEST CLUB (KWC) 
 

 Enter into your GPS 
 393 Key West Drive 
 Charlottesville, VA 22901 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
 
  KWC on jsl.org  
 
 
 
 
 

The shelter area is for swimmers at the Clerk of Course ONLY. 

 
From North of Charlottesville follow Rt. 29 South to the Hydraulic Rd. intersection (K-mart is on 
left).  Turn left onto Hydraulic Rd, follow this to the second traffic light, and turn left onto the Rt. 
250 Bypass East.  Stay on Rt. 250 Bypass East through town and cross the Rivanna River Bridge 
on the east side of town.  Turn left at the first traffic light after the bridge onto Rt. 20 North.  Go 
about 1.6 miles to the Key West neighborhood sign and turn left onto Rt. 816.  Follow this about 
0.9 mile to the club sign and take a left at the triangle.  Take the first left again at the club sign 
and follow the dirt road past a field, through the gate, and into the parking lot. 
 
From the South of Charlottesville follow Rt. 29 North (or Bypass) to the Rt.250 East Bypass 
intersection.  Take Rt. 250 Bypass East through town and cross the Rivanna River Bridge on the 
east side of town.  Turn left at the first traffic light after the bridge onto Rt. 20 North.  Go about 1.6 
miles to the Key West neighborhood sign and turn left onto Rt. 816.  Follow this about 0.9 mile to 
the club sign and take a left at the triangle.  Take the first left again at the club sign and follow the 
dirt road past a field, through the gate, and into the parking lot. 
 
From the East of Charlottesville follow Rt. 250 West coming down Pantops Mountain and take 
a right at the first light onto Rt. 20 North.  Go about 1.6 miles to the Key West neighborhood sign 
and turn left onto Rt. 816.  Follow this about 0.9 mile to the club sign and take a left at the 
triangle.  Take the first left again at the club sign and follow the dirt road past a field, through the 
gate, and into the parking lot. 
 
From the West of Charlottesville follow Rt. 250 Bypass East through town and cross the 
Rivanna River Bridge on the east side of town.  Turn left at the first traffic light after the bridge 
onto Rt. 20 North.  Go about 1.6 miles to the Key West neighborhood sign and turn left onto Rt. 
816.  Follow this about 0.9 mile to the club sign and take a left at the triangle.  Take the first left 
again at the club sign and follow the dirt road past a field, through the gate, and into the parking 
lot. 
 

https://www.google.com/maps/place/393+Key+W+Dr,+Charlottesville,+VA+22911/@38.05875,-78.4500767,17z/data=!3m1!4b1!4m5!3m4!1s0x89b3884120c54513:0xec9a3990f4bf5057!8m2!3d38.05875!4d-78.447888
https://www.google.com/maps/place/393+Key+W+Dr,+Charlottesville,+VA+22911/@38.05875,-78.4500767,17z/data=!3m1!4b1!4m5!3m4!1s0x89b3884120c54513:0xec9a3990f4bf5057!8m2!3d38.05875!4d-78.447888
https://www.jsl.org/kwc2020.php
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DIRECTIONS TO LOUISA GATORS (LG) 
Home Meets are at the Betty Queen Intergenerational Center Pool in Louisa 

 

 Enter into your GPS 
 458 Industrial Dr. 
 Louisa, VA 23093 
 

 
 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  LG on jsl.org  
 
 
 
 

From North or South of Charlottesville take Route 29 to the Route 250 East Bypass (to 
Richmond).  Follow Rt. 250 East to Interstate 64 East and turn left onto Interstate 64.  Take exit 
143 for VA-208 toward Ferncliff/Louisa and turn left onto VA-208.  Continue 8.9 miles and turn 
right at US-33/VA-208/VA-22.  Stay straight on this road for 2 miles, following the signs towards 
the airport, and turn right at Industrial Drive (there is a large Airport Industrial sign).  Go 0.5 miles 
and turn right into the entrance for the Betty Queen Intergenerational Center (marked with a tan 
and stone sign).  Drive around to the back of the Main building by turning left.  The pool and 
parking are located at the next building on your right, behind the Main Center.  The pool is an 
outdoor pool and the building is a locker room entrance. 

 
From east of Charlottesville take Route 15 North or South to Interstate 64 east.  Take exit 
143 for VA-208 toward Ferncliff/Louisa and turn left onto VA-208.  Continue 8.9 miles and turn 
right at US-33/VA-208/VA-22.  Stay straight on this road for 2 miles, following the signs towards 
the airport, and turn right at Industrial Drive (there is a large Airport Industrial sign).  Go 0.5 miles 
and turn right into the entrance for the Betty Queen Intergenerational Center (marked with a tan 
and stone sign).  Drive around to the back of the Main building by turning left.  The pool and 
parking are located at the next building on your right, behind the Main Center.  The pool is an 
outdoor pool and the building is a locker room entrance. 
 
From Charlottesville or West of Charlottesville follow Rt. 250 East thru Charlottesville to 
Interstate 64 East and turn left.  Take exit 143 for VA-208 toward Ferncliff/Louisa and turn left 
onto VA-208.  Continue 8.9 miles and turn right at US-33/VA-208/VA-22.  Stay straight on this 
road for 2 miles, following the signs towards the airport, and turn right at Industrial Drive (there is 
a large Airport Industrial sign).  Go 0.5 miles and turn right into the entrance for the Betty Queen 
Intergenerational Center (marked with a tan and stone sign).  Drive around to the back of the 
Main building by turning left.  The pool and parking are located at the next building on your right, 
behind the Main Center.  The pool is an outdoor pool and the building is a locker room entrance. 
 

https://www.google.com/maps/place/458+Industrial+Dr,+Louisa,+VA+23093/@38.0124506,-77.9734577,17.5z/data=!4m13!1m7!3m6!1s0x0:0x0!2zMzjCsDAwJzUwLjAiTiA3N8KwNTgnMjAuNCJX!3b1!8m2!3d38.013893!4d-77.972347!3m4!1s0x89b3ffa1cfe09923:0xb48393f3181dfe63!8m2!3d38.0124625!4d-77.9719175
https://www.google.com/maps/place/458+Industrial+Dr,+Louisa,+VA+23093/@38.0124506,-77.9734577,17.5z/data=!4m13!1m7!3m6!1s0x0:0x0!2zMzjCsDAwJzUwLjAiTiA3N8KwNTgnMjAuNCJX!3b1!8m2!3d38.013893!4d-77.972347!3m4!1s0x89b3ffa1cfe09923:0xb48393f3181dfe63!8m2!3d38.0124625!4d-77.9719175
https://www.jsl.org/lg2020.php
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DIRECTIONS TO LAKE MONTICELLO (LMST) 
 

 Enter into your GPS 
 41 Ashlawn Blvd. 
 Palmyra, VA 22963 

 
 

 

Diving 
NOT ALLOWED 
at shallow end 

 
 
 
  LMST on jsl.org  
 
 
 
 
 
 
From North of Charlottesville follow Route 29 South to the Route 250 East Bypass (to 
Richmond).  Follow Rt. 250 East past Shadwell.  Go over a bridge and turn right onto Rt. 729 
(North Milton Rd). You will make a left turn at the stop sign at the top of the hill onto Rt. 729. 
Follow this for 3.3 miles and turn left onto Route 53.  Continue on Route 53 for 4.7 miles and turn 
left onto Route 618 at the Lake Monticello sign.  Go another 2 miles and turn right into the main 
gate at Lake Monticello.  Stop at the guard house (if needed), and stay straight on Ashlawn Blvd. 
until it ends.  The main office clubhouse and parking is on the left.  The pool is behind and to the 
left of the clubhouse. 
 
From South of Charlottesville follow Interstate 64 East and turn right at Exit 121A for Rt. 20 
South.  At the end of the ramp, merge into Route 20, and get into left lane.  Turn left onto Route 
53 (signs to Monticello).  Continue on Route 53 for 10.6 miles and turn left onto Route 618 at the 
Lake Monticello sign.  Go another 2.9 miles and turn right into the main gate at Lake Monticello.  
Stop at the guard house (if needed), and stay straight on Ashlawn Blvd. until it ends.  The main 
office clubhouse and parking is on the left.  The pool is behind and to the left of the clubhouse. 
 
From Charlottesville or West of Charlottesville follow Rt. 250 East past Shadwell.  Go over a 
bridge and turn right onto Rt. 729 (North Milton Rd). You will make a left turn at the stop sign at 
the top of the hill onto Rt. 729. Follow this for 3.3 miles and turn left onto Route 53.  Continue on 
Route 53 for 4.7 miles and turn left onto Route 618 at the Lake Monticello sign.  Go another 2 
miles and turn right into the main gate at Lake Monticello.  Stop at the guard house (if needed), 
and stay straight on Ashlawn Blvd. until it ends.  The main office clubhouse and parking is on the 
left.  The pool is behind and to the left of the clubhouse. 
 
From Charlottesville or West of Charlottesville, follow Interstate 64 East and turn right at 
Exit 121A for Rt. 20 South.  At the end of the ramp, merge into Route 20, and get into left lane.  
Turn left onto Route 53 (signs to Monticello).  Continue on Route 53 for 10.6 miles and turn left 
onto Route 618 at the Lake Monticello sign.  Go another 2.9 miles and turn right into the main 
gate at Lake Monticello.  Stop at the guard house (if needed), and stay straight on Ashlawn Blvd. 
until it ends.  The main office clubhouse and parking is on the left.  The pool is behind and to the 
left of the clubhouse. 

  

https://www.google.com/maps/place/41+Ashlawn+Blvd,+Palmyra,+VA+22963/@37.9197341,-78.3153584,17z/data=!3m1!4b1!4m5!3m4!1s0x89b38d41a81e9615:0xf151bcb5f230110f!8m2!3d37.9197341!4d-78.3131697
https://www.google.com/maps/place/41+Ashlawn+Blvd,+Palmyra,+VA+22963/@37.9197341,-78.3153584,17z/data=!3m1!4b1!4m5!3m4!1s0x89b38d41a81e9615:0xf151bcb5f230110f!8m2!3d37.9197341!4d-78.3131697
https://www.jsl.org/lmst2020.php
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DIRECTIONS TO SPRING CREEK POOL 

Meets are NOT currently held at Spring Creek in Louisa County 

 

 GPS directions go to wrong entrance 
 and will take you to Golf Club. 
 181 Clubhouse Way  
 Gordonsville, VA 22902 
 

  
Diving 

Diving 
NOT ALLOWED 
at shallow end 

   
 
 
 
 
 
 
 
 
 
 
 

Parking is allowed on both sides of the road off the pavement on Clubhouse Way.  
PARKING IS NOT ALLOWED IN THE GOLF COURSE PARKING LOT.  You may be towed.  
The fitness center and upstairs clubhouse are off limits.  Only use the bathrooms right by 
the pool.  Use the big grass area by the playground to put chairs and stuff.  No smoking or 
alcohol around the pool area or parking lot. 
 
From North, South, or West of Charlottesville using I-64 East, about 12 miles from the Route 
250E and I-64E interchange, take exit 136 (Rt 15N).  Turn left onto Route 15 North at the end of 
the ramp.  (You will enter a diverging diamond interchange and think you are on the wrong side of 
the road.)  Go approximately 1.2 miles to the second entrance to Spring Creek and turn left onto 
Spring Creek Parkway. 
Stop at the guard gate, then enter the roundabout and take the second right staying on Spring 
Creek Parkway.  Go to the third right and turn onto Clubhouse Way.  Continue straight about 0.2 
miles and you will enter the Sports Club Parking Lot (NOT the Golf Club parking lot).  You may 
park in the lot in front of the Sports Club or completely off the pavement on either side of the road 
leading to the Sports Club.  The pool is behind the Sports Club building and you may enter 
through the gate on the left side of the building. 
 

From Louisa using Route 208 South at its intersection with Route 33, continue approximately 
8.7 miles to Interstate 64 West.  Take the right hand ramp and go approximately 6 miles to exit 
136 (Rt 15N).  Turn right onto Route 15 North at the end of the ramp.  Go approximately 1 mile to 
the second entrance to Spring Creek and turn left onto Spring Creek Parkway.  Follow directions 
in second paragraph above. 
 

From Culpeper using Route 15 South (Madison Rd) at its intersection with Route 29, continue 
approximately 25 miles to the roundabout at Gordonsville.  Take the third exit and continue on 
Route 15S approximately 10.9 miles to the first entrance to Spring Creek.  Turn right onto Spring 
Creek Parkway.  Follow directions in second paragraph above. 
 

From FAR North of Charlottesville using Route 33 East at its intersection with Route 29, 
continue approximately 12.6 miles to the roundabout at Gordonsville.  Take the second exit onto 
Route 15S and continue approximately 10.9 miles to the first entrance to Spring Creek.  Turn 
right onto Spring Creek Parkway.  Follow directions in second paragraph above. 

  

https://www.google.com/maps/place/109+https:/www.google.com/maps/place/Spring+Creek+Sports+Club/@37.991242,-78.2132756,17z/data=!4m13!1m7!3m6!1s0x89b3f4199bce4aa1:0x759e673a1ad81204!2s109+Clubhouse+Way,+Gordonsville,+VA+22942!3b1!8m2!3d37.991242!4d-78.2110869!3m4!1s0x0000000000000000:0x63894b5dba5af014!8m2!3d37.9923906!4d-78.2094598Clubhouse+Way,+Gordonsville,+VA+22942/@37.991242,-78.2110869,17z/data=!3m1!4b1!4m2!3m1!1s0x89b3f4199bce4aa1:0x759e673a1ad81204
https://www.google.com/maps/place/Spring+Creek+Sports+Club/@37.991242,-78.2132756,17z/data=!4m13!1m7!3m6!1s0x89b3f4199bce4aa1:0x759e673a1ad81204!2s109+Clubhouse+Way,+Gordonsville,+VA+22942!3b1!8m2!3d37.991242!4d-78.2110869!3m4!1s0x0000000000000000:0x63894b5dba5af014!8m2!3d37.9923906!4d-78.2094598
https://www.google.com/maps/place/Spring+Creek+Sports+Club/@37.991242,-78.2132756,17z/data=!4m13!1m7!3m6!1s0x89b3f4199bce4aa1:0x759e673a1ad81204!2s109+Clubhouse+Way,+Gordonsville,+VA+22942!3b1!8m2!3d37.991242!4d-78.2110869!3m4!1s0x0000000000000000:0x63894b5dba5af014!8m2!3d37.9923906!4d-78.2094598
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DIRECTIONS TO UVA AQUATIC AND FITNESS CENTER) 
 

The UVa Aquatic and Fitness Center was the PREVIOUS location of JSL Champs. 

 

 Enter into your GPS 
 450 Whitehead Rd 

 Charlottesville, VA 22904 
 
 

 

 Diving 
   ALLOWED 
  at both ends 

 
 
 

  Aquatic and Fitness Center 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
MAP KEY 
1 = Permit & Handicap 

Parking ONLY 
2 = Permit Parking Only 
3 = OPEN Parking 
4 = Team Tents ONLY 
 

Vehicles improperly 
parked are subject 
to towing. 

 
 

 
 
 

Specific parking information will be available before the Championship. 
  

https://www.google.com/maps/place/Aquatic+and+Fitness+Center,+450+Whitehead+Rd,+Charlottesville,+VA+22904/@38.0329055,-78.5156654,17z/data=!3m1!4b1!4m5!3m4!1s0x89b3865bc0820d87:0x6f0739ff1858ccea!8m2!3d38.0329055!4d-78.5134767
http://recsports.virginia.edu/?q=aquatic-and-fitness-center-pool
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DIRECTIONS TO BROOKS FAMILY YMCA 

The Brooks Family YMCA is the location of the annual JSL Championship. 

 
 

 Enter into your GPS 
 151 McIntire Park Dr 

 Charlottesville, VA 22902 
 
 

 

Diving NOT 
ALLOWED at 
non-block end 

 
 
 

  Brooks Family YMCA 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
MAP KEY 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Specific parking information will be available before the Championship. 
 

 

  

https://www.google.com/maps/search/Restaurants/@38.0480083,-78.4803596,16.2z/data=!4m7!2m6!3m5!2sBrooks+Family+YMCA!3s0x89b387e507bf15b1:0x7a431fb2a8f8bcee!4m2!1d-78.4782503!2d38.0492815?hl=en&authuser=0
https://piedmontymca.org/
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This manual, originally written for Hy-Tek’s Team Manager 4.0 and Meet Manager 2.0, was 
printed to assist JSL clubs in the operation of Hy-Tek’s Team Manager 6.0 and Meet Manager 3.0 
programs.  Additional copies may be photocopied or downloaded and printed from JSL Software 
Support.  Complete Hy-Tek User Guides may be downloaded from Hy-tek User Guides.  The 
instructions in this JSL manual were written with the assumption that the reader has basic 
computer skills and knowledge of Windows-based programs.  Such procedures as copying files, 
Internet access, downloading, etc. are beyond the scope of this manual and have been omitted to 
keep the size reasonable. 
 
The manual was originally written by Jessica Simons in 2001, revised in 2005, and again in 2007, 
with the hope that all teams could benefit from her knowledge of these two programs.  
Operational questions may be directed to her at jrsimons@comcast.net, (434)-295-1582 (H) or 
434-962-0443 (C).  Suggestions for expansion, improvement, or correction of this manual should 
be directed to Bob Garland (bgarlandjr@gmail.com) 

 
  JSL Team Manager User Manual 
 (All changes for current season are highlighted) 
Page   1 I Setting up a Team Manager Database 
Page   3 II Setting up Teams 
Page   4 III Setting up an Athlete 
Page   6 IV Standards 
Page   6 V Records 
Page   7 VI Setting Up Meets 
Page   8 VII Entering Swimmers in a Meet 
Page 10 VIII Administrative Reports 
Page 10 IX Performance Reports 
Page 15 X Creating Labels 
Page 17 XI Creating a Back-up of Your Database 
Page 17 XII Importing Commlink Files 
Page 19 XIII Exporting Commlink Files 
 
  JSL Meet Manager User Manual 
Page 21 I Creating a New Meet 
Page 21 II Configuring the Meet 
Page 22 III Setting Up a New Meet 
Page 22 IV Setting Up Athlete/Relay Preferences 
Page 23 V Setting Up Report Preferences 
Page 24 VI Setting Up Entry/Scoring Preferences 
Page 25 VII Setting Up Scoring 
Page 25 VIII Setting Up Events 
Page 27 IX Downloading the Opposing Team’s Meet Entry Files 
Page 27 X Importing Commlink Files 
Page 28 XII Entering Athletes 
Page 28 XII Adding Relays 
Page 29 XIII Seeding the Meet 
Page 29 XIV Creating Heat Sheets and Time Lines Report 
Page 30 XV Creating Coaches’ Report 
Page 31 XVI Creating Entry Card Labels 
Page 31 XVII Running the Meet 
Page 34 XVIII At Meet’s End – creating Meet Results 
Page 34 XIX Creating a Meet Backup 
Page 35 XX Uploading Meet Results 
Page 35 XXI The Daily Progress AP News Format 
Page 36 XXII Post Meet Reports (if needed) 
 
APPENDIX T Computer Operators Checklist 

 

https://www.jsl.org/support2020.php?section=computers&content=softwaresupport
https://www.jsl.org/support2020.php?section=computers&content=softwaresupport
https://hytek.active.com/downloads.html
mailto:jrsimons@comcast.net
mailto:bgarlandjr@gmail.com
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JSL Team Manager User Manual 
 

Conventions 
 

All standard text and explanations are in Times New Roman Font, Size 10 pt 

All standard Sections and Topics are in Times New Roman Font, Bold Size 14 pt 

All Team Manager Menu Items or selectable choices are in Arial Font, Bold Size 10 pt 
All recommended selected or text entry values are in Arial Font, Bold Italic Size 10 pt 

All warning, cautionary, or very important labels is in Arial, Bold Size 12  

All text expressing strong emphasis are in Times New Roman Font, Size 12 pt or Size 14. 

> designates a fly-out, drop-down, or other additional menu options in Arial, Bold Font, Size 10 pt 
All Screen or Window names are in Times New Roman Font, Bold Italic Size 10 pt 

All URLs are in Times New Roman Font, Underlined Size 10 pt 

 

I. Setting Up a Team Manager Database 
 

A. Click on File > Open New. This takes you to the Open Existing or Create New 
Database input box. 

 

1. Type in the name of the database (example: “CGST Swimming”) and press Enter on 

the keyboard. This then takes you back to the main Team Manager screen.  

 

2. Go to Setup > Preferences > System Preferences and press Enter. 

 

3. Under Preferences, select your preferred Gender Designation. 

 

4. Under Athlete Browse Options, check the options Show Ages, Show Birth 
Date and select Last Name First.  Leave Show School Year and First Name 
First blank.  Leave “Faster than” Time STD/Qualifying Times blank as well. 

 

5. Under Relay Lead-Off Splits, uncheck Use Relay Lead Off Splits. 

 

6. Under Stroke Rates, uncheck Enable Stroke Rate Reporting. 

 

7. Under Automated Reminders, chose whatever you prefer. 

 

8. Under Team/Swimmer Defaults, set the following default values as follows: 

 

• Set Default Team Registration to “USS”  

• Set Default Team Type to “Age”  

• Leave Default Country blank 

• For Default LSC, select “Virginia”  

• For Default State, select “Virginia”  

 

9. Under Meet Age-Up Date, ALWAYS select “June-01” of the current year. This 

is the third listed item. 

 

10. Under System Age Update, ALWAYS select “June-01” of the current year. 

 

11. Click OK. This takes you back to the main Team Manager screen. 
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B. Go to Setup > Preferences > Report Custom Age Groups and press Enter. 
 

1. Click Add. This opens the Define Custom Age Groups for Reports dialogue 

box. This is where you create each JSL Age Group and define the appropriate low and 

high ages within each group. 

 

2. Under Custom Age Group, enter the following: 

• Low Age with the appropriate “age”. 

• High Age with the appropriate “age”. 

 

3. Click OK to create a new Age Group. The Define Custom Age Group for 
Reports dialogue box now opens. 

 

4. This is where you select/define which events this new age group can swim. Check the 

appropriate Stroke and Distances that apply. 

 

5. Click OK.  Everything entered so far will now show in the left hand column. 

 

6. Repeat Steps 1 through 5 above for each Age Group. 

 

7. When finished, return to the main Team Manager screen by clicking on return  (the 

small yellow folder with an up arrow found near the left-top of the page). 

 

 

C. Go to Setup > Preferences > Report Preferences and press Enter 

 

1. Under Report Headers, enter the following: 

• Header 1: Enter whatever text you want (example: “Boar’s Head Swim 
Team”) 

• Header 2: Enter whatever text you want (example: “2007”) 

 

2. Under Punctuation, choose the options that you prefer. 

 

3. Under Label Types, make appropriate selections. 

 

4. Suggestion: Set the # of copies to printer to “1”. 

 

5. Click OK, and you are returned to the main Team Manager screen. 

 

 

D. Go to Setup > Favorite Filters and press Enter. 

 

1. Under Favorite Defaults, click Add. 

2. Enter the following: 

• Favorite Name: Enter whatever text you want (example: “Boar’s Head 
Swim Team”). 

• Team: Enter whatever text you want (example: “2007”). 

 

3. Under Preset Season Since and Until Dates, check Use Start Date, then click 

on the Season Start Date down arrow  , which open up a calendar to allow you to 

pick a date. 

 

CAUTION:  Any team choosing to hold an inter-squad practice meet needs to make sure that the date 

selected for Times Since (found in Favorite Filters above) is set for one day later than the inter-squad 

meet to prevent the use of unauthorized times which will incur JSL penalties.  
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4. Click on  (the little red heart) to finalize the Favorite Defaults. 

 

5. Click OK, and the chosen favorite is now highlighted on the screen. 

 

6. When finished, return to the main Team Manager screen by clicking on the  

return  icon (the small yellow folder with the up arrow near the left-top of 

the page). 

 

 

E. Go to Setup > Groups/ Sub Groups/ Codes and press Enter. 

• Entries for Groups and Meet Types is optional and not required for JSL Meets. 

Using this option is totally up to the individual teams and has no effect on anything. 

• Click OK. 

 

F. Go to Course Conversion 

• DO NOT CHANGE THESE VALUES. The JSL requires these default 

values. 

 

G. Go to Athlete Custom Fields 

 

1. Custom fields are defined by the user to track up to three pieces of information about 

athletes that are not one of the predefined Team Manager fields. These are totally 

optional entries and have no effect on JSL meets. 

 

2. Click on OK to return to the main Team Manager screen. 

 

 

II. Setting Up Teams 
 

A. From the main Team Manager screen Teams. The Teams Browser screen opens. 

 

1. Click Add. The Team Maintenance window opens. 

 

2. Under Team Names/Registration, 

• Fill in Team Code (examples: “KWC”, “LMST”, “ACAC”) 

• Fill in the full Team Name (examples: “Key West Club”, “Lake 
Monticello Swim Team”, “Atlantic Coast Athletic Club”) 

• Fill in the Short Name (examples: “KWC”, “LMST”, “ACAC”) 

• Select “USS”  from the Team Registration drop-down menu. 

• Select “AGE”  from the Team Type drop-down menu. 

 

3. Under Mailing Information 

• Fill in text at your discretion. 

 

4. Under Telephone Information 

• Fill in text at your discretion. 

 

5. Click OK. This returns you to Teams Browser screen. 
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B. From the Teams Browser screen, click Edit 

• Use this screen to edit any changes to your team setup. 

• Click OK to return to the Teams Browser screen. 

 

C. From the Teams Browser screen, click Delete 

• Use this screen to delete a team. 

• All athletes and relays will also be purged. 

• All meet results for that team will be purged. 

• Click OK to return to the Teams Browser screen. 

 

D. From the Teams Browser screen, click Results 

• Use this screen to access all results for all team menders from all meets. 

• Click OK to return to the Teams Browser screen. 

 

E. From the Teams Browser screen, click Coaches 

• Use this screen to add your coach’s information if so desired. 

• Click OK to return to the Teams Browser screen. 

 

F. From the Teams Browser screen, ignore Maintenance 

 

G. Click return  to return to the main Team Manager screen.  

 

 

III. Setting Up an Athlete 
 

A. From the main Team Manager screen, select Athletes. 
  

1. Select Add to open up the Athlete Information window. 

 

2. Fill in the appropriate information as follows: 

• Fill in Last Name. 

• Fill in First Name. 

• Fill in Middle (initial only for the JSL). 

• Fill in Preferred Name. 

• Fill in Birth Date. 

• Age will automatically be computed.  

• Click Build ID.  

• Enter Gender (enter “M” of “F”). 

• Select Team from drop-down menu. 

• If Group or Sub-Groups have been set up in system preferences, select 

from the Group drop-down menu.  

• Leave Subgroup, WM Group, WM Subgroup and School Year 

blank. 

 

3. Ignore Registration. 

 

4. Ignore Recruiting. 

 

5. Click on Primary Contact 

• This is optional. Fill in any information that the team requires. 

• If the information for a sibling has already been entered, select sibling 

information and all the previous sibling information will appear. 
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6. Click on Secondary Contact 

• This is optional. Fill in any information that the team requires. 

• If the information for a sibling has already been entered, select sibling 

information and all the previous sibling information will appear. 

 

7.  Click on Medical 

• This is optional. Fill in any information that the team requires. 

• If the information for a sibling has already been entered, select sibling 

 information and all the previous sibling information will appear. 

 

8.  Click on Custom 

• This is optional. Fill in any information that the team requires. 

• If the information for a sibling has already been entered, select sibling 

information and all the previous sibling information will appear. 

 

9.  Click OK to return to main Athlete screen. 

 

10. Edit will now allow the database manager to change information on the highlighted 

athlete. 

 

11. View – Ignore this option 

 

12. Delete  

• Delete will erase all the individual athlete's information and results.  Only use 

delete under the most extreme circumstances.  Information once deleted 

cannot be retrieved. 

 

13. Results - will bring up all the results previously entered for the highlighted athlete. 

• Standards will only apply to JSL Teams using Gold/Silver Standards. Select 

the imported JSL Time Standard (see Section IV on page 6 for details). 

• Course – select the appropriate meet venue (for Gold/Silver or any 

Gold/Silver team swimming out of their division). 

• Show Standards – if using Gold/Silver time standards you must check 

Show Standards. Other options now open above that need to be checked as 

follows: 

• Check Show Standards based on current age. 

• Show Conversions – leave blank (the default). 

• Since Date – use this to show results from a particular date. If you choose 

this option, you must click Use Since Date below. 

• Use Since Date – If you chose the Since Date option above, check the Use 
Since Date for Improvement and fill in “Jun-01” of the appropriate year. 

 

CAUTION:  Any team choosing to hold an inter-squad practice meet needs to make sure that the date 

selected for Times Since (found in Favorite Filters above) is set for one day later than the inter-squad 

meet to prevent the use of unauthorized times which will incur JSL penalties.  

 

• Chronological – leave blank. 

• Show Goals – leave blank. 

• Fastest – click to display only fastest times. 

• Stroke – click to display only that stroke. 

• Distance – click to display only that distance. 

• Meet Type – leave blank. 

 

14. Click on the return icon  to return to the main Athlete screen. 
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 B. If the database manager is using a previous years' database, then-- 

 

1. Go to Athletes. 

 

2. Determine if all the athlete information, including contact and registration information, is 

correct.  Update as necessary. 

 

3. If the athlete is no longer on the team, click Inactive. 

• All the historical information for that athlete remains in the database. 

• This can always be retrieved and included by clicking Include inactive on all 

reports. 

• This information will not show up on any reports for active swimmers. 

 

IV.  Standards 
 

 A.  This applies only to teams using Gold/Silver Time Standards which are no longer used. 

 

 

V.  Records 
 

 A.   On the Records screen, the database manager can add, edit, delete, open, create and copy a 

record file. 

 

1. From the main Team Manager screen Records > Add/Edit. 
 

2. Click on Records > Create New Record Set. 
 

3. The Create New Record File window opens. 

 

4.  Enter the following information: 

• Record Name (example: “Pool Record” or “Team Record”). 

• Course (select appropriate course). 

• Year (record for the year entered). 

• Description (optional information). 

• Identifying Flag (for reports) - pick a character to be used to indicate a record 

that has just been broken. 

• Click OK takes you back to the Main Records Screen. 

 

5.  Select Add to open the Add/Edit Record window. 

• Under Age Group, select the appropriate Age Group. 
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• Select the Distance. 

• Select the Stroke. 

• Select the Gender. 

• Leave Actual as set (the default). 

• Select Individual or Relay. 

• Fill in Record Holder's information. 

• Enter the Time/Score, Date Set, and leave the Team and LSC blank. 

• Click OK to return to the main Records screen. 

• Click on the return icon to return to the main Team Manager screen. 

 

VI .  Setting Up Meets 
 

A. From the main Team Manager screen, select Meets. 

 

1. Go to Add to open the Meet Maintenance screen. 
 
2.    Under Meet Information, 

• Fill in the Meet Name. 

• Fill in Location (optional). 

• Fill in Remarks (optional). 

• Fill in Instructions/Directions (optional). 

• Select Course,  
o Select “Y”, “L”, or “S”. 

o Do Not Select  “YO”, “LO”, or “SO”. 

• Select Meet Type (optional), 

o Leave Sanction Number blank. 

• Leave Enforce Qualifying Times blank. 

• Leave Altitude in Feet blank. 

• Leave Minimum Age Eligibility blank. 

 

3.   Under Dates, 

• Select the Start Date. 

• Select the End Date. 

• Age Update will always be “June-1” of the current calendar year. 

• Click Use Since Date, 

o Fill in Used Time Since Date.  

 

CAUTION:  Any team choosing to hold an inter-squad practice meet needs to make sure that the date 

selected for Times Since (found in Favorite Filters above) is set for one day later than the inter-squad 

meet to prevent the use of unauthorized times which will incur JSL penalties.  

 

4.    Under Entry Fees – leave all blank. 

 

5.    Under Conversion Factor – leave Non-Conforming Course Factor blank. 

 

6.  Click OK which returns you to the Meet Browser screen. 

 

7. Click on Edit, 

• Allows the database manager to make changes for a particular meet. 

 

8. Click on Delete, 

• This will delete all results for the selected meet.   

• This is not reversible. 

• Only choose this option under extreme circumstances. 
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9. Click on Events, 

This will list all the meets in the database. If the database manager is using a database 

from a previous year, all the meets from the previous year/s are accessible. 

• The Copy Events option can be used. 

• Select a Meet that has the same event order. 

• Select All Events from Copy Options. 

• Do not select Also Copy Entries. 

• Click OK. 

o The program now displays the number of entry events copied. Click 

Close.  This returns you to the Events for the Meet screen. 

• Click on return to return to Meet Browser screen. 

 

10.  If there is no existing historical database, click on Events. 
 

11. Click on Add to add new events to the meet. 

• Select Individual or Relay. 

• Select Gender. 

• Select Alternate Gender. 

• Leave Session/Division blank. 

• Select Age Range. 

• Select Distance. 

• Select Stroke. 

• Do not select Qualifying Times. 

• Do not click Import All 3 Courses. 

o Click OK to the Main Event screen. 

 

12. To Edit an Event. 

• Click on Edit to go to the Meet Event Maintenance screen. 

• Change Event, Gender, Age, Distance, or Stroke. 

• Click OK once all changes have been made. 

• On Event Updated window, Click OK. 

• Click on the next event icon  to edit the next event. 

• Click on the previous event icon  to edit the previous event. 

• Click Cancel to get out of this screen. 

• Click on Delete to erase an event and all entries for that event. 

• Click Print to generate a Meet Event Report.  

• Click  to send the report to the printer. 

• Click OK which prints the report. 

• Click  to return to the Events screen. 

• Click  to return to the main Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 

VII.  Entering Swimmers in a Meet 
 

A. From the main Team Manager screen. 
 

B. Select Meets. 
 

1. Highlight the appropriate meet. 
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2. Select Entries > Entries by Name or Entries by Event. 

• Entries by Name will show all events that the selected athlete is eligible to 

swim. 

• Relays cannot be entered using this option.  Only athletes can be entered with this 

option. 

• Select Gender. 

• Select Team. 

• Leave School Year, Group, Sub Group, WM Group and WM Sub Group 

blank. 

• Select Low Age and High Age. 

• A selection indicator  will appear on the left and the chosen athlete will be 

highlighted in blue. 

o Place a check in each event entered for that swimmer in the bottom 

window. 

o As each event is checked, that event will be highlighted in yellow. 

• When finished with all the entries, click on to return to the main Meet screen. 

 

3. Entries by Event will show all the athletes who are eligible to swim the chosen 

event. 

• Select the desired event for entries. This event will turn blue.  

• From the options below the Events window, select Team for entries by team. 

• Leave School Year, Group, Sub Group, WM Group and WM Subgroup 

blank. 

 

4.  For Individual Events, 

• Leave Show Swim Up Athletes unchecked and Only Athletes Already in 
Meet unchecked. 

• Clear All will clear all the entries in the selected event. 

• Enter All will enter all the eligible athletes in the selected event. 

• Click the next event icon  to proceed to the next event. 

• Click the previous event icon  to return to an earlier event. 

 

5.  For Relay Events, 

 

IMPORTANT: Relays can only be entered using the Entries by Event option. 

 

• Select the desired relay event for entries. This relay will turn blue.  

• From the options below the Events window, select Team for relay entries by 

team. 

• Leave Show Swim Up Athletes unchecked, and check Only Athletes 
Already in Meet. 

• Leave School Year, Group, Subgroup, WM Group and WM Subgroup 

blank. 

• Click on New Relay to add a new relay. 

• All eligible athletes can be seen on left-hand side of screen under the Event 

Description. 

o The "A" relay will automatically be shown on the right hand 

side of the screen highlighted in yellow. 

o Check Only Athletes Already in Meet. 
o Click on Find Best Relay. This will automatically place the 

4 fastest swimmers already entered in the meet in order, fastest  
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o to slowest, in the relay swimmers frame. 

o A time for the relay will automatically appear under Custom 
Time. 

• Click on Best Relay Report. This shows the best relay order of swimmers already 

entered in the meet.  Coaches usually never follow this order. 

• This report can be printed out to give to the coaches. 

• Use Clear Swimmers to remove the swimmers from the relay. 

o The program will ask if each swimmer is to be removed 

individually. 

o The time computed for that relay will remain. 

• Click on New Relay to add additional relays to that event. 

• Click on return when all entries have been entered. This takes you back to the 

Meet Browser screen. 

• Click on to return to the main Team Manager screen.  

 

 

VIII. Administrative Reports 

 
A. Return to the main Team Manager screen. 

 

B. Select Reports > Administrative. 
 

1. Click Athletes - A roster of all your active athletes can be generated here, 

• By Name. 

• By Contact Information. 

• By Telephone Number. 

• Attendance Lists can be generated here. 

• Mailing Labels for team mailings can also be generated. 

 

2. Athletes can be selected by name, team, age or gender, 

• Select the Team. 

• Select Group, Subgroup if desired. 

• Select Gender. 

• Select Age Group if necessary. 

• Do not include Inactive Athletes. 

 

3.  Click Create Report, 

• Teams - this will show how many teams you have in your database. 

 

 

IX. Performance Reports 
 

A. Return to the main Team Manager screen. 

 

1. Select Reports > Performance. 

 

2. From the Fly-Out Menu, select the report option you want to work on. Typical reports 

used from this Fly–Out are Top Times, Top Times Spreadsheet, Meet Results, 

Meet Entries, Meet Entries Spreadsheet, and Record Match.  

 
B.  To Generate a Top Times Report 

 

1. From the main Team Manager screen, select Reports > Performance > Top Times. 
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2. Under Meet, select All Meets. 

• Leave default for Prelims/Finals and Splits. 

• Select the Team. 

• Select Gender. 

• Select Age. 

• Click Age Group and check Use Custom. 

• Ignore Include. 

• Under Course Options, check the course as follows: 

o Database mangers in short course meet pools should select “SS”. 

o Database mangers in yard pools should select “YY”. 

o Database managers in long course meter pools should select “LL”. 

• Ignore Stroke Distance Filters. 

 

3. Under Dates, if you are working with a historical database make sure to enter “June-1” 

of the current year in the Use Times Since box. 
 

CAUTION:  Any team choosing to hold an inter-squad practice meet needs to make sure that the date 

selected for Times Since is set for one day later than the inter-squad meet to prevent the 

use of unauthorized times which will incur JSL penalties.  

 

4.  Under Sort by, check Event (Current Age). 
 

5.  Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 

• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 
C.  To Generate a Top Times Spreadsheet Report 

 
1. From the main Team Manager screen, select Report > Performance >Top Time 

Spreadsheet.  
This report saves paper and is the best report to give a coach in order to do the meet line -

up for an upcoming meet. 

 

2. Under Meet, select All Meets and, 

• Leave default for Prelims/Finals. 

• Select the Team. 

• Select Gender. 

• Select Age. 
  

3. Click Age Group and check Use Custom. 
 

4. Under Course Options, check the course as follows: 

• Database mangers in short course meet pools should select “SS”. 

• Database mangers in yard pools should select “YY”. 

• Database managers in long course meter pools should select “LL”. 
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5. Under Dates, if you are working with a historical database make sure to enter “June-1” 

of the current year in the Use Times Since box. 

 

CAUTION:  Any team choosing to hold an inter-squad practice meet needs to make sure that the date 

selected for Times Since is set for one day later than the inter-squad meet to prevent the use of 

unauthorized times which will incur JSL penalties.  

 

6.  Under Filters, leave Meet Type blank.  Check Include Swimmers with NO 
Results only. 

 

7. Under Sort by, check whichever option is best suited for your team.  

 

8.  Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 

• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 

 
D.  To Generate a Meet Results Report 

 

 1.  From the main Team Manager screen, select Report > Performance > Meet Results. 
 
2.  Under Meet, select the meet you want to print the results for. 

 

3. Under Filters, 

• Select Team. 

• Select Gender. 

• Select Age. 

• Leave default for Prelims/Finals and Splits. 
 

4. Under Include uncheck Personal Best Only and uncheck Include Relay Lead Offs. 
 

5. Under Event Filters, make the appropriate selection for your team. 
 

6. Under Improvement,  

• If you are using a new database, uncheck Use Since Date for Improvement. 

• If you are using a database from precious years, check the Use Since Date for 
Improvement and fill in “Jun-01” of the appropriate year in the since date for 

improvement space. 

 

7. Check Use Converted Times for Calculating Improvements. 

 

8. Click Standards. For teams using Gold/Silver scoring, select the JSL Gold Time 

Standard for the current year, check Include Time Standards and uncheck Include 
Only Improved STD. 
 

9. Under Sort by, 

• Check Meet Event Number. 
 

10.  Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 
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• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 
E.  To Generate a Meet Entries Report 

 
1.  From the main Team Manager screen, select Report > Performance > Meet Entries 
 
2. Under Meet, the name of the meet, for which the database manager has entered the most 

current entries, will appear. 

 
3. Under Filters, 

• Select Team. 

• Leave Group, Subgroup, WM Group, WM Subgroup, and School Year 

blank. 
4. Check Totals on Separate Page. 

 

5. Leave Include Registration ID, Include Inactive, and Include Official Statement 
unchecked. 

 

6. Under Other Options, 

• Check Include Proof of Time only.  

 

CAUTION: This helps keep the use of times from previous years which is a JSL violation and subject to 

penalties from occurring. 

 

7.  Under Filters, 

• Select Gender. 

• Select Age. 
 

8.  Under Stroke/ Distance Filters,  

• Ignore Stroke and Distance. 
  

9.  Under Event Filters, check Individual, 

• Ignore Standards and Points. 

• Select Age Group. 

 

10.  Under Sort by, check the appropriate report format. The following information is 

provided to help you select the best option for your team: 

• Meet Event Number – this will generate a report of entries by each event number 

and include all swimmers entered in that event from fastest to slowest.  

• Meet Event Heat/Lane – no one normally uses this format. 

• Meet Event Number (1 per page) - is normally not used. 

• Meet Event Heat/Lane (1 per page) - is normally not used. 

• Name - this is a good way to give the each age group coach a report for the entries 

for his/her swimmers only. 

• Age - is normally not used. 

• Name (1 Swimmer per Page) - this will generate an individual report for each 

swimmer that the coaches can hand out before the meet if they so choose. 

• Stroke and Distance - is normally not used. 

 

11.  Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 
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• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 
F.  To Generate a Meet Entries Spreadsheet 

 

1. From the main Team Manager screen, select Report > Performance > Meet 
Entries Spreadsheet. 

 
2. Under Meet, select the appropriate meet. 

 

3. Under Filters, leave Group, Subgroup, WM Group, WM Subgroup, and 

School Year blank. 

• For GEN (Gender), check All. 

• Leave Include Inactive and Include Relays unchecked. 

 

4.  Under Filter Options, leave all options unchecked. 

 

5.  Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 

• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 

. 

G.   To Generate a High Point Report 

 
1. From the main Team Manager screen, select Report > Performance > High Point 

Reports. 
 

2. Under Meet, select All Meets,.  

• Leave Meet Type blank. 

• Choose the number of Top Swimmers to be included in the report using Top 
How Many?. 

• Click Since Date.  If you are using a historical database fill in “Jun-01” of 

the current year in the Only Results Since box. 

 

3. Under Athletes Filter,  

• Select Team. 

• Leave Specific Group, Specific Subgroup, Specific School Year, and 

Include Inactive blank. 

 

4.  Under Gender, check the report type you prefer. 

 

5. Under Age, fill in appropriate Low Age and High Age. 

 

6.  Under Relay Options, if your team includes relay points for high points, check 

Include Relay Points. 

 

7. Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 

• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 
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H.  To Generate a Record Match Report 

 
1. From the main Team Manager screen, select Report > Performance > Record 

Match. 
 

2. Under Meet, select All Meets. 
 

3. Under Athlete Filters,  

• Select Team. 

• Leave Group, Subgroup, WM Group, WM Subgroup, School Year, 

and LSC blank. 

 
4. Under Gender, check the preferred report type. 

 

5. Under Stroke Distance Filters, ignore all except Equal, which should be checked. 

 

6. Under Dates,  

• If you are using a new database, uncheck Use Since Date. 

• If you are using a historical database, check the Use Since Date and fill in 

“Jun-01” of the current year in the Use Times Since box. 

 

7. Click Filters and under Event Filters, check either Individual or Relay. Leave 

Meet Type blank and leave “1” in Check Top How Many per Athlete. 

 

8.  Click Records and select the appropriate record.  Uncheck Show Ties with Current 
Record (the default).  Leave Update Records blank. If checked, this will 

automatically update the records before you can visually inspect them and they may be 

in a different format than you would like.  By printing the report, you can check to make 

sure no mistakes have been made and then return to this function and use it. 

 

9.  Under Sort by, check the option that best suits your team. 

  

10.  Click Create Report,  

• Click  to send the report to the printer. 

• Click OK to return to the previous screen. 

• Click  to return to the Meet Browser screen. 

• Click  to return to the main Team Manager screen. 

 

X. Creating Labels 
 

A.  Award labels 

 

1. From the main Team Manager screen, select Labels > Award.  

You will not need to print award labels from Team Manager, as you will come home 

from the meet with the awards for your team done from Meet Manager. 

 

B. Entry Labels 

 

1. From the main Team Manager screen, select Labels > Entry. 
You will not need to print entry labels, as this is the responsibility of the host team and 

is done from Meet Manager. 
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C. Improvement Labels 

 

1. From the main Team Manager screen, select Labels > Improvement. 
 
2.  The Improvement Labels screen opens. 

 

3. Under Meet,  

• Select the applicable meet. 

 

4. Under Filters, 

• Select Team. 

• Leave Group, Subgroup, WM Group, WM Subgroup, School Year 

blank and uncheck Include Inactive. 

• Click on GEN (Gender) and check All (the default). 

• Click Age and enter the appropriate number in Low Age and High Age. 

• Ignore Sess/Div. 

 

5.  Under Prelims/ Finals Filter, 

• Check Best (the default). 

 

6.  Under Label Types, 

• Select the appropriate label option. 

 

7.  Under Include,  

• Check First Time Swims at the discretion of your coach. The minimum 

improvement is set to “.01” as the default. Consult your coach for the time to 

be used by your team. 

 

8.  Under Stroke/ Distance Filters, 

• Leave Stroke and Distance blank. 

 

9.  Under Improvement, 

• Those using a new database should leave Since Date for Improvements 

blank. 

• Teams using a historical database will fill in “June-01” of the current year 

and check Use Since Date for Improvement. 

• Check Use Converted Times for Calculating Improvement. 

• Uncheck Show Improvement as Percent (the default). 

 

10.  Under Restrict Improvement to Meet Type, 

• Leave Meet Type blank. 

• Ignore the Standards and Points tabs. 

 

11.  Under Sort by, 

• Check Name. This will set up for printing of all the time improvement labels 

for each swimmer (girls and boys) alphabetically. 

 

12.  Click Create Report, 

• Print preview of the labels appears on screen. 

• Click the printer icon  to send the report to printer. 

• After print job is complete, click on  to return to the Improvement Labels 

screen. 

• Click Cancel returns you to the main Team Manager screen. 
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XI. Creating a Back-up of Your Database 
 

1. From the main Team Manager screen, select File > Backup, 

• Under Backup Drive, select the backup drive that you want.  This is usually 

your C: hard drive and/or a USB Flash Drive. 

• Under Backup Directory, select the backup directory you want to use. 

• Under Enter Comments for the Backup, add any information you deem 

appropriate. 

  

2.  Click OK.  

• It is recommended that you make two (2) backups just in case and that you 

backup after each time you use the database. 

 

 

XII. Importing Commlink Files 
 

A.  Importing Meet Results 

 
1. From the main Team Manager screen, select File > Import > Meet Results. 

 You will use this function after returning from a meet with your team's meet results in a 

Commlink file on a flash drive. 

 

2.  Under Look in: browse to the drive and folder where the appropriate meet result file is 

stored (example: “USB Disk (F:) Meet Results- ACAC at BHSC July 23, 2007-
001.zip”). Highlight the file and click Open. A Team Manager information window 

opens. Click OK.  This takes you to a new directory (“TM4 Temp”) on your 

computer’s hard drive. Highlight this new file and click Open. This takes you to the 

Import Results screen. 

 

3.  Under Import Criteria,  

• Overlay duplicate results - leave unchecked (the default). Check if you 

are re-importing for a specific reason. 

• Uncheck Add New Teams/Athletes (the default).  

o If there were late additions to the meet and the swimmer's 

information was not the same as what is in your database, you will 

get an exception report.   

o Print the exception report to see what the differences are.  You 

now have 2 options. 

▪ First Option - hand enter that swimmer's results. 

▪ Second Option - import the Commlink file again, this 

time check Add New Teams/Athletes. 

• This will import the new athlete and you can 

then merge this athlete with the existing one in 

your database. 

• Make sure you make the changes to the new 

athlete so that it matches the information in your 

database and answer “Yes” to the merge option. 

 

3.  Check Import Relays (the default). 

• Uncheck Import Splits for Individual Results. 

• Uncheck Save Relay Lead Off as Result  - a JSL requirement. 

• Leave Use From Date and Use Thru Date unchecked. 

• Leave One LSC blank. 

• Enter your team in One Team (example: “ACAC”, “KWC”, “FAST”). 

• Leave Import for Time Standards at Least unchecked and the box should 

be kept blank. 
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4.  Under Import Statistics,  

▪ Meets will display “1”. 

▪ Teams will always be “2”. 

▪ Individual Results will be the total number of individual swims for both 

teams. 

▪ Relay Results will be the total number of relays swims for both teams. 

▪ Splits will only appear for teams having automatic timing systems (currently 

only FCC and FAST). 

 

5.  Under Course, leave All Courses checked (the default). 

 

6.  Click OK. 

 

 
B.  Importing Meet Events 

 

1. From the main Team Manager screen, select File > Import > Meet Events 

 You will use this function only when a meet event entry file has been sent to you by 

the host team. This opens the Import Events window. 

 

2.  Under Look in: browse to the drive and folder where the appropriate meet event file is 

stored. (example: “USB Disk (F:) Meet Events- FCC at FSBC June 12, 2007-
002.zip”). Highlight the file and click Open. A Team Manager information window 

opens. 

 

 3.  Click OK.  This takes you to a new directory (“TM4 Temp”) on your computer’s hard 

drive. Highlight this new meet events file and click Open. This takes you to the 

Import Events screen.  

 

4.  Click OK. A Team Manager window now indicates how many events have been 

imported. Click OK to close this window.   

 

 
C.  Importing Athlete Rosters 

 

1. From the main Team Manager screen, select File > Import > Athlete Rosters 
The Import Athlete Roosters window opens. 

You can use this function to import athletes from the JSL central database based on last 

years' team. If you are creating a new database, this is the option to use.  

• It will import all of your team's swimmers who were registered last year.  

• You only need to hand enter any new swimmers.  

• You can inactivate any swimmer who is no longer on your team.  

• This will not have any historical content, but if last year's athlete information is 

not available, it will save a great deal of time. 

 

2.  Under Look in: browse to the drive and folder where the appropriate meet event file is 

stored (example: “USB Disk (F:) GLEN-VA-Rooster001.zip”). Highlight the file 

and click Open. A Team Manager information window opens.  

 

3.  Click OK.  This takes you to a new directory (“TM4 Temp”) on your computer’s hard 

drive. Highlight the “HFILE001.HY3” file and click Open. This takes you to the 

Import Athlete Rooster screen. 

  

4.  Click OK.  Check Overlay existing administrative information (the default).  

 

6. Click OK. A Team Manager window now indicates how many athletes have been 

imported. 

 

7.  Click Close.   
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XIII. Exporting Commlink Files 
 

IMPORTANT NOTE: The Meet Entries File created using the procedures below must be uploaded 

to the JSL website at least 2 days before the scheduled meet per the JSL Rules & Regulations, 

(Article VI, 5.) or penalties will apply. See “C.” below for details. 
  

A. Exporting Meet Entries 

 

1. From the main Team Manager screen, select File > Export > Meet Entries. 
 

2. Under Export to Drive, select the drive to which you want to export your meet 

entries.  This is usually a directory on your hard drive and/or a Flash Drive. 

 

3.  Under Export Directory, select the directory to which you want to export your meet 

entries. 

 

4.  Under Entry Export Restrictions, select the Meet, check Export Relays, and 

leave Use Unconverted Times unchecked. 

 

CAUTION: For JSL Championship Meet Entries only, check the Use Unconverted Times option. 

 
5.  Click OK.  A Team Manager information window opens. 

 
6.  Click OK. To view and verify your meet entries before sending, return to the main 

Team Manager screen. 

 
7.  Select Reports > Export/Import Files Report (CL2, HY3, SD3). 

 

8. Under Look in: browse to the drive and folder where the appropriate meet entry file is 

stored (example: “USB Disk (F:) FV-VA-Entries008.zip”). Highlight the file and 

click Open. A Team Manager information window opens.  

 

9. Click OK.  This takes you to a new directory (“TM4 Temp”) on your computer’s hard 

drive. Highlight the “HFILE001.HY3” or “CFILE01.CL2”file (it makes no 

difference) and click Open. This takes you to the Export/Import File Reports 

screen. This information regarding your meet entry file.  

 

10. Click OK.  Team Manager now generates a Meet Entry File Report for individual as 

well as relay events which can now be checked for accuracy.  

 

11. Click the  icon to exit as you would a typical Windows program to return to the 

main Team Manager screen.   
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B. Exporting Athletes 

 
1. From the main Team Manager screen, select File > Export > Athletes/Teams. 

Use this option to export your team's athletes to the JSL central database.  This will 

ensure that your team's athletes are registered with the name that you choose to use.  

This will also save the central database manager a great deal of time and will preclude 

hand entering of athletes. 

 

2.  Under Export to Drive, select the drive to which you want to export your athletes.  

This is usually a directory on your hard drive and/or a Flash Drive. 

 

3.  Under Export Directory, select the directory to which you want to export your 

athletes. 

 

4.  Under Athlete Export Filters,  

• Leave LSC blank 

• Select your Team and check All. 

• Leave Include Inactive Athletes unchecked. 

• Leave Group, Subgroup, WM Group, WM Subgroup, and School Year 

unchecked. 

  

5.  Under Athlete Export Options,  

• Uncheck Include Contact & Group Information (the default). 

  

6. Click OK.  A Team Manager information window opens. 

  

7. Click OK. Then click Cancel to return to the main Team Manager screen. 

 

C. Uploading Meet Entry Files. 

 
1. Using your favorite browser (example: Firefox), go to the JSL Meet Entry Uploads 

on the JSL website. 

 

2.  Read the instructions found there before proceeding so you understand what to do. 

 

3.  In the data entry box provided, browse to the location where you have saved your Meet 

Entries File and highlight it to enter it into the box. 

 

4. Click the Upload button. 

 

5.  A thank you message will display once the upload is completed successfully. If the 

upload cannot be completed for some reason, an error message will be displayed 

instead. In this case you will need to contact the JSL webmaster as soon as possible. 

 

5. Repeat the same procedure above for the Roster File. 

 
 

https://www.jsl.org/general2020.php?menu=meets&section=entries&content=entriesup
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JSL MEET MANAGER User’s Manual 
 

I. Creating a New Meet 
 

A. From the main Meet Manager screen, select File > Open/New. 
 

1. The Open Existing Database or Create New Database window opens. 

 

2. Under File name,  

• Create a new meet by entering the descriptive text for the meet file 

(example: “ACAC@ BHSC 2007”) in the File name box. 

• Ignore File type. 

• Click Open. 

 

3. The  Meet Set-up screen opens. Select the appropriate year and click OK. 

 

4. Fill in Start Date and the End Date.  The Age-up Date is automatically updated.  

 

5. Under Course,  

• Check the appropriate course for the meet. 

 

6. Ignore all other options on this screen. 

 

7. Click OK to return to the main Meet Manager screen. 

 

 

B. Download the pre-formatted JSL Meet Format for the meet. 

 

1. Minimize Meet Manager and using your favorite browser (example: Firefox), go to 

Meet Format Files on the Internet. 

 

2. Select the appropriate meet. Right-click on the file and use “Save Link As” to save the 

format file in a preferred location. 

• From the Save As window, browse to you store location (example: 

“FlashDrive (F:)”). 

• Leave the file name as is and click Save. 

3. Closing your browser and restoring Meet Manager returns you to the main Meet 

Manager screen. 

 

 

II. Configuring the Meet  
 

1. Go to the main Meet Manager screen. 

 

2. Select File > Restore. 

 

3. This opens up the Restore window. 

 

4. Check the Replace currently open database in C:\swmeets\*.mdb option (the 

default). 

 

  

https://www.jsl.org/support2020.php?section=computers&content=meetformatfiles
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5.  Click OK. 

 

6.  The Locate the zipped Backup file and Open it window opens. 

 

7. Use Look in: to browse (if necessary) to the file location and highlight it. 

 

8. Click Open and the Unzip and Replace the Currently Open Database window opens. 

 

9. Click OK and when the Hy-Tek’s Meet Manager window opens, click Yes. 

 

10. The Unzip and Replace the Currently Open Database window opens again, this time 

with a “Restore Completed !” message displayed. 

 

11. Click OK to return to the main Meet Manager screen. 

 

12.  Go to Setup > Meet Set-up, 

• Double-check that the meet restore is correct and most importantly the Age 
Update is “6/1” of the current year. 

 

 

III. Setting Up a New Meet 
 

A. From the main Meet Manager screen, go to Set-up > Meet Set-up. 

 

1. This opens up the Meet Set-up window. 

 

2. The only things needed to be reviewed on this screen are the following: 

• Review Age-Up Date to verify that the date is correct. It should be “6/1” 

of the current year. 

• Under Meet Type, all teams need to check Standard (the default). 

• Under Meet Style, all teams need to check 2 Team Dual. 
 

3. Click OK to return to the main Meet Manager screen. 

 

 

IV. Setting up Athlete/ Relay Preferences 
 

1. Select Setup > Athlete/ Relay Preferences. 
 

2. The Athlete / Relay Preferences window opens. 

 

3. Under Athlete Preference,  

• Only Enter Ages and Enter birth dates should be checked. 

 

4. Ignore all options under Relay Preferences.  

 

5. Under Competitive Numbers,  

• Check Auto increment competitor numbers (the default). 

 

6. Click OK to return to the main Meet Manager screen. 

 

 

  



Jefferson Swim League Computer Manual – Revised July 5, 2024 

[JSL Man – sec 5 computer manual]                                          © 2024 JSL - Team Manual Section V - Page 23 

V. Setting Up Report Preferences 
 

1. Select Setup > Report Preferences 

 

2.  The Report Preference window opens up. 

 

2. Click on the Report Formats tab. 

 

3. Under Athletes /Relays, 

• Check the option List athletes with last name first (the default).  

 

4. Under Teams, 

• Check Suppress LSC team designate.  

 

5. Under Meet Program / Results, 

• Check Suppress results small “x” for score limits.   

 

6. Under Miscellaneous, 

• Ignore all options.   

 

8.  Click on Report Headers tab. 

 

9. For Header 1: fill in the name of the meet (example: “GLEN @ BHSC”) 

For Header 2: fill in the meet location course (“25Y”, “25S” or “50L”), and the 

“date”. 

 

10. Check Show Report Headers Only, i.e. exclude Meet Name listed in Meet 
Set –up. 

 

11.  Click the Punctuation tab. 

 

12. Leave all default options as is. 

• Under Athlete Names, check Upper/Lower Case. 

• Under Team Name, check Upper/Lower Case. 

• Under Record Holder Names, check Leave as is. 

• Under Open Events, check No Designation. 

• Under AP News Export, check Short Team Name. 
 

13. Click the Printer Set-Up tab. 

• Select the Report Printer and Label Printer you are using from the 

drop-down menu of available printers. 

• Check Preview to screen first.  

• Select your Paper Size. 

• In # of copies to printer enter the number of pages to print (usually two 

copies, one for the Table and one to post). 

 

14.  Click OK to save preferences and return to the main Meet Manager screen. 
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VI. Setting Up Entry/Scoring Preferences 
 

1. Select Setup > Entry/ Scoring Preferences. 
 

2. The Entry / Scoring Preferences window opens. 

 

3. Select the Scoring Awards tab,  

 Leave everything the default except: 

• The Maximum scorers per team per event is limited to “2” for 

individuals and “1” for relays. 

• Top how many for award labels is “16” for individual and a minimum of 

“3” for relays. 

• Ignore Special Point System. 

 

4. Select the Entries/ Entry Limits tab,  

▪ Under Entries, leave everything the default except in Entries must have 
been performed on or after:, enter “06/01/20xx”. 

 

CAUTION: Visiting teams should inform the host team if the Times Since Date needs to be modified 

to avoid JSL penalties for the use of invalid times. 

 

Under Entry Limits,  

• Set Maximum entries per athlete including relays to “4”. 

• Set Maximum individual entries per event to “3”. 

• Set Maximum relay entries per athlete to “1”. 

• Check Warn if entry limits exceeded. 

• Ignore Count Relay Alternates (5-8). 
 

5. Ignore Results tab, Flighted Meet tab, and Improvement tab. 

 

6. Select the Time Stds Meet tab,  

  

7. Select the 2 or 3+ Double Dual tab,  

 In the Select Team box  
 

 
 

 click on the red box.  

 

8.  The Double Dual Meet window opens, 

• Click on Select All Combined and a check mark will appear for that 

option. 

• Click on Save to return to the Entry / Scoring Preferences window. 

• Click OK. 
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VII. Setting Up Scoring 
 

1. Select Setup > Scoring Set-up > Standard 
 

2. The Scoring Set-up window opens. 

 

3.  Change the scoring for ALL individual and relay events to the appropriate settings.   

Refer to the JSL Rules & Regulations (Article VI, #2) for the correct scoring. 

 

4. Click OK. 

 

  

VIII. Setting Up Events 
 

1. Select Setup > Events. 
 

2. The Events screen opens.  The events that you downloaded from the JSL web site and 

restored should appear.  If both teams have agreed to make event changes, this is the 

screen where events can be added, deleted, or edited.  

 

3. To add an event, click on Add. 

 

4.  The Add New Event window opens, 

• Enter the Event #. 

• Check Individual or Relay. 

• Under Gender, check the appropriate gender for the event. 

• Under Round 1 – Prelims or Timed Finals, fill in the Number of 
Lanes (1-10) for the pool. 

o Under Assign Lanes, select Standard. 

o Under Heat Order, select Slow to Fast. 
o Ignore Timed Finals. 

o Check Score Event if appropriate. 

 

CAUTION: Events 1P, 21P, 22P, 41P, and 42P must not be scored. Uncheck Score Event for these 

events only. 

o Under Event Type, check Standard. 

• Click OK to save your options and then click the  icon to exit this screen 

and return to the Events Screen. 

 

5.  Select Edit, the Event Edit – xxxxx window opens. 

 

▪ Type in the event number in Event # that you wish to edit. 

 

▪ Make any changes that are required 

 

▪ Click OK to save your options and then click the  icon to exit this screen and 

return to the Events screen. 

 

6.  To delete an event, highlight the event and select Delete. A Hy-Tek’s Meet Manager 

window opens. 

▪ Click Yes if you want to continue with the deletion. 
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7. Select the Session tab to open the Sessions screen. 

• Select Add and the Add New Session window opens. 

o The Session is “1”. 

o For the Session Title enter the day of meet. 

o Day should be set to “1”. 

o Start Time is (duh!) time of meet start. 

o Interval is usually 30 to 45 (time between heats varies, but 30 

seconds is considered a good average for a well-run meet and a worst 

case scenario is 45 seconds). 

o Extra Backstroke Interval is set to “15” (the default). 

o Course should already be automatically selected. 

• Under Max Entries for Meet Events Export to TM, 

o Maximum entries including relays  is “4”. 

o Max individual entries is “3”. 

o Max relay entries is “1”. 

• Click OK, then click on the  icon to exit and return to the Sessions screen. 

• Select Edit to open the Edit Sessions window which is used to make any 

necessary changes (spelling, start time, etc.) as necessary. 

• To delete the session, select Delete. A warning box opens. Click Yes if that 

is really what you want to do. 

 

8. From the left-bottom of the main Sessions screen,  

• Under Event List – (Double Click to Add), double-click each event  in 

the order in which the event is to be swum , to add that event to the Session 
Schedule – (Double Click Evt # to Delete) section on the right-bottom 

of the Sessions screen. 

 

REMINDER:  In Session Schedule, Events 1P is swum first. Events 21P, 22P are swum before Event 

21.  Events 41P and 42P are swum before Event 41. 

 

 

9. From the Sessions screen, select Print, the Sessions Report screen opens. 

• Select All and the session is highlighted. 

• Check Include event start times. 

• Check Include heat and entry count. 

• Leave all other options unchecked. 

• Click Create Report and the report is generated. 

• Click on the printer icon  to send the report to the printer. 

• A copy of this report should be given to the Meet Director to aid in planning 

the meet. 

• Click on the  icon to exit the screen and return to the Session Report 

window. 

• Click on the  icon to exit the Session Report window to return to the main 

Sessions screen. 

• Now click on the return icon to return to the main Events screen.  

 

 

10. From the main Events screen, select Records, the Records screen opens. 

 Records may be imported from Team Manager as follows: 

• Click on Records. 

• Click on Import to open the Import Records window. 

• Locate the appropriate record file and highlight. 

• Click Open and the Select New Tag window opens with the record 

highlighted. 

• Click OK to import the records. The new records are now listed in the bottom-

left section of the Records screen. 

• Click on the  icon to return to the main Events screen. 
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11. From the main Events screen, select Standards, the Time Standards screen opens. 

 From the main Events screen, ignore Combined Events, Comments, Re-Number 
and Clear Indicators. 
 

12. Click on the  to return to the main Meet Manger 2.0 screen. 

 

 

IX. Downloading the Opposing Teams Meet Entry Files 
 

1. Using your favorite browser (example: Firefox), go to the Meet Entries Page on the 

JSL website. 

 

2.  Read the instructions found there before proceeding so you understand what to do. 

 

3. The Meet Entry Files for both teams become available at the same time as soon as 

possible after the 9 PM deadline 2 days prior to the scheduled meet. 

 

4.  In the teams colored rectangular box, the Meet Entry File is available for download 

once the Download Available link is displayed and highlighted. 

 

5.  Simply click on the Download Available link and save the file(s) to your preferred 

storage location. 

 

 

X.  Importing Commlink Files 
 

1. From the main Meet Manger 2.0 screen,  

• Select File > Import > Entries, the Open File for Import screen opens. 

• Highlight the met entry file you want to Import (example: “FAST-VA-
Entries01.zip”). 

• Click Open. 

• The Hy-Tek’s Meet Manager window opens and click OK. 

• The Open File for Import screen opens up again, this time displaying a 

“HFILE001.HY3” file in the “C:\Temp” directory. 

• Highlight this file and click Open. 

• The Hy-Tek Data Interchange File information window now opens. 

  

http://www.jsl.org/general2020.php?menu=meets&section=entries&content=entries
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• Click OK. 

• The Import Entries screen opens, 

o Check Match on event numbers. 

o Check Include entries with No Time (NT). 
o Leave all other options unchecked. 

• Click OK. 

• The Import File Progress screen opens, displaying details of the import and 

indicating that the import is finished. Click OK. 

• Exception handling when they occur: 

o If exceptions are found (wrong ages, etc.) view and print them out to 

determine the exact discrepancy. 

o If necessary, hand enter the athlete and relay information. 

• Repeat the above import procedure for each team entered in the meet. 

 

 

XI. Entering Athletes  
  

1. Use this instruction to add athletes to a meet who were not in the Commlink file. 

  

2. From the main Meet Manger 2.0 screen,  

• Select File > Athletes, the Athletes screen opens. 

 

3. Click Add, the Add New Athlete screen opens.  

• Fill in Last Name, First Name, Middle Initial, Preferred Name (if given), 

Birth Date (if available), Age, Team, and Gender. 

• Click on Build ID to have Meet Manager create the Athlete ID number. 

• The events for which the athlete is eligible will be displayed.  Click on an Event 
#. The event number is added to the left column. Under Entry Time, enter a time 

or “NT” for no time. 

• Repeat the steps above for each event in which the swimmer will be entered. 

• When all the necessary information has been entered, click OK to return to the 

Athletes screen. 

 

4. To edit an athlete, highlight the Athlete’s name and then click Edit which opens the Athlete 

Edit window. 

• Use this menu to correct errors made on athletes (age wrong, etc.). 

• Make required correction(s). 

• Event numbers may change (if age or sex changes). 

• Click OK to save changes and return to main Athlete screen. 

 

5. To delete an athlete, highlight the Athlete’s name and then click Delete which opens  a 

Hy-Tek’s Meet Manager warning window.  

• Click Yes if this is what you want to do and return to main Athlete screen. 

 

 

6. Click on  to return to the main Meet Manger 2.0 screen. 

 

XII. Adding Relays (which were not already imported with the Commlink file) 

 

1. From the main Meet Manger 2.0 screen,  

• Select Relays, the Relays screen opens. 

 

2. Under Relay Events, select the event to which you want to add a relay, 

• Under Double Click Name to Add Relay at the bottom-right of the 

screen.  
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• Under Team double click the team for which you want to enter the relay. 

• In the Relay Designator window, enter the proper letter designator to be 

assigned to the relay (defaults to the next available letter) and click OK. 

• It is not necessary to enter swimmer’s names for the relays at this point.  

 

3. Click  to return to the Main Meet Manager 2.0 screen. 

 

 

XIII. Seeding the Meet 
 

1. From the main Meet Manger 2.0 screen,  

• Select Set-up > Seeding Preferences and the Seeding Preferences 

window opens. 

 

2. Click the Basic tab, 

• Ignore Preliminaries. 

• Under Parameters, check Seed Exhibition athletes last. 

• Under Timed Finals, check Standard. 

• Ignore Non-Conforming Times. 

 
3. Ignore Standard Lanes tab. 

 
4. Click Dual Meets tab, 

▪ Under Lane Assignments, all teams check Use Lane Assignments 
Above. 

▪ This will fill all the lanes leaving no lanes empty.  In the slower heats, team 

members may swim side by side. 

▪ If you select strict even/odd seeding, this will add extra heats and may well have 

competitors swim with empty lanes between them in slower heats. This adds 

extra time to the meet. (This is strongly NOT recommended) 

▪ The host team gives the visiting team even/odd preference. 

▪ A team for the even lanes is selected. 

▪ A team for the odd lanes is selected. 
▪ Optional seating by time requires the agreement of both teams Meet Directors. 

▪ Click OK to return to the Main Meet Manager 2.0 screen. 

  
 
5. From the Main Meet Manger 2.0 screen,  

• Select Seeding and the Seeding the Meet screen opens. 

• Click on Select All and all the events will be highlighted in yellow. 

• Select Seeding and a Hy-Tek Meet Manager window opens advising that 

seeding is completed. Click OK. 

• To preview the Meet Program (Heat Sheet), select Reports, and then Meet 
Program from the drop-down menu. This opens the Meet Program window. 

Click Select All.  Format as desired and click Create Report to view 

and/or print the report. Click  to return to the Meet Program Screen. Then 

click to return to the Seeding the Meet screen.   

• Clicking again returns to the Main Meet Manager 2.0 screen. 

.  

 

XIV. Creating Heat Sheets and Time Lines Report 
 

1. From the main Meet Manger 2.0 screen,  

• Select Reports > Meet Program and the Meet Program window opens. 
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2. Click the Select All selects all the events which are now highlighted in yellow. 

• Ignore Gender, Age Range, Rounds, and Team. 

• Click the Columns Format tab, and select Single, Double, or Triple 

column (triple is best for large teams). 

• Ignore Format. 

• Under Athlete ID, check None. 

• Under Time Stamp, select whichever options best suits your needs. 

• Click the Include in Meet Program tab. 

• Select the options that you want to display in the meet program (example: 

records, times standards, etc.).  Always check Entry Time.  

• Put a “0” in Relay Athlete Names as they take up too much space in the 

meet program and coaches always change their minds about the order anyway. 

• Click on Create Report to view the report. 

• Click  to send the report to the printer. 

• Photo copy this report and give one copy to each coach and assistant, each 

stroke-&-turn judge, each clerk-of-course, and each sorter (may need as many 

as 25 copies for large teams). 

• Click  to return to the Meet Program screen. 

• Click  to return to the Main Meet Manager 2.0 screen. 

 

XV. Creating the Coaches Report 
  

1. From the main Meet Manger 2.0 screen, select Reports > Entry lists and 

the Entry Lists window opens. 

• Ignore Gender and Age Range. 

• Under Filters, select Team. 

• Under Sort, check Alphabetically. 

 

2. Click the Report Type/Options/Format tab, 

• Under Report Type, check By Team. 

• Under Options, check Athletes + Relays. 

• Under Format, check Event Description and Time. 

 

3. Click the Include in Report tab,  

• Under Include in Report, click Include Heat and Lane and 

Entry Times. 

 

4. Click Create Report to view the report. 

• Click  to send the report to the printer. 

• Photo copy this report and give the head coach from all teams a copy of their 

meet entries. 

• Each Head Coach should receive a Coaches Package which should include their 

teams: 

• Meet Entry List 

• Relay Cards 

• Heat Sheets for each of the team’s coaches. 

• Click  to return to the Entry Lists screen. 

• Click  to return to the main Meet Manager 2.0 screen. 
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XVI. Creating Entry Card Labels 
 

1. From the main Meet Manger 2.0 screen,  

• Select Labels > Entry Cards/Labels and the Entry Card/Labels window 

opens. 

 

2. Select Gender, ignore Age Range, select Team and All Rounds, and check  Indiv 
+ Relays from the appropriate category. 

• This will enable you to run the entry labels by team to give to the clerk-of-

course by team. 

• Selecting the gender, i.e. running female labels and then male labels will make 

it easier to put them on the pink and blue JSL card. 

 

4. Under Label Selection, make the appropriate choice for your printer. 

 

5. Under Format,  

• Select Heat/Lane Number 

• Include Entry Time. 

• Set Relay Athlete Names (0-8) to “4”. 

 

6. Under Sort by, select Event Number.  

 

8. Click Select All and all events in the Event List are highlighted in yellow. 

9. Make sure there are appropriate labels in printer 

10. Click Create Labels to view the Label Report. 

• Click  to send the report to the printer. 

• Click  to return to the Entry Cards / Labels screen. 

 

11.  Repeat above procedure for each team and for both genders. 

• For Event 1P only, the Gender selected MUST be “Mixed”.  

• Click  to return to the main Meet Manager screen. 

 

XVII. Running the Meet 
 

1. From the main Meet Manger 2.0 screen,  

• Select Run and the Run the Meet screen opens. 

 

IMPORTANT:  The meet MUST be run in Session Format – No Exceptions! 

 

2. Click on the Session F7 button (on the left and below the Event List) which opens 

the Select Session screen.  

 

3. Under Session List and under Day, select “1” and click OK. The first event will 

then be highlighted. 

 

4.  Since most often the first event will be a relay we start with relays. Find and click on 

the Relay Names Ctrl-R button which opens the Real Name window. This will show 

all the names of the eligible swimmers for that relay. 

• Under Relay Teams, make sure that the name of the relay matches the relay 

card (examples: “BHSC A”, “GHG A”, “City B”). 

• Under Eligible Athletes, double click on the name of the first swimmer 

listed on the card and continue until all four swimmers have been entered. 

  



Jefferson Swim League Computer Manual – Revised July 5, 2024 

[JSL Man – sec 5 computer manual]                                          © 2024 JSL - Team Manual Section V - Page 32 

• If the name does not appear under Eligible Athletes, check Show Swim-
ups. 

• If you make a mistake, double click on the athlete name under Relay Order 

and the athlete will be returned to the list of Eligible Athletes. 

• Enter all the names of all the swimmers in all the relays. 

• Click and the names of the relay swimmers will be saved and the current 

window closes. 

 

5.  If you need to add a relay to an event, find and click on the Adjust F8 button. The 

Preview /Adjust screen opens. 

• Click Show Teams. 

• Under Eligible Relay Teams, click on the team you want to enter in the 

event (the cursor changes into a swordfish). Hold the mouse button and drag 

that team to the Event Description section above, and into the heat and lane 

you choose. 

• If you make a mistake, double click on the relay. A Hy-Tek’s Swim Meet 

manager 2.0 message box appears and answer Yes to “Scratch” this relay. 

• After you have added all the relays to the event, click Save and the screen 

will close your changes are saved. 

 

6. If you need to add an athlete to an event, find and click the Adjust F8 button. The 

Preview /Adjust screen opens. 

• Click  Show Teams. 

• Under Eligible Athlete, click on the swimmer you want to enter in the event  

(the cursor changes into a swordfish). Hold the mouse button and drag that 

swimmer to the Event Description section above, and into the heat and lane 

you choose. 

• If you make a mistake, double click on the athlete. A Hy-Tek’s Swim Meet 

manager 2.0 message box appears and answer Yes to “Scratch” this athlete 

by name. 

• After you have added all the athlete to the event, click Save and the screen 

will close and your changes are saved. 

 

7.  To enter times and score the event,  

• Under the  Heat == Finals==Event Section (in the  turquoise section), 

o Double-check that the event, heat, and lane match the Timer’s Card, 

then enter final time in the Final Time block and if not “DQ’d”. 

o Click under DQ column for disqualification (no time is entered). 

o Click under EXH column for Exhibitions ("UNO" on the Timer’s 

Card) and enter the time. 

• If there is more than one heat, advance to next heat by clicking one of the 
 

   
  heat numbers or click the next button from among the previous/next 

    

 heat buttons. 

• When a non-scored event is completed, go to the List Cntl-Lt and the results 

will be displayed and can be printed without a score. 

• When a scored event is completed, go to Score Cntl-S and the results will be 

displayed and can be printed with a score. 

• As you complete an event, the upper left-hand screen will show that the event 

was either “Scored” (in purple) or “Done” (in lavender).  

• “Done” means the event was completed and not scored, as is the case with 

the 6 and under mixed relay and all 6 and under events. 
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8.  To move to the next event and in the Event List, highlight the next event for data 

entry. Repeat for each event in the meet. 

 

9. Handling a Judge’s Decision 

• If you are informed of a judge's decision and must make changes in the 

scoring and placing, select JD Cntl-J and follow the directions on the 

Judge’s Decision /Tie Breaker screen.  Be sure to change both the Place (JD 

PL column) AND  the Points (JD Points column). When complete, click OK 

to return to the Run the Meet screen. 

 

10. Printing Ribbon Labels - For those using an inkjet or laser printer, it would be wise to 

wait and print award labels after you have at least a full page. 

• Select Labels > Award Labels at the top of the Run the Meet screen. 

• The Award Labels screen opens. 

• Leave Gender, Age Range, Team, Rounds as defaults shown. 

• Click the individual events under the Event List for which you want to create 

labels. Each event chosen is highlighted in yellow. 

• Under Label Selection, make printer and paper label selections as 

appropriate.  Select “1” thru “16” for Individual Places and “1” thru “3” 

(or “6” when it applies) for Relay Places. 

• Under Award Types, check Standard Award Label and show “4” in 

Relay Athlete Names (0-8). 

• Under Sort by check Event Number. 

• Click on Create Labels, make sure labels are in the tray, and click on  to 

send to the printer. 

• Click OK to confirm that’s what you want to do. 

• Click  to return to original Award Labels screen. 

• Under Event List in the far right column is the Printed column. Clicking on 

each event printed keeps track and reminds you of which events have already 

been printed. 

•  Click  again to return to the Run the Meet screen. 

 

11. Scores 

• From the Run the Meet screen, select Reports > Scores. 

• Leave Gender and Age Range as shown (defaults). 

• Leave Indiv + Relays and Standard Events checked (defaults). 

• At the bottom, click the Format tab. 

o Under Report Type, Click Team. 

o Under Report Gender Choices, click Combined. 

o Under Athlete Criteria, click No age criteria. 

o Under Points, click Std Pts. 

• Ignore the Grouping / Options and High Point Award Labels tabs. 

• Under Event List, 

• Check scored events which have been completed (remember 1P, 21P, 22P, 

41P, & 42P are non-scored events and should not be included). 

• Click Create Report and click  to send to the printer. 

• Click OK to confirm that is what you want to do. 

• Click  on the Team Scores screen to return to original Scores screen.  

• Click  to close the Scores screen and return to the Run the Meet screen. 

•  
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XVIII. At Meet's End 
 

A. Exit the Run the Meet screen by clicking to return to the Meet Manager 2.0 screen. 

 

B. Select File > Export. 
 

C. Select Results > Results for Team Manager or SWIMS. The Export Results screen 

Opens. 

• Under Team:, select the team for which you want to create the Results File.  

• Ignore LSC: and Region:. 

• Under Gender, check Both. 

• Under Events, check Standard Events. 

• Under Relays, check Relays Plus Athletes and leave Include Splits checked 

(the default). 

• Click OK and the Export File Progress screen opens. 

• Click OK and the Meet Results screen opens.  

• Under Drive, select the drive where you want to store the file. 

• Under Directory, select the directory where you want to store the file. 

• Click OK and a Hy-Tek’s Meet Manager window opens informing you that the 

“Meet Results Zipped successfully” and provides the name of the file created 

(example: “Meet Results-FV @ BHSC-06Jul2005-001.zip”. This file contains 

the Commlink file to be imported into Team Manager. 

• Click OK to return to the Meet Manager 2.0 screen. 

• Now, create another file. Repeat the steps above, but this time select All Teams 

or leave blank.  The Registrar and Seeding, who maintains the JSL central 

database, needs the results of the entire meet.  This will create another Commlink 

Meet Results File with all the teams' results. 

 

D. Uploading Meet Results (Commlink) File. 

 
1. Using your favorite browser (example: Firefox), go to the JSL Meet Results Upload 

on the JSL website. 

 

2.  Read the instructions found there before proceeding so you understand what to do. 

 

3.  In the data entry box provided, browse to the location where you have saved your Meet 

Results File and highlight it to enter it into the box. 

 

4. Separately upload the Meet Results (Commlink) file. 

 

5. Click the Upload button to upload a file. 

 

6.  A thank you message will display once the upload is completed successfully. If the 

upload cannot be completed for some reason, an error message will be displayed 

instead. In this case you will need to contact the JSL webmaster. 

 

 

XIX. Create a Meet Backup (a Meet Backup is what the other team expects so they can 

review the meet. The JSL webmaster needs a backup of the meet to post the meet results on the 

web site). 

 

1. From the main screen select File > Backup. 

 

  

https://www.jsl.org/meet-results-uploads2020.php
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2. The Backup Current Database screen opens. 

 

• Under Drive, select the drive where you want to store the file. 

• Under Directory, select the directory where you want to store the file. 

• Click OK and a Backup Options window opens informing you where the file will be 

backed up. 

• Click OK and a Backup Current Database window opens again, this time saying the 

backup is “Completed!” and the name of the file created (example: 

“SwimmBkupFV@BHSC 2005-03.zip”), as well as where it put the file. This 

file contains the a backup of the whole meet. 

• Click OK to return to the Meet Manager 2.0 screen. 

 

XX. Uploading Meet Results Files. 
 

1. Using your favorite browser (example: Firefox), go to the JSL Meet Results Upload 

on the JSL website. 

 

2.  Read the instructions found there before proceeding so you understand what to do. 

 

3.  In the data entry box provided, browse to the location where you have saved your Meet 

Results File and highlight it to enter it into the box. 

 

4. Separately upload the Meet Backup file. 

 

5. Click the Upload button to upload a file. 

 

6.  A thank you message will display once the upload is completed successfully. If the 

upload cannot be completed for some reason, an error message will be displayed 

instead. In this case you will need to contact the JSL webmaster. 

 

 

XXI. The Daily Progress AP News Format 
  

1. From the main screen, select Reports > Results.  

• Under Gender, check All. 

• Ignore Age Range and LSC. 

• Under Rounds, check All Rounds and Indiv + Relays. 

 

2. At the bottom of the screen, click the Columns / Format tab. 

• Under Report Type, and underneath that, Export File, click AP News. 

• Under Format, set Relay Names (0-8) to “4”. 

• Under Athlete ID, check None. 

• Under Time Stamp, select None. 

 

3. Click the Include in Results tab. 

• Under Include in Results, leave all blank. 

• Under Include Team Scores, check Combined. 

 

4. Click the Splits / Sort Order / Selected Teams tab. 

• Under Splits, check None. 

• Under Sort Order, check Event # Order. 

• Under Selected Teams, check All Teams. 

 

5. At the top, click Select All.  All the events in the Event List will be highlighted in 

yellow. 

 

6. Click Create Report. A Hy-Tek’s Meet Manager window opens, click Yes. 

 

https://www.jsl.org/meet-results-uploads2020.php
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7.  The Save AP News File as screen opens. 

▪ Enter in the Save in box the drive location where you want to store the AP News 

Report file called “Results.txt”.  

 

8. Click Save and another Hy-Tek’s Meet Manager window opens, click OK to return to 

the Results screen. 

 

9. Click  to return to the main Meet Manager 2.0 screen. 

 

10. Transmit results in AP Format to the Daily Progress via email attachment. 

• Send email to: 

o sports@dailyprogress.com 

o sportsdailyprogress@gmail.com 

o jshifflett2@dailyprogress.com (John Shifflett, Sports Editor) 

• Include team names and final scores in the email. 

• Send AP Formatted Results as an attachment to this email. 

 

XXII. Post Meet Reports (only if needed) 
These reports may be given to each head coach.  It is not necessary to create these reports for the 

JSL webmaster, as the backup of the meet will contain all this information. 

 

1. From the main Meet Manager 2.0 screen, select Reports > Results. 

 

2. The Results window opens.  

• Under Gender, check All. 

• Ignore Age Range and LSC 

• Under Rounds, check All Rounds and Indiv + Relays 

 

3.  At the bottom of the screen, click the Columns / Format tab. 

• Under Report Type,  
o Under Columns, select Triple. 

• Under Format, set Relay Names (0-8) to “4”. 

• Under Athlete ID, check None. 

• Under Time Stamp, select None. 

 

4.  Click the Include in Results tab. 

• Under Include in Results, leave all blank. 

• Under Include Team Scores, check Combined. 

 

5. Click the Splits / Sort Order / Selected Teams tab. 

• Under Splits, check None. 

• Under Sort Order, check Event # Order. 

• Under Selected Teams, check All Teams. 

•  

6. At the top, click Select All.  All the events in the Event List will be highlighted in 

yellow. 

 

mailto:sports@dailyprogress.com
mailto:Sportsdailyprogress@gmail.com
mailto:jshifflett2@dailyprogress.com
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7. Click Create Report. A Hy-Tek’s Meet Manager window opens, click  to send 

the report to the printer. 

 

8.  A Print window opens.  Click OK. 

 

9. Click  to return to the Print window. 

 

10. Click  to return to the main Meet Manager 2.0 screen. 

 

11. Select File > Exit and click to close Meet Manager 2.0. 
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MEET COMPUTER CHECKLIST               APPENDIX T 
(Added, 2019) 

Thanks to Terry Doherty (GCC) for writing this guide and Jessica Simons (BHSC) for editing. 

 
BEFORE ALL MEETS 

2. In TEAM Manager, create a “meet” for the current week.  It is always good to have the 
date [sample: FSBC @ GCC Jun 1]  To avoid confusion, it is known as CURRENT MEET 
in the rest of this document. 
 

2. Confirm the meet format for the week [Medley Relay/Long Free or IM/Free Relay] 
a. Go to Meet>Set-up to copy a meet event file that matches the correct format AND the 

correct pool length [SCY, SCM, LCM] 
b. Copy the events only from the old meet into the Current Meet you are preparing for. 
c. Make sure that the meet reflects that breaststroke events are “30s” and butterfly 

events “50s.” 
 

3. Enter swimmers in events for the Current Meet. 
a. Go to Meets > Highlight the appropriate week [i.e., Current Meet]. 

i. Week 1 - Each swimmer is limited to 2 individual events and 1 relay. 
ii. Weeks 2 to 6 - Each swimmer is limited to 3 individual events and 1 relay for 

scoring. 
b. Go to “Entries” to add swimmers to events 

i. OPTION 1: Entries > By Event - to get an event-order list of events. 
ii. OPTION 2: Entries > by Name - to get an alphabetical list of swimmers & eligible 

events. 
c. If using “Enter swimmers by Name,” you cannot enter them in Relays.  Go to “Entries 

> By Event” to do that. 
d. Exhibition - Swimmers can swim Exhibition for additional events, at the Head 

Coach’s discretion, and with the approval of both Meet Directors. 
e. Relays may be entered using Option 1 under b, i.  Choose relays by checking the 

“bra box”. 
 

4. Once all swimmers are added to events, create an Entry Report. 
a. Go to Reports > Entry Report. 
b. Select “Males” and “Create Report.” 
c. Select “Females” and “Create Report.” 

 

5. Review the Entry Report for anomalies or errors, including but not limited to  
a. swimmer entered but not swimming 
b. swimmer not entered but swimming  
c. swimmer entered in too few events 
d. swimmer entered in too many events (i.e., for scoring, not Exhibition). 
e. eligible swimmers entered in a relay, as appropriate. 

 

6. Once you are satisfied with the entries, export the meet entry file and export to the JSL 
file Upload. 
a. File > Export > Entries to export an entry file with the team’s entries for the Current 

Week. 
b. File > Export > Athletes to export a roster file of the eligible swimmers. 

 

7. Open MEET Manager to select the pre-formatted meet file for the CURRENT MEET.  
[NOTE: All Meet Setup Files are prepared and downloaded from www.jsl.org]  They 
should be “pre-loaded” into MM at the beginning of the season by Computer Operator 
and will be listed at the bottom of the “File” menu.] 
a. From the left sidebar to go Computers > Meet Format Files. 
b. File > bottom of that menu list > select the correct file. 
c. Confirm that the file is open by checking the top of your screen.  It should have the 

title of the Current Meet listed on the very top line. 

  

https://www.jsl.org/index.php
https://www.jsl.org/index.php
https://www.jsl.org/support2020.php?section=computers&content=meetformatfiles
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APPENDIX T 
(continued) 

8. Upload the Entries for your team 
a. File > Import > Meet Entries 
b. Find the file [.zip] you saved and highlight it for Import. 
c. Select “your team name” from the team dropdown for the file. 
d. If there are no errors … 

 

9. Download the official Meet Entries file: File > Export > Meet Entries. 
 

10. Once the Meet Entries file is downloaded, go to www.jsl.org 
a. From the left sidebar go to Meets > Meet Entries > Meet Entries Upload Page. 
b. Select the correct meet from the dropdown list and click “Submit Query.” 
c. Repeat to upload the current roster file at this time, too. 

 

BEFORE HOME MEETS 
1. Confirm with Meet Director Visiting team’s lane preference and any swimmer 

accommodations. 
2. The Day before the meet, go to www.jsl.org to obtain the visiting team’s entry file. 

a. From the left sidebar to go Meets > Meet Entries > Meet Entries Upload Page. 
b. Select the correct meet from the dropdown menu and click “Submit Query.”  Both 

team’s (home and visiting) files should be listed there. 
 

3. Right-click the visiting team file to “save link as.”  This downloads the file to the team 
computer. 

 

4. Open MEET Manager to import the opposing team’s entries. 
a. File > Import > Entries and select the .zip file for the visiting team. 
b. On the Import Entries Screen select (a) Match on Event Numbers; (b) Include NT 

entries. [all else blank] 
 

5. Go to Set-Up > Seeding Preferences to seed the meet. 
a. Click “Dual Meets” tab and set Lane Assignments, as discussed with Meet Director. 
b. DO NOT select “strict odd/even seeding” because that adds extra heats.  Use lane 

assignment above as the seeding option. 
c. Click “OK” to finish setup. 

 

6. Go to Seeding > Seeding the Meet. 
a. Click “Select All” so that all events turn yellow. 
b. Click “Start Seeding.” 
c. Click “OK”. 

 

7. Review the Meet Program to verify lane assignments and correct seeding (e.g., fastest 
swimmers in middle of the pool).  [There are times when a meet has to be re-seeded.] 
a. Reports > Meet Program. 
b. View Male, Female, or All - Coach’s choice. 
c. Click “Create Report” to view and print report for quality control review. 

 

8. As appropriate / necessary, make adjustments for swimmers with special needs. 
a. Go to Athletes to find the swimmer.  Highlight their name. 
b. In “Entries” box select “All Events.” 
c. Select event you want for swimmer.  MAKE SURE that “Exh” has a checkmark! 
d. Remove the swimmer from event originally entered in and carry the entered time to 

the new event 
e. REVIEW heat sheet to determine heat and lane for this swimmer.  Adjust the event 

so that swimmer 
i. is in the slowest heat 
ii. Seeded in an outside lane. 

f. Go to “Seeding the Meet” and highlight the event. 
g. Select “Preview” so that you can see the event and swimmers. 
h.  Select “Team” and then “Eligible swimmers” to find that swimmer. 
i. Add Swimmer and/or adjust lanes for the slowest heat. 

 

  

https://www.jsl.org/index.php
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APPENDIX T 
(continued) 

9. Print Heat Sheets for workers. 
a. Go to Reports > Meet Program.  Select All (events turn yellow). 
b. Click “Include in Meet Program Tab. 

i. Meet Director / Referee / Starter get a heat sheet with Event timeline. 
ii. Everyone else gets a heat sheet without the Event timeline. 

c. Click “Create Report” to print each of the two reports. 
 

10.  “Print” one heat sheet as a PDF.  [Printer is called Microsoft Print to PDF; save to 
computer.]  
a. Send that file to Meet Director for distribution to home team and the visiting team’s 

Meet Director prior to start of the meet. 
b. This is optional. 

 

11. Go to Labels > Entry Cards/Labels to print event labels for swimmers. 
a. Select Team and gender to run entry labels that are pre-sorted for Clerk of Course.  

There will be 5 sets: Mixed, Home-Girls, Home-Boys, Visitor-Girls, Visitor-Boys 
b. Before printing, check “Sort by Event Number” and label format [3x10]. 
c. Select All Events > Create Labels to view the label report. 
d. Load printer with label sheets and print. 

 

12. Print Entry Reports for coaches.  There are four reports: Visiting Male, Visiting Female, 
Home Male, and Home Female. 
a. Go to Reports > Entry Lists 
b. In Gender box select Male or Female  
c. In Filters box select Team. 
d. In Sort box select “Alphabetical” 
e. In Options Box select “Athletes + Relays” 
f. In “Include in Report” tab uncheck “Show Check-in Req” 
g. Click “Create Report.” 
h. This is optional. 

 
AFTER ALL MEETS 
Computer operators exchange Boy/Girl merge meet results file of same meet to create a 
complete record of the meet.  They will then create a meet backup and a meet result file for 
export. 
 

To ensure that you don’t lose files, there should be a copy in two places: c: / and a thumb drive. 
 

1. From MEET Manager 
a. Export the backup file and Meet Results file (both zip) to your team’s Thumb Drive 

AND the C:/ drive. 
b. Be sure that there is a Meet Results file “for SWIMS …” format. 

 

2. In TEAM Manager 
a. Check the title line to ensure it is the most recent meet. 
b. Import > Meet Results. 
c. Select “Match on Swim ID” - because some swimmers’ nicknames appear on the 

cards, but their official names are in the Registration. 
 

AFTER HOME MEETS 
2. Get backup file and Meet Results file (both zip).  These are “exported” from MEET 

Manager. 
 

2. Upload the zip files (one at a time) to the JSL Meet Results Upload Page on 
www.jsl.org  
a. From the left sidebar to go Meets > Meet Results > Meet Results Upload Page 
b. The Meet Results file [looks like this: Meet Results-FCC @ GCC 2011-16Jun2010-

004.zip] 
c. The Backup file [looks like this: Swmm2BkupGCC @ CGST 2011-01.zip] 
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APPENDIX T 
(continued) 

3. Send an email version of the Meet Results to the Daily Progress.  
a. Go to Reports > Results. 
b. Top of the screen: The following items should already be selected: All, All Rounds, 

and Indiv + Relay.  Ignore Age Range and LSC 
c. Bottom of screen. 

i. Columns/Format Tab: AP News and Results by Heat should be already checked.  
Also make sure that “Top How Many” is empty and “Relay Names” is 4. 

ii. On Include in Results Tab: “Combined” should be checked.  All else left blank. 
iii. Ignore Splits / Sort Order / Selected Teams Tab. Should already be checked as 

None, Event # Order, and All Teams. 
d. At top, hit “Select All.” 
e. Click “Create Report” and “Save in” to identify location for file named results.txt. 
f. Create email to sports@dailyprogress.com and sportsdailyprogress@gmail.com. 

Include team names and final scores in the email and ATTACH the results.txt file. 
 

TIME IMPROVEMENT LABELS 
2. Open TEAM Manager and confirm that the most recent meet results are in the system. 

 

2. Go to Labels > Improvement Labels to print Time Improvement ribbons.  Review the 
boxes.  
a. Check only “Time Standards” 
b. Check “conversions” - this ensures best time across pool sizes (LCM, SCY, SCM) i.

 Head Coach’s Call: Check (or uncheck) “First Time Swim.” 
c. Make sure that “Best” is the selected option.  
d. Check print format (3 x 10 is what you want). 

 

3. Click “Create labels” to get a preview of the labels.  Click >| to see how many pages of 
labels are needed, and put them in the printer. 

 

4. Print. 
 

Notes for printing time improvement labels: 
- For the first two meets of the year, you will need to “play with” [check or uncheck] the 

“Use Since Date” (06/01/current year).  Reason: sometimes the system wants to pull 
improvements from the previous season. 

- You may also need to “play with” the conversion box.  It is helpful to have a Meet Results 
report with actual times for swimmers before printing labels.  It is a good check / balance 
for actual improvements. 

 

IMPORTANT 
The instructions above are meant only as a guide and checklist.  More detailed information may 
be found in the JSL Computer Manual which may be viewed and downloaded. 
 
There are also Up to date manuals available from 
Hy-Tek User Guides or Demos for Meet Manager or Team Manager 

 

mailto:sports@dailyprogress.com
mailto:sportsdailyprogress@gmail.com
mailto:sportsdailyprogress@gmail.com
https://www.jsl.org/documents/bin/Current/JSLComputerManual.pdf
https://hytek.active.com/downloads.html

